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Cumulative Changes from Mainframe
Express to Enterprise Developer for
Eclipse

Welcome to Enterprise Developer for Eclipse. This document combines information on Enterprise
Developer for Eclipse releases from the first release to the most recent release, and on upgrading from
Mainframe Express to Enterprise Developer. This information is taken from the various releases' Release
Notes and other sources, and brought together here for your convenience.

You can use this document:

• If you are migrating from Mainframe Express, to see everything that has changed in the life of
Enterprise Developer for Eclipse.

• If your Enterprise Developer installation is up to date, to see the changes made in the latest release.
• If you already use Enterprise Developer but your installation is not entirely up to date, to see the

changes made over several updates, together in one place.

About this Guide
We recommend that you read all the sections of this publication, looking for information on the release that
is most relevant to your needs. The main sections are as follows:

What was New This section describes new functionality that was introduced in each
successive release.

Significant Changes This section describes, for each successive release, the changes in
behavior or usage that could affect the behavior of existing applications or
impact the way the tools are used.

Unsupported or Deprecated
Functionality

This section describes any functionality that was discontinued or
deprecated at a given release.

Known Errors and
Restrictions

This section describes known errors affecting the latest release, and
restrictions in its use.

Upgrading from Mainframe
Express to Enterprise
Developer

This section gives guidance on upgrading from earlier Micro Focus
products.

Within each section, we recommend reading in the reverse chronological order in which it is presented
here - that is, reading about the most recent release first, and then going back through the development of
the products. That way, you can more easily see if anything was added in an earlier release and
subsequently removed.

Changes to Compiler Directives, Run-Time Tunables,
Library Routines and Environment Variables

This section provides an index of items added, deprecated and changes since the first version of
Enterprise Developer. The changes are presented in a number of tables according to the type of feature
involved. The first set of tables lists changes in alphabetical order. A second section lists changes in order
of release.
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Changes in Alphabetical Order
The changes are presented in the following tables:

• Compiler Directives
• Run-Time Tunables
• Library Routines
• Environment Variables

For each change, the table lists:

• The name of feature that changed,
• The type of change,
• The version of Enterprise Developer in which the change was introduced,
• A link to more information.

Table 1: Changes to Compiler Directives

Name Change At Product
Version

See

01SHUFFLE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

64KPARA Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

64KSPECT Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

ACU-UNDERSCORE New 2.2 What was new in 2.2

ALPHA-LIT-CONT New 9.0 What was new in 9.0

AMODE New
parameter

8.0 What was new in 8.0

ANIM Changed
default

5.0 Significant changes in 5.0

AUXOPT Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

CHANGE-MESSAGE Changed
scope

2.2 What was new in 2.2

CHECKDIV New
parameter

4.0 What was new in 4.0

CHECKREFMOD New
parameter

6.0 What was new in 6.0

CHIP Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

COMMAND-LINE-LINKAGE New 2.3 Update 2 What was new at 2.3 Update 2
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Name Change At Product
Version

See

COMP1 New 2.1 What was new in 2.1

COMP2 New 2.1 What was new in 2.1

CONVERTRET Deprecated 3.0 Unsupported or Deprecated at 3.0

DECLARE New 9.0 What was new in 9.0

DIALECT"RM" Changed
effect

2.2 What was new in 2.2

DISPLAY New 2.1 What was new in 2.1

DISPLAY-AT New 6.0 What was new in 6.0

DISPLAY-PICU New 8.0 What was new in 8.0

DISPSIGN New 4.0 What was new in 4.0

DATALIT Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

DATAMAP New
parameter

2.1 What was new in 2.1

DBSPACE New
parameter

2.3 What was new in 2.3

DPC-IN-DATA New 6.0 What was new in 6.0

EANIM Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

EBC-COL-SEQ New 2.3 Update 2 What was new at 2.3 Update 2

EDITOR Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

ENSUITE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

EOF-1A New 2.3 What was new in 2.3

EXECSQL-FLAG New 7.0 What was new in 7.0

EXITPROGRAM New 2.2 What was new in 2.2

EXPANDDATA Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

FIXING Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

FLAG-CHIP Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

GNTLITLINKSTD New 4.0 What was new in 4.0
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Name Change At Product
Version

See

HIDE-MESSAGE Changed
scope

2.2 What was new in 2.2

HOSTSIGNS Unsupported 3.0 Unsupported or Deprecated at 3.0

IDXFORMAT8 New option Enterprise
Developer Base
release

IDXFORMAT12 New option 2.3 Update 1

IDYSRCPATH Deprecated 3.0 Unsupported or Deprecated at 3.0

ILCONDITIONPARAM New 6.0 What was new in 6.0

ILEXPONENTIATION New 2.2 What was new in 2.2

ILEXPOSEALPHA New 9.0 What was new in 9.0

ILEXPOSEGROUP New 9.0 What was new in 9.0

ILCLR"2" Deprecated 7.0 What was new in 7.0

ILMAIN New 2.3 Update 1 What was new in 2.3 Update 1

ILNORMALIZENAMES New 5.0 What was new in 5.0

ILOBJECTIFY Deprecated 3.0 Unsupported or Deprecated at 3.0

ILPARAMS New 2.2 Update 1 What was new in 2.2 Update 1

ILSHOWPERFORMOVERLAP New 2.2 What was new in 2.2

ILSMARTRESTRICT New 2.1 What was new in 2.1

ILSMARTTRIM New 4.0 What was new in 4.0

ILSTRINGLOAD New 9.0 What was new in 9.0

INIT-BY-TYPE New 2.2 Update 1 What was new in 2.2 Update 1

INITIAL New 9.0 What was new in 9.0

JAVA-CALLABLE New 9.0 What was new in 9.0

JAVA-GEN-PROGS New 9.0 What was new in 9.0

JAVA-GEN-STRG New 9.0 What was new in 9.0

JAVA-OUTPUT-PATH New 9.0 What was new in 9.0

JAVA-PACKAGE-NAME New 9.0 What was new in 9.0

JAVA-SHAREABLE New 9.0 What was new in 9.0

JVMDECIMAL New 2.3 What was new in 2.3

JVMTARGET New 5.0 What was new in 5.0

MAINFRAME-FLOATING-POINT New 4.0 What was new in 4.0

MANAGED-FNC-PARAM-BY New 9.0 What was new in 9.0

MASM Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010
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Name Change At Product
Version

See

MODEL Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

NATIONAL New 2.3 Update 2 What was new at 2.3 Update 2

NLS-CURRENCY-LENGTH New 2.3 What was new in 2.3

NULL-ESCAPE New 2.3 What was new in 2.3

NUMPROC New
parameter

4.0 What was new in 4.0

OOCTRL New 2.3 Update 1 What was new in 2.3 Update 1

OOCTRL New
parameter

4.0 What was new in 4.0

OPTIMIZECURSORS New 3.0 Significant changes in 3.0

OPTION Deprecated 3.0 Unsupported or Deprecated at 3.0

OPTSIZE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

OPTSPEED Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

PANVALET-INCLUDES-IN-COMMENTS New 7.0 What's new in 7.0

PARAS Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

PRESERVECASE Changed
scope

2.2 What was new in 2.2

PROTMODE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

PROTOTYPE New
parameter

6.0 What was new in 6.0

REGPARM Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

RESTRICT-GOTO New 2.1 What was new in 2.1

RM-FILE-ERRORS New 7.0 What's new in 7.0

SEGCROSS Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

SEGSIZE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010
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Name Change At Product
Version

See

SIGNCOMPARE Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

SMALLDD Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

SPZERO Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

TABLESEGCROSS Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

TRICKLE Deprecated 3.0 Unsupported or Deprecated at 3.0

TRICKLECHECK Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

WB2 Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

WB3 Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

WB Deprecated Enterprise
Developer Base
release

Unsupported or Deprecated at
2010

Table 2: Changes to Run-time Tunables

Name Change At Product
Version

See

command_line_linkage Deprecated 2.3 Update 2 Unsupported or Deprecated at 2.3
Update 2

default_cancel_mode New default
value

New parameter

2.3 What was new in 2.3 - Tunables

putenv_interface New 2.3 What was new in 2.3 - Tunables

reduce_java_signals New 2.2 Update 2 Significant changes in 2.2 Update
2

strict_file_locking New 2.3 What was new in 2.3 - Tunables

subsystem_cancel_mode New 2.0 What was new in 2.0 - Run-time
Tunables

New parameter 2.3 What was new in 2.3 - Tunables
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Table 3: Changes to Library Routines

Name Change At Product
Version

See

CBL_CREATE_CORE New 5.0 What was new in 5.0

CBL_CTF_COMP_PROPERTY_GET New 2.0 What was new in 2.0

CBL_CTF_TRACE New 2.0 What was new in 2.0

CBL_CTF_TRACER_LEVEL_GET New 2.0 What was new in 2.0

CBL_CTF_TRACER_GET New 2.0 What was new in 2.0

CBL_CTF_LEVEL New 2.0 What was new in 2.0

CBL_CODESET_SET_MAPPING New 2.3 Update 1 What was new in 2.3 Update 1

CBL_GET_DEBUG_START New 4.0 What was new in 4,0

CBL_GET_DEBUG_STOP New 4.0 What was new in 4,0

CBL_GET_ERROR_INFO New 7.0 What's new in 7.0

CBL_GET_EXIT_INFO Enhanced 6.0 What was new in 6.0

CBL_GET_OS_INFO New 4.0 What was new in 4,0

CBL_LOCATE_FILE New parameter 2.3 What was new in 2.3

CBL_MANAGED_SESSION_GET_USERD
ATA

New 2.3 What was new in 2.3

CBL_MANAGED_SESSION_SET_USERDA
TA

New 2.3 What was new in 2.3

CBL_RUNTIME_ERROR New 2.3 Update 1 What was new in 2.3 Update 1

CBL_SEMAPHORE_ACQUIRE New parameter 2.0 What was new in 2.0

CBL_CREATE_CORE New 5.0 What was new in 5.0

MFU_GET_FILE New 6.0 What was new in 6.0

MFUGETF New 6.0 What was new in 6.0

PC_PRINTER_SET_FONT Enhanced 8.0

Table 4: Changes to Environment Variables

Name Change At Product
Version

See

ES_CAT_RETRY_COUNT New 4.0 Configuring Multiple Catalogs

ES_CAT_RETRY_WAIT New 4.0 Configuring Multiple Catalogs

ES_DSENQSHR New 8.0 What was new in 8.0

ES_IMS_DISPLAY_NEW New 9.0 What was new in 9.0

ES_IMS_TLOG_FLUSH Deprecated 2.2 Update 2 Significant changes in 2.2 Update 2

ES_JES_ENFORCE_EXPIRE_
DATE

New 8.0 Significant changes in 8.0

ES_JES_LISTCAT_YMD New 8.0 Significant Changes in 8.0

ES_RDO_MAX_RESOURCES New 7.0 What's new in 7.0
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Name Change At Product
Version

See

ES_SNATRC_DIR New 5.0 Significant changes in 5.0

ES_ZOS_SYSPRINT_DCB New 8.0

FSWRKDIR New 3.0 What was new in 3.0

FSCHKLFH New 3.0 What was new in 3.0

HCOBND Deprecated 3.0 Unsupported or Deprecated at 3.0

MFALLOC_PCFILE Default value changes 2.2 Update 2 Significant changes in 2.2 Update 2

MFFTPXIT New 9.0 Significant changes in 9.0

MFJ_LEX_LOCATION New 8.0 Significant Changes in 8.0

SPOOL_TIMEOUT New 8.0

strictvsam New 2.2 Update 1 What was new in 2.2 Update 1

Changes in Order of Release
The changes are presented in the following tables:

• Compiler Directives
• Run-Time Tunables
• Library Routines
• Environment Variables

For each change, the table lists:

• The version of Enterprise Developer in which the change was introduced, starting with the earliest,
• The name of feature that changed,
• The type of change,
• A link to more information.

Table 5: Changes to Compiler Directives

At Product
Version

Name Change See

Enterprise
Developer Base
release

01SHUFFLE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

64KPARA Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

64KSPECT Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

AUXOPT Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

CHIP Deprecated Unsupported or Deprecated at
2010
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At Product
Version

Name Change See

Enterprise
Developer Base
release

DATALIT Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

EANIM Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

EDITOR Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

ENSUITE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

EXPANDDATA Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

FIXING Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

FLAG-CHIP Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

IDXFORMAT8 New option

Enterprise
Developer Base
release

MASM Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

MODEL Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

OPTSIZE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

OPTSPEED Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

PARAS Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

PROTMODE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

REGPARM Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

SEGCROSS Deprecated Unsupported or Deprecated at
2010
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At Product
Version

Name Change See

Enterprise
Developer Base
release

SEGSIZE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

SIGNCOMPARE Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

SMALLDD Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

SPZERO Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

TABLESEGCROSS Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

TRICKLECHECK Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

WB2 Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

WB3 Deprecated Unsupported or Deprecated at
2010

Enterprise
Developer Base
release

WB Deprecated Unsupported or Deprecated at
2010

2.1 COMP1 New What was new in 2.1

2.1 COMP2 New What was new in 2.1

2.1 DISPLAY New What was new in 2.1

2.1 DATAMAP New
parameter

What was new in 2.1

2.1 ILSMARTRESTRICT New What was new in 2.1

2.1 RESTRICT-GOTO New What was new in 2.1

2.2 ACU-UNDERSCORE New What was new in 2.2

2.2 CHANGE-MESSAGE Changed
scope

What was new in 2.2

2.2 DIALECT"RM" Changed
effect

What was new in 2.2

2.2 EXITPROGRAM New What was new in 2.2

2.2 HIDE-MESSAGE Changed
scope

What was new in 2.2

2.2 ILEXPONENTIATION New What was new in 2.2

2.2 ILSHOWPERFORMOVERLAP New What was new in 2.2

2.2 PRESERVECASE Changed
scope

What was new in 2.2
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At Product
Version

Name Change See

2.2 Update 1 ILPARAMS New What was new in 2.2 Update 1

2.2 Update 1 INIT-BY-TYPE New What was new in 2.2 Update 1

2.3 DBSPACE New
parameter

What was new in 2.3

2.3 EOF-1A New What was new in 2.3

2.3 JVMDECIMAL New What was new in 2.3

2.3 NLS-CURRENCY-LENGTH New What was new in 2.3

2.3 NULL-ESCAPE New What was new in 2.3

2.3 Update 1 IDXFORMAT12 New option

2.3 Update 1 ILMAIN New What was new in 2.3 Update 1

2.3 Update 1 OOCTRL New What was new in 2.3 Update 1

2.3 Update 2 EBC-COL-SEQ New What was new at 2.3 Update 2

2.3 Update 2 COMMAND-LINE-LINKAGE New What was new at 2.3 Update 2

2.3 Update 2 NATIONAL New What was new at 2.3 Update 2

3.0 CONVERTRET Deprecated Unsupported or Deprecated at 3.0

3.0 HOSTSIGNS Unsupported Unsupported or Deprecated at 3.0

3.0 IDYSRCPATH Deprecated Unsupported or Deprecated at 3.0

3.0 ILOBJECTIFY Deprecated Unsupported or Deprecated at 3.0

3.0 OPTIMIZECURSORS New Significant changes in 3.0

3.0 OPTION Deprecated Unsupported or Deprecated at 3.0

3.0 TRICKLE Deprecated Unsupported or Deprecated at 3.0

4.0 CHECKDIV New
parameter

What was new in 4.0

4.0 DISPSIGN New What was new in 4.0

4.0 GNTLITLINKSTD New What was new in 4.0

4.0 ILSMARTTRIM New What was new in 4.0

4.0 MAINFRAME-FLOATING-POINT New What was new in 4.0

4.0 NUMPROC New
parameter

What was new in 4.0

4.0 OOCTRL New
parameter

What was new in 4.0

5.0 ILNORMALIZENAMES New What was new in 5.0

5.0 JVMTARGET New What was new in 5.0

5.0 ANIM Changed
default

Significant changes in 5.0

6.0 DISPLAY-AT New What was new in 6.0

6.0 DPC-IN-DATA New What was new in 6.0

6.0 ILCONDITIONPARAM New What was new in 6.0

6.0 CHECKREFMOD New
parameter

What was new in 6.0
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At Product
Version

Name Change See

6.0 PROTOTYPE New
parameter

What was new in 6.0

7.0 EXECSQL-FLAG New What's new in 7.0

7.0 ILCLR"2" Deprecated What's new in 7.0

7.0 PANVALET-INCLUDES-IN-COMMENTS New What's new in 7.0

7.0 RM-FILE-ERRORS New What's new in 7.0

8.0 AMODE New
parameter

What was new in 8.0

8.0 DISPLAY-PICU New What was new in 8.0

9.0 ALPHA-LIT-CONT New What was new in 9.0

9.0 DECLARE New What was new in 9.0

9.0 ILEXPOSEALPHA New What was new in 9.0

9.0 ILEXPOSEGROUP New What was new in 9.0

9.0 ILSTRINGLOAD New What was new in 9.0

9.0 INITIAL New What was new in 9.0

9.0 JAVA-CALLABLE New What was new in 9.0

9.0 JAVA-GEN-PROGS New What was new in 9.0

9.0 JAVA-GEN-STRG New What was new in 9.0

9.0 JAVA-OUTPUT-PATH New What was new in 9.0

9.0 JAVA-PACKAGE-NAME New What was new in 9.0

9.0 JAVA-SHAREABLE New What was new in 9.0

9.0 MANAGED-FNC-PARAM-BY New What was new in 9.0

Table 6: Changes to Run-time Tunables

At Product
Version

Name Change See

2.0 subsystem_cancel_mode New What was new in 2.0 - Run-time
Tunables

2.2 Update 2 reduce_java_signals New Significant changes in 2.2 Update
2

2.3 default_cancel_mode New default
value

New parameter

What was new in 2.3 - Tunables

2.3 putenv_interface New What was new in 2.3 - Tunables

2.3 strict_file_locking New What was new in 2.3 - Tunables

2.3 subsystem_cancel_mode New parameter What was new in 2.3 - Tunables

2.3 Update 2 command_line_linkage Deprecated Unsupported or Deprecated at 2.3
Update 2
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Table 7: Changes to Library Routines

At Product
Version

Name Change See

2.0 CBL_CTF_COMP_PROPERTY_GET New What was new in 2.0

2.0 CBL_CTF_TRACE New What was new in 2.0

2.0 CBL_CTF_TRACER_LEVEL_GET New What was new in 2.0

2.0 CBL_CTF_TRACER_GET New What was new in 2.0

2.0 CBL_CTF_LEVEL New What was new in 2.0

2.0 CBL_SEMAPHORE_ACQUIRE New parameter What was new in 2.0

2.3 CBL_LOCATE_FILE New parameter What was new in 2.3

2.3 CBL_MANAGED_SESSION_GET_USERDA
TA

New What was new in 2.3

2.3 CBL_MANAGED_SESSION_SET_USERDA
TA

New What was new in 2.3

2.3 Update 1 CBL_CODESET_SET_MAPPING New What was new in 2.3 Update 1

2.3 Update 1 CBL_RUNTIME_ERROR New What was new in 2.3 Update 1

4.0 CBL_GET_DEBUG_START New What was new in 4,0

4.0 CBL_GET_DEBUG_STOP New What was new in 4,0

4.0 CBL_GET_OS_INFO New What was new in 4,0

5.0 CBL_CREATE_CORE New What was new in 5.0

6.0 CBL_GET_EXIT_INFO Enhanced What was new in 6.0

6.0 MFU_GET_FILE New What was new in 6.0

6.0 MFUGETF New What was new in 6.0

7.0 CBL_GET_ERROR_INFO New What was new in 7.0

8.0 PC_PRINTER_SET_FONT Enhanced

Table 8: Changes to Environment Variables

At Product
Version

Name Change See

2.2 Update 1 strictvsam New What was new in 2.2 Update 1

2.2 Update 2 ES_IMS_TLOG_FLUSH Deprecated Significant changes in 2.2 Update 2

2.2 Update 2 MFALLOC_PCFILE Default value changes Significant changes in 2.2 Update 2

3.0 FSWRKDIR New What was new in 3.0

3.0 FSCHKLFH New What was new in 3.0

3.0 HCOBND Deprecated Unsupported or Deprecated at 3.0

4.0 ES_CAT_RETRY_COUNT New Configuring Multiple Catalogs

4.0 ES_CAT_RETRY_WAIT New Configuring Multiple Catalogs

5.0 ES_SNATRC_DIR New Significant changes in 5.0

7.0 ES_RDO_MAX_RESOURCES New What was new in 7.0

8.0 ES_DSENQSHR New What was new in 8.0
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At Product
Version

Name Change See

8.0 ES_JES_ENFORCE_EXPIRE_
DATE

New Significant changes in 8.0

8.0 ES_JES_LISTCAT_YMD New Significant Changes in 8.0

8.0 ES_ZOS_SYSPRINT_DCB New

8.0 MFJ_LEX_LOCATION New Significant Changes in 8.0

8.0 SPOOL_TIMEOUT New

9.0 ES_IMS_DISPLAY_NEW New What was new in 9.0

9.0 MFFTPXIT New Significant changes in 9.0

What was New
This section describes the new features that were introduced in each successive release of Enterprise
Developer.

What was New in Enterprise Developer 9.0

New Features in Enterprise Developer 9.0
Enhancements are available in the following areas:

• Application Workflow Manager
• AppMaster Builder
• COBOL Language
• Compiler Directives
• Data Modernization Advice
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• IMS support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Enterprise Extension for Visual Studio Code
• Micro Focus Learn COBOL extension and COBOL course
• Micro Focus Unit Testing Framework
• PL/I Support
• Terminal Emulation
• Tracing

Application Workflow Manager

Back to Top

This release offers the following improvements:

• A new Git Function Package - provides tools that support common Git interactions such as Clone, Add,
and Commit. This function package provides tool types to integrate the distributed revision control
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system Git into your AWM model and enabling you to build a development workflow that includes Git
version control actions within the AWM Team Developer perspective.

AppMaster Builder

Back to Top

This release includes new functionality to support long and spacey paths. This affects the following:

• 8dot3 short-name creation behavior is no longer required on your computer file systems. See your
Windows documentation for more information about enabling and disabling 8dot3 short-name creation.

• AMB file-tailoring skeleton files no longer require modification (usually these modifications consisted of
enclosing paths within quotes) to use long and spacey file names.

• You must compare and reintegrate any customizations applied to file-tailoring skeleton files used in
earlier versions of AMB into the new skeleton files provided with this release. These files are found in
your %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ispslib directory,
and include:

SSMSISP
SSMSDLG
SSMSMFS
SSMCHK
SSMPCOM
SSMSCGEN
SSMCOMP
SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY

COBOL Language

Back to Top

This release provides the following new features and enhancements to the COBOL language:

• Double-colon, ::, qualification is now available as a qualifier for data names and when dereferencing
pointers.

• PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

• Parameterized sections - syntax that allows program sections to accept arguments and return values.
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• PERFORM of a SECTION can now pass arguments to that SECTION.
• A result can be returned to the code that PERFORMed the SECTION.
• Sections that return a value can be used as functions, in contexts where an identifier is expected.

• Compiler can identify platform at compile time - the compile-time constants __unix, __windows,
__dotnet, __jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

• Enhanced CBL_STRING_CONVERT intrinsic function - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

• User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

• Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

• COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.

• COBOL program can call Java static methods using the java.class.method call.
• COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.

• Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives

Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

• Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple and Mainframe
Subsystem applications without having to specify the directives individually. This feature is not available
for Assembler or IMS.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

• ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

• DECLARE - defines the behavior of locally declared variables.
• ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items

passed by value to parameterized sections or methods in JVM COBOL programs as byte arrays (the
default is to expose as string objects).

• ILSTRINGLOAD - where JVM COBOL programs with a very large number of distinct alphanumeric
literals cause internal limits to be exceeded, use this directive to create these literals in a backing file,
which can then be converted to strings at run time.
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• MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with JVMGEN.

• INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL:

• JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

• JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

• JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.

Data Modernization Advice

Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
Enterprise Developer that enable you to achieve this, including advice on the best option for your
application as well as performance considerations.

Debugging

Back to Top

This release provides the following new feature:

• In Eclipse, new Debug and Run configurations have been added for debugging and running COBOL/
Java Interoperability applications. These enable you to debug COBOL programs calling Java static
methods. To debug Java code calling a COBOL program, you must create a Java Application launch
configuration and manually define the VM arguments property -Djava.library.path with a value
representing the output path to the native library produced from the COBOL builder.

Eclipse

Back to Top

Enhancements are available in the following areas:

Eclipse IDE:

• Eclipse 4.24 (2022-06) support, which is shipped and installed with Enterprise Developer. Versions of
Eclipse prior to this one are not supported.

• Exporting code coverage results - an option has been added to the Code Coverage view to allow you
to export the current code coverage results to a .tcz file.

• The Problems view now displays a sequence number column.
• A new project template is available for COBOL/Java interoperability applications. The project enables

you to compile both COBOL and Java sources at the same time.

COBOL editor:

• Auto-indenting on end-*.
• Collapsible regions for EVALUATE statements, and for 01 group items - a new option, Enable folding

for group level items, has been added to the Eclipse preferences (Window > Preferences > Micro
Focus > COBOL > Editor > Folding).

• Local variables support.
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• Parameterized sections - support is available in the editor for parameterized sections.
• Paste JSON as COBOL classes - you can now copy JSON data and do a Paste JSON As Classes into

a JVM COBOL file. This generates COBOL classes which enable you to deserialize the data in those
classes.

• A Quick Fix is available for end of scope termination. To enable this, your project must have the
NOIMPLICITSCOPE Compiler directive set, and error level to warning as errors.

• Renumber lines on save - line numbers can be automatically applied to a source file when it is saved,
by selecting Perform line numbering on save from Window > Preferences > Micro Focus > COBOL
> Editor > Line Numbering.

• Case preference for COBOL keywords on code clean up. A new preference in the code clean up profiles
enables you to convert all COBOL keywords to uppercase or lowercase, if required.

Enterprise Server

Back to Top

This release provides the following enhancements:

• A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

• You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

• Installation improvements on UNIX - when upgrading from releases 6.0, 7.0, or 8.0 on UNIX, Enterprise
Developer now preserves more configuration details. During the installation of the product, a set of
configuration files are moved to a config location before the upgrade occurs. These are linked back to
the product install location on completion. When you reinstall the full product, install a patch update, or
install an upgrade to the same location, the previous configurations settings are maintained.

Previously, the upgrade process required manual intervention to redeploy existing configuration settings.
This now occurs automatically.

• Enterprise Developer CICS now supports the MAPPINGDEV option of SEND MAP and RECEIVE MAP
commands.

• Application diagnostic reporting now enables you to collect JCL process failures. See Application
Diagnostic Reporting for Enterprise Server for more information.

Enterprise Server Common Web Administration (ESCWA)

Back to Top

Enhancements are available in the following areas:

• Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.
• API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,

and has been extended to contain more endpoints.
• Merged Archived Spool - you can now configure an enterprise server region to view a merged archived

spool in the UI. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

• Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

• PAC clients - the ESCWA UI lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

• TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.
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Enterprise Server Security

Back to Top

This release provides the following new features and enhancements:

• Demo CA - the component has been completely redesigned and is now included as part of Enterprise
Developer. Demo CA supports multiple installations, uses up-to-date cryptographic support, and
generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.

Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.

• esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

• OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.

• VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

IMS

Back to Top

This release includes the following new features for IMS:

• A new environment variable, ES_IMS_DISPLAY_NEW, has been added to enable the new z/OS /
DISPLAY timestamp output format.

Interface Mapping Toolkit

Back to Top

This release provides the following enhancements:

• YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

• A new option, Refresh Service, has been added to the Web Services and Java Interfaces context
menus. Use the Refresh Service option to update the bitism of the program for an existing Web
Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.

JCL

Back to Top

In this release the security around running programs from JCL jobs has been enhanced to enable you to
limit:

• The location of the programs to load
• Permission to run particular programs based on user ID
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This release writes several additional messages to the job log as a JCL job runs, including the location
from which each program is loaded. For example:

JCLCM0303I Program IDCAMS (MFJAMS) loaded from library
SYS1.LOADLIB

When running one of your own programs, you might see messages such as:

JCLCM0305I Failed to find program JCLREAD in private libraries
and SYS1.LNKLIB.
JCLCM0306I Number of SYS1.LNKLIB entries: 0.
JCLCM0303I Program JCLREAD loaded from library SYS2.LOADLIB.

Combined, these three messages indicate that the program was not found in the main program search
path (SYS1.LNKLIB) but has been loaded from the JES Program Path (SYS2.LOADLIB).

For more information about increased JCL security checks including a configuration example, see JCL
Enhanced Security Checks. For information about suppressing security check messages in the job log, see
ES_JES_HIGHER_SECURITY_LEVEL.

Mainframe Access

Back to Top

This release includes the following new features for:

• Mfdaemon vault usage - the Mfdaemon persistent stored secrets are now stored in the vault.
• TAUZCAPP master configuration file location from JCL - MFA Server now enables you to specify the

location for the master configuration file, required by TAUZCAPP, to be performed via JCL instead of
having to edit a REXX script.

• UNIX support for WebAPI USS - the MFDAS command-line USS functionality is now supported on
UNIX.

Micro Focus Enterprise Extension for Visual Studio Code

Back to Top

The following features are now available in the Micro Focus Enterprise Extension when you use it with
Enterprise Developer 9.0:

• A PL/I Language Server is available. This enables the following advanced features in the PL/I editor -
Find All References, Peek, Outline view, collapsible regions, Rename, Navigate To, background error
reporting, variable highlights.

• A new button, , Debug PL/I Program or Run PL/I Program in the top right corner of the editor, is
present for the current PL/I program.

• You can now specify the PL/I main file context for include files if an include copybooks is referenced in
more than one program.

Micro Focus Learn COBOL Extension and COBOL Course with Visual Studio Code

Back to Top

Micro Focus has released a new video-based training course in COBOL. The course teaches the
fundamentals of the COBOL language, introduces the Micro Focus COBOL syntax, and usage of Micro
Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn COBOL extension for Microsoft Visual Studio Code is available. The extension comes with the
training materials for the COBOL training course. For information about the COBOL course, and the Micro
Focus Learn COBOL Extension, visit www.cobol.com.
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Micro Focus Unit Testing Framework

Back to Top

The Micro Focus Unit Test Seam pre-processor (mfupp) has been enhanced to aid the creation of self-
contained unit tests that contain EXEC CICS or EXEC SQL statements. These EXEC statements can be
removed or mocked depending on the requirement of the test case.

The Micro Focus Unit Test Runner has also been enhanced to aid the development of these styles of unit
tests by the addition of new code generation arguments available from the command-line interface.

PL/I

Back to Top

This release includes enhancements in the following areas:

Open PL/I Compiler:

The following enhancements make the migration of existing applications to new platforms easier. They also
provide an improved functionality when using Open PL/I to develop z/OS applications.

• The QUICKSORT and QUICKSORTX built-in functions are now supported.
• Restricted expression evaluation now also takes place on AUTOMATIC, DEFINED, and BASED

declarations in addition to STATIC which was added previously.
• Support is available for the XMLCONTENT attribute.
• The use of the RELEASE statement now implies OPTIONS(FETCHABLE).
• Improvements have been made to the support for factored lists used in the INIT attribute of a variable

declaration.
• DEFAULT RANGE(*) with no attributes no longer causes the compiler to abort.
• Support is available for the FIXEDOVERFLOW condition.
• Support is available for the FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal

behaviors.
• Support is available for validation of FIXED DECIMAL data.

• Support has been added for more than 2GB of static data in a single procedure.
• Support has been added for placing uninitialized static data in the .BSS section.
• Improved diagnostics when passing an array to a procedure which expects an array with differing

attributes.
• Improved diagnostics when passing CONTROLLED variables as parameters and attributes are in

conflict.
• PL/I FETCH xxxx SET() syntax supports setting a PL/I ENTRY LIMITED.

Open PL/I Debugger:

• Performance improvements on the display of arrays and complex structures.
• Support for arrays declared with negative array bounds.
• Improved debugger performance when watchpoints are set but not active.
• Improved breakpoint clean-up and handling in-between debugger sessions under Enterprise Server.
• Added a message to PLIDUMP to print {cond static external} for CONDITION declarations in the locals

section rather than printing a generic "variable not found" message.
• Added support for decorated symbol/variable names in PLIDUMP on Windows.
• New watch points are now honored after a CONVERSION condition was raised.
• Remote debugging is supported on Solaris (SPARC).

Open PL/I EXEC Preprocessor:

• It is now possible to specify DB2 LUW OPT guidelines within static SQL.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Open PL/I Macro Preprocessor:
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• The COMMENT built-in function now supports comments larger than 100 bytes in length.
• The -tagmin preprocessor option supports skipping of %SDEBUG; and %RDEBUG; statements when

the replacement text fits on the same line as the macro invocation without wrapping.
• The conditional statements processing has been improved.

Open PL/I Run-Time System:

The following enhancements are available:

• Support for more than 2GB of static data in a single procedure.
• Support for placing uninitialized static data in the .BSS section.
• JSONPUTMEMBER now supports quotation marks within its input.
• Support for the XMLCONTENT attribute.
• The PL/I Run-Time System optionally provides the ability for ERROR to be driven in place of

STRINGRANGE and SUBSCRIPTRANGE.
• PLIDUMP display of the offset within prologue code a signal is received within the prologue of a PL/I

procedure.
• Support for FIXEDOVERFLOW condition.
• Support for FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal Behaviors.
• Support for validation of FIXED DECIMAL data.
• The speed for FIXED DECIMAL operations has been improved.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Product Help:

• The product Help includes a new section on Open PL/I Conditions.
• A new section, Open PL/I Problem Determination is available. Reference this section to learn how to

mitigate execution, link, and debugger problems, how to use PLIDUMP to resolve issues, and also to
learn about specific PL/I-related information pertaining to the use of the Consolidated Tracing Facility.
This new documentation also includes a list of data items you need to collect before raising a PL/I
problem with Micro Focus Customer Care.

Terminal Emulation

Back to Top

This release provides the following new features.

• Enterprise Developer and Enterprise Server now incorporate Host Access for the Cloud (HACloud) to
provide 3270 emulation. HACloud is the leading Web-based emulator and requires no additional
desktop installation. HACloud replaces the Rumba+ Desktop emulator previously supplied with
Enterprise Developer. Customers that have Rumba+ Desktop entitlement can continue to use it within
Rumba+ Desktop.

• In this release, Host Access for the Cloud supports session configuration options, as well as creating
and using macros.

• IDE support for Micro Focus Reflection Desktop - you can now select Reflection Desktop as the default
TN3270 display to open from the IDE when you run or debug your TN3270 applications. You can now
play Reflection or Rumba+ Desktop macros with Reflection Desktop.

Tracing

Back to Top

This release provides the following enhancements and new features:

• Improvements have been made to the to the Common Communications Interface (CCI) tracing. CCI
tracing can now be enabled using only the Consolidated Trace Facility (CTF) configuration, without
needing to set trace options in CCI.INI or the environment as well. SSL/TLS trace points have been
added to the CCI CTF trace, making it easier to control. It uses the same mechanism as other
components such as the COBOL RTS. SSL/TLS tracing is now incorporated into CTF, placing all
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communications trace output in one place and adding timestamps and other useful information to these
tracepoints. See Enabling CCI Tracing for more information.

What was New in Enterprise Developer 8.0

Features Added in Enterprise Developer 8.0
Enhancements are available in the following areas:

• Micro Focus Enterprise Extension for Visual Studio Code
• Application Workflow Manager
• CICS Support
• COBOL Language Enhancements
• Code Analysis
• Compiler Directives
• Data File Tools
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• JCL Support
• Mainframe Access
• Micro Focus Unit Testing Framework
• Open ESQL
• PL/I Support
• Terminal Emulation

Micro Focus Enterprise Extension for Visual Studio Code

Back to Top

The Micro Focus Enterprise extension for Visual Studio Code provides the following enhancements:

• The use of the Micro Focus Enterprise extension with Enterprise Developer 8.0 provides PL/I editor,
compiler and debug support. The PL/I debug support includes data breakpoints, conditions, and
signals.

Note: The Micro Focus Enterprise extension is available from the Microsoft Visual Studio Marketplace
- click here.

Application Workflow Manager

Back to Top

This release offers the following improvements:

• A new "Select Element List" button in the action bar of the Table Results view enables you to directly
select an existing list. Navigation in the history using the backward and forward arrows is now per
Eclipse session.

• A new relationship for an action, Create Element List.
• A new JES function package - enables you to define tools in an AWM model to browse, cancel, or

delete z/OS jobs.
• The IDz Function Package Tools now support the new tool interface introduced with release 5.0.
• A new Filter Data Tool in the AWM function package.
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CICS Support

Back to Top

This release introduces the following new features in Eclipse:

• A CICS Resources context menu command for CICS-enabled native enterprise server regions in
Server Explorer - enables you to manage the PCT, FCT, and PPT resources.

• Enterprise Server validation in the IDE for CICS Web Services.

• Reports validation errors where the associated enterprise server region configuration requires
adjustments to support the CICS Web service.

• Enables you to change the current configuration of the enterprise server region.
• Validates that the enterprise server region supports the CICS Web service when all validation errors

are resolved.

COBOL Language

Back to Top

The following enhancements have been made to the Micro Focus COBOL language:

• Further support for IBM Enterprise COBOL 6.3:

• JSON PARSE and JSON GENERATE statements - for JSON GENERATE, anonymous objects can
be generated using the OMITTED key word; the SUPPRESS phrase has been enhanced; the
CONVERTING phrase is supported. For JSON PARSE, anonymous objects can be parsed using the
OMITTED key word; the CONVERTING phrase is supported.

• Intrinsic functions - the following list of functions is now supported: COMBINED-DATETIME,
FORMATTED-CURRENT-DATE, FORMATTED-DATE, FORMATTED-DATETIME, FORMATTED-
TIME, INTEGER-OF-FORMATTED-DATE, SECONDS-PAST-MIDNIGHT, SECONDS-FROM-
FORMATTED-DATE, TEST-FORMATTED-DATETIME, and UUID4.

• The AMODE Compiler directive has been enhanced to allow COBOL programs full access to the 64-
bit address space (AMODE"64"). This emulates the LP"64" option in Enterprise COBOL.

• The DYNAMIC LENGTH clause, introduced in the last product release, is now supported in JVM
COBOL (as well native COBOL).

• JVM COBOL enhancements:

• When no explicit type is declared for a variable, but the value is a non-integer numeric (for example
declare var1 = 1.23), it is assumed to be of type float-long.

• The NAME OF expression has been introduced. It returns the unqualified name of the type or
member specified.

Code Analysis

Back to Top

The Application Analysis Server enables you to access either Micro Focus Enterprise Analyzer or COBOL
Analyzer from the IDE. This release includes the following enhancements to this feature:

• A generate code search report and a single code search reports are available.
• An improved Get Direct References report.

Enhancements to the Analysis Services include:

• An enhanced Program Flow Graph
• Support for displaying the Data Flow analysis as a Graph.
• A new Eclipse preference page, Application Wide Knowledge in Window > Preferences > Micro

Focus > COBOL > Code Analysis. This enables you to adjust certain timeout settings for certain long-
running queries executed against a remote Enterprise Analyzer or COBOL Analyzer server.
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Enhancements in the Rule-Based analysis include:

• The Rules preference page in Window > Preferences > Micro Focus > COBOL > Code Analysis
now supports nested rules.

Compiler Directives

Back to Top

The following Compiler directive is new in this release:

• DISPLAY-PICU - defines the way PIC U data items are displayed: either as ANSI or UTF-8.

The following Compiler directive has been enhanced in this release:

• AMODE - a new parameter "64" stores pointers in 64-bit format - see COBOL Language Enhancements
for more details.

Data File Tools

Back to Top

The following enhancement has been made to the Data File Tools:

• The Data File Editor now supports opening and editing KSDS VSAM files stored in an MFDBFH
datastore.

Debugging Applications

Back to Top

This release includes the following enhancement:

• Enterprise Server debug configurations can now configure the Program breakpoint on main entry
point only option, which if selected, only breaks execution when the Procedure Division entry point is
called.

Eclipse

Back to Top

Enhancements are available in the following areas:

Product:

• Enterprise Developer for Eclipse is now available on Linux platforms. Includes features such as:

• Building and debugging of mainframe COBOL projects
• Support for PL/I background parse, running and debugging
• CICS Web services
• Server Explorer
• IMS support for PSB, DBD, and MFS Files
• Data File Editor
• Code analysis using the Application Analysis server
• Host Access for the Cloud 

• This release supports Eclipse 4.20 (2021-06), which is shipped and installed with Enterprise Developer.
Versions of Eclipse prior to this one are not supported.

Projects:

• Apache Maven support - native COBOL and native COBOL Unit Testing projects can be incorporated
into your Maven-based lifecycles. They now accept a pom.xml file, which can be configured to run the
Maven AntRun plugin, which allows Ant-based projects to work with Maven.
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• Automatic directives determination - it is now possible to specify if this should run and if you will be
prompted to perform it from Perform automatic directives determination preference, available from
Window > Preferences > Micro Focus > COBOL|PL/I > Directives Determination.

• Code Clean Up - you can configure code clean up preferences, which you can apply to your code to
ensure consistency throughout your COBOL code (for example consistent use of the PIC or PICTURE
keyword). These preferences are stored in profiles, which allows them to be shared among
development teams.

• Multi-file compilation - right-click a selection of files, and click Compile when Automatic Build is
disabled. This utilizes the Maximum compilations/links to execute concurrently option (available
from Window > Preferences > Micro Focus > Builder > Project) for native COBOL projects.

• Order of the Dependency Paths list - it is now possible to control the initial position of the new directory
in the list. Use the Insert to the beginning of dependency paths list or Append to the end of
dependency paths list options to determine the position. These options are available from Window >
Preferences > Micro Focus > Builder > Project.

COBOL Editor:

• COBOL code mining - code minings are additional content shown in the COBOL editor to give extra
context to certain code elements. Use the Window > Preferences > Micro Focus > COBOL > Editor
> Code Minings page to enable an indicator showing the number of times that a section or a paragraph
is called in your native or procedural JVM COBOL code. Select the link shown to show a list of
references in the Search view, where you can use the matches shown to jump to the actual call within
your code.

• end- delimiter tooltips - within the COBOL editor, if you hover over the end- delimiter of a statement
such as an IF or an EVALUATE statement, a tooltip showing the opening clause of the statement is
displayed. You can enable/disable this behavior from the Block matching section in the COBOL editor
preferences.

Enhanced BMS tools integration with Eclipse on Windows and Linux:

• A BMS Preview view inside Eclipse enables you to preview the BMS screens on Windows and now on
Linux where the standalone Micro Focus BMS Painter utility is not supported.

To invoke the preview, open a BMS file in the editor and click Toggle the BMS previewer view  in
the Eclipse toolbar.

• The BMS text editor in Eclipse now offers enhanced writing support with smart editing and smart tabs,
smart Home/End caret support, collapsible sections in the BMS code, and initial syntax checking and
error reporting on background parse.

• The tree structure inside the Outline and Program Outline views now includes the mapsets and maps,
and any macro attributes and strings. Hovering an element in the views shows their properties.

• Enhanced navigation - when you navigate inside the BMS source file, the relevant fields in the BMS
Preview view are highlighted. The same fields are highlighted in the tree view inside the Outline and
Program Outline views and this works both ways - clicking on any of the nodes in the tree view
highlights the line in the editor that includes the relevant field.

Host Access for the Cloud integration

You can now use Host Access for the Cloud as your TN3270 display when interacting with MSS-enabled
enterprise server regions.

Use the Window > Preferences > Micro Focus > COBOL > Enterprise Server > TN3270 preferences
pane to configure an HACloud session to be the default connection type.

Enterprise Server

Back to Top

This release provides enhancements in the following areas:
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• EZ Sockets now supports up to 4096 sockets on Linux, up from 1024, and enhanced tracing.

• EZ Sockets applications, including ones that use the CICS listener CSKL (EZACIC02), can have
more simultaneous connections.

• EZ Sockets tracing now has options for logging the recent history only when any error or one of a set
of particular errors occurs. This makes it easier to use tracing to diagnose EZ Sockets issues.

• Enterprise Server dataset management - dataset maximum retention period with the ability to alter and
create reports:

• ES_JES_ENFORCE_EXPIRE_DATE - helps determine whether or not to check the expiration date
when deleting a catalogued dataset, and if expired, delete the dataset. If it hasn't expired and the
PURGE option has not been specified, the dataset is not removed. The PURGE keyword is required
to delete non-expired datasets. PURGE removes the underlying physical dataset file unless it is
referenced by another catalog entry. SMS MANAGEMENTCLASS now supports maximum RETAIN
days. See Using SMS MGMT Classes and the %SMS example command in the same topic.

• ES_JES_LISTCAT_YMD - helps determine the date format used in the HISTORY report generated
when the IDCAMS LISTCAT command specifies the ALL option.

• The EXPDT entry in a DD statement must be a four-digit year (YYYY); otherwise 1900 is the default,
which is in-line with the mainframe processing, and prevents unexpired datasets from being
erroneously removed (as was the case with the previous default of 2000). The ALTER command now
takes the TO and FOR options to enable specification of the retention period for the entry being
altered. The maximum retention period might be limited by the management class. The IDCAMS
LISTCAT command ALL parameter now generates a separate HISTORY report that shows the
creation date time and job, the last changed date time and Job, and the expiration date.

• HTTP compression - the Communications Server supports compressing large HTTP responses with
gzip, and handles gzip-compressed HTTP requests. The Common Client supports gzip-compressed
HTTP responses. Some large HTTP responses are compressed automatically if the client supports it.
Large HTTP messages can be compressed, saving network bandwidth and improving performance.

• Task-cleanup performance - the performance of post-processing for tasks in MFCS has been improved.
• ICETOOL emulation - now supports the COUNT+n and COUNT-n syntax during trailer processing,

where n is a numeric between 0-999. This adds to or subtracts from the COUNT value.
• DSNRLI now implements one-phase commit optimization where appropriate.
• Listing DEQ errors - a new caspac action, CasDEQs, enables you to list all errors that might have

occurred on DEQs either at the end of a task or while a job or a transaction was executing.
• Enterprise Server configuration - you can now change the recording directory of the dump, trace, HSF,

and the console.log files of each region..
• CICS API support - the CICS API GET CONTAINER option BYTEOFFSET is now supported.
• Compression on ECI calls via CASBNCCL Client - when using the Micro Focus External Call Interface

(ECI) over TCP/IP, the request and response data flows are now compressed using RLE.

Enterprise Server Common Web Administration (ESCWA)

Back to Top

This release includes the following enhancements:

• Oracle Coherence is now available as a PAC Scale-Out repository as an alternative to Redis.
• Reduced number of Redis instances required when a PAC incompatible upgrade is performed - it is now

possible to have multiple PSORs in one REDIS instance. This allows for the REDIS instances
provisioned in the PAC to be reused.

• Enhanced PAC diagnostics via CTF - a new option on the ES Control page is now available to enable or
disable CTF for a running region without the need to recycle the region.

• ESCWA API, version 2 - includes updated versions of some of the existing API, version 1 endpoints,
with improved JSON property names, more sensible URIs. The version 2 API is a single API standard
across API endpoints. It includes a number of usability enhancements, has a better readability and
discoverability, and includes an improved API documentation.
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• Enterprise Server Configuration Manager

• A variety of configuration options are available in ESCWA on the General >Advanced page for a
region.

The property grid in ESCWA shows the full list of configurable properties, categorized by group,
along with help text and some additional meta-information. Properties marked as dynamic in the
property grid can also be updated in a running region.

• A number of properties that were previously set with environment variables are now available in the
ESCWA UI. The environment variables are still supported for backward compatibility.

• Accessibility enhancements - the ESCWA UI includes a number of improvements in the areas of
usability with screenreaders, color contrast, and text and icon sizing and alignment. This is to give it an
improved compliance with the 508 and WCAG 2.1 standards.

Enterprise Server Security

Back to Top

This release includes the following enhancements:

• AWS Secrets Manager - support is available for using an AWS Secrets Manager, mfsecretsaws, as a
remote vault.

• Protection for sensitive data - some sensitive data is now protected in the memory. This helps reduce
the risk of exposing sensitive data such as passwords in core dumps and similar scenarios.

• An option to update short names - the ESF Update mechanism enables you to change between OS
users ("long names") and ES userids ("short names") in running regions. This requires a non-default
configuration setting.

• Caching improvements - ESF caching now caches more types of requests. This helps improve the
Enterprise Server latency and throughput when external security is configured with caching.

• Support for Argon2 in password history - when Micro Focus passwords are used with the MLDAP ESM
Module and password history is enabled, use Argon2 password verifiers in the history to avoid the
potential exposure of passwords via weaker verifiers. This helps improve the security of the password-
history mechanism.

• The product Help includes a new section, Securing Enterprise Server, which provides guidance on
improving the security of Enterprise Server installations and the applications they host. This includes
information on security and how to reduce security exposure.

IMS Support

Back to Top

This release provides the following enhancement:

• The JES aliasing feature can be used with IMS DLI and BMP applications run from JCL.

Interface Mapping Toolkit

Back to Top

This release includes the following enhancement:

• Support has been added to Enterprise Developer for Eclipse on Windows and UNIX for creating JSON
(RESTful) Web Services using API resources.

JCL Support

Back to Top

This release provides the following enhancements:
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• In Eclipse, a Show Spool and a Show Catalog context-menu command are available in Server
Explorer for MSS-enabled enterprise servers. These enable you to display and manage the regions'
JES spool queues and catalogs, respectively.

• Support is available for the DSENQSHR JOB statement parameter with options of ALLOW, USEJC, and
DISALLOW. You can configure the use of this parameter with the new ES_DSENQSHR environment
variable for Enterprise Server.

Mainframe Access

Back to Top

This release introduces:

• UNIX client support (EAP) - a subset of the MFDAS command-line functionality is now supported on
UNIX. Features include:

• Download, upload, and administration of data sets and JES.
• Client post-processing such as DFCONV conversion.
• UNIX Vault storage for user credentials

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

Micro Focus Unit Testing Framework

Back to Top

The following enhancement has been made to the Micro Focus Unit Testing Framework in the IDE:

• IDE support has been added for self-contained tests.

The following enhancement has been made to the command-line version of the Micro Focus Unit Testing
Framework:

• You can now use the Micro Focus Unit Testing Framework to build and run test cases from within
a .NET 6 environment. Install the NuGet package supplied with Enterprise Developer to enable the
mfunit extensions to the dotnet command line utility.

OpenESQL

Back to Top

This release includes the following enhancement:

• The new SQL Error Mapping feature enables you to customize how error information is returned in
SQLCODE, SQLSTATE, SQLERR and MFSQLMESSAGETEXT.

PL/I Support

Back to Top

Enhancements are available in the following areas:

PL/I compiler compatibility:

Support has been added for the following:

• Decimal Floating Point (IEEE-754-2008) when running on Intel architectures. This enables data to be
held in Densely Packed Decimal (DPD) format or in Binary Integer Decimal (BID) format. This feature is
in Early Adopter Program (EAP) release status.

• NOEXECOPS when running under the control of JCL.
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• PL/I built-in functions including: ENDFILE, EPSILON, EXPONENT, ISFINITE, ISINF, ISNAN, ISZERO,
MAXVAL, MINVAL, PLACES, PRECVAL, PRED, RADIX, ROUNDAWAYFROMZERO, ROUNDTOEVEN,
SCALE, SQRTF, SUCC, and XMLSCRUB.

• The IEEE attribute on a FLOAT DECIMAL variable declaration.
• Patch Update 1 provides a new compiler option, -directive, which sets the conditions under which a

FIXEDOVERFLOW is raised for a FIXED DECIMAL overflow.

PL/I compiler listing enhancements:

PL/I compiler listings now include:

• Display of options in effect and option defaults
• Unreferenced variables
• The OPTIONAL attribute for parameters

PL/I debugging:

PL/I debugging now supports:

• Hardware breakpoints in the IDE.
• STEP out of a CICS LINK level
• Much larger call stacks
• Remote debugger support on AIX and Solaris for PL/I programs running under the control of Enterprise

Server.
• Callstack generation using DWARF debug information on Linux.

PL/I EXEC Preprocessor:

• Early adopter support for an EXEC SQL statement that specifies a compiler-generated exit.

PL/I Language

• Starting with Patch Update 1, the default behavior of the FIXEDOVERFLOW condition used with the
PL/I ON statement has been changed for FIXED DECIMAL variables that specify an even precision.
The new behavior matches that of mainframe PL/I, which uses the extra high order nibble in arithmetic
operations and assignments even though it exceeds the defined precision.

PL/I Macro Preprocessor:

• COMPILETIME/COMPILEDATE builtin functions now output without %SDEBUG/%RDEBUG pairs
• New GETENV built-in function
• Support for CALL within a PL/I Macro
• Support for ITERATE, DEPRECATE, DEPRECATENEXT

PL/I Run-time System:

• Improved performance of JSON builtin functions
• Improved PLIDUMP callstack accuracy on the newest Redhat and SUSE releases
• PLIDUMP Display of the offset within prologue code a signal is received within the prologue of a PL/I

Procedure
• FIXEDOVERFLOW generated upon assignment to FIXED DECIMAL variables where truncation occurs
• Support for NOEXECOPS when running under the control of JCL
• PLIHSSR now allows for use of PCB in addition to PCB Pointer in call

Terminal Emulation

Back to Top

• This release installs the Session Server component of Micro Focus Host Access for the Cloud
(HACloud). HACloud provides browser-based HTML5 access to 3270 host applications on Windows
and Linux for multiple connected users. HACloud is configured to work out-of-the-box with the default
configuration for ESCWA and MFDS and might need to be configured before you start using it.
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• Patch Update 1 provides the following enhancement to the HACloud support:

• On Windows, a new Windows service, Micro Focus HA Cloud, enables you to start the HACloud
session server from the Windows Management Console. Before you can use the service, you need
to deploy it with the hacloudserviceinstall script available from an Enterprise Developer
command prompt.

• Host Access for the Cloud is available as a setting in the Eclipse preferences . You can enable it as
the default TN3270 display to use when you run or debug your applications.

What was New in Enterprise Developer 7.0

Features Added in Enterprise Developer 7.0
Enhancements are available in the following areas:

• Micro Focus COBOL Extension for Visual Studio Code on page 35
• Application Workflow Manager
• Assembler Support
• CICS Support
• COBOL Language Enhancements
• Code Analysis
• Code Set Support
• Compiler Directives
• Database Access - HCOSS Manage Connections Tool
• Database Access - MBDT Utilities
• Database Access - OpenESQL
• Data File Tools
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• IMS Support
• Library Routines
• Licensing Technologies
• Mainframe Access
• Micro Focus Database File Handler
• Micro Focus Unit Testing Framework
• Micro Focus Rumba
• PL/I Support

Micro Focus COBOL Extension for Visual Studio Code

Back to Top

The new Micro Focus COBOL extension for Visual Studio Code is available on the Microsoft Visual Studio
Marketplace. This provides edit, compile and debug support for Visual COBOL and Enterprise Developer
users in Visual Studio Code.

Note: The new Micro Focus COBOL extension is not included with the Enterprise Developer installer.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:
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• Modelling support for tool process logic under an action:

• You can now model loops and conditional execution of tools under an action, making the modeling of
complex tool logic under an action easier and more transparent. See Action Descriptor for more
information.

• Icon support:

• Icons can be specified to consist of several layers which, for example, enables you to model icons
with decorators. The decorators can be displayed depending on conditions. See Relationship
Element Has Icon, Relationship Action Has Icon, and Relationship Filter Has Icon for more
information.

• Additional icons have been added to AWM. See Icons for the AWM Function Package for more
information.

• You can now specify and use your own icons.
• You can now specify icons for filter definitions. See Relationship Filter Has Icon for more information.

• Filter definitions view:

• You can now export and import filter definitions to and from another workspace.
• The filter definition view's structure has been changed to a tree design enabling you to group

corresponding filters.
• "Micro Focus z/Server" connection type:

• Now supports drag & drop of a data set from the connection to an enterprise server instance's
catalog entry.

• You can now compress a z/OS PDS data set.
• New Micro Focus DevHub connection type function package:

• Provides a tool to send commands to a Micro Focus DevHub connection and receive the output
returned by the command so that it can be processed by other tools. See Micro Focus DevHub
Connection Type Function Package for more information.

Assembler Support

Back to Top

This release includes the following enhancements:

• Support for Assembler data table generation on UNIX and Linux - a new command-line executable,
MFMODGEN, is available on these operating systems to generate an Assembler data table (.MOD file)
from an Assembler source file.

This feature is the only Assembler functionality currently supported on UNIX systems. The rest of the
Micro Focus Assembler functionality is supported for 32-bit Windows only.

CICS Support

Back to Top

CICS support in development has the following new features:

• A 64-bit BMS Compiler on Windows and UNIX - the command-line utility, MFBMSCL, is now available in
64-bit format on Windows as part of Enterprise Developer and on UNIX as part of Micro Focus
Enterprise Developer UNIX Components.

On Windows, Eclipse now uses the 64-bit BMS Compiler by default.

The availability of the compiler on UNIX means that in remote development scenarios using Eclipse,
BMS files are compiled directly on the UNIX machine. It is no longer necessary to copy the BMS files to
your local Windows machine to compile them. There is no longer a requirement to only use SAMBA
connections if your remote projects include BMS files.
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COBOL Language

Back to Top

The following enhancements have been made to the Micro Focus COBOL language:

• JVM COBOL data type to hold strings of utf-8 characters - support is now available in JVM COBOL
for the PIC U data type. This was already available for native COBOL, to support its introduction by IBM
in Enterprise COBOL version 6.3.

• The DYNAMIC LENGTH clause, which enables a data item to vary in length at run time, is supported for
native COBOL code. Again, this is in response to its introduction by IBM in Enterprise COBOL version
6.3.

• The following date-format-checking intrinsic functions have been added: TEST-DATE-YYYYMMDD and
TEST-DAY-YYYYDDD.

Code Analysis

Back to Top

This release includes the following enhancements:

• Get Direct References command - you can use this command to see if changing a file will affect the
other files in your project as well as the files in the whole application. In Eclipse, you can access this
from the context menu or from the Analysis Server Explorer.

• Import points of interest - the Code Analysis view now includes a new button,  (Import points of
interest).

Code Set Support

Back to Top

The following enhancements have been made to the integrated code set translation support:

• Arabic support for Enterprise Server applications is available.

If you are building Arabic support into Enterprise Server applications, your terminal emulator must
support the Arabic EBCDIC 420 code page.

Support is added by building your applications and configuring your enterprise server regions with the
MFCODESET variable set to the supported country code (0420). Your product's in-built code set
translation utility performs translations between the ASCII 1256 Arabic code page on your enterprise
server region, and a terminal emulator that supports the Arabic EBCDIC 420 code page (for example,
IBM's Personal Communications emulator).

There are some considerations when working with a bi-directional language such as Arabic; these are
discussed in Arabic support considerations.

Compiler Directives

Back to Top

The following Compiler directives are new in this release:

• PANVALET-INCLUDES-IN-COMMENTS - This directive controls whether ++INCLUDE statements in
comments are actioned or not.

• EXECSQL-FLAG - This directive defines whether syntax reporting should emulate that of the DB2
preprocessor, the DB2 coprocessor, or to allow all syntax variations of both.

• RM-FILE-ERRORS - This directive generates run-time system errors for certain file conditions, even
when a FILE STATUS clause is present; this is to emulate RM/COBOL behavior.

The following Compiler directive option has been deprecated:
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• ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Enterprise Developer.

Database Access - HCOSS Manage Connections Tool

Back to Top

This release includes:

• Enhanced usability features around connection error diagnosis and SQL Server connection/installed
ODBC driver selections.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require further
clarification.

Database Access - MBDT Utilities

Back to Top

This release introduces:

• The SQLTUL utility, which is equivalent to the z/OS DB2 DSNTIAUL program.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

Database Access - OpenESQL

Back to Top

This release provides the following enhancement:

• New OpenESQL TRACELEVEL=5 option - native OpenESQL applications can now trace ODBC calls to
the database vendor’s ODBC driver, recording the start and stop times of each call’s execution.
OpenESQL tracing can now provide more detail on where an SQL application is spending execution
time, in the OpenESQL layer or the underlying ODBC driver layer.

Data File Tools

Back to Top

This release includes the following enhancements in the Data File Editor:

• New Data Explorer for working with data sets - a new Data Explorer enables you to connect to either
an ESCWA service or directly to an enterprise server region to access a catalog when working with
data sets in the editor.

• Multiple record selection- you can select multiple records and, where appropriate, can perform certain
actions on more than one record at once.

• Cut, copy, and paste functionality - traditional cut, copy, and paste functionality (including the
standard Ctrl+X, Ctrl+C, and Ctrl+V shortcuts) is now available throughout the editor.

• New filter creation - a new process for creating filters has been introduced. A filter consists of one or
more sets of conditions, and the resulting filter can include or exclude those records selected. The
previous filter process is still available, but has been marked as deprecated.

• Remote filtering - functionality has gone into Fileshare Server which allows filtering to occur server
side when opening data sets on remote enterprise server regions. The filter process results in only
those filtered records being downloaded to the data file editor client.

• Find/replace functionality - you can search records in a data file to identify specific strings, and then if
required, replace them.
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Eclipse Integration

Back to Top

This release includes enhancements in the following areas:

• Supported Eclipse versions - this release supports Eclipse 4.16 (2020-06), which is shipped and
installed with Enterprise Developer.

Versions of Eclipse prior to this one are not supported.
• Micro Focus Search - the search has been enhanced to filter results on the build action: in the Limit

To section, select Files configured for compilation to only include files in the search results that have
a build action set to Compile. The search results also include a new column, Build Action, that shows
the current action for each file.

• Formatting profiles - the formatting and clean up preferences for your COBOL code are now stored in
profiles. You can have many profiles per workspace, allowing you to easily switch between different sets
of formatting for different projects. The profiles can also be shared between local workspaces and to
other users, allowing developers to format code consistently throughout their team.

• The following new preferences have been added:

• Force native line endings when pasting with Ctrl + Shift + V, available from Micro Focus >
COBOL > Editor: this option produces line endings native to the local operating system.

• Show Compiler directive summary in editor, available from Micro Focus > COBOL > Editor >
Compiler Directives summary: this option shows a summary of the Compiler directives in effect, in
the editor.

• Spool and Catalog views - you can now use Server Explorer to control the spool queues and catalogs
for JCL-enabled enterprise server regions. You can submit JCL jobs to the enterprise server, and then
view the spool queues as those jobs are processed. Also, you can manage the associated catalog,
displaying and editing the attributes and content of data sets within. 

Enterprise Server

Back to Top

This release includes the following enhancements:

• Multiple Network Interface support - there is improved support for multiple network interfaces in some
components, including better awareness of network interfaces and control over networking. This is a
partial implementation and will be enhanced in future releases.

• Extended IPv6 support - support is available in Micro Focus Directory Server (MFDS) and in the Micro
Focus Communications Server (MFCS) listener for multiple IPv6 addresses.

In release 6.0, you could only configure MFDS and MFCS listeners to listen on a single IPv6 address. In
release 7.0, by default, MFDS and MFCS now listen on all configured IPv4 and IPv6 addresses, and
can also be configured to listen on a combination of specific addresses.

• HTTP improvements:

• Additional security measures for HTTP, such as security-related headers.
• Chunking support for large HTTP messages makes it possible to retrieve very large files from

Enterprise Server regions.
• Enhancements to CICS Web Interface and CICS Web Services.

• Application Diagnostic Reporting for Enterprise Server - Application diagnostic reporting collects and
packages a number of reports, trace, and log files into a single report file. See Application Diagnostic
Reporting for Enterprise Server for more information.

• Enterprise Server now supports automatic reconnection to the standby Queue manager in an Multi-
Instance Queue Manager. See Reconnecting to an MQ Server in a Multi-instance Queue Manager and
Enterprise Server XA Reconnect for more information.

• The casmgr process has been optimized to improve the use of initiators when dispatching jobs across a
PAC. In addition, improvements have been made to the way it manages the queue of jobs waiting to be
dispatched.
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• Information has been added describing the best practice and the recommended approach you should
adopt when performing a Patch Update to your PAC environment. See Performing a Product Upgrade to
a PAC Environment for more information.

• New operating modes , upgrade and quiesce, have been introduced for Performance and Availability
Clusters (PACs). These operating modes can be used to facilitate the installation of product updates
that introduce incompatibilities between PSOR data structures. You can check for incompatibilities using
the new caspac utility option CheckCompat. An upgrade mode can be set when starting the first
enterprise server region in a new PAC using the new casstart utility start-type option u. This upgrade
mode will prevent participating enterprise server regions from processing batch workloads as part of its
normal operation, and any EXEC CICS START requests will be rejected. See casstart and caspac in
your product Help for more information.

When enough enterprise server regions have been switched over to the new PAC, the old PAC can be
set to operate in the quiesce mode. This prevents further batch workload and EXEC CICS START from
being processed.

The new PAC can now be switched to running mode so that batch workload and EXEC CICS START
are enabled for processing again.

Note: Before setting the new PAC mode to running, you must switch enough enterprise server
regions to the new PAC to enable it to service the expected workload.

Enterprise Server Common Web Administration (ESCWA)

Back to Top

This release offers the following improvements:

• MFDS User Interface functionality replacement - ESCWA now replaces the MFDS inside the IDE as the
engine that provides access to and management of regions. ESCWA provides all the functionality that
was previously available from MFDS. This release includes the following enhancements:

• Delete all regions.
• Session list.
• Renew listening addresses.

• ESMAC User Interface functionality replacement - the following ESMAC features have been
implemented in ESCWA:

• Resource Filtering. See CICS Resources for more information.
• Millisecond support. See Threshold, Monitor, and Active PCT for more information.
• Control the scope for all changes to timeouts, trace flags, and memory strategy when applied to

regions in a PAC. See ES Control for more information.
• Enable Application Diagnostic reporting. See ES Control and Application Diagnostic Reporting for

Enterprise Server for more information.
• Submission of local jobs from the JES Control page when CASRDO44_NEWSUB=OFF has been

specified. See JES Control for more information.
• View and reply to pending ACCEPT FROM CONSOLE statements. See Pending Replies for more

information.
• The messages after a JCL job has been submitted are now correctly JSON formatted. This page

now works in ESCWA when MFJUXIT is enabled.
• Import, export, and copy regions - you can now use the UI to export and import regions in various

formats, including use JSON. You can:

• Copy regions between Directory Servers
• Import and export regions in JSON, XML or in the .dat legacy format. The legacy format can be

converted to a modern format.
• Mainframe Access (MFA) administration - ESCWA provides a modern Web UI and does not require you

to use a separate terminal application. Features include:
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• Log in or off from MFA.
• Change your MFA password.
• View MFA server tasks.
• Retrieve the XDBOUT log (Web UI).
• Retrieve the JES spool files by DD Name (API).
• Set the MFA and JES tracing level.
• View the active MFA users.
• Invalidate active user sessions.
• View mainframe/MFA statistics.

See Mainframe in the Enterprise Server Common Web Administration chapter for more information.

The MFA API library has been exposed to enable you to test and use the requests that are provided.
See MFA Interactive API Library for more information.

• CICS resource support - the following resources are supported:

• Resource Name List (RNL) CICS resource.
• Thresholds CICS resource.
• Extended Architecture Table (XAT) CICS resource.

• Scale-Out and PAC administration - you can now:

• Monitor Redis Sentinel and Cluster instances when used for Scale-Out Repositories.
• Specify that all changes to timeouts, trace flags, and memory strategy can be applied to one of three

options:

Only the local region.
All members of a PAC except the regions where local changes have been made.
All members of a PAC.

You can configure this in ESCWA with the Apply Scope field on the ES CONTROL page.
Alternatively, you can use the casutl utility with the /w option. See casutl for more information.

• Multi-Network Interface Card support - ESCWA now enables you to configure Communications Servers
and Listeners to listen on multiple IPv4 and IPv6 addresses. Previously, they were limited to listen on
either all IPv4 addresses, or a single IPv4 or IPv6 address. Now a combination of any of the following
can be used:

• One or more specific IPv4 addresses.
• One or more specific IPv6 addresses.
• All IPv4 addresses.
• All IPv6 addresses.

• A new filter field resFilter has been added to the following ESCWA and ESMAC resource listing
modules:

Every resource in By Type
Every resource in By Start L
Resource lists under Groups
Every active resource type except Locks

This parameter will filter the list of resources displayed by ESCWA and ESMAC. In addition, a new
environment variable ES_RDO_MAX_RESOURCES has been added that enables you to specify a limit
to the number of records displayed. For JSON requests, the list being truncated is indicated by the
addition of the JSON property "truncated": true.

Enterprise Server Security

Back to Top

This release includes the following enhancements:
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• MLDAP ESM caching - the MLDAP ESM Module now implements LDAP search-result caching. This is
controlled by the existing Security Manager cache settings, so that many installations will have this
activated automatically. See the product Help for details.

• Vault Hashicorp support - support is available for using a Hashicorp KV2 vault server as a local or
remote vault.

IMS Support

Back to Top

This release includes the following enhancements:

• An IMS Automated Operator Interface (AOI) - allows an application program to send IMS commands to,
and receive responses from IMS Transaction Manager using the DL/I CMD and CGMS functions. This
support includes:

• Enterprise Developer and Enterprise Server support IMS DL/I functions CMD and GCMD across all
language interfaces. These functions are used to send IMS commands and receive responses.

• Commands can be sent from applications compiled either ASCII or EBCDIC.
• Commands sent using AOI are limited to those supported in Enterprise Developer and Enterprise

Server.
• You can install an exit program that enables programming support for commands not directly

supported by Enterprise Developer and Enterprise Server.
• The IMSAO.CBL and IMSAO.JCL sample files, located in %PUBLIC%\Documents\Micro Focus

\Enterprise Developer\Samples\Mainframe\IMS\Classic\Examples (Windows)
or /opt/microfocus/EnterpriseDeveloper/demo/ims/examples (UNIX), are provided to
demonstrate the use of AOI.

• The AOEXIT.CBL program, located in the same place as the other AOI sample files, is an example
of an installed exit routine for processing of AOI commands. Instructions for this interface are
described in the program source.

• The JES aliasing feature can be used with IMS DLI and BMP applications run from JCL.

Library Routines

Back to Top

The following library routines are new:

• CBL_GET_ERROR_INFO - enables error processing routines to establish the location of the error that
occurred to cause the error processing routine to execute. This is available on a restricted range of
platforms.

• CBL_CREATE_STACKDUMP - generates a stackdump file.

Licensing

Back to Top

AutoPass licensing technology

In this release, Micro Focus brings in the power of the in-house Micro Focus AutoPass licensing technology
alongside Sentinel RMS. AutoPass has the following additional benefits compared to Sentinel RMS:

• Usage logging which enables you to monitor the product usage. You need to install the AutoPass
License Server in order to do this.

• Ongoing support for all platforms that this product is available for.

Features include:

• Installing this release installs both the AutoPass Daemon and the Sentinel RMS License Manager. Both
of them are available in the Micro Focus License Administration tool.
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• You can have both AutoPass and Sentinel RMS licenses installed on the same machine. Optionally, you
can switch off the licensing technology you do not use.

• If you are an existing user of a Visual COBOL or an Enterprise Developer product, you only need an
AutoPass license if you want to utilize usage logging or if you want to use your product on a platform on
which Sentinel RMS is not supported.

• If you are a new user of the Micro Focus COBOL products, you will normally be issued an AutoPass
license.

• Micro Focus will continue to provide Sentinel RMS in future releases of this product.
• AutoPass licenses should be installed into the existing Micro Focus License Administration tool, and not

in the AutoPass License Server.

Important: The SafeNet Sentinel licensing system has been deprecated and will be not available in
this product starting with the next major release after release 9.0.

The SafeNet Sentinel licenses will not be supported after release 9.0 and you need to use AutoPass
licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus Customer Care for further information.

Installing licenses at the command line

On Windows, Micro Focus License Administration is now also available as a command-line utility.

For more about AutoPass and usage logging, and about Micro Focus License Administration, see
Managing Licenses.

Mainframe Access (MFA)

Back to Top

This release includes the following enhancements:

• Improved file download and upload speeds - offers over seven times faster speeds for compressed files
larger than 64K, and almost four times faster speeds for uncompressed files over 64K. This requires
that you update both the Mainframe Access client and server, if you are using an older version of them.

• Endevor transaction performance improvements - transactions with Endevor have been improved and
are now around two times faster.

• Support for MFDAS load and unload - load and unload-specific load library members are now available
from the MFDAS command line. This enables you to interact remotely with Load libraries from the
MFDAS command line.

• SCLM export protection - you can now configure the MFA components to respect the SCLM managed
flags. In this way, you can prevent outside source control changes to your managed datasets.

• Drag and drop from the MVS Explorer to Catalog Explorer in Eclipse - you can now drag files to the ES
Catalog from MVS Explorer instead of having to use the Mainframe Explorer connection.

The Micro Focus Database File Handler

Back to Top

This release includes the following enhancements to the Micro Focus Database File Handler:

• Oracle support: support has been added for use with Oracle databases (version 19c and later).
Support is mostly equivalent to that of the existing databases, except that ODBC connectivity is not
supported; connections must be made directly with the databases, using Oracle's OCI interface.

• The dbfhview command line utility: a command line utility that generates database views from your
Data File Editor structure files. These views allow you to view your data once it's stored in a datastore.

• The mfdbcatc command line utility: a command line utility that helps you to relocate a disk-based
catalog to a database. It can scan the current catalog, then generate a deployable response file that
attempts to maintain the current structure of the catalog.
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• COBOL Run-Time System support for datastores: Library routines and variables that typically deal
with files and folders on disk are now capable of also handling the SQL URLs required to reference file
and folders in a datastore. Where appropriate, this is noted in the library routines documentation, and
the topic 'The Datastore URL' gives full details of the SQL URL required.

• Support has been added for Microsoft SQL Server and PostgreSQL users to host datastore, region and
cross-region database resources in a single physical database. This support was already available for
Db2 and Oracle users. See Using a Single Database for more details. 

• Datastores, regions, and cross-regions being hosted within the same physical database can now share
connections. This greatly reduces the number of connections an MFDBFH application would require at
any one time. See Sharing Database Connections for more details. 

The Micro Focus Unit Testing Framework

Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• The MFUPP preprocessor has been introduced to provide a seam between your program and a unit
test. This seam lets you access the internals of a program under test, allowing you to create granular
unit tests from paragraphs or sections. The MFUPP preprocessor also provides the ability to mock
programs or stub programs out to create a unit test.

• In Eclipse, remote unit test projects for native COBOL can now be stored and run from Micro Focus
Enterprise Developer UNIX Components.

Micro Focus Rumba

Back to Top

Support for Micro Focus Rumba inside Eclipse has the following enhancements:

• Multiple views for embedded Rumba connections - it is now possible to have multiple Rumba Mainframe
Display views opened in the IDE, each having a different connection. You can enable multiple views
from the TN3270 preferences for the IDE.

• Connections to a server are now secured using SSL/TLS.
• Import and export connection details - it is now possible to export and import connection details and

share them between client machines.

PL/I Support

Back to Top

Enhancements are available in the following areas:

PL/I debugger:

• Much larger call stacks are now supported.

PL/I compiler compatibility:

• New statements supported - DEFINE STRUCTURE, LOCATE.
• Improved compatibility for the DEFAULT RANGE statement.
• New built-in functions - AUTOMATIC, ENTRYADDR built-in function and pseudovariable, HEXDECODE,

INLIST, ISLL, ISRL, REPLACE, and TIMESTAMP.
• Support for the DIMACROSS attribute and for the PARM attribute on a declaration.

PL/I compiler functionality:

• You now receive warnings when redundant WHEN clauses appear in a SELECT statement.
• DWARF line number information is now generated on Linux and Solaris.
• Improved compiler listings to show more attributes for parameters.
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• The editor in Eclipse is now sensitive to EXEC SQL Host variables, references, and modifications.
• The PL/I Compiler and preprocessors are now used by default for background parsing in Eclipse.
• In Eclipse, you can now format the code inside a PL/I program or only format selected sections.
• The PL/I error messages in the product Help are now in sync with the messages shown in the product.

PL/I EXEC Preprocessor:

• Provides information about host variable references/modifications for the background parsing.
• Support for DB2 style comments in EXEC SQL Statements.

PL/I Macro Preprocessor:

• The SCAN option of the ANSWER statement is now supported.
• Improved compatibility of COMPILEDATE and COMPILETIME built-in functions.

PL/I Run-Time System:

• The behavior of PL/I ON FINISH now matches IBM's behavior.
• Improved compatibility for the JSONPUTVALUE built-in function - it now supports multi-dimensional

arrays within structures.
• Improved compatibility for the XMLCHAR built-in function.
• PLIDUMP now checks the allocated memory chains for corruptions.
• PLIDUMP can now display much larger automatic variables and parameters without consuming excess

memory and CPU resources.
• Support for the L format PUT EDIT directed I-O.

What was New in Enterprise Developer 6.0

Features Added in Enterprise Developer 6.0
Enhancements are available in the following areas:

• Application Workflow Manager
• Building Applications
• COBOL Application Console Size
• COBOL Language Enhancements
• Code Analysis
• Code Analyzer Refactoring
• Compiler Directives
• Containers
• Database Access - HCO for DB2 LUW
• Data File Tools
• Debugging
• Deploying Applications
• Eclipse Integration
• Enterprise Server
• Enterprise Server Security
• Enterprise Server Common Web Administration
• File Handling
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Library Routines
• Micro Focus Database File Handler
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• Micro Focus Unit Testing Framework
• Microsoft Build Tools and Windows SDK Configuration Utility
• Multi-Threaded Applications
• PL/I Support
• Problem Determination
• Product Documentation

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:

• REST modelling - the REST function package now supports the following:

• HTML formatted text fields.
• Copying and pasting of JSON format template into a JSON structured file descriptor in the AWM

model editor.
• Specify a general status code handling, which is applicable for all tools from the REST function

package.
• Handling loops when specifying a status code handler.
• Uploading and downloading text files to and from a REST based application.
• Automatic retrieving of valid values for a dialog input field without the need to click Retrieve.
• Auto-completion in dialog input fields.
• Specify clearing dependencies between dialog input fields.

• Local Java development - the following features supporting local projects for Java development have
been added:

• A Java function package with the corresponding property, element types, and tools
• A sample AWM model for local Java development

• The function package developer guide now provides more details.
• AWM extension templates are now available
• AWM model editor improvements:

• The AWM model properties now only display the relevant attributes in the Properties view.
• Auto-completion of fields which enable you to specify property references.
• The Used by dialog now displays property reference usage.

Building Applications

Back to Top

This release includes the following new functionality:

• Maven build support - you can use the Apache Maven support in Eclipse to build COBOL JVM projects
and COBOL JVM Unit Test projects.

COBOL Application Console Size

Back to Top

The maximum console size of a COBOL application has increased. It can now be 255 lines by 255
columns, configurable using the screen_lines and screen_cols run-time tunables.

COBOL Language Enhancements

Back to Top

The following enhancements are available:
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• Enterprise COBOL 6.2 Update - new syntax, library routines, and the respective analysis tooling are
available for compatibility with IBM's Enterprise COBOL 6.2 Update:

• New intrinsic functions are supported: BIT-OF, BIT-TO-CHAR, BYTE-LENGTH, HEX-OF, HEX-TO-
CHAR, NUMVAL-F, TEST-NUMVAL, TEST-NUMVAL-C, TEST-NUMVAL-F, and TRIM

• A number of intrinsic functions now support national data (especially surrogate pairs): REVERSE,
ULENGTH, UPOS, USUBSTR, USUPPLEMENTARY, UVALID, and UWIDTH.

• A LOC phrase has been added to the ALLOCATE statement to define whether memory is allocated
above or below the 16MB line.

• CONSTANT qualifier - it is now possible to define data items as constants. This improves the code
readability and usability, and helps detect programming errors. The ability to create constant items is
already in .NET COBOL and JVM COBOL, and many other languages.

• Local variable declarations in native COBOL - it is now possible to declare data items inline in the
code and not only in a separate DATA DIVISION. This provides better locality of data, making the
source code easier to reason about.

• Native data type to hold strings of utf-8 characters - in native COBOL, support is now available for
the PIC U data type as introduced by IBM in Enterprise COBOL version 6.3. Direct support is available
for utf-8 data.

• Performance improvements - this release provides various performance improvements, most
significantly on 32-bit Intel x86 platforms. When using the highest optimization level, opt(4), the
performance of native code generated by the COBOL Compiler has improved. A number of cases are
affected, most particularly those where it is beneficial to locate PERFORM ranges inline.

Code Analysis

Back to Top

Support is provided in Enterprise Developer for accessing the Application Analysis Server which is part of
the Micro Focus Enterprise Analyzer and Micro Focus COBOL Analyzer products.

If you have one of these products installed, you can connect to the Application Analysis Server from Server
Explorer and access the Enterprise Analyzer web client. Enterprise Analyzer web client provides quick
searches for repository objects, detailed code searches, diagrams, reports, and data item impact analysis
and other features such as viewing and editing of business rules (separate license required).

Code Analyzer Refactoring

Back to Top

Support is now available for extracting program logic from COBOL code and moving it to a new program.
The following commands are available from the editor context menu:

• Create program from Section
• Create program from Computation
• Create program from Condition

In Eclipse, you can now refactor your code using the Extract to Section command available from the
Refactor menu.

Compiler Directives

Back to Top

The following Compiler directives are new in this release:

• DISPLAY-AT - specifies a default foreground and background color for DISPLAY AT and ACCEPT AT
statements that do not specify any color attributes.

• DPC-IN-DATA - controls whether the DECIMAL-POINT IS COMMA clause (if specified) is applied to the
output from the XML GENERATE and JSON GENERATE statements.
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• ILCONDITIONPARAM - switched on by default. Enables the support for conditional expressions as
method parameters.

Important: Applications that use the old COBOL syntax for specifying named parameters as
custom-attributes will not compile with the ILCONDITIONPARAM specified. This can result in any
older applications failing to compile in the current version of the product. See
ILCONDITIONPARAM in your product Help for details about how to work around this issue.

The following Compiler directives have new options:

• CHECKREFMOD - now takes an additional parameter (NOZEROLENGTH), which acts as
CHECKREFMOD, but does not permit reference modifier lengths of zero.

• PROTOTYPE - now supports options that specify whether prototypes are required, and the severity of
error messages issued for prototype mismatches.

Containers

Back to Top

Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.

Database Access - HCO for DB2 LUW

Back to Top

Support for the following has been added to this release:

• Multi-row fetch (MRF) and insert (MRI) statements with or without the FOR ROWS clause
• Array update and delete statements

Notes:

• These new features are supported for DB2 LUW version 11.1 Mod 4 Fix Pack or newer. Currently,
IBM does not support either of these features with DB2 LUW 11.5.

• For coding examples, see the IBM DB2 LUW documentation: Embedded SQL/COBOL Support for
MRI and MRF.

Database Access - XA Switch Modules

Back to Top

Support for the following has been added to this release:

• XA switch modules have been enhanced to enable storage of sensitive information in the Micro Focus
Vault Facility. This new functionality includes a customizable program, ESXAEXTCFG.CBL, you can use
to obfuscate xa-open strings by storing them as secrets.

Data File Tools

Back to Top

The following enhancements have been made to the Data File Editor:

• Double-byte character sets are now supported within the editor.
• Insert mode is now available when editing a formatted record, except for numeric fields.
• When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are

automatically added when editing a formatted record and you are editing in Insert mode.
• You can now load and unload structure files for an open data file.
• A ruler at the top of the editing pane can be toggled on/off.

48 | Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse

http://www.microfocus.com/docs/links.asp?vc=ibm-embedded-sqlcobol
http://www.microfocus.com/docs/links.asp?vc=ibm-embedded-sqlcobol


Debugging

Back to Top

This following enhancements are available:

• Breakpoints - in JVM COBOL, you can now access a breakpoint's properties from the breakpoint's
context menu in the editor.

• Expressions - you can now specify complex expressions in the Expressions view. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Views in the Debug Perspective in the product Help for details.

Deploying Applications

Back to Top

This release supports easier deployment of native COBOL applications from an Eclipse project. A new
page in the project's properties, Micro Focus > Build Configuration > Deploy, enables you to specify a
deploy folder and which files will be deployed. Building the project deploys certain executables and
supporting files to this folder. In addition, you can archive and deploy the files on application servers, cloud
storage such as AWS buckets and access the application files with AWS services, and so on.

Eclipse Integration

Back to Top

The following enhancements are available:

• COBOL compile settings summary - this pane, which is displayed when viewing the COBOL project
settings at the project, folder, and file level, now indicates the settings that are inherited and the ones
that are set at that level. Settings inherited from the level(s) above are shown in <>.

• Deploy folder - a new build configuration feature in the project's properties enables you to copy build
artifacts and supporting files essential for deployment, to a particular folder.

• Context menu improvements - the editor context menu has been reorganized, where certain options
have been grouped together under a logical heading, and other redundant options removed.

• Copybook tooltips - hovering COPY statements in the editor now displays the path to the referenced
copybook.

• Collapsible statements - it is now possible to collapse IF, EVALUATE, and PERFORM statements in the
editor.

• Dark theme with COBOL - you can enable the dark theme from Window > Preferences > General >
Appearance > Theme.

Enterprise Server

Back to Top

The following enhancements are available:

• Definition Import/Export Tool - a new utility, casesxml, has been added to enable you to import and
export enterprise server definitions. Using casesxml you can do the following:

• generate .xml files, in casesxml export format, that contain structured definitions of a region, a
CICS resource definition file, and the catalog

• import a casesxml export format .xml file to update the definitions of a region, a CICS resource
definition file, and the catalog

• IPv6 support (EAP) - This feature is in Early Adopter Program (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.
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• Administrative Commands - the add command in cascertreg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).

Enterprise Server Security

Back to Top

This release provides the following enhancements:

• Micro Focus Secrets file storage permissions

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.

• Certificate wildcard support

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, server1.mycorp.com, and so on. These wildcard-
bearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.

• Improved ACL wildcard support

In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.

• PAM ESM module

On Linux platforms, Enterprise Server now includes an External Security Manager module which
integrates with the Pluggable Authentication Modules (PAM) operating system feature. The PAM ESM
module can be used to authenticate Enterprise Server users with the same mechanism used for Linux
users, or with any other mechanism available through PAM.

• PKIX compliance for TLS certificate validation

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.

• Security improvements for XML parsing

In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration (ESCWA)

Back to Top

This release offers the following new features and improvements:
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• MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/I, MQ,
and XA options, and security, is now available.

• ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.

• Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, and security menu
items.

• Usability improvements

• Starting and stopping regions from the navigation tree.
• The native menu items are not displayed if the region features are not configured correctly.
• Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.

• CICS resource support - the following resources are supported: ICEs, DocTemp, TCPIPService,
URIMap, Bundle, Pipeline, and WebServices.

• Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORs)
association with its PAC and member regions.

• Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:

• Redis cluster support
• A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.

You can also use the file to configure Lua scripts tracing on servers.
• Authentication support for the standalone Redis server.

• Kubernetes support - when ESCWA is run in a Kubernetes cluster, it is now possible to configure it to
automatically discover the pods hosting MFDS within the cluster, and display them in the ESCWA user
interface.

File Handling

Back to Top

Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
microfocus/fh, using the mfsecretsadmin utility.

To ensure the Fileshare server uses the file stored in the vault, start the server with the /uv option.

IMS Support

Back to Top

Improvements are available in the following areas:

• BMP inbound and outbound message processing - full support is available for BMP inbound and
outbound message processing. Batch message processing programs (BMPs) can now access the IMS
message queue for input and output, in addition to their batch-type processing and data-access
capabilities.

• Commands - the following commands are now supported: - /START TRAN ALL, /DISPLAY Q TRAN,
and /DISPLAY STATUS TRAN.

• DB Control SUSPEND / RESUME commands in an active system - IMS DB Control supports the
SUSPEND command while transactions are active. DB Control will block any new units of work and
allow active UOWs to complete during a quiesce. Once DB Control reaches a state with no outstanding
UOWs it suspends. Note a long running BMP may prevent a system from suspending.

This enables support for administrative tasks such as database and transaction log archiving. It also
enables the creation of new transaction logs when roll forward recovery is enabled.

• IMS BTS trace - IMS BTS trace is now visible from active SSTM and batch jobs. WIDTH and NOHEX
options have been added for additional control of trace output format.
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This enables BTS output to be viewed when debugging a batch IMS application. Previously the job step
had to complete before the trace was visible. This also enables you to view the trace output in an active
SSTM job. Previously the MPR had to be stopped to make trace output visible.

• User DB handler exit - database exit support has been added for GSAM databases. This provides
programmatic control of the DB Catalog setting for a database instead of using the defined DB Catalog.
Also, this exit can process DL/I calls completely, for example, to map DL/I calls into VSAM I/O requests.
Previously, this exit was available only for full function databases.

To assist you with writing an exit, a template file, USERDB.CBL, and an explanatory text file,
USERDB.TXT, are available with your IMS classic samples.

• JES Alias support - the JES aliasing feature can be used with IMS DLI and BMP applications run from
JCL.

Interface Mapping Toolkit

Back to Top

Improvements are available in the following areas:

• Resource-based REST APIs - the following enhancements enable the creation of resource-based
REST APIs:

• Operations in JSON RESTful Web services can now have a customizable URI path that identifies a
resource. Operation paths have support for dynamic templating.

• API resources can now be automatically identified from COBOL groups in a COBOL program, and a
set of operations can be generated for each API resource.

• It is now possible to specify the location of interface fields in the service request or response. An
interface field can either be a parameter in the URI path, a query parameter, or be in the JSON
message body.

• Summary support for OpenAPI - the IMTK now supports the OpenAPI Specification (originally called
Swagger) which is the most widely-accepted format for REST API specifications. Features include:

• Consumption of OpenAPI 3.0 and Swagger 2.0 files for purposes of client and service generation.
• Generation of OpenAPI 3.0 files to describe the APIs of a JSON RESTful Web service.

• REST service output filtering and field selection - Enterprise Server JSON RESTful Web services
now include the following features:

• Automatic filtering of the JSON response body of a Web service by path and query parameters
received in the request URI.

• A special query parameter "$fields" that can be used to indicate that the JSON response body is to
contain only certain specified fields, and to exclude all other fields.

• REST API discovery - Enterprise Server API discovery is now supported. For a JSON RESTful Web
service, a list of all its available operations, and their URI paths, can be retrieved. This enables a client
to efficiently navigate an Enterprise Server REST Web service without having information about the
service’s operations ahead of time.

JCL Support

Back to Top

The following features have been added to the JCL support:

• The sample printer exit in the product has been enhanced to retrieve extended information. The
structure defined by idadoutp.cpy now contains two new entries (ws)-extended-output and
(ws)-extended-data. The item (ws)-extended-output contains the version of the extended
output data; currently, this should be set to 1. The item (ws)-extended-data is a pointer, that if null
means there is no extended data; otherwise, it points to a new structure defined in outpext.cpy. That
structure contains the extended output information for a given job. This is demonstrated in the provided
sample - sampprnx.
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Library Routines

Back to Top

The following library routines are new:

• MFU_GET_FILE and MFUGETF - both these routines are used with data-driven tests in the Micro
Focus Unit Testing Framework. If the .csv file under test references external data in one of its cells
(using the @file-name notation), use either of these routines to load that external file into memory
before such tests are run.

The following library routine contains new functionality:

• CBL_GET_EXIT_INFO - this library routine has been enhanced to better detect the circumstances in
which an exit procedure has been invoked.

The Micro Focus Database File Handler

Back to Top

Support for Db2 and Microsoft Azure databases has been added to the Micro Focus Database File Handler
(MFDBFH). This support is equivalent to that of the existing databases.

The following features have been added for all databases:

• I-O optimizations for sequential, line sequential, and ESDS/KSDS/RRDS files opened for output.
• Using direct connection strings to make a database connection (as an alternative to using ODBC

DSNs).
• Creation of databases using script files.
• Maintaining database configuration files with a command line utility, dbfhconfig.
• Using the dbfhdeploy utility to delete data files from a datastore.
• Database configuration files can now store confidential information in the Vault Facility.
• CTF tracing of ODBC and Vault operations.
• Recovering of locked processes or files can with the dbfhadmin utility.
• The dbfhconfig and dbfhdeploy utilities are now capable of executing commands batched up in a

response file.

The Micro Focus Unit Testing Framework

Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• You can now run unit tests against an executable file from both the IDE (new in Eclipse) and the
command line. Before you run such tests from the command line, you must initially rebuild the
executable in order to link it into the testing framework.

• The .csv source files used in data-driven tests can now reference external data: use the @file-name
notation in a cell to use the contents of file-name in the tests. The external source files must be
loaded into memory, using the MFU_GET_FILE or MFUGETF library routines, before the tests are run.

• Two new elements are available for data-driven tests: a data-driven setup and a data-driven teardown.
Conventional setup and teardown entry points would run multiple times during a data-driven test; these
two entry points run only once per test run.

The Microsoft Build Tools and Windows SDK Configuration Utility

Back to Top

On Windows, the Enterprise Developer setup file now installs the Microsoft Build Tools and the Windows
SDK packages, as these are dependencies for a number of features and operations of the product.
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You can use the Microsoft Build Tools and Windows SDK configuration utility to view the package versions
in use in your COBOL environment. You can also use this utility to set the environment to use other
versions of these packages that you have installed.

Multi-Threaded Applications

Back to Top

This release includes the following improvements:

• Improved validation of detached threads on UNIX - the reliability for applications with many threads,
when using the CBL_THREAD_KILL routine and during abnormal process termination, such as when
an error occurs, has been improved.

• Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.

PL/I Support

Back to Top

Enhancements are available in the following areas:

PL/I compiler

Improvements in the compiler make it easier to migrate existing applications to new platforms. Support is
available for:

• The GENERIC attribute on an ENTRY declaration.
• The COPY option of the GET statement.
• Assignment of an ENTRY to an ENTRY LIMITED variable.
• The INONLY attribute.
• Support for a SELECT with no WHEN or OTHERWISE modified to match IBM’s behavior.
• Support for new compile option which allows specification of the FIXED DECIMAL precision for

intermediate operations.
• The ability to use LIKE on a structure that contains * for element names.
• Built-in functions:

• New functions - FIXEDDEC and FIXEDBIN
• The TRIM built-in function to support its usage with structures.
• The VALID function - improved support when used with FIXED DEC arguments.
• Function precision of 15 or 31 (see the –bifprec compiler option)

• PL/I bytestream IO via FILEREAD, FILEWRITE, FILETELL and FILESEEK statements.
• Improved compatibility - when using DEFAULT RANGE with patterns; for use of the STRING

pseudovariable.
• Improved support for - structures declared with the LIKE attribute where the referenced structure

members contained NOINIT attribute(s).

Improved functionality for customers using Open PL/I to develop z/OS applications is available:

• Improved compiler listing to show attributes of parameters to an ENTRY declaration.
• Improved expanded listing showing line numbers for code generated by preprocessors.
• Improved compiler diagnostics when trying to use BIT operators on non-BIT operands.
• Improved compiler diagnostics when an unqualified name is resolved to a structure member rather than

a matching non-member declaration of the same name in a parent block - Informational (I-level)
diagnostic (MFPLI01305I).

• A string indicating which compiler was used to generate the object code is now embedded in every
compiled routine to facilitate ease of upgrading and troubleshooting by customers.

• *PROCESS statements are now mapped to the equivalent Open PL/I compiler options where
appropriate.
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PL/I debugger in Eclipse

Support is available for the following features:

• STEP out of the end of an ON Unit.

When stepping off the end of a PL/I ON-unit, the debugger attempts to determine the next debuggable
statement, and then pause execution. This allows you to continue stepping through the program upon
completion of the ON-unit. Stepping through a PL/I GOTO statement from an ON-unit continues to be
supported as well.

• Improved monitoring of variables that is not based on the procedure in which they are declared.
• Support for debugging PL/I application using Solaris (SPARC) 11.4 or later.
• PLIDUMP now generates information for STATIC variables and displays the HEAP data storage.

• Changes have been made to remove the variable scoping limitation which existed in previous releases.
Prior to this version, variable watches were limited to the procedure in which they were declared/used. If
a variable was passed to another subroutine, the debugger would only stop after returning from that
subroutine and recognizing that the variable value had been changed - so it wasn't possible to know
exactly where in the subroutine it had happened unless an additional variable watch was set in the
subroutine itself.

In this release, the variable's address and size are now being stored away for watch instead of the
procedure name and variable name. This allows the address/size to be monitored from the time it is
established until you cancel the watch. By doing this, the debugger is stopped as soon as it recognizes
a change of value - regardless of where it is in the user program.

Since the watch is active until you cancel it, it is possible to be watching an address/size which is no
longer allocated or active depending on the flow of the user program. In this situation, execution will be
stopped if/when the memory space is reused for some other reason.

PL/I EXEC preprocessor

• Information about host variable references and modifications is now available for the background
parsing.

• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation
starts or ends.

Macro preprocessor

• Supports the new SOURCEFILE() built-in function
• Improved compatibility for %DO statements
• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation

starts or ends

Run-Time System

• Support is available for bytestream IO via FILETELL, FILESEEK, FILEREAD and FILEWRITE for
RECFM(U) files.

• Support for the COPY option of the GET statement.
• It is now possible to use a STATIC FIXED BIN(31) variable to control the RECSIZE of a file at OPEN

time.
• The JCL utility IKJEFT01 can now be driven from PL/I as a callable interface.

Problem Determination

Back to Top

The following enhancement is available:
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• Consolidated Tracing Facility (CTF) on UNIX - CTF is now always present during process
termination, such as when an application, or a third-party code, calls exit() directly.

Product Documentation

Back to Top

The following functionality is new in this release:

• Online context help in Eclipse - online context Help is now the default setting for Enterprise Developer.
Requesting F1 help from within Eclipse now opens the documentation available on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/. You can configure
Eclipse to show either local or online help. See Viewing the Product Help.

Features Added in Enterprise Developer 5.0
Enterprise Developer 5.0 provided enhancements in the following areas:

• Amazon Web Services Quick Start for Enterprise Server
• COBOL Formatting
• Code Analysis
• Enterprise Server and Scale Out Architecture
• Enterprise Server Common Web Administration
• Application Workflow Manager
• AppMaster Builder
• CICS Support
• COBOL Language Enhancements
• Compiler Directives
• Consolidated Trace Facility
• Data File Tools
• Database Access
• Debugging
• Eclipse Integration
• Enterprise Server Security
• IMS Support
• JCL Support
• Mainframe Access
• Micro Focus Native Database File Handler
• Micro Focus Rumba
• Micro Focus Unit Testing Framework
• PL/I Support
• Platform Support
• Product Documentation

Amazon Web Services Quick Start for Enterprise Server
Back to Top

Micro Focus has worked with Amazon Web Services (AWS) to create an AWS Quick Start for Enterprise
Server. The Quick Start includes AWS CloudFormation templates and a deployment guide with step-by-
step instructions that enable you to deploy Enterprise Server into a new or existing virtual private cloud
(VPC) on the AWS Cloud in about 1 hour and 15 minutes.

For full information see Micro Focus Enterprise Server on AWS.
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COBOL Formatting
Back to Top

You can now reformat your COBOL code in the editor according to your preference and standards.
Formatting sets the indentation based on the configuration options which you can set in Windows >
Preferences > Micro Focus > COBOL > Editor > Formatter (for Eclipse).

You can find the COBOL formatting features on the editor context menu (for Eclipse) menu.

Code Analysis
Back to Top

You can now create the following views for your code:

• Program Flow Graph - enables you to view the overall structure of the COBOL program with nodes
representing sections and paragraphs. PERFORM statements between them which affect the program
flow are represented by links joining the nodes. External calls to other programs are shown but cannot
be expanded in the Program Flow Graph view. Hovering over the nodes shows a tooltip containing the
code representing the respective sections or paragraph. Clicking a node or a link joining said nodes
positions the code editor to that point in the source, allowing quick and easy navigation of the program.

• Data Flow Analysis Tree - enables you to select a data item and then either statically trace what might
change its value or what other data items it might affect.

Enterprise Server and Scale Out Architecture
Back to Top

Note: This feature is in Early Adopter Program (EAP) release status.

This release offers an enhanced and improved availability, and serviceability of Enterprise Server through
the ability to administer and maintain a cross-system group of regions as a single system image with the
new Performance and Availability Cluster (PAC).

In order for different Enterprise Server instances to be able to work together, they need to be able to share
data. This is achieved through the use of a Scale Out Repository (SOR). All ES instances in a PAC will
have a common SOR (PSOR) which is used to store CICS resources (limited to PCTs, PPTs, FCTs, DCTs
and TSTs in this release) as well as internal system data to facilitate synchronisation between instances.
Temporary Storage Queues and Transient Data Queues can also be shared between Enterprise Server
instances by directing them to a SOR. Benefits of using PACs and SORs in this way include:

• Reduced hardware costs - taking advantage of the PAC to scale-out rather than scaling-up for more
efficient use of processor resources.

• Easier maintenance - Dynamically adding or removing of regions to the PAC for system maintenance.
• Increased availability - in the event of the failure of an Enterprise Server instance, the PAC can continue

to operate with reduced capacity. Enterprise Server instances can reside on different machines,
improving availability further.

• Dynamic scaling - Enterprise Server instances can be added to, or removed from, the PAC depending
on demand.

• Better performance - throughput is no longer restricted by the resources on a single machine (scale-up).
• Improved serviceability - you can now administer the PAC and any associated regions as a single image

from a new contemporary web-based administration interface (ESCWA).

Enterprise Server Common Web Administration
Back to Top
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Note: This feature is in Early Adopter Program (EAP) release status.

Enterprise Developer now includes a new Enterprise Server Common Web Administration interface
(ESCWA). ESCWA is a web user interface and server for modern administration, monitoring and control of
Enterprise Server. It offers improved usability that consolidates the different Enterprise Server user
interfaces so that native and managed regions, and security stores can be managed in one place. Features
include:

• Administering directory servers across multiple hosts.
• Monitoring and control of CICS and JES Enterprise Server instances.
• Configuring and administering a security store, defined in an LDAP-compatible security manager such

as Microsoft Active Directory or OpenLDAP.
• Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server

instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORs).

• Administering, monitoring and control of Enterprise Server for .NET regions and listeners.
• The use of current web frameworks that have a greater focus on security.
• (Included with 5.0 Patch Update 2 ) - support for Enterprise Server XA, MQ and PL/I configuration and

monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS
console, Region Trace options, displaying the current ESMs on logon page and Local/loopback
connections warning changes.

Application Workflow Manager
Back to Top

Improvements have been made in the following areas:

• Tools from the AWM, Eclipse, and ISPF Function Packages have been restructured and improved:

• Tool parameters are now named so that the position of the parameter is not significant anymore.
• You can only specify parameters which are supported by the tool.
• Only the parameter types String and File are now supported.
• Mass Processing is now an attribute of a tool parameter and is no longer a special input/output

parameter type.
• The tool relationship "Resource Operation Value" replaces the parameter type

"ToolDefinedResourceOperation".
• A new REST Function Package has been added. It provides support for the following functions -

DELETE, HEAD, GET, PATCH, POST, and PUT.

The new JSON File Descriptor has been provided to support REST payloads. This function package
enables you to integrate RESTful API with your AWM workflow. See REST Function Package.

• New tools in the Eclipse Function Package enable you to store and retrieve information from the Eclipse
secure store:

• Save To Secure Storage; Read From Secure Storage; Delete From Secure Storage

You can use these tools to securely store login credentials to a remote system and reuse the
information for subsequent access.

• A new attribute is now available to enable you to add comments to every model component in the AWM
model editor. See Comments in the AWM Model Editor.

AppMaster Builder
Back to Top

The AppMaster Builder Data View Explorer tab has been redesigned in this release make it easier to
create and maintain data views. Features include:
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• Creating SQL data views directly from the mainframe DB2 catalog
• Creating IMS and VSAM data views without the requirement for a global DDIFILE
• Generating data views using new DDIMETA files located in the DDIMETA folder in the AMB project
• A data view import process is provided to create DDIMETA files from existing DDISYMB files

CICS Support
Back to Top

Note: This feature is in Early Adopter Program (EAP) release status.

This release includes the following enhancements:

• CRCN CICS transaction - this new in-built CICS transaction monitors the state of XA connections for
each resource manager (RM) entry defined in the system. If CRCN finds that connections have become
unavailable, it will attempt to reconnect at regular intervals. (The frequency of the monitoring is
controlled by the ES_XA_RECONNECT environment variable.) CRCN will emit messages to the
console to warn of connections lost and regained.

COBOL Language Enhancements
Back to Top

The following enhancements have been made to the COBOL syntax:

• ISO2002 conditional compilation - an additional mechanism for conditional compilation, the ISO2002
Conditional Compilation method, is now available. This has been implemented as part of the support for
Enterprise COBOL 6.2.

The following compiler directing statements are supported:

>>DEFINE

>>IF/>>ELSE/>>END-IF

>>EVALUATE/>>WHEN/>>WHEN OTHER/>>END-EVALUATE

• The JSON PARSE statement enables you to convert JSON text into COBOL data formats. This has
been implemented as part of the support for Enterprise COBOL 6.2.

• INSPECT statement - the performance of INSPECT... CONVERTING has been improved, particularly
for cases where source-alphabet is long.

• Support has been added for the portable syntax for SET - set[string].

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

JVMTARGET Specifies the JVM version number targeted by the class files generated in this
compilation unit.

ILNORMALIZENAMES Determines the program elements that are normalized when a program is
compiled to .NET or JVM COBOL. Normalization in this context results in
replacing all $ and - (hyphen) characters with _ (underscore) characters in the
name of the generated class file.

Consolidated Trace Facility (CTF)
Back to Top

This release provides the following enhancements:
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• Availability of CTF from the Eclipse interface - a new property tab, CTF, in the Eclipse launch
configuration dialog box helps to enable CTF tracing and specify a CTF configuration file. By default, the
trace files are then saved in a Logs subfolder within the project's folder.

• Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being
traced. This feature is only currently available on Windows platforms.

Using a new command line utility - cblctd - you can alter the tracing events of running applications
that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from
the trace, and also configure the emitters in effect.

Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity
of the Micro Focus Native Database File Handler.

Data File Tools
Back to Top

This release provides the following enhancements:

• The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.

• Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.

• When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.

• You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.

• You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access
Back to Top

Enhancements are available in the following areas:

SQL Option for DB2

• XML data type support - the following XML scalar functions are now supported - XMLATTRIBUTES,
XMLCOMMENT (add), XMLCONCAT, XMLDOCUMENT, XMLELEMENT, XMLAGG(delete),
XMLNAMESPACES, XMLPARSE, XMLPI, XMLSERIALIZE, XMLTEXT, XMLQUERY.

• Initial XDB Server (add) support for z/OS DB2 V11 - includes support for archive tables and ALIAS on
sequences (delete).

• XDB Link support for z/OS DB2 V10/V11/V12 (add)

Eclipse Integration
Back to Top

This release includes enhancements in the following areas:

• Supported Eclipse versions - this release supports Eclipse 4.7 (Oxygen) and 4.8 (Photon). The setup
file installs Eclipse 4.8.

Eclipse 4.6 (Neon) is no longer supported.
• Java support - the 64-bit Java 8 is required to run the Eclipse IDE. The setup file installs Adopt

OpenJDK 8 (u202) with Hotspot. Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. For full
details on the supported Java versions, see Software Requirements.

• COBOL editor:
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• Automatic insertion of END statements - Eclipse now automatically inserts the end clause for IF,
EVALUATE, PERFORM, EXEC and TRY statements.

• Automatic insertion of closing symbols - by default, Eclipse now automatically adds closing quotes
and brackets where required.

• Search text positioned between specified columns - the Micro Focus Find/Replace dialog box now
includes options to search between specified columns in the code.

• Directive sets - Compiler directives for your projects are now saved in language-specific .mfdirset
XML files stored within a .settings subfolder in the project's folder. You can create your own versions
of .mfdirset files and verify them against an XML schema that Micro Focus supplies.

Previously, all settings were stored in a single, proprietary IDE project file. Existing projects which
currently specify directives and other similar settings in the .cobolproj file will be upgraded to use the
new .mfdirset files when imported or loaded in Enterprise Developer 5.0. If you are storing your
source code in a source control system, ensure that you add the .mfdirset files to source control as
well.

• Remote connections - support is available for automatic SSH tunnelling of Micro Focus Enterprise
Developer UNIX Components network traffic. You can route most Micro Focus Enterprise Developer
UNIX Components network traffic using SSH port forwarding. This makes developing on a remote UNIX
host running a firewall easier to configure. In addition, the network traffic is encrypted as it is being sent
within an SSH tunnel.

• User Interface:

• The COBOL Explorer view uses an icon overlaid with P to indicate COBOL programs that will not
be built because they are preceded by another of the same name on the build path.

• Improved settings UI - the COBOL, IMS, and the Run-time Configuration settings pages now use a
property grid that also shows the definitions of the settings.

Debugging
Back to Top

This release includes the following enhancements:

• Animate - Eclipse now includes an additional menu option when debugging a COBOL program for
setting the speed and toggling Animate mode. When active, the program will automatically step through
each line of source code, updating the source code in the editor, the Debug Stack, Outline and
Variables Views. See Debugging Commands and Options.

• Conditional watchpoints - you can now specify conditions and hit counts for COBOL watchpoints. A
condition can be in the form of an expression or it can be a hit count (for the number of times memory
associated with a data item has been updated). The condition is evaluated each time the data item
being watched changes. If the condition evaluates to true, then program execution stops. This enables
more fine-tuning of the current watchpoint support and is useful when debugging large, complex
programs.

• Dynamic core dumps - you can now invoke a core dump programmatically and continue execution of
your program. A new library routine, CBL_CREATE_CORE, enables you to produce a core file for the
current process or a process owned by the same user that owns the current process.

• Improved visibility of the PERFORM stack - the PERFORM stack and PERFORM range names are
visible in system debuggers such as gdb in many cases on 32-bit Linux with Intel architecture and
Solaris with Intel architecture. This was already the case on AIX, 64-bit Solaris-Intel, and all other Linux
platforms (including 64-bit Linux-Intel).

• In order to include source line numbers in run-time error messages, which makes the diagnosis of
issues in your program easier, the COBOL compiler now produces .idy files by default when building
from the command line, unless the NOANIM directive is specified. You can safely remove .idy files
after compilation if you do not need them; they do not need to be distributed with your application unless
you want to debug your code. However, unless you specify the ANIM directive, generated executables
such as .dll and .gnt will not be debuggable, which is consistent with prior behavior.
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Note: Behavior has not changed if you are using an IDE or build scripts generated by an IDE.

• Stackdump files (Linux Intel 64-bit, Solaris Intel 64-bit, and Linux/390 platforms only) - you can produce
a stack trace for applications in a production environment that encounter a Run-Time system error. Use
the stackdump_on_error and stackdump_filename tunables to configure the production of a stackdump
file when an error occurs, from which you can locate the exact line of failing code in your program.

• A new configurable tool is now available that dumps to a file stack traces of all threads in process on
any Run-Time System error. [Linux Intel, Solaris Intel, zLinux only – requires ANIM on 32-bit Linux
Intel]. This is only supported for native COBOL.

• Line number information is now being output for optimized builds (on Linux Intel 64-bit, Solaris Intel 64-
bit, PowerLinux, zLinux, and Solaris SPARC platforms only). This is only supported for native COBOL.
Because of what optimization does, the information is imperfect, but it remains highly indicative. This
gives the following advantages:

• Enables the use of the stackdump utility (where available) for optimized builds.
• Provides location information should a signal occur when running in a system debugger such as gdb.
• Provides some limited ability to step through optimized code in system debuggers.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File.

• Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.

• OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.

This is the stable Long Term Support version of OpenSSL.

• Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:

• Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.

• Using only the most secure ciphers and hash methods.
• TLS 1.3 will be negotiated in preference to the older TLS protocols.

• Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.
• The default security level for previously configured endpoints has been moved from Security Level 0

to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.

• Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of
X509 certificates bearing the name of the Fileshare service as the Common Name element of the
certificate.

In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unique certificate. While running on the same host and registered
with the same network endpoint.

• Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
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Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.

• Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.

• Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:

• The client library vendor and version information is logged after the library is loaded
• The module has better heuristics for loading the correct library supplied by the OS vendor, so the

"provider" configuration option can generally be omitted
• For OpenLDAP, the module sets its proprietary "connect timeout" option

• SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the
Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a
growing number of Web services being hosted on SNI servers.

Enterprise Server for .NET
Back to Top

This release includes the following enhancements:

• Improved CICS compatibility - CICS EIBRCODE handling in Enterprise Server for .NET now matches
the mainframe specification. CICS BMS support in Enterprise Server for .NET now matches the
behavior on the mainframe and in native Enterprise Server more closely.

• MMC administration UI support for ESF security - the MMC snap-in for Enterprise Server for .NET
administration now supports the External Security Facility. This means you can use LDAP-based or
custom security solutions to provide administrator authentication and access control.

• TLS (SSL) support - the seelistener utility now supports TLS (also known as SSL) for its TCP
communications channels. These include all channel types except MQ. The Enterprise Server for .NET
client classes also have been enabled for TLS. For example, the seeout utility can now be used with a
TLS-enabled MFBINP channel.

• Performance improvements - this release comes with an improved performance in WCF, system
database operations, and VSAM database operations.

IMS Support
Back to Top

This release includes the following new feature:

• Checkpoint and restart are now available for output GSAM files in addition to input GSAM files.

JCL Support
Back to Top

This release includes the following enhancements:

• Spool file housekeeping - you can now merge your archived spool files to a central location where they
can be viewed using the Micro Focus Data File Editor. This copies the archived spool files and merges
them into a new, combined archive. It does not change the original archive, so the audit trail remains
untouched, but the combined archive allows viewing of all the jobs that have been merged. The merge
process is carried out using a JCL job or by using a command line utility.

• A new user exit MFJFAXIT - this user exit allows you to receive notifications when 'file open' events are
processed by the JCL engine. A sample exit can be found in the src\enterpriseserver\exits
sub-directory of your product install directory. You can enable this exit by using the MFJFAXIT
environment variable, to point to the exit program.
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Mainframe Access
Back to Top

This release provides enhancements in the following areas:

• Full support for the z/Server functionality - MFA Server now has the capability to service all z/Server
requests. This means it is no longer necessary to configure z/Server, and the number of started tasks
running on the mainframe is reduced. Installing and configuring MFA Server becomes easier as z/
Server is no longer required.

• Browse dataset using IDCAMS dump - when using the MFDAS BROWSE command, it is now possible
to view the output of the IDCAMS DUMP command on the specified dataset in hex and printable
characters side-by-side.

• Improved JES support for executing jobs and input datasets - it is now possible for MFA Server to
interact with JES jobs that are in executing phase, and to list and download input datasets.

• Retrieve binder information for load modules - when executing the MFDAS BINDER command, it is now
possible to view the binder information from a load module.

• TSO command server - MFA Server includes a new type of application server to support executing TSO
commands as the current user. The address space is spawned as your user id and any valid TSO
command can be executed.

• UNIX sub-system (USS) support - MFA Server can now operate on files stored on a USS file system.
The available functions are - edit, browse, rename, delete, and copy USS files and directories.

Micro Focus Native Database File Handler
Back to Top

The Micro Focus Database File Handler (MFDBFH) is a file handler that enables your native CICS and
batch enterprise server applications to interact with data files and certain infrastructure files stored within a
database.

VSAM files may experience logical and/or physical corruption in the event of a hardware failure. This is due
to a single COBOL I-O operation consisting of multiple physical I-O operations. If all the physical I-O
operations that make up the COBOL I-O operation are not performed, the file can be left without integrity.
In previous releases you could guard against such occurrences with Fileshare and logging, but they
required some manual intervention and came with performance cost.

In this release, configuration options have been added that allow the I-O operations to be routed to an
RDBMS to take advantage of the availability and performance characteristics of the database. This can be
achieved with no changes required to the application. The file will be routed to the SQL database simply by
changing the filename prefix to sql://.

Features include:

• CICS and batch Cobol file I-O can now be routed to an RDBMS with only simple configuration changes.
No application changes are required.

• Supports all Micro Focus file formats
• Files can be routed to an RDBMS on a file by file basis.
• Utilities are provided to enable data to be moved between disk files and RDBMS.
• Support for PostgreSQL 10.x, Amazon Aurora PostgreSQL, Db21, and MS SQL Server (on Windows

and Linux Intel)

Micro Focus Rumba
Back to Top

1 Db2 support was introduced in the 5.0 Patch Update 2 release
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This release comes with Micro Focus Rumba+ Desktop version 10.2 SP1 which you can choose to install
with Enterprise Developer. This will enable embedded Rumba+ Desktop support within the IDE.

Micro Focus Unit Testing Framework
Back to Top

This release provides support for the following functionality:

• Data-driven unit tests - a new type of test suited to testing data where values read from a source are
passed through the same tests.

• JCL unit tests - two types of test that interact with the JES engine on an enterprise server region. These
tests are run from the command line.

• Test output colorization - test output can now include basic colorization for supported terminal
emulations. This feature must be run from the command line.

PL/I Support
Enhancements are available in the following features:

• Code coverage in Eclipse - code coverage data can now be generated for PL/I programs in the Eclipse
IDE using the same mechanisms as for COBOL programs.

• Compiler:

• Full support for GET DATA.
• Built-in functions:

• New built-in functions - ALLOCATE, INDEXR, MEMCONVERT, MEMINDEX, ONCONDCOND,
PLIFREE, REM, REPLACEBY2

• The HEX built-in function now matches its z/OS version.
• The PROCNAME and PROCEDURENAME functions used without trailing open/close parents.

• Allow the use of VALUE to initialize members of a PL/I Data Structure.
• Support for INONLY, NONASSIGNABLE attribute.
• Diagnostics when a supplied parameter to a call is larger than the entry declaration.
• Diagnostics when the Compiler detects that a loss of precision occurs as a result of operations on

FIXED DECIMAL operands.
• Compiler listings now provide additional information about arrays.
• OPTIONS(REORDER) is now parsed but ignored.
• *PROCESS OPT(TIME); is now supported.
• Support for larger concatenations when initializing variables or making assignments.
• Support for named constants of numeric PICTURE type in static structure dimensions and

initializations.
• Diagnostics when the concatenation of two strings results in a string that is larger than the target

variable.
• Support for the DUMMY ALIGNED and DUMMY UNALIGNED arguments.
• Support for the XML case asis and XML case Upper.
• Diagnostics if code attempts to use bitwise operators on non-bit variables.
• (Added in 5.0 Patch Update 1) A new option, –fdmaxp 15,31, has been added. With this one

specified, arithmetic operations with fixed decimal operands with precision <= 15 produce a result
with a maximum precision of 15. For arithmetic operations with fixed decimal operands with precision
<= 31, they produce a result with a maximum precision of 31.

The options –fdmaxp 15,15 and –fdmaxp 31,31 are allowed, and correspond to –fdmaxp 15 and –
fdmaxp 31, respectively.

• PL/I debugger in Eclipse:

• Variables surrounding current point of execution now displayed in Variables view.
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• A Console view for PL/I programs that are being remotely debugged outside the control of Enterprise
Server, and in Eclipse.

• Data watchpoint setting using a variable declaration in the debugger.
• PLIDUMP now emits STATIC variables in addition to AUTOMATIC and Parameters when

documenting the callstack.
• The Macro preprocessor now supports %INSCAN and %XINSCAN.
• The EXEC preprocessor now supports the following:

• SQL statements embedded within PL/I packages
• The -maxmsg option for setting the maximum number of errors to be generated before terminating

the compilation
• Up to 4000 include files in a signal program

• PL/I Run-Time System - support is now available for:

• Optionally generating Windows "Mini-Dumps" or a Linux coredump off the back of a call to
PLIDUMP.

• Dynamic allocation of datasets using the TITLE option(s).
• Raising an ERROR condition when a called subroutine raises a COBOL RTS error.
• FILE variables can have differing DCB when used in differing contexts.
• STATIC FIXED BIN(31) variable accessed at open within the RECSIZE() attribute of the

ENVIRONMENT.

Platform Support
Back to Top

Support is now available for the following additional or updated operating systems:

• SUSE (Power) 11 SP3, 12
• Red Hat (Power) 7.2, 7.3
• Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.

Product Documentation
Back to Top

The following is new in this release:

• The Comparison of COBOL with Other Managed Languages document has been updated to reflect the
recent enhancements in the .NET and JVM COBOL support.

What was New in Enterprise Developer 4.0
This release provides enhancements in the following areas:

• Integration with Eclipse
• Application Server JCA Support for Enterprise Server
• Application Workflow Manager
• AppMaster Builder
• Build Tools for Windows
• Code Coverage
• Codeset support
• Compiler directives
• Data File Tools
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• Debugging
• Docker
• Documentation on working with large applications
• Enterprise Server
• File Handler
• HCO for DB2 LUW
• IMS support
• JCL support
• Mainframe Access
• Managed COBOL
• Library routines
• Micro Focus Unit Test Framework
• OpenESQL
• Platform support
• PL/I support
• Web Service Clients

Integration with Eclipse

Back to Top

This release provides the following general enhancements:

• Support for Eclipse 4.7 Oxygen (64-bit) and 64-bit project templates - the 64-bit Eclipse 4.7 is now
installed by default. Project templates are available for both 32-bit and 64-bit applications. You can set a
default project template (either 32-bit or 64-bit) to use so that all future new projects will use that as the
preference. On platforms only capable of building to 64-bit, the 64-bit templates are the default ones.

The 32-bit Eclipse is still supported on 64-bit Windows platforms, however you need to manually install
it and a 32-bit Java.

Support for Eclipse 4.4 and 4.5 has been discontinued.
• Starting with release 4 Patch Update 4, you can plug Enterprise Developer into Eclipse 4.8 (either 32-bit

or 64-bit) installed on your machine. On Red Hat, this requires that you have Red Hat 7 or later.
• Support for SUSE 12 - only the 64-bit SUSE 12 platform is supported and you can only use the 64-bit

Eclipse with 64-bit projects on it.
• (Native COBOL projects only) The Project Settings page in the project's properties now include a

search option. This enables you to find files and build configurations that have settings different from the
ones set at project level.

• Remove File Directives - a context menu command in the explorer view enables you to reset a file's
directives.

• IVP diagnostic tool enhancements - it is now possible to run the server-side IVP diagnostic tool for
diagnosing issues with a remote connection from within Eclipse installed at the client side. The IVP tool
now also performs a check for whether XTERM is installed on the remote machine.

• IMTK service mappings are now automatically regenerated if you make a change to the interface fields
in the underlying program.

The following enhancements are available for JVM COBOL projects and package handling:

• New wizards for creating ENUM, DELEGATE and VALUETYPE types.
• Additional code snippets for Method-Id and Property-Id.
• Showing and grouping packages in the COBOL Explorer view - use the COBOL JVM Project

Presentation command from the View menu in the explorer to either display COBOL categories or
packages.

• Refactoring by renaming the package name - available from the context menus in the COBOL Editor
and in COBOL Explorer.
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• Refactoring by moving source folders, packages or compilation units - available from the explorer
context menu.

• Support for switching off the package name mapping using the Each part of the package name
corresponds to a subdirectory option in the Build Configuration page.

• Support for packaging .class files in a .jar file when building COBOL JVM projects.
• Open Type Hierarchy and Open Call Hierarchy context menu commands - available in the COBOL

editor, COBOL Explorer and in the outline views while seeing the packages presentation in the IDE.

The following editor improvements are available:

• A Properties context menu command - enables you to access a file's properties directly from the editor.
• A Show In context menu command - enables you to locate the file in the COBOL or the PL/I Explorer.
• Edit > Convert Tabs to Spaces command - enables you to convert any tabs in your COBOL source

files to a specified number of spaces.

Automatic relinking of applications created with Enterprise Developer 3.0:

• Enterprise Developer 4.0 can automatically relink existing projects created with Enterprise Developer
3.0 that have executable link artifacts. Eclipse displays a warning in the Problems view that the project
requires relinking. It then offers a Quick Fix action for you to execute that will link your project with the
most recent version of the run-time system.

For more information see Related Information at the end of this topic.

Application Server JCA Support for Enterprise Server

Back to Top

This release includes the following enhancements:

• COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
• Tomcat 7.0 support for servlet generation with J2SEBeans.
• NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL

fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

For more information see Related Information at the end of this topic.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:

• Model editor - now includes:

• A new Edit action. Enables you to edit any model component instead of working with the Properties
view. The new action enables you to change the attribute values of several model components at a
time.

• An Outline and a Relationship Hierarchy view.
• Improved backwards and forwards navigation in the model.
• Automated sequence numbering in the model.
• The context menu of the model editor has been restructured for more clarity.
• Context help.
• Tool creation has been improved. Dependent components are generated from the function package

tool definition.
• Development of models:

• Newly created empty models now contain all categories. The new models also validate without any
errors or warnings.
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• A new AWM system type, “Custom System”, is available. This system type supports the model
development process by facilitating the creation, change, load and reload of a model.

• New modelling features:

• The “Return Property Value” tool in the function package now supports several additional use cases.
• The “Transfer File” tool in the function package offers improved support for mass processing.
• Support for properties with an application-wide scope.
• A modelling capability to structure the local file cache for copybooks and include files downloaded by

the background parser in the editor. Additional tools are provided to check the existence of or clear
the file cache for copybooks and include files.

• The product help includes some tutorials showing how to create new models and extend the
functionality of existing models. See the Tutorials Guide.

• A number of template models are now available and can be used as a base to develop your own
models.

For more information see Related Information at the end of this topic.

AppMaster Builder

Back to Top

This release includes the following new features:

• AppMaster Builder is now available in the Team Developer Perspective (Technology Preview) - this
perspective provides a development environment for your AMB projects that includes much of the
functionality available from the AppMaster Builder perspective plus access to the AMB Endevor
Interface (Technology Preview).

• AMB Endevor Interface (Technology Preview) - enables you to share and synchronize resources
between an AMB project and mainframe Endevor datasets.

• A re-number/un-number feature in the Data Structure Editor.

For more information see Related Information at the end of this topic.

Build Tools for Windows

Back to Top

This release includes Enterprise Developer Build Tools for Windows, a separately-installable component of
Enterprise Developer that has been designed to be used in environments where you want to work with your
COBOL and PL/I projects but you don't want the overheads associated with the Eclipse IDE.

Build Tools provide a lightweight, easy-to-install development environment that is well-suited for use in
Docker containers and continuous integration or continuous delivery systems.

For more information see Related Information at the end of this topic.

Code coverage

Back to Top

This release provides the following enhancements:

• Support has been added in Eclipse for code coverage for procedural copybooks.

For more information see Related Information at the end of this topic.

Codeset support

Back to Top

Support has been added to enable codeset mapping to additionally be configured to use IBM's Conversion
Tables directly instead of the Micro Focus supplied tables. You need to download IBM's conversion tables
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from IBM's Web site. Then you can use the MFCODESET environment variable to convert between IBM's
CCSIDs.

For more information see Related Information at the end of this topic.

Compiler directives

Back to Top

The following Compiler directives are new in this release:

• DISPSIGN - determines the display output of numeric fields with included signs, under an IBM
mainframe dialect only.

• GNTLITLINKSTD - stops the suppression of call-convention 8 when both call-convention 2 and call-
convention 8 are in effect for a .gnt file in an Intel x86 32-bit environment.

• ILSMARTTRIM - trims any trailing spaces from a string item returned by the get property associated
with an alphanumeric item processed by ILSMARTLINKAGE.

• MAINFRAME-FLOATING-POINT - specifies the format of a program's floating point data items: either
IBM hexadecimal format or IEEE format. This directive is supported in managed code only.

The following Compiler directives contain new parameters in this release:

• CHECKDIV - a new parameter 'ACOS' now emulates a divide by zero operation on an ACOS
mainframe system: the quotient and the remainder are set to the value of the dividend.

• OOCTRL - a new parameter, L, specifies whether to include directory location comments in .cls
and .ins inheritance files.

• NUMPROC - a new parameter 'ACOS' provides partial compatibility with the behavior of NEC ACOS
COBOL processing of invalid data in USAGE DISPLAY data items and invalid sign information in
USAGE COMP-3 data items.

For more information see Related Information at the end of this topic.

Data File Tools

Back to Top

It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:

• Save the filtered records to a new file.
• Save the records that match the specified filter (such as customer information or orders).
• Download a subset of the data from a remote file.
• Save a small portion of the data for testing purposes.

For more information see Related Information at the end of this topic.

Debugging

Back to Top

This release includes the following enhancements:

• Debugging CICS channels and containers - you can now debug CICS COBOL applications that use
channels and containers. The debugger now enables you to view the contents of any channels and
containers, and to change content as you debug.

For more information see Related Information at the end of this topic.

Docker

Back to Top
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This release provides support to enable you to run your COBOL and PL/I applications in Docker
containers, taking advantage of the many benefits offered by the Docker platform such as portability,
performance, agility, isolation, and scalability.

For more information see Related Information at the end of this topic.

Documentation on working with large applications

Back to Top

The product help now includes a new section, Working with a Large Code Base, that includes
recommendations and best practices for working with large applications inside the IDE. It includes tips on
how to structure your projects, how to optimize the performance of the IDEs, and step-by-step workflow
showing how to move an existing legacy application into Enterprise Developer.

For more information see Related Information at the end of this topic.

Enterprise Server

Back to Top

The following enhancements have been made to Enterprise Server:

• Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

• The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.

This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

• (Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.

It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

• XA-compliant Resources (XARs) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

• A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

• Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

• Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.

• Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

• The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within

Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse | 71



your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.

• You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

For more information see Related Information at the end of this topic.

File Handler

Back to Top

This release provides the following enhancements:

• The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.

• The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

For more information see Related Information at the end of this topic.

HCO for DB2 LUW

Back to Top

This release includes the following new features:

• Support for CHARSET EBCDIC COBOL stored procedures
• Seamless integration with DB2 LUW SBCS databases, providing various EBCDIC collation sequences
• 64-bit HCO command-line tools are now available across all supported platforms
• HCO DCLGEN enhancements that provide more copybook generation options

For more information see Related Information at the end of this topic.

IMS support

Back to Top

This release introduces the following new features:

• The IMS Database Forward Recovery feature has been updated to provide point-in-time forward
recovery that enables you to recover all database transactions completed up to a specified point in time,
including date and time of day.

• IMS support now includes MFS code for Light Pen devices. In your MFS, include a DEV statement with
the FEAT=PEN parameter, and set the ATTR property on appropriate fields to DET or IDET to make
them detectable by a light pen. See your IBM documentation for details.

Note: MFS that contains light pen code must be regenerated to take effect if the MFS is part of an
Enterprise Developer project created using an earlier release.

• Support for export and import of IMS-configured enterprise server regions through Server Explorer.
• Support for the same IMS user ID to be signed on to multiple LUs simultaneously by using the

ES_IMS_SINGLE environment variable and optionally the ES_LTERM_PREFIX environment variable.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such.

For more information see Related Information at the end of this topic.

JCL support

Back to Top

This release introduces the following new features and enhancements:
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• Micro Focus FTP utility - you can now configure MFFTP to not process trailing blank spaces for a GET
command, by setting the new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and
setting the LOCSTAT value TRAILINGBLANKS=FALSE.

• A new API has been introduced - MVSSPLPB - that enables you to search all job information held in the
JES spool control files. It is more comprehensive that the existing MVSCASPB API, and should instead
be used for all new spool enquiries.

• A number of new environment variables have been introduced that enable you to configure the JES
startup behavior with regards to opening user catalog files. You can configure JES to open user catalog
files only when they are required (and not during system startup), and you can configure JES to retry
opening a catalog file that has failed to open. These changes increase the resilience of the JES system,
as you can mitigate against JES startup failures if the user catalog files are not readily available whilst
the region starts. See Configuring Multiple Catalogs for more information.

• The public catalog API, MVSCATPB, has been enhanced to better report on file errors when opening
catalog files. The following new functions have been added to mfpubcat.cpy: GCFS, GNFS, STNI,
GCFE, and GNFE. See Functions for more information.

For more information see Related Information at the end of this topic.

Library routines

Back to Top

The following library routines contain new functionality:

• CBL_GET_OS_INFO - this library routine can now detect if the program is running within a Docker
container: cblte-osi-rts-capabilities parameter, bit 7.

For more information see Related Information at the end of this topic.

Mainframe Access

Back to Top

The installation process has been changed as follows:

• A single installer for both Mainframe Access and the Mainframe Access z/Server support is provided.
• There is now only one XML configuration file for Mainframe Access. There is also a new configuration

utility that guides you through the configuration process.
• Specify your own JES console character - it is now possible to configure the Mainframe Access

installation to use a different JES console character instead of the default ("$"). To achieve this, use the
new JES_CONCHAR configuration parameter.

Enhancements are available in the following areas:

• The Mainframe Call Generator now runs in an independent address space. Previously, it was possible
for code run in the MFA address space to enter a supervisor state. MCGLIB is now the new address
space's STEPLIB. This enables other user modules to be called without placing them in MFA's
STEPLIB, as was previously necessary. See Mainframe Call Generator: Calling Programs on the
Mainframe for more information.

Managed COBOL

Back to Top

Deploying JVM COBOL to an Application Server:

• Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

For more information see Related Information at the end of this topic.
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Micro Focus Unit Test Framework

Back to Top

This release provides support for the following functionality:

• Generation of unit test stubs for selected entry points within your program.

For more information see Related Information at the end of this topic.

OpenESQL

Back to Top

This release provides the following new features:

• Support for SQL Server 2017.
• The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction

boundaries.
• A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that

do not do positioned updates or deletes with PostgreSQL or MySQL.
• Larger communication area (PID) that accommodates longer plan and program names.
• SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all

OpenESQL backends.

For more information see Related Information at the end of this topic.

Platform support

Back to Top

Note the following changes in platform support for this release:

• Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment.

• SUSE platforms - this release only supports SUSE Linux 12 SP2, 64-bit.

On this platform, you can only build COBOL and PL/I programs to 64-bit executables. This applies when
using Eclipse on SUSE or with remote projects when Micro Focus Enterprise Developer UNIX
Components is installed on SUSE.

For more information see Related Information at the end of this topic.

PL/I support

Back to Top

Note: PL/I applications that were created using Enterprise Developer 3.0 and earlier must be
recompiled in Enterprise Developer 4.0 to ensure they will compile and execute properly.

Support has been added for the following features in PL/I debugging:

• Displaying complex data structures in the Expressions and Variables views.
• Viewing the console window on non-Windows platforms so that output and input can be seen or

entered.
• The Outline view in the default Debug perspective.
• Watchpoints on variables on the line where the variable has been declared.
• Conditional breakpoints.
• Skipping variables a defined number of times before the execution stops.
• Adding expressions to the Expressions view from the Outline view.
• Inspecting variables when referenced as part of a macro argument.
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• Signals and conditions.

PL/I compiler and Run-Time System enhancements:

• Support for the following built-in functions - CHARVAL(), COMPARE(), CURRENTSIZE(), EDIT(),
PICSPEC(), SOURCEFILE() and SOURCELINE().

• Support for additional DATETIME() format strings.
• Support for the FLUSH FILE(*), ITERATE, and RESIGNAL statement.
• Support for the XMLOMIT and XMOLATTR attributes on variable declarations.
• Support for the MARGINI compiler option.
• Support for the SIZE and STRINGSIZE prefix conditions.
• Improved support for the repeat factor on arrays of AREA variables.
• Improved pointer arithmetic on 64-bit platforms.
• Where necessary, MFPLX now recognizes selected *PROCESS statements and passes them to the

appropriate preprocessors.

PL/I EXEC preprocessor:

• The EXEC preprocessor now honors the -margins setting for the output MDECK in addition to the input
file. This provides an improved experience in the Eclipse IDE when using the Outline view and other
PL/I features provided by the background parser.

PL/I macro preprocessor:

• The Micro Focus macro preprocessor now provides a new default behavior that mimics IBM's
RESCAN(ASIS) behavior. In addition, a new option, rescan_upper, has been introduced to enable you
to optionally mimic IBM's RESCAN(UPPER) behavior.

Improvements in compatibility with IBM's Macro Preprocessor:

• Allows OTHER as an acceptable abbreviation for OTHERWISE on a macro SELECT statement.
• Supports the SCAN/NOSCAN option on declaration of macro variables.
• Implements the NOSCAN option on ANSWER statements.
• The %NOTE message format has been modified to match IBM's behavior.
• The SYSVERSION built-in function has been modified to always return a value of 22 bytes in length

(space padded, if necessary).
• Relaxed diagnostics for scenarios where Enterprise Developer is generating a warning message and

IBM does not.

(Technical Preview) Generating PL/I test coverage reports:

• The PL/I Compiler and Run-Time System now support capturing of information showing which lines in
the program have been executed, and the generation of human-readable reports at the conclusion of a
run.

(Technical Preview) Interaction with COBOL AMODE and 370 Assembler programs (Windows 32-bit only):

• A new compiler option is available which enables Open PL/I to interact with 370 Assembler, and with
COBOL programs compiled with AMODE. See the product help for the current limitations to this
support.

For more information see Related Information at the end of this topic.

Web service clients

Back to Top

This release provides the following enhancements for Web service clients:

• Improved support for larger, more-complex WSDL files, including:
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• Configurable generation of variable arrays and repeated structures by specifying the Inline-Array-
Size-Limit parameter.

• Generation selection for service, port, and one or more operations.
• Support for SOAP version 1.2 in addition to version 1.1.

What was New in Enterprise Developer 3.0
Enterprise Developer 3.0 provided enhancements in the following areas:

• Integration with Eclipse
• Application Server JCA support for Enterprise Server
• Application Workflow Manager
• Building applications
• Character encoding
• CICS Web services
• COBOL language enhancements
• Code analysis
• Code coverage
• Compiler control
• Data File Tools
• Database access - HCO for DB2 LUW
• Database access - HCOSS
• Database access - MySQL
• Database access - OpenESQL
• Debugging applications
• Deployment on multiple platforms
• Documentation
• Enterprise COBOL 6.1 compatibility
• Enterprise Server
• IMS support
• Mainframe Access (MFA)
• Micro Focus Unit Testing Framework
• PL/I support
• Rumba terminal emulator
• Transaction Classes
• XML processing
• z/Server

Integration with Eclipse

Enterprise Developer 3.0 provided enhancements in the following areas:

• Support for Eclipse 4.6 - Enterprise Developer now ships with the 64-bit Eclipse 4.6. By default, Eclipse
is configured to compile applications for 32-bit and the default target platform for new projects is 32-bit.

Note: Applications that were created using Enterprise Developer 2.3 Update 2 and earlier must be
recompiled in Enterprise Developer 3.0 to ensure they will compile and execute properly.

The 32-bit Eclipse is still supported on 64-bit Windows platforms and you need to manually install the
32-bit IDE and a 32-bit Java

You can install the Enterprise Developer plugin in other instances of Eclipse (32-bit or 64-bit). Support
for Eclipse 4.2 and 4.3 has been discontinued.

• Rename refactoring - enables you to rename COBOL elements such as variables and identifiers,
section and paragraph names, classes, and methods across a program or a workspace. Renaming
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helps improve the readability of an item or make its purpose clearer. Two preferences for renaming are
supported in Eclipse - directly in the editor or using a Rename dialog box that offers a preview.

• Dependency paths - it is now possible to specify dependency paths to folders that are outside the
project folder.

• Standalone files:

• It is now possible to specify the locations where the IDE will search for the program symbol files
(.idy) for standalone files: Window > Preferences > Micro Focus > COBOL > Standalone Files
> Program Symbols (.IDY).

• It is now possible to use the Eclipse debug configurations to debug standalone files, including core
dump files.

In previous versions of Enterprise Developer, standalone files were known as "single files". References
to "single files" in the IDE and the product help have been changed to "standalone files".

• Error reporting - errors reported in the Console view now include a link for opening the source file at the
line where the error originates.

• Editor improvements - an option for removing trailing whitespaces has been added to the IDE
preferences for the COBOL and the PL/I editor.

Application Server JCA support for Enterprise Server

In Enterprise Developer 3.0, EJBGEN has been updated to generate an EAR file as a part of the COBOL
deployment process, which enables you to deploy EJBs to Java Application Server.

Application Workflow Manager

Enterprise Developer for Eclipse now provides the Application Workflow Manager (AWM) feature. AWM
enables you to customize and extend the Eclipse UI and workbench functionality to create application
workflows that meet your requirements.

The features comes with:

• A standard project model for local COBOL development that reflects the features available in COBOL
Explorer. You can modify this model by adding or removing project features.

• Application Explorer, Filter Definitions, Properties, and Table Results views in the COBOL
perspective.

Enterprise Developer 3.0 includes improvements in the following areas:

• Application Workflow Manager model editor:

• The definition of linked element types and properties has been improved. Some required model
objects and relationships are now generated automatically.

• The editor now detects unused references in a model.
• Application Workflow Manager modeling:

• Basic resource processing has been extended to support mass processing where appropriate.
• The AWM function package now includes the following new tools:

• "Return Property Value" - enables you to map the values of input parameters to output
parameters.

• "Validate Value" - enables you to validate a filename against a specified naming convention.
• You can now specify enabling conditions in a more granular way. An additional condition type has

been introduced to hide actions or properties. For example, hiding an action from the context menu
of an element.

• The Eclipse linked element type now enables the label and label decorator to be automatically set to
mirror their representation in other Eclipse views if they are not explicitly modeled.

• Table columns can be modeled as a combination of two or more properties - for example, to combine
a date and time property value.
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• Additional standard icons.
• Mainframe Access (MFA) integration and the MVS function package:

• MVS resources are now available as linked element types.
• The following tools have been added to the MVS function package:

• Delete MVS data set or member
• Rename MVS data set or member
• Copy MVS file to clipboard, Paste MVS file from clipboard
• Get data set or member attributes

• Improvements have been made to copy and paste support in the MVS Explorer.
• File mapping between z/OS and local files now supports additional local code pages.
• The editor context menu contains a "Submit to Mainframe" action when a file is opened from the

MVS Explorer with an extension which is mapped to JCL in the File Mappings view.
• Some of the new MVS function package tools replace existing ISPF function package tools resulting

in improved performance of the tools.
• The sample model "MVS Projects Sample Application" has been improved by including some of the

new AWM MVS function package features.
• AWM is now available as a standalone feature which you can install into a separate instance of the

Eclipse IDE installed on your machine.

Building applications

Enterprise Developer 3.0 provided the following improvements:

• Support for faster, parallel building on multi-CPU machines - support has been added for multi-
processor compilation of the sources in native COBOL projects on multi-CPU machines.

You can specify the maximum number of concurrent compilations from the IDE preferences - Window >
Preferences > Micro Focus > Builder.

Character Encoding

A new utility, cobutf8, is available. cobutf8 enables you to seamlessly run applications that require non-
UTF-8 character encodings in a UNIX environment that is using a UTF-8 locale.

CICS Web Services

From Enterprise Developer 3.0, CICS Web Services was made generally available; it had previously been
available (from Enterprise Developer 2.2 Update 2) as a Technology Preview feature.

From Enterprise Developer 3.0, support also includes the following additional features:

• CICS JSON Web services for request/response and RESTful JSON. CICS Web Services support has
been extended to allow JSON/REST requests to be used in both requestor and provider mode.

• Use of container-based mappings

COBOL language enhancements

Enterprise Developer 3.0 includes the following enhancements to the COBOL syntax:

• The DISPLAY-OF and NATIONAL-OF intrinsic functions are now able to process conversions using any
IBM CCSID value. See To install a CCSID Table for details on installing the required CCSID table.

The following enhancements are available in managed COBOL:

• To avoid an exception being thrown if an explicit conversion fails, use the AS IF syntax, which results in
the target object being set to null and no exception thrown. See cast expressions in the Expressions
topic for more information.
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Code analysis

Enterprise Developer 3.0 provided the following improvements:

• A new group of predefined rule sets for 64-bit readiness is now included in Enterprise Developer.
• Support for importing code analysis reports produced with one of Micro Focus's advanced tools for code

analysis, Enterprise Analyzer or COBOL Analyzer.

Code coverage

The following improvements are available within the IDE:

• Information about unexecuted programs - the code coverage reports in the Code Coverage window
now show the unexecuted programs.

• Code coverage support for standalone COBOL files - you can import existing code coverage reports in
the Code Coverage window and use it to supply code coverage information for standalone files.

• Remote code coverage files - in the Code Coverage window in Eclipse, it is now possible to import
code coverage report files that are stored in remote locations.

• Test coverage files - it is now possible to use a test coverage file to debug applications.

If you are using Test Coverage from the command line, you can now use the following features:

• A new Compiler directive, COLLECTION - the directive enables test coverage to gather information
about unexecuted programs. In the IDE, this directive is automatically set on a project when you enable
code coverage for it.

• A new command line utility, tcutil - the utility enables you to convert the test coverage binary results file
into XML format.

• It is now possible to integrate test coverage in a Continuous Integration (CI) system. You can use tcutil
and an XSLT processor to transform test coverage data into a format suitable for including in a CI.

Compiler control

The following Compiler directive are new in this release:

• COLLECTION - provides a mechanism for code coverage to identify unexecuted programs.

The following Compiler directives have been updated:

• ALIGN - this directive has new parameters (FIXED and OPT) that can be used in conjunction with the
integer taken, which can aid performance. The default is ALIGN"8 OPT"; see the Comments section of
the ALIGN Compiler directive topic for details of its affect on memory boundaries.

• ARITH - this directive emulates the IBM mainframe option of the same name. Defines the maximum
number of digits for numeric data items.

• FASTINIT - this directive is now on by default when setting the MF dialect; it remains not set by default
for other dialects.

• SSRANGE - this directive now has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.

• XMLPARSE - includes a change in the way entities are processed when XMLPARSE"COMPAT" is set

Data File Tools

The Data File Tools editor previously provided (from Enterprise Developer 2.3) as a Technology Preview
item was supported at GA level from Enterprise Developer 3.0.

Enterprise Developer 3.0 provided the following enhancements to Data File Tools:

• Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.

• Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
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provide a user ID, group and a password when they try to access and view datasets in enterprise server
instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.

• Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.

This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.

• Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.

• Support for existing .pro files - enables you to use your existing editor profiles.
• Support for existing .str files - enables you to use your existing COBOL and PL/I structure files.
• Automatic timeout - if no internal operations or external actions (such as a mouse click) have been

detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Database access - HCO for DB2 LUW

Enterprise Developer 3.0 provided a new DB2"QUALIFY-CALL" Compiler directive that enables stored
procedure invocations to include a schema name.

Database access - HCOSS

Enterprise Developer 3.0 provided a new Offline Schema Extract feature – a batch solution that migrates a
z/OS DB2 catalog to SQL Server without direct access to z/OS DB2.

Database access - MySQL

Enterprise Developer 3.0 provided support for MySQL with ODBC.

Database access - OpenESQL

Enterprise Developer 3.0 provided the following new features:

• Statement prefixes for the SQL"CHECK" Compiler directive that enable the creation of temporary tables
and other SQL objects at compile time, ensuring full SQL syntax checking during compilation.

• SQL"OPTIMIZECURSORS" Compiler directive that enhances processing for traditional embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses.

• SQL"CLOSE_ON_COMMIT" Compiler directive to leave cursors open for further result set processing
after a commit.

• SQL"GEN-SQLCA" Compiler directive that generates an SQLCA similar to the z/OS DB2 directive
STDSQL"YES".

Debugging applications

Enterprise Developer 3.0 provided the following new features:

• Debugging core dump files without a project.

Deployment on multiple platforms

Enterprise Developer 3.0 provided support for deploying JVM COBOL applications on multiple platforms.
You can compile an application on one platform (such as Windows) and then deploy its class files to a
different platform (such as Linux or UNIX).

Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications for details.
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Documentation

The following new sections have been added to the product help:

• Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.

• Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.

• Configuring an SSL Client Connection to a Mainframe - includes instructions about how to configure
client applications to connect to MFA and z/Server mainframe via AT-TLS in a zOS environment.

Enterprise COBOL 6.1 compatibility

The following features have been added to support Enterprise COBOL 6.1:

• A new statement, JSON GENERATE, which enables you to convert data to JSON format.
• A new special register, JSON-CODE, and its resulting exception codes to support the new statement.
• Two further new statements, ALLOCATE and FREE, to obtain and release dynamic storage.
• A new MF level, MFLEVEL"19", which contains the following new additions to the reserved words list:

• JSON
• END-JSON
• ALLOCATE
• FREE
• INITIALIZED (context-sensitive reserved word)

Note: These keywords are also in effect under the ENT dialect.

• The SSRANGE Compiler directive has an additional option "3", which permits zero-length reference
modified items at run time when bounds checking.

• Support for the INITIALIZE statement under the ENT dialect has been enhanced.

Enterprise Server

Improvements are available in the following areas:

Integration with Eclipse

• Exporting an enterprise server definition from the IDE in XML format.
• Importing an enterprise server into the IDE using its definition file.

iFileshare

iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:

• An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:

• A primary failover now results in a takeover from the most suitable node.
• If configured, external clients will automatically reconnect to the new primary and will issue a

notification if the transaction has been lost.
• A failed node, when restarted, will rejoin the group, recover its files and request a log update from

the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.

• Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.

• A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.
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• The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
• The following new iFileshare-specific environment variables are available:

• FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.

• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.

• The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds
the entire contents of the data directory to the database reference file.

EXEC CICS TRANSFORM:

• Enterprise Server now supports the XMLTODATA and DATATOXML options of this API.

JCL spool

The JCL spool repository infrastructure has been redesigned to significantly improve its performance. The
improvements include:

• A more disk-efficient infrastructure, reducing the space required by the spool files by up to 75% in some
cases.

• Improved internal indexing, resulting in quicker generation of messages and sysout records during
processing.

• Improved navigation of spool queues: job status Complete replaces the Output, Out Hold, and
Printed statuses, and completed jobs with any combination of sysout files can be displayed in a single
list.

• Increased range of job numbers, from five digits to seven digits.

Important: These changes are automatically in place for new enterprise servers that you create.
To enable these updates to existing enterprise servers, you must run a conversion utility before
any JCL processing is permitted. Follow the To run the spool conversion utility process,
detailed in Significant Changes in Behavior, for each existing JES-enabled enterprise server you
have.

Long user IDs and passwords:

• Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

Multi-factor sign-on:

• Multi-factor authentication enables users to sign on to Enterprise Server CICS without entering a
username and password. A secure user identifier, such as a certificate, is mapped to a username and is
used to generate a passtoken. It is possible to use smartcards, biometrics, or other authentication
systems to identify yourself to the system. The username and passtoken can then be used to log on to
CICS in an automated way.

The supported sign-on mechanisms are Express Logon Feature (ELF) and Automated Sign-On for
Mainframe (ASM).

SHA-256 support in DemoCA:

• By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:

• Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
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auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

IMS support

A new MFSGEN Compiler directive, CONTMVS, has been added to enable the compiler to parse MFS
continuation lines (those continued without a terminating comma) by treating the line that follows as a
comment line, just as is done on the mainframe.

Mainframe Access (MFA)

Enterprise Developer 3.0 provided the following improvements:

• Running MFA client in 64-bit processes - you can now call the MFA client modules from 64-bit
applications and take advantage of the wider memory addressing available to those modules.

• MFA client CTF tracing - MFDAS now supports CTF tracing. This provides better diagnostics of issues
and helps increase turnaround on issues. CTF is common to a number of Micro Focus modules so
cross-component logging can be turned on from a single place.

• MFA and z/Server holder close coupling - MFA server can now start the z/Server holder as a subtask in
its own address space. This helps improve the performance as MFA can hand-off AWM sessions
directly to the z/Server scheduler without instructing AWM to redirect them.

• Endevor functions - the following functions are now available to Enterprise Sync and MFDAS: DELETE,
DIRX, GENERATE, GETENQI, LIST, MOVE, SIGNIN and TRANSFER.

The Micro Focus Unit Testing Framework

The Micro Focus Unit Testing Framework is now available from within the IDE. It includes much of the
architecture you would expect of an xUnit framework to create, compile, run and debug unit tests, including
the following features:

• A unit test project template.
• A test creation wizard that enables you to generate tests from your source code.
• Code templates for each element of a test case.
• Support for running tests with Code Coverage enabled.
• The Micro Focus Unit Testing view, where you can manage your test runs and view test output.

There has been a number of enhancements to the command line version of the Micro Focus Unit Testing
Framework. Support has been added for:

• Running test fixture files using Apache Ant.
• Applying traits to your test cases, then performing a test run based on those traits.
• Applying a high, medium, or low priority to test cases, which affects the order in which they are run.
• Adding coded command line options directly into your test code.
• Using a test run-specific configuration file, in which you can set environment variables.

PL/I support

Enhancements are available in the following areas:

PL/I debugging

• New Eclipse-based PL/I debugger - the CodeWatch debugger has been replaced with the debugger
within the industry standard Eclipse User Interface. New features such as true remote debugging are
now available along with a much simplified user debugging experience that works in exactly the same
way as the debugger works for COBOL (and Java). This can help improve the productivity of PL/I
application developers who are adding new features or migrating existing applications to a distributed
world.

A selection of features which are now supported includes:
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• Attaching to a running PL/I process, waiting for attachment from a PL/I process
• Breakpoint-setting in the editor
• Stepping through PL/I code and querying the contents of PL/I data items
• Viewing the execution stack, resetting the executions point, and running to a selected line
• Remote debugging of PL/I applications running on Linux or AIX machines

PL/I compiler and run-time system

Support has been added to enable the following:

• The UNSIGNED data type - the PL/I Compiler now supports the UNSIGNED attribute for FIXED
BINARY data items. In addition to the basic language support, the SIGNED, UNSIGNED, ISIGNED, and
IUNSIGNED new built-in functions have been implemented. These features offer an improved
compatibility with other languages such as C or C++.

• New built-in functions - UTF8(), UTF8TOCHAR(), UTF8TOWCHAR(), and SUBTRACT(). These new
build-in functions make it easier to modernize migrated PL/I applications.

• The ENTRY LIMITED data attribute - the Open PL/I Compiler now accepts and fully supports the
LIMITED attribute on ENTRY declarations. This increases the compatibility of the Micro Focus PL/I
Compiler with IBM's PL/I for applications that you are migrating from the mainframe.

• Support for processing of JSON data - a number of new built-in functions are available for processing
JSON text. This enables you to modernize your PL/I applications by enabling them to interpret, create
and process JSON data.

JSONGETARRAYEND JSONPUTARRAYEND JSONGETMEMBER

JSONGETARRAYSTART JSONPUTARRAYSTART JSONGETVALUE

JSONGETCOLON JSONPUTCOLON JSONPUTMEMBER

JSONGETCOMMA JSONPUTCOMMA JSONPUTVALUE

JSONGETOBJECTEND JSONPUTOBJECTEND JSONVALID

JSONGETOBJECTSTART JSONPUTOBJECTSTART

PL/I macro preprocessor

A number of enhancements have been made to improve the compatibility between the PL/I macro
preprocessor and IBM's macro preprocessor which helps ease the effort required to migrate PL/I
applications to new platforms. Support is available for:

• RESCAN in the ANSWER statement.
• The shorthand "<>" syntax for indicating "Not Equal To".
• Break characters in hex literal constants to improve readability of code.
• A new option, -tagdbg, that annotates macros and %FILE/%ENDFILE statements with line numbers and

the source file which injected them.
• The -caseasis option which allows source code to flow through to the mdeck.pp file retaining the case

as entered.
• Macros with a null parameter list.
• The LEAVE statement.
• Improved macro preprocessing speed.
• New built-in functions: SYSENDIAN() and MFPHOSTNAME().

Rumba terminal emulator

Enterprise Developer now ships with Micro Focus Rumba 9.5.

Back to Top
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Transaction Classes

Transaction classes, which provide a mechanism to limit the number of CICS® tasks in your system and
were previously a Technology Preview item, was supported at GA level from Enterprise Developer 3.0.

XML processing

XML PARSE now works in a purely managed COBOL environment. It is now supported in JVM COBOL
and, in both .NET and JVM COBOL, it has a fully managed implementation. XML PARSE working without
calling out to native code ensures it can be used in restricted rights environments.

z/Server

The z/Server configuration has been simplified through the use of a unified scheduler. This replaces the
three different types of scheduler, STC, CEA and JOB, that were used previously for starting different types
of user servers.

What was New in Enterprise Developer 2.3 Update 2
Enterprise Developer 2.3 Update 2 provided enhancements in the following areas:

• Integration with the Eclipse IDE
• Application Workflow Manager (AWM)
• COBOL language enhancements
• Classic Data File Tools
• Compiler directives
• Database access - DSNREXX
• Editor writing assistance
• File handling
• IMS support
• Interface Mapping Toolkit
• Library routines
• PL/I support
• Tutorials

Integration with the Eclipse IDE

Enterprise Developer 2.3 update 2 provided enhancements in the following areas:

• The following settings have been added to the BMS page in the project's and file properties - Redefine
Input, SDF Map Size, and Hyphenate Field Suffix.

• Using the search facility, Search > Micro Focus, you can now limit the search to the copybooks used
by the current program rather than all copybooks in the project or the entire workspace.

• The editor provides a new context menu command, Extract COBOL code to copybook, that enables
you to move a selected segment of the code to a new copybook file in your project. The segment of
code moved to a copybook is replaced with a COPY statement in the original program.

• Support for Eclipse 4.5 - after installing Enterprise Developer, you can add it as a plugin into a separate
instance of Eclipse 4.5. See your product's Installation notes.

Application Workflow Manager (AWM)

Enterprise Developer 2.3 update 2 provided enhancements in the following areas:

AWM model editor:

• It is now possible to use drag and drop not only for objects of the same type but in all cases where this
is relevant. For example, it is now possible to drag tool descriptors onto an action descriptor which will
create an "Action Descriptor has Tool" relationship. Dragging a File_Descriptor_has_Property
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relationship onto an element list structure will create an Element_List_Structure_has_Column
relationship.

• It is now possible to group any major modelling objects such as action descriptors, properties and tool
descriptors in the AWM model editor.

AWM modelling:

• The Eclipse function package includes a new tool, "Build Project", and the MVS function package
includes a new tool, "Refresh DataSet".

• "Edit MVS File" now provides a parameter to the editor ID.
• The AWM meta model has the following enhancements:

• New model objects for configuring the decoration of labels displayed in the Team Developer Tree
view.

• Visible conditions for enabled conditions. You can use the visible conditions to specify whether an
action should be shown on an element's context menu.

• A new application-specific attribute, INITIAL_PARSE, enables you to specify whether the background
parse process of the editor should start when a file is opened in the editor.

• The Eclipse function package includes a new category of linked properties that support the Eclipse
team properties.

• The Eclipse linked element types now support the "Run As", "Debug As" and "Profile As" context
menu actions.

AWM z/OS extensions:

• The Micro Focus z/Server connection now provides an Owner filter.
• The Micro Focus z/Server connections support case sensitive input of passwords.
• The IDz function package provides a new tool which opens MVS resources depending on the RSED

connection defined in the Micro Focus z/Server connection. This now enables you to download
copybooks in IDz environments using the Micro Focus z/Server connection.

Micro Focus model extensions:

Support is available in the Micro Focus model extensions (the Enterprise Development Projects model and
the SCM models for Endevor, ChangeMan, SCLM and SVN) for:

• The Eclipse team linked properties
• Grouping modelling objects in the editor
• Visible conditions
• The "Run As", "Debug As" and "Profile As" commands

COBOL language enhancements

Numeric, edited and external floating point items can now specify USAGE NATIONAL when the
NATIONAL"2" Compiler directive is in effect. Signed numeric items must be specified with the SIGN IS
SEPARATE clause.

Classic Data File Tools

A new command line utility is available which enables you to initiate the following actions: open data files,
create or open record layout files, create or open segment layout files, and open IMS databases using a
DBD or PSB file. Note that although you can initiate these actions from the command line, you must
complete them from within the IDE.

Compiler directives

The following Compiler directives are new in this release:
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• COMMAND-LINE-LINKAGE - enables you to call a program and pass the command line to the main
program as a parameter to be accessed via the Linkage Section. This offers equivalent functionality to
the command_line_linkage tunable, which has now been deprecated.

• EBC-COL-SEQ - controls the behavior of an EBCDIC collating sequence, specified in a
NATIVE"EBCDIC" program. EBC-COL-SEQ"1" (the default) maintains use of the long-standing fixed
(platform-independent) EBCDIC collating sequence. EBC-COL-SEQ"2" prompts use of the latest
CODESET table, which varies according to platform and user-controlled MFCODESET environment
variable setting.

• NATIONAL - enables you to specify numeric, edited and external floating point items as USAGE
NATIONAL.

Database access - DSNREXX

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.

DSNREXX support is available for use with Enterprise Server using DB2 LUW and SQL Server. See
DSNREXX Support for more information.

Editor writing assistance

Enterprise Developer 2.3 update 2 provided the following enhancements:

• Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.

• $REGION statement - support is provided for the $REGION Compiler-control statement. You can use
$REGION - $END-REGION to surround blocks of code that you want to fold or expand in the editor.

• AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

For more information see Related Information at the end of this topic.

File handling

MFJSORT ICETOOL now supports the USING parameter in the SELECT operator.

For more information see Related Information at the end of this topic.

IMS support

Enterprise Developer 2.3 update 2 supports the PROMPT keyword in MFS source files.

For more information see Related Information at the end of this topic.

Interface Mapping Toolkit

Enterprise Developer 2.3 update 2 supports JSON schemas for the generation of REST Web service
clients in the Eclipse IDE.

For more information see Related Information at the end of this topic.

Library routines

The following library routine contains new functionality:
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• CBL_GET_PROGRAM_INFO - a new function (function 10) has been added for native COBOL which
returns the path and program name, or the program name only of a particular program.

For more information see Related Information at the end of this topic.

PL/I support

Enterprise Developer 2.3 update 2 provided the following enhancements:

• New built-in functions - support has been added for the ONCONDID() and SAMEKEY() built-in
functions.

• Support for strings declared with the VARYINGZ attribute - the Open PL/I compiler and run-time system
now support the use of VARYINGZ strings as variables, parameters, and targets for built-in functions.
This provides an improved compatibility with IBM's mainframe compiler, and the ability to more easily
interact with other languages such as ANSI C.

• Improved PL/I macro preprocessor compatibility - the Open PL/I compiler now supports all macro
preprocessor built-in functions used by IBM's PL/I Macro Preprocessor.

• Improved compatibility with IBM's Structure Alignment rules - the -zalign option of the Open PL/I
compiler now maps structure elements of the BIT data type that do not consume a full byte to the same
boundaries as IBM's PL/I compiler. This helps make the migration of mainframe data files to a
distributed platform easier and improves the program execution compatibility.

• Improved floating point support - the Open PL/I Code Generator now utilizes the newer Intel floating
point operands for improved speed. In addition, the Code Generator now provides improved
compatibility with passing parameters between C and COBOL.

• PL/I editor improvements:

• A new context menu command in the editor, Extract PL/I code to an include file, which enables
you to move a selection of code in the editor into a new include file. The extracted code is replaced
with an %INCLUDE statement which references the include file.

For more information see Related Information at the end of this topic.

Tutorials

The product help includes the following new tutorials:

• Tutorial: SQL - Deploying an Enterprise JavaBean Containing JVM COBOL to a JBoss Application
Server - that walks you through the process of deploying an EJB that contains JVM COBOL code.

• Tutorial: DSNREXX, that walks you through the process of executing DB2 LUW queries using
DSNREXX.

What was New in Enterprise Developer 2.3 Update 1
Enterprise Developer 2.3 Update 1 provided enhancements in the following areas:

• Integration with the Eclipse IDE
• Application Server JCA support for Enterprise Server
• Application Workflow Manager (AWM)
• CICS Web services (Technology Preview)
• Code Analysis
• Code Coverage
• Compiler directives
• Database Access - HCO for SQL Server
• Database Access - Mainframe Batch Database Tools (MBDT)
• Data File Tools
• Editor writing assistance
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• Enterprise COBOL 5.2
• File Handling
• Library routines
• Managed COBOL Syntax
• Native COBOL Syntax
• PL/I support
• Rosetta Stone for COBOL, .NET and Java Developers
• SourceConnect
• z/Server

Integration with the Eclipse IDE

Enterprise Developer 2.3 Update 1 provides the following enhancements in the integration of Micro Focus
COBOL with the Eclipse IDE:

Editors:

• COBOL editor:

• You can now specify the increment for the COBOL and the standard line numbering from Window >
Preferences > Micro Focus > COBOL > Editor > Line numbering.

• You can now toggle single or multiple lines between commented and uncommented states.
• JCL editor - the Unnumber and Renumber commands are now supported for the JCL editor. You can

specify the line number increments from the IDE preferences in Window > Preferences > Micro Focus
> JCL > Editor > Line numbering.

• PL/I editor:

• The Unnumber and Renumber commands are now supported for the PL/I editor. You can specify the
line number increments from the IDE preferences in Window > Preferences > Micro Focus > PL/I
> Editor > Line numbering.

• You can now toggle single or multiple lines between commented and uncommented states.

Building applications:

• Environment variables - a new page, Build Environment, in the project's properties enables you to
specify environment variables for your applications. You can also specify environment variables that only
apply at run time on the run or debug configuration for the application.

Application Server JCA support for Enterprise Server

This release provides support for:

• Automatic connection recovery to an active Java application server when an enterprise server region is
restarted. This applies to:

• COBOL resource adapters
• CICS resource adapters
• All CICS API based programs

• The IBM implementation of CICS resource adapter for WebSphere 8.5 and JBoss 7.1.1.

Application Workflow Manager (AWM)

Enterprise Developer 2.3 Update 1 provides enhancements in the following areas:

New features and enhancements are available in the following areas:

• AWM modelling:

• It is now possible to associate keyboard shortcuts with modeled actions. The key sequence is
displayed in the corresponding context menu at run time.
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Currently, it is not possible to persistently overwrite any modelled key bindings with user key
bindings.

• Support is provided for table row updates in modeled AWM dialogs - it is now possible to use table
row actions in in the modeled AWM dialogs to modify table rows similarly to how this is done in the
Team Developer Tree or in the Table views. The supported modifications are copy, delete, insert and
update of selected rows.

• It is now possible to hide element properties in an AWM element's property view using the "Element
Type has Property" condition.

• The "Get Children" attribute of an element type has been replaced by the "Element Type has Get
Children Action" relationship between an element type and an action descriptor which enables you to
check whether an AWM container element can be expanded.

• Full support and a seamless integration is now available in the IDE for the AWM SCM models for
ChangeMan, Endevor and SCLM. You can now check out sources from the SCM system directly into
your COBOL or PL/I projects in the IDE and vice versa.

• AWM Run-Time:

• A single port for server connection - starting with this release you now only need to specify one port,
the Mainframe Access (MFA) server port, for the Micro Focus z/Server connection type in the
Remote System view. All other required ports are configured centrally in the server configuration on
the mainframe. You must install the latest version of z/Server.

It is still possible to connect to an earlier supported version of z/Server. There is a backward
compatibility flag that must be enabled to be able to specify the three ports that are required with the
earlier z/Server version.

• SSL support - it is now possible to specify a SSL/TLS configuration when defining a new Micro
Focus z/Server connection in the Remote System view. The client then uses the configured
SSL/TLS certificates for the communication with the server. The mainframe must support SSL/TLS
tunneling (such as AT-TLS from IBM).

• RACF passticket support - AWM clients now include an extension point which you can use to provide
user credentials from an external application. When connecting to a Micro Focus mainframe server
system (either MFA or z/Server), the password dialog is then bypassed. This enhancement enables
you to integrate a login mechanism that uses RACF passtickets instead of RACF passwords.

• Support for binary download and upload of files - it is now possible to specify a Transfer Mode (either
text or binary) in the file mapping dialog of the File Mappings view when transferring files between
the mainframe and the local machine such as when editing files or during a drag and drop operation:

• Text - the configured code pages are respected.
• Binary - no code page translation is applied. You must use binary mode when transferring

mainframe load modules.
• The SVN attachment is now an integrated part of the Enterprise Developer and is installed as part of

the product. This enables you to use the tools from the SVN function package in an AWM model. For
example, you can extend an existing model by adding the check-in and check-out functions for
sources in an SVN repository. A sample model that includes a full integration of SVN support in the
Enterprise Development Project model is available.

• A new AWM "MVS Projects Sample Application" is available with the installation of z/Server. The
application uses the tools from the MVS and ISPF function package and is designed as a template
AWM application for project-based access to MVS data.

• The AWM Enterprise Development Projects Application now provides the following enhancements:

• Web Services support for COBOL applications in the Team Developer perspective.
• Context menu commands for performing code analysis on demand of the sources in your projects

from the Team Developer Tree and Table views.
• An Open in context action for COBOL copybooks in the Team Developer Tree and Table views.
• An Import and Export are wizards from the context menus of the Team Developer Tree and Table

views.
• Error markers in the Team Developer Tree and Table view on project, folder and file level when the

sources compile with errors.
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• A "Link with Editor" function in the Team Developer Tree view for such files that you viewed when you
expanded the tree view.

• Support for using filters (using Customize View > Filters) in the Team Developer Tree and Table
views to specify what entries should be displayed.

• An improved support for drag and drop between the Team Developer Tree and Table view and the
standard Eclipse views (such as Project Explorer and the Navigator view), the Remote Systems view
(from the local and the Micro Focus z/Server connections), and Microsoft's Windows Explorer.

• The product help now includes a new section, AWM API Programming and Extension Points, that
describes the published AWM API classes and interfaces and the extension points provided by the
AWM client. Use cases for the usage of the AWM API and extension points and a detailed tutorial
showing how to extend the main AWM extension point, com.microfocus.awm.model.extension, are also
available.

CICS Web services (Technology Preview)

Note: This was introduced as a technology preview feature only. It is being made available to allow
you to test and provide feedback on this new capability; however, this feature is not intended for
production use and it is not supported as such.

This release provided an initial support for CICS Web services (CWS) using an SOAP-based provider and
requester modes and using HTTP or MQ as the transport mechanism. CICS Web services support the
Coded Character Set Identifier (CCSID) and configuring the CCSID is a prerequisite for CWS in all
environments.

Restriction: Security and Web Service Atomic Transactions (WSAT) are not currently supported.

Code Analysis

This release provides support for performing code analysis at the command line using Ant which enables
the integration of code analysis in CI frameworks. Features include:

• Support for performing code analysis at the command line using the project's .cobolBuild Ant script
and specifying a target.

• New Ant targets for code analysis - analyze and build.and.analyze. These enable you to only run
analysis and produce analysis data or to build and produce build artifacts as well as analysis data.

• New Micro Focus Ant task, analysis, for the .cobolBuild file. A parameter for this task enables you
to specify whether the build fails or continues when code analysis results are received.

• New parameters for code analysis for the cobol Ant task - analysisData, analysisDataDir.
• New Ant type, ruleList, for the .cobolBuild file - enables you to specify the rules to execute.
• Support for running analysis using a custom .cobolBuild file from outside of the project directory or

the workspace.

See the Micro Focus Ant User Manual for more details on the new task, types and parameters.

Code coverage

The code coverage reports are now integrated with the IDE and with the editor. Features include:

• A new Code Coverage view (Eclipse) showing the statistics of what percentage of the code has
executed.

• Navigation from the Code Coverage view (Eclipse) to the missed and covered blocks in the editor.
• Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).

Compiler directives

The following Compiler directives are new in this release:
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• ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.

This directive is now available for JVM COBOL.
• OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in

your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it

Database Access - HCO for SQL Server

This release provides the following new features:

• End-to-end demonstrations that show several methods for submitting a JCL batch job that calls COBOL
stored procedures. To view these demos, see the SQL demonstrations in the Mainframe Samples
browser.

• The SPCALLLOCAL SQL compiler directive option, used to convert an EXEC SQL CALL into a call to a
local COBOL subroutine instead of a call to a SQL Server SQLCLR stored procedure.

• Extended support for conversion of the DB2 CONCAT function.

Database Access - Mainframe Batch Database Tools (MBDT)

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such.

This release provides MBDT support for DB2 LUW partitioned tables.

It also provides support for 32-bit MBDT for use with DB2 LUW on the following platforms:

• IBM System p running AIX
• x86-64 running SUSE Linux
• x86-64 running Red Hat Linux

Database Access - SQL Option for DB2

This release provides the following new features:

• Import/export of XML with SQLWizard/DSNUTILB(XUTLB)
• New XDBSetup utility for TS/Citrix environments
• Using Migrate to move XML tables from z/OS DB2 to XDB
• Support for Temporal Tables

Data File Tools

This release provided improved security and increased support for more file types. Features include:

• Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

• When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

• Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data

Editor writing assistance

Enterprise Developer 2.3 Update 1 provides the following enhancements:
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• Colorization of conditional compilation regions - by default, inactive code is now colored the same as
Compiler directive elements. Inactive code is defined as code within conditional blocks that do not
evaluate with the applied Compiler settings.

• $REGION statement - support is provided for the $REGION Compiler-control statement. You can use
$REGION - $END-REGION to surround blocks of code that you want to fold or expand in the editor.

• AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version. This
feature is enabled by default and can be configured from a new preference page in Window >
Preferences > Micro Focus > COBOL > Editor > AutoCorrect.

Enterprise COBOL 5.2

With the introduction of Enterprise COBOL 5.2, the following features were supported:

• The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.

• Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.

• The SUPPRESS clause of the XML GENERATE statement has been enhanced.
• The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

File Handling

• A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

• Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

Library routines

The following library routine were new at this release:

• CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
• CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.

Managed COBOL syntax

The following enhancements have been made to the managed COBOL syntax:

• A new command line utility, mfjarprogmap, is available to allow you to create the necessary Java
property file when calling COBOL programs that have been compiled as part of a package.

• You can now create generic iterators.
• You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed

COBOL applications.

Native COBOL Syntax

The following items are new features of the native COBOL syntax:

Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.
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PL/I support

Enterprise Developer 2.3 Update 1 provides the following enhancements:

• FIXED BIN(63) data type - PL/I programs that utilize FIXED BIN data types that are larger than FIXED
BIN(31) are now supported which enables you to migrate such programs more easily to distributed
platforms.

• TRIM() built-in functions - the Open PL/I macro preprocessor now supports the TRIM() built-in function.
• A 64-bit Open PL/I peephole optimizer - when compiling 64-bit Open PL/I programs optimization for

speed, a peephole optimizer is now run against the intermediate code to improve your applications'
performance. Any code which has attributes that benefit from peephole optimizations will then run
faster.

Rosetta Stone for COBOL, .NET and Java Developers

The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.

SourceConnect

It is now possible to use SourceConnect to link to mainframe locations and to define mainframe datasets
and members. The datasets and members then appear in your project's directory structure within the IDE.

z/Server

The z/Server Configuration Utility is now installed as part of Enterprise Server and is not a Technology
Preview download. The user interface has been streamlined for the creation of a default working
configuration.

What was New in Enterprise Developer 2.3
Enterprise Developer 2.3 provided enhancements in the following areas:

• Integration with the Eclipse IDE
• General IDE enhancements
• Building JVM COBOL Projects Incrementally
• COBOL Editor in Eclipse
• Code analysis
• Code coverage
• Command Line Compilation and Linkage
• Compiler directives
• Data File Structure command line utility
• Data File Tools (Technology Preview)
• Database access
• File locking
• File handling
• Library routines
• Managed COBOL syntax
• Micro Focus Unit Testing Framework
• Preprocessors
• Profiler
• Remote Connections
• REST service interfaces
• RM/COBOL Compatibility
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• Single file support
• Tunables
• Updated run-time system

Integration with the Eclipse IDE

This release shipped with Eclipse version 4.4.2.

Support for Eclipse versions 3.7 and 3.8 has been deprecated. This affects any applications that were
created using an earlier version of Enterprise Developer that have a JVM COBOL part. Such applications
must be rebuilt using Enterprise Developer 2.3 to avoid receiving errors during compilation or execution.

In addition, when Enterprise Developer is installed, you can optionally install the Enterprise Developer
plugin in other instances of Eclipse installed on your machine (supported versions of Eclipse are 4.2, 4.3
and 4.4 for the 32-bit IDE).

General IDE enhancements

In Eclipse:

• The Variables view now shows the file status of an internal file name.
• The Find All References and Go To Definition commands are now supported for JVM COBOL

applications.
• Support is provided for the SOCKS5 proxy server for debugger communication over SSL.

Building JVM COBOL Projects Incrementally

To minimize the number of modules to compile when building JVM COBOL projects, Enterprise Developer
now enables you to configure your projects so that they are built incrementally - the IDE only rebuilds the
files that have changed.

To enable incremental builds for JVM COBOL applications that contain namespaces, check the Use
incremental build (Technical preview feature) option on the project build configuration tab in the
project's properties.

For JVM COBOL applications that do not contain namespaces, you can use the Use dynamic calls option
available on the build configuration tab in the project's properties. When the project is built with this setting,
calls to modules are resolved at run time rather than during compilation. This has the effect of not requiring
every module to be compiled when rebuilding the application.

COBOL Editor in Eclipse

Content Assist support for COBOL includes various enhancements and is now also available in JVM
COBOL:

• Context sensitive proposal - Content Assist only shows proposal that are relevant for the position of the
cursor in the code or for the type of project

• Enhanced proposal lists - lists include any relevant COBOL verbs, clauses and words, copybooks, code
templates, data items and section and paragraph names

• Intelligent assistance with completing statements - when you have entered a COBOL verb, Content
Assist shows proposals for the relevant clauses and identifiers that you can use to complete the
statement.

• Automatic completion for items - Content Assist automatically inserts single suggestions in the code.
• Qualifying non-unique names - Content Assist qualifies data items whose names are not unique.
• Configuration preferences for Content Assist - enable you to configure what suggestions appear in the

completion lists, whether suggestions are added in insert or overwrite mode, and the case of the
inserted words.

• Code templates - code templates are now included in the Content Assist proposals.

Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse | 95



Code analysis

Enterprise Developer now offers more advanced code analysis features and enables you to run various
analysis queries (rules and groups of rules called rule sets) against your code to ensure adherence to
standards such as standards for coding or performance.

You can run analysis rules against programs in a project in the IDE at user request or you can run analysis
rules at the end of a project's build.

Code coverage

Enterprise Developer now provides support for code coverage of native COBOL applications directly from
within the IDE where code coverage uses the Test Coverage functionality. You can produce code coverage
reports for applications running in the COBOL run-time and for applications that run in Enterprise Server.

To produce reports, you need to enable code coverage in a project's, a build configuration's, or a file's
properties, compile your application and then run your application with code coverage to produce the
relevant reports. For applications that require an Enterprise Server instance, you start the enterprise server
with code coverage.

Command Line Compilation and Linkage

When using the cbllink command to compile and link, there is a new -y option. Use this option to create
an executable that includes support to be able to run on Windows XP and Windows Server 2003.

Compiler directives

The following Compiler directives are new in this release:

EOF-1A Treats a 0x1a character in the source file as the end of file.

JVMDECIMAL Determines the type in which certain items are exposed. This directive affects
COBOL data items of type 'decimal' and non-integral numeric items exposed as a
result of either ILSMARTLINKAGE usage or the PROPERTY keyword.

NLS-CURRENCY-
LENGTH

Specifies the number of bytes to allocate for the currency symbol in a PIC field.

NULL-ESCAPE Treats a 0x00 character in the source file as an escape character for other non-
printable characters in the source code.

The following Compiler directives contain new parameters in this release:

DBSPACE The new parameter "MIXED" extends the DBSPACE directive to be able to evaluate data
items in programs that contain a mix of single-byte and double-byte strings.

Data File Structure command line utility

The Data File Structure Command Line (DFSTRCL) utility is a DOS-based command line utility that
enables you to create record layout (.str) files from COBOL debug information (.idy) files. You can use
the utility to process a single .idy file or batch process up to 100 .idy files.

Data File Tools (Technology Preview)

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will be
delivered at a GA level and if it is, then the functionality provided might differ considerably from this
technology preview.

The Data File Tools (Technology Preview) is a new standalone text editor in which you can create and edit
data files. By nature of it being a 'technology preview' product, it does not currently include all the
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functionality that was available in the previous version of Data File Tools - now referred to as Classic Data
File Tools. If you require any of the functionality not provided in this version, you can still use the classic
version by accessing it in the usual way.

To run Data File Tools (Technology Preview), type mfdatatools2 from Enterprise Developer's command
prompt (Windows) or a terminal (UNIX).

To use the new editor directly from the Eclipse IDE, use the Open with option on the shortcut menu when
selecting a data file or structure file, and select Data File Tools. Eclipse remembers the last tool used for a
particular file type, and so will use Data File Tools (Technology Preview) until you select a different editor.

Database Access

Enterprise Developer version 2.3 provides the following enhancements to database access:

COBSQL Enterprise Developer version 2.3 provides:

• Selection and configuration of the Oracle Pro*COBOL preprocessor for compiling
COBSQL applications in project properties on the SQL Preprocessor tab and in the
build configuration settings.

• Support for COBOL directives SOURCEFORMAT=TERMINAL and
SOURCEFORMAT=VARIABLE for Pro*COBOL applications.

HCO for DB2
LUW

Enterprise Developer version 2.3 provides:

• GUI versions of data migration tooling (Windows platforms)
• A new tool that enables you to bind or rebind all packages. See BindAll Packages Tool

for details.
• Support for MFHCO mode across all platforms by default via the new HCO "NOHCO"

DB2 compiler directive option. See the HCO DB2 compiler directive option topic for
details.

• A new DB2 compiler directive option, OPTPER "NOOPTPER", that enhances
performance for CHARSET EBCDIC processing. See the OPTPER DB2 compiler
directive option topic for details.

• A new DB2 directive option, BINDDIR, which specifies an alternative directory in which
to write the DBRM file created during compilation. You can set BINDDIR from the
command line or specify it in your project properties. See the BINDDIR DB2 compiler
directive option topic, and the Binding topic for details.

• 64-bit support for PL/I on appropriate platforms. See Additional Software
Requirements on Windows and Additional Software Requirements on UNIX for details.

HCO for SQL
Server

Enterprise Developer version 2.3 provides:

• Support for the DATA-CHANGE-TABLE-REFERENCE clause.
• Context Help is now provided for:

• Options for HCO for SQL Server tools
• For each tool in the HCO for SQL Server user interface

OpenESQL Date/Time
Processing

This release provides streamlined datetime processing for ODBC and
JDBC.

OpenESQL
Assistant

OpenESQL Assistant Options are now set via the Eclipse IDE from
Window > Preferences > Micro Focus > Database > OpenESQL
Assistant (applies to Windows environments only).

Performance This release includes a new SQL compiler directive option, OPTPER
"NOOPTPER", that enhances performance for CHARSET EBCDIC
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processing. See the OPTPER SQL compiler directive option topic for
details.

PL/I This version provides 64-bit support for PL/I on appropriate platforms.
See Additional Software Requirements for details.

PostgreSQL In this release, PostgreSQL 9.4 has been tested with OpenESQL and
OpenESQL Assistant with the following PostgreSQL software:

Server software PostgreSQL EnterpriseDB version 9.4.1-3

Client software • psqlODBC driver version 09.03.04.00
• JDBC41 PostgreSQL driver version

9.4-1201

PostgreSQL 9.4 has been tested with OpenESQL and OpenESQL
Assistant on the following Windows platforms:

• Windows 32-bit
• Windows 64-bit

PostgreSQL 9.4 has been tested with OpenESQL on the following
UNIX platforms:

• X86-64 running Red Hat Linux, 32- and 64-bit
• X86-64 running SuSE Linux, 32- and 64-bit

Note: Micro Focus provides compatibility for PostgreSQL but
does not directly contribute to or support the PostgreSQL
open source project. Any issues relating to PostgreSQL
functionality should be addressed through an open source
support vendor.

SQL Server Enterprise Developer version 2.3 provides support for the SQL Server
OUTPUT clause.

Mainframe
Batch
Database
Tools
(MBDT)

Windows only. Enterprise Developer version 2.3 includes mainframe batch utilities that
provide the following functionality for Oracle, DB2 LUW, and SQL Server agnostically, as
well as specifically for HCO for SQL Server:

• DSNTEP2
• DSNUTILB LOAD
• DSNUTILB UNLOAD
• 32-bit and 64-bit support
• New batch configuration utility

SQL Option
for DB2

Enterprise Developer version 2.3 provides the following z/OS DB2 version 10
enhancements:

• Extended support for implicit casting
• Greater timestamp precision for applications
• Support for TIMESTAMP WITH TIME ZONE

This release provides initial XML support for the XDB engine.

XA Switch
Modules

In this release, the XA interface has been redesigned to provide:

• Consistent look and feel for SQL Server, DB2, and Oracle user personalization
• Consistent look and feel for both RM dynamic and static registration (SQL Server,

DB2, Oracle, generic one-phase commit)
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• Additional support for two instances of the same switch module using Web Services
applications via the new XAID compiler directive

• Using a specified XA resource only with batch applications executing under Enterprise
Server

File handling

This release contains the following new configuration options:

ACUFH Enables or disables the use of the ACU file handler (ACUFH), which is required to handle
Vision and RM/COBOL indexed files.

ESACUFH Enables or disables the use of the ACU file handler (ACUFH) for file handling operations
running under Enterprise Server. ACUFH must also be enabled for this option to take effect.

File Locking

In versions prior to Enterprise Developer 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX and
Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the tunable
strict_file_locking=true is set, which is the default setting.

Example of potential changes in behavior:

• Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

• Process-B then attempts to open the file with read-only access and a sharing mode that denies other
processes read access (SHARING WITH NO OTHER).

With strict_file_locking=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

With strict_file_locking=false, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result of
the new file locking behavior. In such circumstances, we recommend that you review the file locking and
sharing requirements of your application and refactor your source code to work with the default setting. The
original file locking and sharing behavior can be restored by setting strict_file_locking=false.

Library routines

The following library routines are new in this release:

CBL_MANAGED_SESSION_GET_USERDATA Retrieves user data saved in the current RunUnit.

CBL_MANAGED_SESSION_SET_USERDATA Sets user data in the current RunUnit.

The following library routines contain new parameters in this release:

CBL_LOCATE_FILE You can now specify a file name that is a null-terminating string, which has resulted
in three new values available for the user-mode parameter.

Managed COBOL syntax

The following enhancements have been made to the managed COBOL syntax:

• The TYPE OF type-name[ANY...] syntax enables you to obtain the System.Type (.NET) or
java.lang.Class (JVM) object for a generic class, interface, or delegate.

• The self:: or super:: syntax is no longer required to access inherited data within a subclass.
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• The ATTRIBUTE-ID syntax enables you to define new attribute types, which can be used in various
contexts.

Micro Focus Unit Testing Framework

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability, but it is not intended for production use and is not supported
as such. Furthermore, Micro Focus does not guarantee that this feature will be delivered at a GA level
and if it is, then the functionality provided might differ considerably from this technology preview.
During the preview, you are encouraged to share your feedback and experiences via the Micro Focus
community forum - https://community.microfocus.com/t5/Enterprise-Developer-User/bd-p/forumid-9).

The Micro Focus Unit Testing Framework is an xUnit style testing framework, available from the command
line, for procedural COBOL applications.

It includes much of the architecture you would expect in an xUnit framework. The test runner is a 32- or 64-
bit executable that you run from an Enterprise Developer command or shell prompt. A test fixture or suite is
a COBOL program compiled to .dll (Windows) or .so (UNIX) that can include the setup, the test case
code, and the teardown associated with the test case.

Test results are available in a number of formats. By default, results are displayed to screen and to a .txt
file, but you can use additional parameters on the command line to produce reports in JUnit format.

Preprocessors

Support has been added in the IDE for enabling and using multiple preprocessors with your projects.

A new page, Additional Preprocessors, has been added to the project's and the files' properties of native
COBOL applications to enable you to choose one or more preprocessors to use when building your
application and to specify their order of execution.

New reporting capability is now available for user preprocessors: resp-main code 18 indicates that a buffer
contains a data name to be marked as modified by the immediately preceding preprocessed line. The data
name may be qualified and resp-more contains the column information for the reference.

Profiler

Enterprise Developer now provides support for Profiler for native COBOL applications directly from within
the IDE. To produce reports, you need to:

1. Enable Profiler in the COBOL property page for a project, a build configuration, or a file.
2. Compile your application to apply the changes.
3. Create a run configuration that has Profiler enabled.
4. Run your application with Profiler to produce the relevant reports.

Remote Connections

This release provided the following enhancements:

• An improved diagnostic tooling to help determine connection problems - enhancements are available for
both the client and the server installations.

• It is now possible to specify the Remote System Explorer (RSE) type of connections to create remote
mainframe COBOL and PL/I projects. This is to cater for scenarios when it is not possible to use
SAMBA or NFS connections within your environment.

Note: The following features and utilities are not supported when remote projects use the RSE
connection type:

• The file layout editor and the file editor in the Classic Data File Tools and Data File Tools
(Technology Preview) utilities.
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• The BMS compiler and painter.
• The IMS layout editor and the IMS database editor.
• Mainframe Assembler.

• Changing the type of a remote connection - it is now possible to change the type of the remote
connection from RSE to NFS and vice versa using the Remote Settings for remote projects.

REST service interfaces

RESTful service interfaces utilizing JSON as the media type in request and response messages are now
supported using the Interface Mapping Toolkit. This enables you to extend COBOL applications using
modern transport payloads and protocols.

RM/COBOL Compatibility

This release includes improved support for RM dialect applications. Please consult with Micro Focus before
considering a transition from RM/COBOL to Enterprise Developer.

Single file support

The recommended way to work with files within Enterprise Developer is to include them in a project. For
situations where you might want to quickly open edit a single file, Enterprise Developer now provides
support for native COBOL files in the IDE when the file is not opened as part of a project. There is limited
support for the IDE editing, compiling and debugging features as full support requires a project file.

Tunables

Enterprise Developer version 2.3 contains the following new tunables:

putenv_interface Provides backward compatibility for UNIX systems in which the operating system's
putenv() function is required when setting environment variables.

strict_file_locking Enables a new, more reliable method of file locking for UNIX systems. See File
Locking for more information.

Enterprise Developer version 2.3 contains the following updates to tunables:

default_cancel_mode A new parameter, and default, has been introduced for this tunable; see
default_cancel_mode for more information.

subsystem_cancel_mode A new parameter has been introduced for this tunable; see
subsystem_cancel_mode for more information.

Updated run-time system

Enterprise Server has been updated to provide an execution environment capable of running applications
that were each built using different development products. A consequence of this is that If your application
has a main COBOL executable (.exe) that was built with a previous version of Enterprise Developer, you
should ensure that the executable is rebuilt and packaged with the new run-time system. This does not
affect mainframe subsystem projects deployed to Enterprise Developer. You can rebuild from the IDE or
the command line.

Other COBOL subprograms built with previous versions of Enterprise Developer are not required to be
rebuilt.

What was New in Enterprise Developer 2.2 Update 2
Enterprise Developer 2.2 Update 2 provided enhancements in the following areas:

• Eclipse
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• Character Set Enhancements
• Code Analysis
• AppMaster Builder
• Database Access
• Enterprise COBOL 5.1 compatibility
• External Call Interface (ECI)
• Micro Focus COBOL enhancements
• External Security Facility (ESF)
• Enterprise Server MQ-IMS Bridge
• IMS Connect
• PL/I General Enhancements
• PL/I Editor Enhancements
• RUMBA 9.2
• Transaction Classes (Technology Preview)
• Tunables

Eclipse

Enterprise Developer 2.2 Update 2 provides the following new functionality and improvements:

• Support for Eclipse 4.2 and 4.3 - Enterprise Developer 2.2 Update 2 ships with Eclipse 3.8 but also
supports Eclipse 4.2 and 4.3 (the 32-bit IDE only). To use Enterprise Developer with a newer version of
Eclipse, you need to install Enterprise Developer first and then use the
installeclipseplugins.bat script in %ProgramFiles(x86)%\Micro Focus\Enterprise
Developer\installer (UNIX). See Installing into other instances of Eclipse for more details.

• Remote JVM COBOL projects - this release provides enhanced support for remote JVM COBOL
projects.

• Remote project connections - the diagnosis tool for remote connection issues has been improved.
There is now a client-side diagnosis tool and a server-side diagnosis tool for diagnosing connection
problems to remote projects and connections to your Micro Focus Enterprise Developer UNIX
Components. You should run both tools for a complete diagnosis.

Character Set Enhancements

The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

• Thai Extended (0066) - new
• Korean (0082)
• Simplified Chinese (0086)
• Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and
double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Code Analysis

Enterprise Developer version 2.2 Update 2 provides Dead Code analysis for COBOL programs that
enables you to find unreferenced items or any piece of code that can't be reached .

AppMaster Builder

The AppMaster Builder Database View and maintenance support (known as Data Views) is now provided
within the Eclipse framework for Enterprise Developer, rather than relying on invoking the AMB database
view interface that was part of Mainframe Express Enterprise Edition. You must install the AMB Eclipse
plug-in to be able to use this feature.
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Data Views enable you to create and maintain database views, as well as add and compile PSB and DBD
sources in a COBOL project, all while working within the Eclipse framework.

Database Access

The following new features are available in database access support:

COBSQL In Eclipse, the new KEEPCOMP directive resolves COMP/COMP-5 issues with Oracle
applications on little-endian platforms.

HCO for DB2
LUW

Enterprise Developer version 2.2 Update 2 introduces GEN-HV-FROM-GROUP - a new
DB2 ECM compiler directive option, that generates host variables for all elementary data
items when a multiple-level group variable is used in a FETCH or singleton SELECT
DB2 statement.

HCO for SQL
Server
(HCOSS)

Enterprise Developer 2.2 Update 2 provides the following new HCOSS features:

• DATE/TIME formatting - the OpenESQL Configuration Utility now supports DATE/
TIME formatting for HCOSS batch utilities.

• Multi-row INSERT - supports a multi-row INSERT statement.

OpenESQL This version provides the following new OpenESQL features:

• Support for SQL Server 2014.
• New SQL Compiler directive options:

• DETECTDATE=SERVER - resolves host variables alignment with column data
types in an SQL table.

• GEN-HV-FROM-GROUP - generates host variables for all elementary data items
when a multiple-level group variable is used in a FETCH or singleton SELECT
SQL statement.

• Sample applications - the following native COBOL SQL sample applications are new
with this version:

• Get Diagnostics - demonstrates how to use GET DIAGNOSTICS EXEC SQL calls
to get diagnostic information from various DBMSs.

• LOB Data Types - Demonstrates how to INSERT and SELECT LOB data in a
native application using various DBMSs.

SQL Option
for DB2

Support for the following has been added in this version:

• DSNUTILB LOAD LOG=NO option
• RID scalar function
• XML data type via XDB Link to mainframe DB2

XA switch
modules

The following XA switch module updates are available in this version:

• Oracle switch module - Windows and UNIX platforms :

• Supports User Impersonation when statically registered.
• Enables you to specify which XA resource definitions use User Impersonation.
• Now compiled with one source file, rather than two.

• SQL Server switch module - Windows platforms only:

• Enables you to specify which XA resource definitions use User Impersonation.
• Now compiled with one source file, rather than two.

Enterprise COBOL 5.1 compatibility

There have been a number of enhancements to make this version of Enterprise Developer more
compatible with Enterprise COBOL 5.1.
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Note: These enhancements are available under both DIALECT(MF) and DIALECT(ENTCOBOL).

• The following phrases have been added to the XML GENERATE statement:

• NAME
• SUPPRESS
• TYPE

• The following intrinsic functions have been added:

• ULENGTH
• UPOS
• USUBSTR
• USUPPLEMENTARY
• UVALID
• UWIDTH

• A number of reserved and context-sensitive reserved words have been added; see the topics Reserved
Words Table and Context-sensitive Words Table for complete lists.

External Call Interface (ECI)

Enhancements to the ECI include:

• The ECI for Java clients is no longer restricted to the 32K Commarea. You can now transfer virtually
unlimited containers of any size in a channel to a CICS server program. See ECI Java Interface for
more information.

• Java support for IBM's implementation of ECI, which, in turn, uses the Micro Focus implementation.
• A ECI RA for WebSphere; however, in this release, no IMTK tooling is provided for servlets or JSP.

Micro Focus COBOL enhancements

The following enhancements have been made to Micro Focus COBOL:

• The following phrases have been added to the XML GENERATE statement:

• NAME
• TYPE
• SUPPRESS

• The following intrinsic functions have been added:

• ULENGTH
• UPOS
• USUBSTR
• USUPPLEMENTARY
• UVALID
• UWIDTH

External Security Facility (ESF)

The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.
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Enterprise Server MQ-IMS Bridge

At Enterprise Developer 2.2 Update 2 the Enterprise Server MQ-IMS Bridge was supported at GA level. It
had previously (from Enterprise Developer 2.2 Update 1) been available as a Technology Preview item
only.

IMS Connect

Visual COBOL 2.2 Update 2 now supports Java IMS Connect messages except when also using the IBM-
supplied HWSJAVA0 I/O exit, excluding customizations to that exit.

PL/I General Enhancements

Enhancements are provided in the following areas:

• Attributes - the PL/I DECLARE statement now supports the OPTIONAL attribute as part of the
parameter-descriptor list or as an attribute in a parameter declaration. This provides an improved
functionality and a greater language compatibility for customers looking to migrate applications from
z/OS environments.

• Built-in functions - the PL/I Compiler and run-time system now support the PRESENT and OMITTED
built-in functions which provides an improved functionality and a greater language compatibility if you
are looking to migrate applications from z/OS environments.

• CodeWatch - this release includes the following enhancements:

• CodeWatch is now supported in native 64-bit environments which ensures that the CodeWatch
debugger runs properly in native 64-bit mode. This enables the PL/I debugger to take advantage of
faster speeds and to debug larger programs which have access to larger amounts of storage.

• Notifications for the CodeWatch conditions - you can use the command line and the UI to turn
notifications on or off for all of the currently documented PL/I conditions. The use of notifications
enables you to investigate the state of programs and optionally set breakpoints before continuing
program execution.

• Compound operators - the PL/I macro preprocessor now supports the compound operators += , -=, *=,
and /= within macro assignment statements.

• Error handling - you can now use the EXEC CICS HANDLE ABEND check which provides a consistent
error handling technique for PL/I programs running under CICS that is consistent with error handling on
the mainframe. EXEC CICS HANDLE ABEND determines error handling for programs running under
CICS. Conditions detected by CICS cause an abend if established using EXEC CICS HANDLE ABEND,
and PL/I ON units do not get control. If EXEC CICS HANDLE ABEND is not established, CICS defines
that the action taken will be as defined by CICS, which normally leads to a transaction abend.

• PL/I data structures - this release provides enhanced support for PL/I data structures in the Data File
Tools. You can now easily generate a PL/I structure map (.str) from within the IDE, and the Data File
Tools can then use to generate a formatted layout for a PL/I data file. This enables you to see what is in
each field within a PL/I Data File Record, and to modify the records in a logical way without having to
know the offset, length and raw format of the data item.

PL/I Editor Enhancements

Enterprise Developer2.2 Update 2 provides a new and improved PL/I editor within Eclipse. Features
include:

• Configurable background syntax parsing.
• Syntax error reporting - uses red squiggles to denote errors in the code.
• Configuration settings for the editor - you can hide or show the horizontal ruler, turn on or off visible

lines for the margins (at columns 2 and 72 for Mainframe Subsystem projects, and only at column 72 for
native projects), and configure the syntax coloring and the smart edit mode.

• Smart edit mode - defines the word wrapping behavior when breaking lines or around margins, moving
the cursor using the Home and End keys.
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• Folding - support for collapsing and expanding regions for procedures and blocks within procedures.
• Content Assist - provides assistance with inserting PL/I keywords, variables and syntax templates.
• Syntax templates for the most commonly used PL/I statements.
• Block selection - use the button from the toolbar to toggle the mode.
• Breadcrumbs navigation - enables you to quickly navigate between source programs and the dependent

include files.
• Outline view - shows a structure of the procedure and structure declarations within a program. Clicking

on an item in the Outline view positions the cursor on that item in the code and vice versa.
• Include Dependency View - shows where in the source file's structure the INCLUDE statements appear,

and which include files they reference.
• Opening include files directly from the editor using F3.
• Task creation - inserting a TODO or a FIXME in a comment in the code automatically creates a task that

appears in the Task view.

Rumba 9.2

Visual COBOL 2.2 Update 2 of Enterprise Developer includes Micro Focus Rumba 9.2 which you can
optionally install as part of the setup process. The license for Enterprise Developer will license all
components of Rumba.

Transaction Classes (Technology Preview)

Transaction classes provide a mechanism to limit the number of CICS® tasks in your system. By spreading
your tasks across a number of transaction classes and configuring the maximum number of tasks that can
be dispatched within each transaction class, you can control resource contention between tasks and limit
the number of tasks that CICS considers eligible for dispatching at task attach.

Tunables

Enterprise Developer 2.2 Update 2 includes the following new tunable:

• reduce_java_signals - specifies the options that are passed to a JVM when mixing Java and COBOL.

What was New in Enterprise Developer 2.2 Update 1
Enterprise Developer 2.2 Update 1 provided enhancements in the following areas:

• Micro Focus Heartbleed Update
• ACUCOBOL-GT Compatibility
• AppMaster Builder
• Assembler Support
• Btrieve Support
• COBOL Source Information
• Compare and Synchronization Monitor
• Compiler Directives
• Database Access
• Eclipse IDE
• Enterprise Server Integration in the IDE
• Enterprise Server MQ-IMS Bridge (Technology Preview)
• Environment Variables
• Fileshare Recovery
• Line Numbering for COBOL Programs
• Local Catalog
• IMTK
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• Working with the Mainframe
• Mainframe Emulation
• Mainframe Subsystem
• Managed COBOL
• Managed COBOL Syntax
• PL/I
• Preprocessors
• Project and Item Templates
• Remote Connection
• Rumba Integration with Eclipse
• Run-time Launch Configuration Files
• Terminfo Files

Micro Focus Heartbleed Update

The OpenSSL library used in this product was updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

ACUCOBOL-GT Compatibility

The following ACUCOBOL-GT support has been added in this release:

-Di compiler option The -Di compiler option, which initializes Working-Storage data items based in their
type, is now supported.

AppMaster Builder

Enterprise Developer 2.2 Update 1 provided updated AppMaster Builder support that integrates more fully
into the Eclipse IDE. In addition, the following enhancements have been added:

• Code generation and compilation in an Eclipse COBOL project
• Enhanced Program Painter
• Enhanced Job Queue

Assembler Support

Enterprise Developer 2.2 Update 1 provided Assembler support from within the IDE. Features include:

• Support for creating Assembler programs (.mlc extension), macro files (.mac or .cpy extenstions) or
Assembler linker files (.lin) from within the IDE.

• Support for building Assembler programs and for linking Assembler linker files from within the IDE. You
can choose to exclude certain files from the build.

• Assembler editors for Assembler and macro files - includes content assist for reserved words and
colorization.

• Support for using Ant for building .asm, .mlc and .cap files and for linking .lin files.
• IDE support for configuring the Assembler compiler and linker options on project, build configuration

and file levels.
• Configuring the macro paths.

Btrieve Support

Support for the Btrieve file handling system from Pervasive Software Inc. has been added into Enterprise
Developer.

Support is restricted to native COBOL, in a Windows environment.
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COBOL Source Information

The Quick Browse option is now available as a context menu command in the editor.

Compare and Synchronization Monitor

Note: This feature is only available in a Windows environment.

With the release of Enterprise Developer 2.2 Update 1, the Compare and Synchronization Monitor has
been updated to version 2.

Version 2 is greatly improved in terms of performance, especially during initial checkout of partitioned data
sets or when synchronizing a large number of members. Also, the user interface has been improved, and
some of the functions available in the old version have now changed or become obsolete.

Compiler Directives

The following Compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY-
TYPE

Initializes Working-Storage Section data items to a default value, according to their type.

• Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized to
spaces.

Note: For an OSVS dialect, numeric edited items are initialized to zeroes.

• Numeric items are initialized to zero.
• Pointer items are initialized to null.
• Index items are initialized to the value 1.

Database Access

The following new features have been added as part of database access support:

HCO for DB2
LUW

• Support added for DB2 LUW version 10.5.
• Enhanced RETURN-CODE processing.
• The HCO DDL processor now accepts column names with a length greater than 18

characters.
• The HCO Import Data tool now processes CLOB data less than 32K in size.
• The HCO Import Data tool can now convert DSNTIAUL import files to delimited

format, enabling the actual import to be done by DB2 LUW IMPORT and LOAD
utilities. This is done using the new SAVEDEL and CHARDEL parameters.

HCO for SQL
Server
(HCOSS)

• Support for the mainframe SET CURRENT SQLID statement.
• Support for the mainframe LEFT and RIGHT scalar functions.
• Data Migration tools now support the mainframe ALIAS and SYNONYM objects.

OpenESQL • Enhanced internationalization support for UNICODE, DBCS and MBCS.
• Enhanced GET DIAGNOSTICS statement support.
• Enhanced LOB support for CLOB, BLOB and DBCLOB data types.
• Enhanced IDE support for OPTION directives.
• Now provides support for the creation of save points and rolling back to save points.
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XA Switch
Modules

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

• New two-phase commit module for SQL Server based on Microsoft's XA switch.
This provides support for xa_recover.

• Support for DB2 LUW version 10.5.
• Support for Oracle version 12.1.

Eclipse IDE

Assigning
memory to
Linkage Section
items

If the debugger steps on a line with an unassigned linkage item (for example, if you
are debugging only a part of your application and no memory has been allocated to
that linkage item), debugging terminates. To assign linkage to that data item and
continue debugging, you need to select the data item, right-click it and click Inspect
COBOL. When prompted, confirm and assign a value to the data item. Alternatively, to
assign linkage, you can right-click the data item in the Variables view and click
Change Value.

Debugging
Windows
Services

It is now possible to debug Windows services. You must be logged on to the console
of the computer running the service and can debug either using just-in-time debugging
and a CBL_DEBUGBREAK call, or using library routines and a "COBOL Wait for
Application Attachment" debug session having added a call to CBL_DEBUGBREAK or
CBL_DEBUG_START to the application.

Indicating that a
file is a
copybook or a
COBOL
program

In COBOL Explorer, you can now use two new file context menu commands to
indicate that a COBOL program is a copybook (Transform Program to Copybook)
and that a copybook is a COBOL program (Transform Copybook to Program). You
may need to use these in situations when you imported existing COBOL source code
in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

Enterprise Server Integration in the IDE

You can now use the context menu for the servers in Server Explorer to enable the display of the
Enterprise Server log information in the Console view.

Enterprise Server MQ-IMS Bridge (Technology Preview)

Note: At Enterprise Developer 2.2 Update 1 this was provided as a technology preview feature only. It
was made available to allow you to test and provide feedback on this new capability; however, this
feature was not intended for production use and was not supported as such.

Enterprise Developer version 2.2 Update 1 provided support that enables WebSphere MQ applications to
communicate with IMS applications in an Enterprise Server region.

Environment Variables

The following environment variable has been added in this release:

strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.
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Fileshare Recovery

Recovery of Fileshare data files has been enhanced.

Rollback recovery is a faster process that aims to fix the files from their failed state.

This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Line Numbering for COBOL Programs

Enterprise Developer version 2.2 Update 1 provided options for auto-inserting or removing line numbers in
source files open the editor. Features include:

• COBOL numbering - line numbers are inserted in the sequence area of the code (columns 1 - 6),
starting by default at 000100 at the first line, incrementing by 100 by default.

Micro Focus recommends that you use COBOL numbering only if your files are in fixed or variable
source format.

• Standard numbering - line numbers are inserted immediately to the right of area B, in columns 73 - 80,
starting by default at 00000100 at the first line, incrementing by 100 by default.

Micro Focus recommends that you use Standard numbering only if your files are in fixed format.

• The Renumber and Unnumber commands available from the context menu in the editor.

Local Catalog

From within Server Explorer in the IDE, you can add one or more local catalogs, and then use them in
conjunction with Drag and Drop to drag down data set items from your mainframe, edit them and then
move them back to the mainframe or to your testing environment.

IMTK

You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

Working with the Mainframe

Enterprise Developer version 2.2 Update 1 includes the “Launch ISPF” functionality as a technical preview.
This feature is supported only under z/OS 1.13.

Mainframe Emulation

Previously, MGMTCLAS was supported by simply saving it on the catalog record when a dataset was
allocated in JCL using the MGMTCLAS parameter on the DD statement. Starting with this release, you can
use batch jobs to define MGMT classes and to specify the EXPIRE AFTER time (in days).

Mainframe Subsystem

New editors Enterprise Developer now provides special editors for REXX, TSO CLIST and Easytrieve
programs. The editors include colorization and content assistance. Syntax checking is not
available.

Managed COBOL

Enterprise Developer now provides support for Java managed beans (MBean) in JVM COBOL code that
enable you to manage and monitor RunUnits, and to identify certain issues such as leaks and long-running
RunUnits.
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• You can enable an MBean only for a particular RunUnit level or for all RunUnits you create.
• You can view and use MBeans from programs such as Oracle's Java Mission Control or JConsole.
• MBeans include the LogicalRunUnitCount and LiveRunUnitCount attributes that enable a visual

indication of how many RunUnits are live. If the values of these two attributes are different, this might
indicate some issues.

Visual COBOL 2.2 Update 1 also includes the following tutorials for JVM COBOL:

Deploying JVM
COBOL to an
Application Server

Using some ready-made sample projects, this tutorial guides you through
implementing your JVM COBOL code into an Enterprise JavaBean (EJB), then
deploying it to a JBoss application server. Instructions are also included on how
to deploy the application to WebSphere and WebLogic application servers.

Managed COBOL Syntax

Enterprise Developer version 2.2 Update 1 includes the following enhancements to the managed COBOL
syntax:

Specifying parameters in
the method signature

You can now specify passing parameters and returning items in the method
signature, instead of using a Procedure Division header. This applies to
methods, indexers, iterators, constructors and delegates.

CONSTANT keyword Use the CONSTANT keyword on a field to protect it from being altered.

Operations on string
fields

You can now use the STRING, UNSTRING and INSPECT statements on
fields of type string.

PL/I

PL/I support within the IDE now includes the following enhancements:

• Support for new built-in functions

The PL/I Compiler and Runtime now support the following new built-in functions:

DAYS
DAYSTODATE
SECSTODATE
SECS
WEEKDAY
DAYSTOSECS
ONSUBCODE
REPATTERN
IAND
IOR
INOT
OMITTED
XMLCHAR

This provides an improved functionality and a greater language compatibility when you migrate
applications from a z/OS environment.

• Support for %OPTION in the PL/I macro preprocessor

You no longer need to modify application code that uses %OPTION in order for it to compile
successfully.

• Support for QUOTE() and COMMENT() built in functions.

This enables the use of PL/I macros that generate code using these built-in functions.
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• Support for IBM Style %INCLUDE(s) that utilize PDS name as part of include file names.

The PL/I macro preprocessor now parses the %INCLUDE syntax of the form shown below and utilizes
the –isuffix and –ipath Compiler directives to locate the “member”.

%INCLUDE MYPDS(MYMEMBER);

This provides an improved language compatibility with the application code without the need to modify
the original underlying source code.

• Support for PL/I AREA data items up to 2Gb.

Open PL/I now supports the declaration and usage of variables of type AREA up to 2Gb in size. This
provides you with improved functionality and greater language compatibility when migrating applications
from a z/OS environment as there is no need to modify the code in order to deal with a maximum area
size of 32Kb.

• Enhanced compatibility with the DISPLAY() REPLY() syntax.

The PL/I Compiler and runtime now provide a DISPLAY() REPLY() syntax that is no longer dependent
upon the use of the SYSIN and SYSOUT DD’s and that no longer causes behavioral differences if
stream IO to SYSIN/SYSOUT is intermingled with programs using DISPLAY() REPLY().

• Support for big-endian style bit strings on little-endian platforms.

Using a new Compiler directive –bitsltr to compile programs that have logic that is dependent on big-
endian bitstring ordering enables you to utilize the code unchanged on Open PL/I little-endian platforms
(such as Windows, Red Hat Linux, SUSE Linux). This enables you to migrate applications that make an
assumption about bit ordering on the underlying operating system or hardware and to run them
unchanged.

• Support for the –initcall Compiler directive.

Compiling a PL/I program with the –initcall directive causes the specified program to be invoked prior to
any user logic. This enables you to customize your environments and do things such as tracking which
routines have been invoked, detect memory corruption prior to routine startup, establish database
connectivity.

• Support for the “F” option in PLIDUMP.

A PLIDUMP which was generated using the “F” option will now attempt to list all known information
about files which have been accessed during the execution of the program and includes information
about the last IO operation, key values, and a dump of buffers, if available. This enables you to identify
more easily the cause of file-related failures and what file operations were in progress at the time of
failure.

• Technology Preview support for PL/I data structures Data File Tools.

In the IDE, you can now generate a PL/I structure map (.str) which can be utilized by the Data File Tools
utility to generate a formatted layout for a PL/I Data File. The PL/I data structure must be compiled in
advance with the -adt Compiler directive. This enables you to see what is in each field within a PL/I data
file record, and to modify them in a logical way without having to know the offset, length and raw format
of the data item.

• Support for PL/I debugger notification for ON Unit invocation.

You can now request that the debugger stops when a PL/I ON Unit is about to be triggered. This
enables you to locate the ON Unit, establish appropriate breakpoints within the ON Unit and determine
the cause of the ON Unit being triggered.

• Support for PL/I debugger notifications for the load of shared libraries and .dll files.

You can now request that the debugger issues a notification when a shared object or a .dll file has been
dynamically loaded. This enables you to stop a program when a dynamic program has been loaded and
to establish the appropriate breakpoints, watch lists, etc.

• Alternative Index Performance Improvements for the CASSPOOL command.
• Support of the SHAREOPTIONS property in a VSAM cluster.
• Support for setting directives automatically for PL/I files.

In Eclipse, click Window > Preferences > Micro Focus > PL/I > Directives Determination.
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• A new page in the project and file properties enables you to set SQL directives on PL/I source files.

Preprocessors

A guide for third-party vendors and administrators showing how to integrate additional preprocessors with
Enterprise Developer is now available in the product help in the General Reference > Integrated
Preprocessor Interface section.

Project and Item Templates

Support is now available for using existing projects and files as custom templates to create new projects
and files. You create and configure projects that include the files and settings you would like to use as
templates.

Remote Connections

Enterprise Developer now provides a new connection type, Micro Focus DevHub using SSH, that uses a
Secure Shell daemon process to launch a server on the remote host.

You can use this type of connection when the UNIX machine you are connecting to uses LDAP
authentication which is not supported by the DevHub daemon.

Using this connection also means you do not need to run the DevHub daemon process with root privileges.
It also gives you greater flexibility in setting environment variables needed for building or debugging on the
remote server.

Rumba Integration with Eclipse

Enterprise Developer 2.2 Update 1 provided enhanced integration with the Micro Focus Rumba application
for running and debugging Mainframe Subsystem applications that require a TN3270 emulator to run. You
can now configure Eclipse to launch a Rumba mainframe display embedded in the IDE or a mainframe
session of Rumba Desktop.

Run-time Launch Configuration Files

Note: This feature is only supported in a Windows environment.

Use a run-time launch configuration file to ensure an application can be launched when it is deployed in a
separate location to the run-time system (in the case of dynamically bound applications), or when the
licensing daemon is not already running.

Terminfo Files

The following terminfo files have been added:

• ansi80x25 - this is based on the old ansi file. A newer version of ansi exists in this release that has no
function key support, which is consistent with ansi terminfo files on various other UNIX platforms. If you
currently use ansi and require function key support, you should instead set the TERM environment
variable to ansi80x25 to continue previous behavior.

• xterm-color and kterm-color - these are now available on all UNIX platforms - previously, they were only
available on Linux.

• aixterm-old (AIX systems only) - this has similar capabilities to the AIX OS terminfo file of the same
name. It differs from the existing aixterm file, because it has no line drawing capability. Line drawing is
only possible with aixterm if it is displayed on an appropriate display (X server).

• vt220-w - this is the wide (132-column) version of the vt220 file, and is based on the vt100-w file. For
more information, see Wide Terminal Mode in the documentation referenced at the bottom of this
section.

There have been a number of additions and fixes to existing terminfo files; refer to the Terminfo Database
and Terminal Devices section of the documentation for full details.
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There have also been a number of terminfo files that have been removed; refer to the Backward
Compatibility section for a complete list.

What was New in Enterprise Developer 2.2
Enterprise Developer 2.2 provided enhancements in the following areas:

• ACUCOBOL-GT Compatibility
• RM/COBOL Compatibility
• Application Configuration
• COBOL Source Information (CSI)
• Compiler Directives
• Consolidated Tracing Facility
• Enhanced Accept and Display Statements
• Debugging
• Grouping Files in Virtual Folders in Solution Explorer
• File Handling
• Interface Mapping Toolkit
• Managed COBOL
• Problems View
• Upgrading from Net Express to Visual COBOL
• XML Extensions

ACUCOBOL-GT Compatibility

The following enhancements are applicable to Enterprise Developer:

• Accessing data files through AcuServer - You can now access your ACUCOBOL-GT data files, both
sequential and Vision files, through AcuServer.

• Standard library routines - Support for the following library routines has been added:

• C$GETPID
• C$JUSTIFY
• C$LIST-DIRECTORY
• C$LOCKPID
• C$REGEXP
• C$RUN
• C$SLEEP
• C$SYSTEM
• C$TOLOWER
• C$TOUPPER
• I$IO

• Using Vision files with Micro Focus Data File Tools - You can now use some of the Data File Tools
functionality with Vision files. You can:

• Convert Vision files to Micro Focus format using the Data File Converter and the DFCONV command
line utility.

• Edit Vision files using the Data File Editor.

Note: For more information about the Data File Tools utility, see Data Tools.

RM/COBOL Compatibility

The following support has been added to Enterprise Developer in this release:
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• Subprograms - Support for the following subprograms (referred to as library routines in Enterprise
Developer) has been added:

• C$OSLockInfo
• C$SecureHash

• recover1 - The recover1 utility, RM/COBOL's indexed file recovery utility, is now distributed with
Enterprise Developer. Refer to the RM/COBOL File Handling section of RM/COBOL Compatibility for
details of its use.

Application Configuration

You can now set environment variables for when you run native projects from within the IDE from the
project's properties - click Environment on the Application tab in the project properties.

COBOL Source Information (CSI)

COBOL Source Information (CSI) provides a quick and easy way of providing you with information about
your program when you are working on it. You enter a query in the Quick Browse dialog box and CSI
returns the results of the query in the Search view.

Compiler Directives

The following Compiler directives are new:

ACU-UNDERSCORE This directive treats underscores in COBOL words as hyphens.

ILSHOWPERFORMOVERLAP This managed COBOL-only directive generates a warning when an
overlapping PERFORM range is detected in the program.

ILEXPONENTIATION This managed COBOL-only directive enables you to optimize exponential
arithmetic operations by specifying the calculation method used.

EXITPROGRAM This directive determines how the EXIT PROGRAM statement is
executed.

The following Compiler directives have changed

CHANGE-MESSAGE The scope of this directive has been widened to allow you to change the severity
of different types of error messages, not just syntax checking messages.

DIALECT"RM" DIALECT"RM" now sets PERFORM-TYPE"RM". If you recompile an application
that uses DIALECT"RM", the behavior may change for nested PERFORM
statements. If that is the case, explicitly set PERFORM-TYPE"MF" after
DIALECT"RM" to continue with the previous behavior.

HIDE-MESSAGE The scope of this directive has been widened to allow you to hide different types of
error messages, not just syntax checking messages.

PRESERVECASE This directive now defaults to PRESERVECASE when compiling native COBOL;
managed COBOL compilation already defaults to PRESERVECASE. This results
in externally visible identifiers preserving their case instead of being converted to
uppercase.

Consolidated Tracing Facility

The following changes have been made to the Consolidated Tracing Facility (CTF):

CTF for JVM
COBOL
application

CTF tracing is now supported in JVM COBOL applications.
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New emitters A new emitter, JAVALOGGER, is available for JVM COBOL web applications. This
emitter passes details to the Java logging API that is available through your web
server. Use this emitter if you are unable to configure the TEXTFILE or BINFILE
emitters due to web server permission restrictions.

New properties
and variables for
existing emitters

The following support has been added to existing emitters.

Properties The following property has been added to the BINFILE emitter:

Property Description

RunUnitID Controls whether the RunUnit information is
included in the trace.

Variables Four new pseudo-variables for the FILE property have been added to the BINFILE
and TEXTFILE emitters:

pseudo-variable Description

$(PLATFORM) A platform specific constant, useful when
two run-time systems are in the same
process, and you require separate trace files

$(RUNUNIT) A unique number that represents the
managed RunUnit ID

$(RUNUNIT_SESSIONNAME) The session name passed to the managed
RunUnit

$(RUNUNIT_GUID) The globally unique identifier associated
with the managed RunUnit

Enhanced Accept and Display Statements

Two of the existing Enhanced ACCEPT and DISPLAY settings available through Adis have additional
values, which are aimed at RM/COBOL users migrating their source code to Enterprise Developer. The
new values are:

• Emulation of RM/COBOL-85 style data entry for numeric data entry on ACCEPT statements.
• Emulation of an RM/COBOL backspace in free format fields when in replacement editing mode, in that

deleted characters are removed and characters to the right are shifted left, the same as when in
insertion editing mode.

For more information on how to set these values, refer to Configuring Enhanced ACCEPT and DISPLAY.

Debugging

Displaying debug
information for
managed
applications

You can set the DEBUG constant for managed COBOL projects on the COBOL
tab in the project properties. This enables you to use the
System.Diagnostics.Debug class in your applications to ensure they write
diagnostic information in the Output window for projects compiled for Debug but
not for projects compiled for Release.

Changing the
display format for
individual items in
the Watch window

It is now possible to change the display format for individual items in the Watch
window in COBOL. To do this, click a row, press F2, and type: Variable,h or
Variable,x to always display the values in hexadecimal format; Variable,d to
always display the values of variables in decimal format, and of strings - as text.
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Grouping Files in Virtual Folders in Solution Explorer

Enterprise Developer now provides a Virtual View of a project within Solution Explorer. In the Virtual View
you use virtual folders to improve navigation by logically grouping the files that make up the project. You
can also create your own virtual folders to group files of your choice (a file can only belong to one virtual
folder). The files can be of different file types.

File Handling

New features include:

• Converting and editing Vision and RM/COBOL indexed data files using the Data File tools is now
supported.

• Access to data files (either sequential or indexed) through AcuServer is now supported.
• Access to Vision and RM/COBOL indexed data files through Enterprise Server is now supported.

Interface Mapping Toolkit

Enterprise Developer now supports the creation and deployment of COBOL program-based services using
the Interface Mapping Toolkit (IMTK).

Managed COBOL

Documentation A guide that provides a basic introduction to Object-Oriented Programming (OOP) for
COBOL developers, An Introduction to Object-Oriented Programming for COBOL
Developers, with examples is now available from the Product Documentation section on
the Micro Focus Customer Support Documentation Web site.

Named and
optional
parameters

Two new types of parameter have been introduced for use during method invocation:

Named
parameters

As part of the invocation expression, you can define a value for a
parameter named in the method definition. The named argument
must be specified after any positional arguments, and must not
correspond to any of those preceding arguments.

Optional
parameters

Optional parameters are parameters defined with a default value in
the procedure division header of the invoked method. If none of the
arguments passed in during invocation correspond to this parameter,
the default value is used in the method; if an argument does
correspond, the value that was passed in is used.

Delegates
and events

A number of new features have been added that relate to delegates and events:

Note: Some of these features were also available in previous versions of Enterprise
Developer.

The ATTACH and
DETACH statements

Use these statements to attach or detach a delegate, method
group or an anonymous method to or from an event.

The RUN statement Use this statement to invoke a delegate once it has been
created.

Combining
delegates

Use the '+' operator to add a method group, anonymous method
or another delegate to a delegate, and use the '-' operator to
remove a method or another delegate from a delegate.

Method groups
conversions

Use the METHOD keyword to specify a compatible method from
a method group, and convert it to a delegate.

Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse | 117

https://www.microfocus.com/en-us/support/documentation/


Problems View

The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. Click this column heading to sort the errors by program.

If the column is not present in the view by default, you can add it through the Configure Columns dialog
box in the View Menu.

Support for SOA

Restriction: This topic applies only when the Enterprise Server feature is enabled.

Enterprise Developer now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you are
upgrading to this release from an earlier version of Enterprise Developer, you may need to apply for a new
authorization code in order to access the functionality - please contact Micro Focus Customer Care to
receive an updated authorization code. Note that the Enterprise Developer Personal Edition license does
not support the IMTK functionality.

Upgrading from Net Express to Enterprise Developer

A new section in the product help, Upgrading from Net Express to Enterprise Developer for Eclipse,
provides guidance on how to move existing applications either developed or debugged in the Net Express
IDE into the Eclipse IDE.

XML Extensions

You can now use XML Extensions in your managed COBOL projects.

Use XML Extensions to import and export XML documents to and from COBOL working storage.
Specifically, XML Extensions allows data to be imported from an XML document by converting data
elements (as necessary) and storing the results into a matching COBOL data structure. Similarly, data is
exported from a COBOL data structure by converting the COBOL data elements (as necessary) and
storing the results in an XML document.

While importing or exporting data to or from XML documents, you can apply XSLT transforms to the data
by using XSLT stylesheets.

For more information, refer to the XML Extensions User's Guide.

What was New in Enterprise Developer 2.1 Update 1
Enterprise Developer 2.1 Update 1 provided enhancements in the following areas:

• Compiler Directives
• DB2 ECM
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• Enterprise Server
• HCO for SQL Server
• Mainframe Compatibility
• OpenESQL Assistant
• PL/I Support
• SQL Option for DB2
• Debugging Enhancements

Compiler Directives

You can now set SQL and PL/I-related Compiler directives and their values more easily, using a table of tick
boxes in a project’s Properties dialog box.

DB2 ECM

• Support for 64-bit DB2 ECM
• Support for 64-bit compile and runtime
• Support for DB2 10.1
• New DB2 SQL compiler directive option, BGP, to enable background parsing

Enterprise Server

The following new features and enhancements are available:

Clustering Enterprise Server Clustering allows the scaling-out of work units, so that an
increased number of operating system images can share the workload, resulting
in high-performance, multi-system data sharing across all platforms.

Historical Statistics
Facility

The Historical Statistics Facility has been extended to include the generation of
JCL file records, increasing the amount of information customers have available
to assist them in monitoring and tuning their Enterprise Server installations.

Recovery of in-doubt
XA transactions

Some events in XA environments can result in ‘in-doubt’ transactions, where all
parts of a composite transaction are not committed through all participating
resource managers. The recovery of such in-doubt transactions is now
supported.

SSL Support for the
CICS Web Interface

Enterprise Server now allows clients and servers to identify themselves through
X.509 certificates and participate in SSL-enabled conversations.

HCO for SQL Server

• Data Transfer tool enables you to:

• Specify the number of error rows to identify before committing them to the log file.
• Transfer tables in one SSIS package instead of one package per table (optional).
• Execute DDL for tables
• Transfer DDL

• The Generate DDL tool provides you the option of using SQL Server database collation or preserving
mainframe DB2 collation with SQL Server.

• Migration of DB2 temporary tables has been enhanced.

Mainframe Compatibility

Enterprise Developer for z Systems is compatible with IBM System zEC12 mainframe hardware and later.

OpenESQL Assistant

Support for generation of PL/I SQL queries and copybooks.
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PL/I Support

This release of Enterprise Developer includes support for developing, compiling and debugging PL/I
applications, including PL/I-specific project types, file categories, and editors.

• Support for executing PL/I programs using IBM MQ Series software
• DEFINE ALIAS support for the Open PL/I Compiler for XML
• Support for TSO/IDCAMS
• Improved PLISRTD performance on UNIX/Linux
• Improved file I/O speed when using the PL/I language to read or write sequential, indexed and relative

record files
• To enable PL/I for CICS, JCL, IMS you only need to set ES_PLI_SUPPORT=Y. You no longer need to

set ES_PL1_MFFH_JCL=Y.
• Support for character picture data types A,X
• Support for %XINCLUDE (macro preprocessor and compiler)
• Support for %OPTION (macro preprocessor)
• Tolerance for source code containing INLINE and ABNORMAL attributes.
• Support for the TINY and HUGE built-in functions
• New PLICTF and PLICTFHX built-in functions
• Support for the PARAMETER attribute
• Support for the NONINIT attribute

SQL Option for DB2

• Background parsing support
• Enhanced XDB engine LOB support
• UTF-8 support for client-side expressions
• Support for indices on expressions

Debugging Enhancements

You can create a breakpoint for any program in the workspace that your application uses by clicking Run >
Add Program Breakpoint, or clicking the  icon in the Breakpoints view, and entering the name of the
file.

What was New in Enterprise Developer 2.1
Enterprise Developer 2.1 provided enhancements in the following areas:

• ACUCOBOL-GT Data Types in Managed Code
• ACUCOBOL-GT Library Routines in Managed Code
• Compiler Directives
• .int, .gnt and .lbr File Types Support
• IMS Support
• Just-in-time Debugging
• Managed code enhancements
• OpenESQL
• UNIX Platforms Support
• Automatic Directives Detection and Setting

ACUCOBOL-GT Data Types in Managed Code

ACUCOBOL-GT data types and sign() variants that were previously only available in native code are now
supported in managed code. Use the Compiler directives COMP1 and COMP2 to set ACUCOBOL-GT
behavior for those particular data types.
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ACUCOBOL-GT Library Routines in Managed Code

ACUCOBOL-GT library routines that were previously only available in native code are now supported in
managed code.

Compiler Directives

The following new Compiler directives are now available:

DISPLAY Defines the default behavior of standard DISPLAY statements.

COMP1 Specifies the behavior of a COMP-1 data item.

COMP2 Specifies the behavior of a COMP-2 data item.

RESTRICT-GOTO Generates a syntax error for GO TO statements that transfer control to outside of
the current section.

ILSMARTRESTRICT Limits the generation of properties in ILSMARTLINKAGE classes to non-redefining
elementary items.

The following Compiler directive has changed:

• DATAMAP - Two new parameters allow you to display either the address or offset values for data items
in your program.

.int, .gnt and .lbr File Types Support

Support has been added within the IDE for compiling native COBOL applications to the Micro Focus legacy
formats .int and .gnt, and to package these files as a Micro Focus library file (.lbr). Improvements
include:

• An option to compile all native COBOL projects to .int and .gnt code. You can set this in your
project's properties.

• An option to package the .int and .gnt files produced by the project as a Micro Focus .lbr library
files.

• Improvements to the Net Express Project Import wizard that enable you to convert existing Net Express
projects to Enterprise Developer projects that compile to .int and .gnt code.

IMS Support

Mainframe projects contain categories for IMS resources (.dbd, .mfs, and .psb files), in which files with
these extensions are automatically put when you add them to the project. Each file type has its own editor
that colorizes tokens to aid development. Building a project containing these file types automatically
generates DBD, PSB, and MFS files.

Just-in-time Debugging

Enterprise Developer now supports "Just-in-time" debugging: when a run-time error occurs, or an
application calls CBL_DEBUGBREAK, the IDE can start automatically with the debugger attached to the
failed process.

Managed code enhancements

Delegates
and Events

Delegates and events are now implemented on the JVM platform.

This release provides support for combining delegates, using the METHOD keyword to
specify method groups, and implicit conversion from a method group or an anonymous
method to the suitable delegate type.
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Handling
Invalid
Numeric
Data

The handling of invalid numeric data is controlled by a number of Compiler directives:
HOSTNUMMOVE, HOSTNUMCOMPARE and SIGNFIXUP. These directives were
previously only available in native code but are now supported in managed code.

Resolving
Types

In this release, the Compiler attempts to resolve types to those defined in the current
compilation unit wherever possible. The Compiler will attempt to resolve such types to an
external name only if no suitable type exists in the current compilation unit. For example:

$set ilusing"System"
class-id MyNamespace.EventHandler.
01 o type EventHandler.                       
end class.

In this release, 01 o type EventHandler. resolves to
MyNamespace.EventHandler and not to System.EventHandler.

Specifying
Properties

In previous versions of the products, properties declared using the PROPERTY keyword
on a data item were generated as final properties. Starting with this release, they are
generated as virtual properties by default. In order to make the properties final, you need
to specify the word FINAL following PROPERTY. This change may affect the generation of
Proxy classes, for example, if you are using WCF.

OpenESQL

JDBC JDBC has been enhanced to support two new directives:

JNDI Enables you to specify a JNDI class that looks up connection strings.

JNDIENC Enables applications to use the JNDI Environment Naming Context
(ENC) when looking up JDBC data source names using JNDI.

ODBC Added support for a generic one-phase commit for ODBC XA switch module.

SQL Compiler
Directive
Options

OpenESQL has been enhanced to support the following new SQL compiler directive
options:

DATE Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
specified.

TIME Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
used.

DATEDELIM Specifies a single character as the delimiter between the year, month,
and day components to override the default delimiter determined by
the HCOSS DIALECT or DATE directive specification.

TIMEDELIM Specifies a single character as the delimiter between the hour,
minute, and second components to override the default delimiter
determined by the HCOSS DIALECT or TIME directive specification.

TSTAMPSEP Specifies a single character as the separator between the date and
time parts of timestamp and date/time data.

OpenESQL
Assistant

OESQL Assistant now supports updateable cursors.

SQL Server We now support Microsoft SQL Server 2012.
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UNIX Platforms Support

Support for remote development and deployment of projects is now available on UNIX and Linux.

Automatic Directives Detection and Setting

The IDE automatically determines and sets the COBOL dialect, and the CICS and SQL directives on local
or remote native COBOL projects. You can also start a directives scan from within COBOL Explorer - select
Determine Directives from the context menu for the projects or the COBOL source files. This triggers a
scan to determine the COBOL dialect, the CICS and SQL settings, and sets them as Compiler directives
on a file or project level respectively. At the end of the scan, you view the results and choose to apply the
changes.

What was New in Enterprise Developer 2.0
Enterprise Developer 2.0 provided enhancements in the following areas:

• Automatic Directives Detection and Setting
• COBOL Explorer view
• COBOL File Search
• Compiler Directives
• Compiling Single Files
• Enhancements to Developing Applications on a Remote Machine
• Converting Projects
• Copybook Context
• Debugging Enhancements
• Eclipse 3.7
• JVM COBOL File Handler
• Library Routines
• Managed COBOL Language Features
• Data Access
• Remote COBOL JVM Projects - Early Release
• Run-Time Tunables
• Samples
• Vision Data File Searching

Automatic Directives Detection and Setting

It is now possible to automatically determine and set the COBOL dialect and SQL directives on native
COBOL source code. In the COBOL Explorer, select Determine Directives from the context menu for the
projects or the COBOL source files. This triggers a scan to determine the COBOL dialect and SQL settings
and sets them as Compiler directives on a file or project level respectively. At the end of the scan, you view
the results and choose to apply the changes.

This feature works with local or remote native COBOL projects only.

COBOL Explorer View

Enterprise Developer now includes the COBOL Explorer view in the Eclipse IDE. This allows you to
navigate around COBOL projects in a more useful and convenient way than Eclipse's own Navigator view.

The COBOL Explorer view includes the following features to help you manage your projects:

• For COBOL Project, Remote Project, and Mainframe COBOL Project types, COBOL Explorer adds
category folders that automatically group together your project's COBOL programs, copybooks, and
output files. (These folders are not physical folders on the disk, but effectively headings for certain file
types.)
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• To simplify navigation around your project, you can hide some files that are part of the project, such as
the .cobolBuild, .cobolProj, and .project files, and the .settings folder and its content in
JVM projects. You do this by opening the view menu, selecting Customize View and choosing from the
options.

Filters Choose types of content to hide in COBOL Explorer.

Option Description

.*resources Any files of type .* such
as .cobolBuild, .cobolProj

Closed projects Resources in closed projects never display, but
you can choose to hide all closed project icons

 too

Empty folders inside COBOL categories Folders mapped to the COBOL Programs and
Copybooks that contain no COBOL program or
copybook files

Non-COBOL projects Projects of types other than those under Micro
Focus COBOL - for example AspectJ, Plug-in, or
Update-site projects

RSE Internal projects Projects generated by the RSE plug-in

Content Choose types of content to show in COBOL Explorer.

Option Description

Working Sets Working sets are subsets of workspace
resources you can choose to show or perform
options on. To define a working set, click Project
> Build Working Set > Select Working Set >
New.

COBOL Elements Non-resource types that are COBOL-specific:

1. x

2. category folders, including those for COBOL
programs and copybooks, and BMS macro
source files

3. icons for the different types of COBOL files.

4. overlays for build errors and warnings

5. some context menu items

Resources COBOL projects, COBOL programs and
copybooks. Has effect only if the COBOL
Elements option is unchecked.

• COBOL Explorer helps you fix problems by using icons to identify files and containers that cause build
errors and warnings.

• A file that generates a warning, and any containing folders and categories, is marked with a yellow
warning sign. For example:
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• A file that causes an error, and any containing folders and categories, is marked with a cross. In this

example the icons indicate the most severe problem is the error caused by Program4.cbl, and the
folders are marked with error icons despite Program5.cbl generating a warning:
 

 
• A project that suffers from a dependency error is marked with a red exclamation mark; its contents

remain unmarked. In this example the project depends on another project that is closed, causing a
build path problem:
 

 

Also, the context menus are reorganized and include some additional tasks such as the Determine
Directives command.

You access COBOL Explorer in the same way as other Eclipse views, by selecting Window > Show View.

COBOL File Search

Enterprise Developer now includes the COBOL File Search feature in the Eclipse IDE.

You can use the Micro Focus search feature to make it easier to find files within your projects:

• Select Search > Micro Focus, and type the file search pattern.

You can filter results based on:

• File type: choose from COBOL programs, copybooks, PL/I files, JCL files, and BMS and macro
source files.

• Only those files that cause build errors.
• Only those files that cause build warnings.

You can control the scope of your search:

• Workspace - searches entire workspace.
• Selected resources - searches only the resource currently being edited or highlighted in the tree

view.
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• Enclosing projects - if the editor is focussed on a resource or resources are highlighted in the tree
view, then the search is within the entire project containing the resources.

• Current program - searches the resource currently being edited, as well as within any copybooks or
include files used by the resource.

• Working set - see Working Sets for more information.
• Select Search > Run Stored Micro Focus Search Query and choose to find either:

• Only those files that cause build errors.
• Only those files whose properties override the project's properties (for example Language dialect or

Compile for debugging settings).

Whichever way you use the Micro Focus search the results are shown in the Search view.

After you have performed a search you can edit the properties of any of the program files listed in the
search view. You can even simultaneously edit the properties of multiple program files which have
compilation settings available on them, that is program files rather than copybooks or include files. Highlight
the files you want to change, right-click Properties, and then check Enable file specific settings. Change
the file properties as required and then click OK.

You can save your search criteria and give it a label which is added to the list of stored queries available
when you select Search > Run Stored Micro Focus Search Query:

1. In the Search tab, click  Save the Current Search.

This opens the Add Micro Focus Search dialog box.
2. In the Search label field, type a search label.

• You can assign a keyboard shortcut by typing the required keystrokes in the Binding field.

• Optionally, you can modify the current search criteria.
3. Click OK.

The search label is added to the list under Search > Run Stored Micro Focus Search Query.

You can also add, edit, and remove your searches from Window > Preferences > Micro Focus > Search.

Note: Do not open the Keys preferences page (Window > Preferences > General > Keys) while
editing the binding in the Search preferences page. Opening the Keys preferences page will prevent
any changes you make to the search bindings from being saved.

Compiler Directives

The following new directives are now available:

• COPYSEARCH - enables you to specify how copybooks are located. You can choose between usual
Micro Focus COBOL behavior or usual RM/COBOL behavior.

• ILSMARTNEST - enables you to nest ILSMARTLINKAGE classes inside the program class in which
they are defined. This makes it possible to have multiple programs in a single compilation unit that
include linkage records with the same name.

The following directives have been changed:

• DIALECT(RM) - now accepts a new parameter, RM, which enables the RM-compatible functionality that
the RM directive used to enable.

• ILREF - can only specify a .class as a parameter, and not a .jar file or other file types.
• ILUSING - when set on a single file using the SET statement, $set ilusing, the directive only affects

that file.

Compiling Single Files

It is now possible to compile individual COBOL source files without rebuilding your entire project. Build
Automatically on the Project menu must be turned off.
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Enhancements to Developing Applications on a Remote Machine

Previously, this product depended on Samba or NFS to transfer and manage the project files on a remote
UNIX machine. Remote Server Explorer (RSE) was only used to build the applications on remote
machines.

"Remote file system (RSE)" is now the default option in the Create Remote COBOL project wizard for
managing the files of remote COBOL projects. RSE establishes a connection with the remote machine and
is used to transfer and manage the project files on it.

Important:

• You must use SSH connection and not DStore for remote COBOL projects created with Remote
file system (RSE).

• You can still use Samba and NFS as file system providers. On system where SSH is not allowed,
you can use SAMBA and DStore connection to transfer and manage the files on the remote
system.

Converting Projects

It is now possible to convert Net Express projects into Eclipse projects and use them with Enterprise
Developer. To do this, use the Net Express Project Import and Convert Wizard available from File > Import
> Convert NetExpress Projects to COBOL Projects. The wizard analyzes the Net Express project file
and its configuration settings, creates Eclipse projects based on this information, imports the existing
source code into them, and sets the requisite project and file properties from the original Net Express
project.

Note: If you import a Net Express project that uses functionality that is not supported in Enterprise
Developer, the wizard will still produce an Eclipse project. In some cases you might be able to perform
additional steps (such as editing source files, installing AddPacks, or reworking parts of the
application) in order to successfully compile and run it. See Converting Net Express Projects to
Eclipse Projects for more information about the limitations of the wizard.

Copybook Context

When you view or edit a copybook, you need to see it in the context of the program that references it, as its
appearance and usage can change depending on the program. For example, data items that are not used
in the program are struck through, and horizontal lines indicating the start and end of code lines can show
depending on the source format of the program. The Program Outline view can differ between contexts too.

A breadcrumb trail at the top of the Editor indicates which program and copybooks are the current context -

click Toggle Context Breadcrumbs  in the Eclipse toolbar and use the drop-down list to view and open
the dependent copybooks.

Debugging Enhancements

Enterprise Developer 2.0 provides the following enhancements to debugging:
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Program
Breakpoints

Note: Program breakpoints are supported in native COBOL only, and are not
supported with nested programs.

You can now set program breakpoints, which break into a program whenever it or
one of its entry points is called.

To set or toggle a program breakpoint, double-click in the left margin, next to the
Procedure Division heading. The  icon appears when the program breakpoint is
set.

Step out of OSVS
perform
statements

You can now step out of a perform statement when PERFORM-TYPE(OSVS) or
DIALECT(OSVS) is set.

Eclipse 3.7

Enterprise Developer 2.0 uses Eclipse 3.7.1 Indigo.

JVM COBOL File Handler

Use the JVM COBOL File Handler, a File Handler written in purely JVM COBOL managed code, when you
are deploying to environments that do not allow the use of native code such as the default Micro Focus File
Handler.

Library Routines

The following CTF library routines are now available in COBOL for JVM:

CBL_CTF_COMP_PROPERTY_GET
CBL_CTF_TRACE
CBL_CTF_TRACER_LEVEL_GET
CBL_CTF_TRACER_GET
CBL_CTF_LEVEL

The following routine has been enhanced:

• The CBL_SEMAPHORE_ACQUIRE routine now accepts a timeout parameter.

Managed COBOL Language Features

The following new syntax elements are now available in managed COBOL:

Local
Variables

In managed COBOL, Data items can now be declared in the procedure division, using
the DECLARE statement. In addition, they can be declared inline as the iterator in a
PERFORM statement, or as an exception message in a TRY … CATCH … FINALLY
statement block.

Collections There are two new collection types in managed COBOL: LIST and DICTIONARY. For a
LIST, you can add elements to a list, retrieve the nth element of the list, replace the nth
element, iterate through the list and clear the list. For a DICTIONARY, you can add key
value pairs, retrieve a value corresponding to a key, to replace the value corresponding
to a key, iterate through the dictionary and clear the dictionary.

Properties In managed COBOL, a property can now be defined using PROPERTY-ID and GETTER
and SETTER phrases to access to the property. The previous technique of specifying
the keyword PROPERTY on a data declaration is still available.

Indexers In managed COBOL, an indexer can now be defined using INDEXER-ID and GETTER
and SETTER phrases to access the indexer value. Indexers are similar to properties,
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except that their accessors take parameters. Indexers allow instances of a class or
valuetype to be indexed just like arrays.

Zero-based
Indexing

The managed COBOL syntax for arrays now uses zero-base indexing to access arrays
when square brackets are specified. For backward compatibility, one-base indexing is
used when round parentheses are specified.

The Help now contains code examples comparing managed COBOL and Java.

Data Access

Enterprise Developer version 2.0 provides the following enhancements:

• Improved IDE integration with SQL directives - now supports handling of deprecated and removed
directives. Also supports filtering of the choices offered to the user by product type, project type, and
platform.

• OpenESQL has been enhanced and it now:

• defaults to optimal performance
• supports 64bit ODBC across all platforms
• OpenESQL now supports JDBC across all platforms

Remote COBOL JVM Projects - Early Release

You can use Eclipse to develop COBOL JVM projects on a remote UNIX/Linux machine. The source code
resides and is being compiled and debugged on the remote machine.

Run-Time Tunables

Enterprise Developer 2.0 provides the following new tunable:

• subsystem_cancel_mode - use this to override the default cancel mode when you use the
CBL_SUBSYSTEM library routine to cancel a subsystem.

Samples

The following new samples are now available:

• Collections - demonstrates the managed COBOL collections syntax
• Local Variables - shows how to declare data items in the procedure division in the DECLARE,

PERFORM and TRY statements
• The code in the Properties sample has been enhanced to use the new PROPERTY-ID syntax. The

sample also includes a sample program for Indexers which illustrates the new INDEXER-ID syntax.

Vision Data File Searching

Enterprise Developer 2.0 provides the following new ACUCOBOL-GT compatible environment variables to
help search for Vision data files at run time:

APPLY_FILE_PATH
FILE_CASE
FILE_PREFIX
FILE_SUFFIX

What was New in Enterprise Developer 2010
Enterprise Developer 2010 provided enhancements as part of the following releases:

• New Features in Enterprise Developer 2010 R4 Update 2
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• New Features in Enterprise Developer 2010 R4

Features Added in Enterprise Developer 2010 R4 Update 2

New Platforms Support

Support for Enterprise Developer for Eclipse has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for Enterprise Developer Development Hub has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for COBOL for JVM has been added for the following platforms:

HP IA 11.31 - 32/64-bit
x86-64 running Red Hat Linux 5.6/6.1 - 32/64-bit
SPARC running Solaris 10 - 32/64-bit

Native OO COBOL Class Library Reference

On Windows, Help for the following native OO COBOL class libraries is available:

Base class library
GUI class library
OLE class library
OLE Automation class library

The Help is available in the file nxrclr.chm, which is installed in the Help folder of your installation. The
default location is%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\Help.

To open the help, double-click nxrclr.chm in File Explorer.

Help for the native OO COBOL class libraries are available from the Micro Focus Web site, as follows:

1. Go to the Server Express documentation.
2. In the Reference section, click OO COBOL.
3. Expand OO COBOL Class Library Reference.

OpenESQL

OpenESQL now includes the JDBC preprocessor option that you can use to access databases for
applications running under the Java Virtual Machine (JVM).

Features Added in Enterprise Developer 2010 R4

ACUCOBOL-GT Compatibility

The Compiler and run-time continue to provide support for ACUCOBOL-GT. The directive ACU is the main
switch for turning on ACUCOBOL-GT compatibility. The ACU directive enables various ACUCOBOL-GT
syntax extensions and other language elements. Additional ACUCOBOL-GT compatibility features include
the following:

• When using a CALL statement, the USING and GIVING/RETURNING phrases can now appear in either
order.

• The following ACUCOBOL-GT standard library routines can now be used with Enterprise Developer in
native code:
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• C$CALLEDBY
• C$CALLERR
• C$CHDIR
• C$MAKEDIR
• C$MEMCPY
• C$MYFILE
• C$PARAMSIZE
• C$RERR
• M$ALLOC
• M$FREE
• M$COPY
• M$FILL
• M$GET
• M$PUT
• WIN$VERSION

• The following ACUCOBOL-GT 'ccbl' compiler options can now be used with Visual COBOL:

• -E, -V
• -Cv
• -Da, -Db, -Dd31, -DL1/2/4/8, -Dq, -FpRounding
• -La, -Li, -Lc, -Lf, -Ll, -Lo, -Ls, -Lw

Note: The output that these list options provide differs in Visual COBOL.
• -Qm
• -Rc, -Rn, -Rw
• -Sa, -St, -Sd, -Sp, -S1...-S9
• -noTRUNC, -truncANSI, -Dz
• -Td, -Te
• -Vc
• -Za, -Zc, -Zl, -Zn, -Zs, -Zi, -Zr1, -Zy, -arithmeticVSC2

Full ACUCOBOL-GT compatibility is documented under the Programming section in the product help.

COBOL for Java Virtual Machine (JVM) Support

In this release you can compile COBOL applications to JVM byte code (.class files) so that they can be
run on a JVM. There is support in the IDE to edit, compile and debug JVM COBOL applications. This
release includes Managed COBOL - COBOL with extensions to support the JVM framework plus OO
syntax support.

Features include support for

• New managed COBOL syntax:

• The SYNC statement, which marks a statement block as a critical section by obtaining the mutual-
exclusion lock for a given object, executing a block of statements, and then releasing the lock.

• Extension methods, enabling you to extend an existing class with new methods without the need to
recompile the existing class

• Java style inner classes, which define a nested class within another class. These follow all the
methods belonging to the containing class.

• The STATIC keyword, enabling you to mark methods and data as static.
• Enumerators, which represent a list of constant values. You can declare an enum type that defines

the values and symbolic names for them, and refer to the values by name in your code.
• Seamless interoperation between JVM COBOL and native COBOL
• The ability to add Java projects to the classpath for COBOL JVM projects, and COBOL JVM projects to

the classpath for Java projects
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• Red Hat, AIX and SUSE platforms

Embedded HTML

We now support the use of Embedded HTML (EHTML) in COBOL CGI programs, which enables you to
output HTML directly from your applications.

HCO for SQL Server (HCOSS)

Host Compatibility Option for SQL Server (HCOSS) is a new component in Enterprise Developer for
Eclipse. However, it was previously available in the Visual COBOL 2010 Enterprise Option product. The
following are HCOSS features that are new since its previous release in Visual COBOL 2010 Enterprise
Option:

• HCOSS supports client-based applications compiled with the DBMAN=ADO and
DIALECT=MAINFRAME compiler directives when the application targets .NET Framework versions 2.0,
3.0 and 3.5, or .NET Framework version 4.0, but only when the application does not contain dynamic
SQL that uses an SQLDA structure.

• HCOSS supports dynamic SQL that uses the SQLDA structure in client-based applications compiled
with the DBMAN=ADO and DIALECT=MAINFRAME compiler directives, but only when the application
is built to target .NET Framework version 4.0.

Improved Usability

The following improvements to COBOL development in Eclipse have been made:

Dialog box improvements The dialog boxes governing build configuration, debug configuration,
and launch configuration are redesigned to make them easier to use.

Autocompletion and Content
Assist

The IDE now includes autocompletion and content assist editing
features.

Language Improvements

The following improvements have been made to managed COBOL:

Extension methods
and extending
operators

Managed COBOL now supports extension methods. This feature enables you to
add methods to existing types without the need to edit or recompile the code. You
can also extend operators.

The SYNC modifier
for methods

The SYNC modifier locks the values of the arguments sent to the method, so that
they do not change while the method is processing.

Nested classes In managed COBOL, a nested class can now be defined so that it can access the
instance fields, properties and methods in its containing class. To allow this, you
add the optional SHARING PARENT phrase to the nested class definition.

Renamed Color Preferences

The COBOL Editor syntax-coloring scheme called "Micro Focus Net Express" is now called "Micro Focus
Traditional".

The syntax-coloring element called "Identifiers" is now called "Identification Division Names".

Any existing settings for these options will not change.

Reporting of Linker Errors

Errors relating to linking, such as undefined entry points and libraries not being found, are now logged in
Eclipse's Problems view.
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RM/COBOL Compatibility

The Compiler and run-time continue to provide support for RM/COBOL. Additional RM/COBOL
compatibility features include the following:

• The following RM/COBOL standard library routines can now be used with Enterprise Developer in
native code:

• C$Century
• C$ConvertAnsiToOem
• C$ConvertOemToAnsi
• C$DARG
• C$Delay
• C$GetEnv
• C$GetNativeCharset
• C$LogicalAnd
• C$LogicalComplement
• C$LogicalOr
• C$LogicalShiftLeft
• C$LogicalShiftRight
• C$LogicalXor
• C$NARG
• C$SetEnv
• C$RERR
• DELETE
• RENAME

• The RM/COBOL file handler can now be used with Enterprise Developer, enabled by using the
CALLFH"ACUFH" Compiler directive, and then configuring an add-on to the Vision file handler.

Full RM/COBOL compatibility is documented under the Programming section in the product help.

XML Extensions

Note: This functionality is supported in native COBOL only.

You can now use XML Extensions, the system that enables your COBOL applications to interact with XML
documents, with Enterprise Developer.

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
RM/COBOL product documentation set, in the Customer Care section of the Micro Focus Web site.

Significant Changes
This section describes significant changes in behavior or usage in each successive release. These
changes could potentially affect the behavior of existing applications or impact the way the tools are used.

Significant Changes in Enterprise Developer 9.0
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
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The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• .NET Support
• Application Workflow Manager
• ApppMaster Builder
• Compiler
• Data Tools
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• IMS Support
• JCL Support
• Micro Focus Directory Server
• PL/I Support
• Runtime System
• Setup Issues (Windows)

.NET Support

Back to the list

• The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL.Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus.COBOL.Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Application Workflow Manager

Back to the list

• The related AWM resource (required to perform the resource operation) of the open file is now cached.

02307586 (278005)

AppMaster Builder

Back to the list

• In this release, AMB file-tailoring skeleton files no longer require modification (usually these
modifications consisted of enclosing paths within quotes) to use long and spacey file names. If you use
customized file-tailoring skeleton files, you must compare and reintegrate any customizations applied to
these files into the new skeleton files provided with this release. File-tailoring skeleton files are found in
your %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ispslib directory,
and include:

SSMSISP
SSMSDLG
SSMSMFS
SSMCHK

134 | Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse



SSMPCOM
SSMSCGEN
SSMCOMP
SSMOXGEN
SSMCBL
SSMMBMS
DVSQL2
DVSQLR
DVSYMS
DVSYMSX
DVBAT
DVVSM2
DVMAIN
DVJOBVSM
DVJOBDDG
DVJOBIMS
DVJOBSQL
DVCHECK
DVIMS2
DVCOPY

Compiler

Back to the list

• Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools

Back to the list

• A new print function available from the File group and the File menu enables you to print the records
shown in the editor.

00367084 (12432)
• An enhancement to the Compare Files function has been added, so that when a comparison is made,

the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)
• In the Data File Editor, the Compare Files function has been enhanced to allow you to select start and

end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)
• A Quick final page access option has been added to the Preferences dialog box of the Data File

Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Documentation

Back to the list

• When using the cob command to link PL/I programs targeting Enterprise Server, you must include the -
lmfpdfpz parameter in your link command to avoid problems in multi-step jobs. 
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02451241 (386064)
• FIXEDOVERFLOW conditions are now implemented and will occur when detected.

02163371 (203207)

Eclipse IDE

Back to the list

• When creating a new remote project using the SSH file system, the wizard now allows you to create a
new Micro Focus DevHub using SSH connection. (Previously, only the Micro Focus DevHub SSH
Only connection was available.)

(301058)
• The Import Server option (from within Server Explorer) is now working correctly with an XML if the

XML file type is known. If the XML file is in an unknown format, an error message is displayed, and
import is not possible.

02345573 (310017)

Enterprise Server

Back to the list

• A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
• ESCWA now validates the TLS properties to help prevent errors on entry.

Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
• In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)
• An issue with not being able to update or navigate the ESCWA UO though the job output in the spool

while it is still running has been resolved.

02322494 (286142)
• In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)
• In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your

product Help for more information.

(374021)
• The Job View page in ESCWA now includes a list of job steps that have run during the current

enterprise server region up time.

(347033)
• A new configuration property has been added to ESCWA to enable the default language the UI displays

to be overridden from the user's browser locale.

02227239 02307446 (260128)
• ESCWA now supports TLS enabled Redis repositories.

(306097)
• In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See

Dynamic Debug in your product Help for more information.

(350029)
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• In ESCWA, the Spool page can now display multiple Spool Output types.

02503214 (401184)
• ESCWA now supports Expiration Dates for Catalog DCB.

02159515 (202201)
• In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members

and associated information. See PAC Client List in your product Help for more information.

(384037)
• ESCWA now supports merged archive spool. See Spool in your product Help for more information.

(245050)
• An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to

enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)
• Corrected the spelling for the db_server_name Configuration Manager property. You will need to

update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCF0071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
• A recent change resulted in EXEC CICS TIME(...) expiring immediately. This has been fixed.

02525957 (411120)
• In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror

transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)
• You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to

JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)
• When submitting JCL by content via ESCWA or the JCL command cassub, Enterprise Server will now

authorize the request against a new cassub.content resource class under OPERCMDS. If this class is
not specified then Enterprise Server will revert to existing behavior. See Resource Classes for ESMAC
and Operator Command Security in your product Help for more information.A prototype definition has
been provided in the standard LDIF files shipped with the product.

(313048)
• A new parameter, -i has been added to the cassub utility. This parameter enables the user to specify a

correlator up to 32-bytes long comprised of ASCII printable characters. The JCL engine will ensure this
correlator has not previously been supplied for a JCL JOB. If a duplicate correlator is detected, the job
submission will be rejected and the previous JOB ID will be returned. See cassub in your product Help
for more information.
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02462072 (394004)
• The Redis server supplied with the product is now version 6.2.6.In ESCWA, you must now specify the

Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)
• When a CICS abend occurs, the 4 letter abend code now appears after the Transaction ID in HSF

records. There has been no change in behavior in the case of an RTS abend, where the transaction
name followed by ABEND still appears.

(246037)
• EXEC CICS INQUIRE TASK LIST now includes dispatchable (queued) tasks in the returned LISTSIZE

parameter.

(365089)
• When performing a DPL targeting a program that had an installed PPT specifying that it was remote,

the use of the TRANSID option on the LINK would be ignored. This has been fixed.

02434323 (386136)
• During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a

CASXO0040W message will now be displayed in the console.

(425081)
• If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.

Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
• ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in

ESCWA.

(397027)

File Handling

Back to the list

• The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
request failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.

(285197)
• The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as

documented.

02454638 (386087)
• ICETOOL emulation now supports the RESIZE operator.

(350035)
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IMS Support

Back to the list

• A problem that occurred when a restart call (XRST) referencing a checkpoint ID received checkpoint
data that originated from a different program when a shared checkpoint log file was used and the other
program issued the same checkpoint ID has been fixed.  IMS now requires that the name of the
program issuing the XRST must match the name of the program that issued the checkpoint.

(310065)
• The JES alias feature is now supported for IMS application main programs executed from JCL.

02356855 (308032)

JCL Support

Back to the list

• After the release of Enterprise Developer 7.0 PU17 and 8.0, the structure of the M_SPL_JOB.dat file
was updated. If you are upgrading to this release from a release that does not contain the update, you
must rebuild M_SPL_JOB.dat using the following command, and then replace M_SPLJOB.dat with
NEW_M_SPLJOB.dat before executing the merge spool job.rebuild
M_SPLJOB.dat,NEW_M_SPLJOB.dat /r:v344-604

02516141 (407126)
• When performing an IDCAMS REPRO on a cluster with the LIKE parameter set, if the LIKE cluster has

data or index references associated with it, then similar data and index references are now created for
the new cluster.

02358077 (363063)
• If an XA switch module failed while a DSNRLI program was using it then there was no way to

programmatically restart the switch module. This has been corrected. If a module fails with an TX_FAIL
error code (-7) the module can be reassociated with the unit of work by calling DSNRLI IDENTIFY. In
this case the check for the correct DSNRLI call ordering has been suspended so that IDENTIFY can be
called after an TX_FAIL error. The TX_FAIL return code will be passed back to the calling program so
that it is aware of the error. TX_FAIL is -7 and will replace the normal DSNRLI return code (8).

02364792 (323018)
• System symbols, defined in SYS1.PARMLIB(IEASYM00) can now be filtered by use of the LPARNAME

entry. See INITSYS.JCL in the jcl-symbols examples.

(387029)
• Security for loading utility programs, either supplied by the user or any Micro Focus utilities, has been

increased. Users can now specify a number of libraries that hold program modules and who can use
them. See JCL Enhanced Security Checks in the product Help for more information.

PSEC:103014 (86177)
• When a dataset is required by MFFTP to be sent (put) or received (get), then MFFTP issues a dataset

lock that remains in effect until the end of the step. The location of the physical files used by MFFTP are
also validated against the PHYSFILE rules (if implemented). This access validation could cause security
errors if access is not allowed to the location of the FTP input and output file and might require that the
location be changed. This is usually the default allocation location, but may also be specified by
MFFTP_TEMP_DIR, or by adjusting the PHYSFILE rules to accommodate the location.

02210700 (244030)
• A step running IKJEFT01 was incorrectly returning the highest return code of all commands executed

instead of the return code of the last command executed. The MF_IKJEFT_KEEP_MAX has been
added to correct this problem. Its default setting is MF_IKJEFT_KEEP_MAX=N. However, if the new
behavior leads to a change in the COND CODE, and this is a problem for your application, you can
return to the original behavior by setting MF_IKJEFT_KEEP_MAX=Y.

02532126 (415094)
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• When the return code from an IKJEFT step exceeded 4095 it could be incorrectly adjusted depending
on the IKJEFT program called. To remedy this, the return code when IKJEFT01 is called is changed to
12. Also, when IKJEFT1A or 1B is called, the return code is adjusted to RC modulo 4096.

02514544 (406145)
• DSNRLI return codes did not always correctly reflect the outcome of the SRRCMIT and SRRBACK

functions. This has been fixed.

(408001)
• When the result of a SRRCMIT or SRRBACK call was a MIXED status, meaning that some XA modules

committed or rolled back and some did not, then DSNRLI issue either commit or rollback upon
shutdown at the end of the step. This was incorrect. DSNRLI will not NOT issue commit or rollback at
step end. The XA Recovery processing maybe able to recover the 'in doubt' transaction.

02512717 (406089)
• MFFTP has been enhanced to pass relevant file transfer information for FTP operations such as PUT,

GET, and DEL, to a user exit defined by the new environment variable, MFFTPXIT. To enable the exit,
set MFFTPXIT to a user-exit program file, for example, the provided MFFTPXIT.cbl sample file. A list
of valid parameters is in the provided mfftpxit.cpy copybook. When the user exit is enabled and an
FTP step returns a non-zero code, a copy of the *.op FTP output file is created using the *.out
extension in either the defined MFALLOC_LOC or MFFTP_TEMP_DIR location. Use the *.out file to
determine the cause of FTP operation failures.

02287628 (259117)

Micro Focus Directory Server

Back to the list

• The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)
• To query Enterprise Server security configuration information (details of configured external Security

Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.

(285199)
• Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is

not authorized to view.

02305916 (285169)
• Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit

Event Codes in your product Help for more information.

02412285 (365149)

PL/I Support

Back to the list

• When assigning a PICTURED item into a FIXED DECIMAL, FIXEDOVERFLOW is now triggered if
enabled and the target source or precision is not large enough to fit the PICTURED representation.

(400099)
• The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), namely

offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)
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• The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has
been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
• The Open-PLI compiler now performs Restricted Expression Evaluation on  AUTOMATIC, DEFINED,

and BASED declarations in addition to STATIC declarations as in previous releases.

00368483 (11358)
• The OPTIONS and LIMITED attributes now imply type ENTRY to correct a problem wherein type was

not specified and the default type was set by applying the I-N rule to the variable name.

02048549 (165087)
• The behavior of the PRECISION built-in was incorrect for most data types, except FIXED BIN, FIXED

DECIMAL, and PICTURE. This has been corrected.

(363237)
• When passing an array argument to a procedure with differing array dimensions or extents of the

corresponding parameter descriptor, a dummy argument was created. To correct this, a Severe
diagnostic message is now generated instead. In addition, when an array argument with variable
extents was passed to a procedure whose corresponding parameter descriptor had constant extents, a
dummy argument was created. To correct this, the array argument is now passed by reference and a
Warning diagnostic is generated. Both of these issues apply to passing arrays without surrounding
parentheses.  

02310772 (286006)
• Previously OPTIONS(FETCHABLE) was not implied by the coding of a RELEASE statement for an

ENTRY. This has been fixed.

01862366 (120035)
• Data exception 8097 now occurs when the sign nibble of a fixed decimal value does not contain a valid

sign 0x0A thru 0x0F during an arithmetic operation, conversion, or assignment.

02198788 (222107)

Run-Time System

Back to the list

• By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mftrace.emitter.es#level in the MFTRACE_CONFIG.

(328008)
• If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails

for a second time the runtime will call _exit() to terminate the process immediately.

02286519 (258130)
• Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL

RTS, will now result in a COBRT090 error message.  Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
environment.  The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)
• The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been

increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)
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Setup Issues (Windows)

Back to the list

• Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
• In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal

application.

(421016)
• On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
• 32-bit Windows is no longer supported.

(382034)

Significant Changes in Enterprise Developer 8.0
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• Code Analysis
• Common Communications Interface
• Compiler
• Containers
• Eclipse IDE
• Enterprise Server
• Machine Administration
• Mainframe Access
• File Handling
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Communications Server
• Micro Focus Directory Server
• PL/I Support
• REXX Support
• Run-time System
• SQL: OpenESQL
• SQL Option for DB2

Code Analysis

Back to the list

• Rules in nested folders are now correctly processed, as well as rules with the same name.

(207020)

Common Communications Interface

Back to the list
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• For improved security, SSL/TLS connections are now restricted to TLS versions 1.2 and 1.3 by default.
This is an industry best practice. If you need to use older, less-secure protocol versions with legacy
clients or servers you should consult the product online help for instructions on configuring TLS protocol
versions.

PSEC:103001 (87188)

Compiler

Back to the list

• When a RELEASE or RETURN statement is executed in an input or output procedure of a sort
statement, if the SORT-RETURN special register is found to contain a value of 16, then the sort should
be aborted, even in a case where the RELEASE or RETURN statement is at a lower perform level than
the input or output procedure itself. Previously, this was not happening for programs compiled to JVM
or .NET COBOL, but this erroneous behavior is now fixed.

01723392 (104114)
• When a variable is defined in a DECLARE statement with no explicit type, but a value that is a non-

integer numeric literal, the type is assumed to be float-long (i.e. a 64 bit floating point).

(148103)

Containers

Back to the list

• The containers image build tool now supports custom Java run-times which helps to keep the size of
Java-based applications smaller. 

(182004)

Eclipse IDE

Back to the list

• COBOL formatter functionality has been enhanced with the introduction of a 'Code Clean Up' feature.
The code clean up preferences are stored in profiles, similar to the COBOL formatter preferences, and
are also applied in a similar way, within the COBOL editor. See Formatting COBOL code in the
documentation for more details.

(123034)

Enterprise Server

Back to the list

• The Security Manager passwords no longer appear in the commonwebadmin.json configuration file.

(203052)
• The X-XSS-Protection header will now be set on all requests instead of only on API requests.

01938835 (138176)
• In ESCWA, the colors and contrast have been adjusted to improve visual accessibility.

01995403 (158071)
• ESCWA now displays an improved message if there is an issue with loading the application, especially

in the case where there is a browser incompatibility.

(241013)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

00370773 (11742)

Cumulative Changes from Mainframe Express to Enterprise Developer for Eclipse | 143



• In ESCWA, the Console Log page now enables you to easily traverse and navigate the log. The new
paging feature uses an API call from the Communications Server group documented in the Enterprise
Server Administration Server API, typically located at http://localhost:10086/docs/#/
Communications_Server on the machine where you have the product installed.

02085456 (191017)
• ESCWA now supports multiple PACs in a single Redis store.

(248003)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

(91001)
• In ESCWA, the IMS MPR Processes table on the Monitor > SEPs page now displays the new IMS Type

and PROCLIM columns from MPR PWFI support.

(182066)
• In ESCWA, on the Communications Process page you can now specify a Requested Status for the

communications process.

00669779 OCTCR50A69378 (69378)
• In ESCWA, the CICS DCT resource now displays all fields regardless of the type. See Transient Data

Queue in your product Help for more information.

(173056)
• In ESCWA, the Catalog DCB page now displays the file size in bytes.

01909652 (138002)
• ESCWA now supports Circular Logging. On the Tracing and Logging Settings page you can now

specify the Log Max File Size and the Log File Count fields. By default, these fields are set to 1024kB
and 5 respectively. See Tracing and Logging Settings in your product Help for more information.

02083633 (191019)
• In ESCWA, a new optional Logon security resource has been added. This can be used to control

users' ability to log on. See Security Resources to Control ESCWA and API Access in your product Help
for more information.

01886579 (124022)
• CICS THRESHOLDS now support IMS. Notes modified in the following three topics:CICS Defined

THRESHOLDThresholdActive Threshold

(246113)
• You can now define and install shared SOR Models. In the SOR Model dialog box, check Shared to

enable the SOR Model to be shared between PACs. 

(244088)
• CICS Resources can now only be created via the group if they are appropriate for the functionality of

the enterprise server region.

01858819 (148068)
• For LDAP-based security in Enterprise Server, the processing of password changes has been modified

to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security now denies a sign-on attempt by default if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)
• A change has been made to the way that TS queues and TD queues are stored in a PAC. This was to

ensure that deleting a 0TSQ did not also delete all queues that had a 0TSQ_ name prefix.
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Note: After the update is applied you must cold start your PAC.

(183044)
• In a PAC, the SIT setting is now honored when a TS or TD is to be applied to the enterprise server

region if the TS or TD is not under a SOR, MFDBFH, or Fileshare. This means that if a SIT has to cold
start for TS or TD and the files are either in the workarea or on disk then the SIT settings will be applied,
otherwise the PAC-wide settings will be applied.

02149316 (204020)
• EZASOKET traffic will now be assigned to Communications Process instance #1. You might need to

consider this if you use load balancing.

02060014 (201009)
• When a PAC is cold started, the configuration file specified by MFDBFH_CONFIG will be uploaded to

the PSOR and a temporary file created in the enterprise server region’s workarea. This temporary file
will be used by all the processes for that enterprise server region. Subsequent enterprise server regions
joining the PAC will then create a temporary file in its workarea for the MFDBFH_CONFIG from the
PSOR store. If an enterprise server region in the PAC is killed or is terminated abruptly than the restart
of the enterprise server region will try to recover the previous UUID left in the PAC and DEQ all
remaining ENQs in MFDBFH that were created from the previous run. New messages will be created in
the console.log identifying if the recovery was initiated and successful, if the enterprise server region
could not be recovered automatically, the region will stop. A log file will be created in the workarea with
the following file naming convention:

 Caspac_Recover_UUID_xxxxxxxxxxxx.log

For example: CASCD4012W Region was not stopped properly, recovering previous region UUID
14BAAA87B4C010BFBDE278A5F65B350C 18:15:17CASCD4014I UUID recovery file log C:\Users
\mag.CORPDOM\Documents\Micro Focus User\Enterprise Developer\WORKAREA
\RAS1\Caspac_Recover_UUID_14BAAA87B4C010BFBDE278A5F65B350C.log 18:15:18. Using
the caspac utility with the -aStatus parameter will display if the enterprise server region in a PAC has
lost its connection to the PSOR. If you determine that the region is no longer in the PAC, then you can
run the caspac utility with the -aRecoverUUID parameter to recover the enterprise server region. If
the -aRecoverUUID parameter is used, then a file will be created in the current directory with the
following file naming convention:

02081952 02123645 (182093)

Caspac_Recover_UUID_xxxxxxxxxxxx.log. 

See caspac in your product Help for more information.
• Functions have been added to file_utilities which check a given file name against either a default

blacklist containing operating system reserved file names, or a passed blacklist. Read, write, and delete
in AES and MSCPD use this function to disallow secret names which are inappropriate names.

OCTCR50A7844 (112022)
• The default users are now able to access only the corresponding areas:

mfuser -- esmaccicsuser -- CICS and enterprise server region start and stop.
jesuser -- JES related operations and areas.imsuser -- IMS related operations and areas.

01990931 (138369)
• Fileshare is no longer used to locate the Resource Definition and CNV file.

00468648 (69010)
• MQ updates did not rollback on step failure. This has been fixed.

01976727 02161235 (155010)
• PSOR stores are now prefixed by the PAC NAME and a version number enabling you to run multiple

PACs in the same PSOR, simplifying the incompatible upgrade process. The caspac utility enables you
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to add the PAC Name as part of the command line parameters using -pPACName or if not specified
using the ES_PAC environment variable. See caspac in your product Help for more information.

(202162)
• The XA reconnect mechanism now attempts to reconnect to all XA entries marked as "enabled" at the

start up of the enterprise server region. To prevent the reconnect attempts, do one of the following:

• Remove the XA manager from the enterprise server region definition.
• Set the XA manager as disabled before starting the enterprise server region.

01991481 02003277 (151008)
• A new MLDAP ESM custom configuration section has been added. The [Prefix Search] option

enables the Prefix Search wildcard optimization for limiting the scope of wildcard resource entities
checked under a resource class. See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

00726158 (73180)
• For LDAP-based security in Enterprise Server, the processing of password changes has been modified

to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security will now by default deny a signon attempt if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)

File Handling

Back to the list

• The connection registration process has been enhanced to rectify a problem where XA registrations
sometimes failed to register with MFDBFH in an Oracle RAC environment.

Note: This fix is dependent upon the Oracle XA switch module being recompiled with the latest XA
switch sources.

02214893 (246077)
• SYMNAMES support has been added to the ON operand in the SELECT statement of ICETOOL.

02040047 (167028)
• When using the SELECT operator of the ICETOOL emulation, a validation check has been

implemented to ensure that when making use of the DISCARD operand, the data set opened for output
does not have an LRECL greater than the LRECL that ICETOOL is expecting. If it does, the job will
fail.This check may now cause jobs that previously ran successfully to now fail, but this behavior is now
consistent with that of the mainframe.

01978959 (199001)
• Micro Focus' ICETOOL emulation now sends carriage control characters in the LIST data set by default.

The RECFM of the LIST data set will be FBA. If NOCC is set, the carriage control characters are
suppressed and the RECFM of the LIST data set will be FB.

01685295 (97066)
• There have been some performance improvements for files opened exclusively (i.e. DISP=OLD,

DISP=NEW, and DISP=MOD), in batch jobs running under Enterprise Server.

00780741 (101034)
• The dbfhadmin utility has been enhanced to allow the integrity of a datastore to be verified, and

optionally, fixed up: use the dbfhadmin -verify -list|-recover options. See The dbfhadmin
Command Line Utility in your product Help for more information.
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00778044 (90143)
• The dbfhadmin command-line utility has been enhanced to provide the capability for verifying and

optionally repairing (cross-)region databases.

02123645 (193071)
• The cross-region database heartbeat interval can now be configured using the dbfhconfig -add|-

update -heartbeat interval-in-seconds command. The default heartbeat interval remains as
5 seconds. A warning message is now output to the Enterprise Server console during region database
start-up if the heartbeat interval is configured to be >15 seconds. The larger the heartbeat interval, the
longer the time that is required to be able to recover (cross-)region database resources. Recovery can
only take place for a process if its associated heartbeat record has not heartbeat within the last
"heartbeat-interval + 5" seconds.

02155269 (202149)
• The performance of PostgreSQL optimized I/O has been improved. If you use the psqlodbc device

driver, you will need to ensure that you are running with version 12.02.0000 or later. This change has
been tested with version 13.01.0000. To take advantage of the performance benefits of this change,
specify BatchSize=100 for each of your ODBC DSNs. Using a version of the driver earlier than
12.02.0000 could result in a performance degradation when deploying large files to datastores.

(125032)
• Table record locking and database record locking are incompatible and may lead to data corruption if

used together by separate processes when processing the same file. MFDBFH has been enhanced to
ensure that if a file is already opened in a process with table locking, all other processes attempting to
open the same file, even if requesting database locking, will also use table locking. However, if a
process has a file opened using database locking, other processes attempting to open the file will only
be allowed to do so if they are transactional files (i.e. database record locking can only be used for
transactional files). An attempt to open the file as non-transactional will fail. Refer to the Record Locking
Strategies documentation for more information.

(102011)
• MFDBFH now enforces the existing requirement that a region database used by a PAC, or a region

database used by an ES region configured to use ES_LOCK_DB, is not used by any other PAC or
ES_LOCK_DB regions. This is necessary to avoid problems such as jobs with the same name
submitted to two separate regions, but erroneously using the same region database, from being blocked
by waiting on SYSZJOBD and/or SYSZJOBN ENQs. A check is now performed during region start-up to
ensure that the region database is not already being used by another region, If it is, the region start up
will fail, with error messages indicating the cause of the failure output to the ES console. Existing ES
PACs/regions will need to be stopped and restarted for these new region database state checks to take
effect. The dbfhadmin -region -status [-reset] command has been introduced to allow a
region database's state to be displayed and, optionally, reset. See Resource Locking in your product
Help for more information..

(121030)

JCL Support

Back to the list

• The User Exit event has been updated to contain the date and time of the job submitted when the job-
ready event occurred in the past. To make use of this functionality, you must recompile the CAS User
Exit Event Manager. See mfjdjevt.cpy for more information.

(177018)
• A new environment variable, ES_JES_ENFORCE_EXPIRE_DATE , has been added to determine

whether or not to check the expiration date when deleting a catalogued dataset, and if expired, delete
the dataset. If it hasn't expired and the PURGE option has not been specified, the dataset is not
removed. The PURGE keyword is required to delete non-expired datasets. PURGE removes the
underlying physical dataset file unless it is referenced by another catalog entry.SMS
MANAGEMENTCLASS now supports maximum RETAIN days. See the example of the %SMS
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command in the Using SMS MGMT Classes topic in your documentation.The EXPDT entry in a DD
statement must be a four-digit year (YYYY); otherwise 1900 is the default, which is in-line with the
mainframe processing, and prevents unexpired datasets from being erroneously removed (as was the
case with the previous default of 2000).

3190103 00368441 (12368)
• A change in behavior of the evaluation of step COND CODES has been made. The new behavior is that

step ABENDS now take precedence over normal return codes. This corrects a problem that caused a
step that returned a higher decimal value than an earlier step ABEND code to take precedence and
become the job COND CODE.

02210859 (244066)
• It was possible to run a job without required enques. To correct this, an error now occurs at the start of a

job if the required enques are missing, and the job does not run.

02164345 (203249)
• SYSOUT datasets that were referenced in later steps were incorrectly marked as temporary, and

therefore 'PASSED' on in the job. This caused them to be deleted at the end of the job. To correct this,
those SYSOUT datasets are now 'RETAINED'.

00713567 (69460)
• The ALTER command now takes the TO and FOR options to enable specification of the retention period

for the entry being altered. The maximum retention period may be limited by the management class. 

3190103 00368441 (12249)
• The IDCAMS LISTCAT command ALL parameter now generates a separate HISTORY report that

shows the creation date time and job, the last changed date time and Job, and the expiration date.A
new environment variable, ES_JES_LISTCAT_YMD, has been added to determine the date format used
in the HISTORY report generated when the IDCAMS LISTCAT command specifies the ALL option.

3190103 00368441 (11429)
• The validation of configuration settings used by JES has been improved, together with more detailed

error messages.

02041040 (165046)
• Support for DSENQSHR has been added to JES via the ES_DSNQSHR environment variable. See the

ES_DSENQSHR topic in your product documentation for full details.

01818520 (111002)
• Two new spool housekeeping performance options, USE_DISK_HK and

DISABLE_LOCK_FOR_BULK_DELETE, have been added to enable spool housekeeping to be
processed on a local disk instead of the server. See Configuring the MVSSPLHK Housekeeping
Process in your product Help for more information.

00367284 (79030)
• GDG model support has been updated to support the assignment of an empty subdirectory value in the

allocation override configuration (see the JCL - Allocation Override sample in the Mainframe Samples
Browser).

02177846 (209041)
• In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not

validated for user access. This has been corrected. If the user does not have permission to access
(READ) the dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient
authority to read dataset '<DATASET NAME>'." is written to the SYSTSPRT. A message is also written
to the job log: "*MSG User not authorised to access SYSEXEC <DATASET NAME>". This fix might
require updates to the DATASET access rules.

02144158 (248013)
• In a security-enabled region, the dataset containing a REXX or TSO command was not validated for

user access. This has been corrected. If the user does not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
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dataset '<DATASET NAME>'." is written to the SYSTSPRT. This fix might require updates to the
DATASET access rules.

02144158 (208030)
• A problem that erroneously caused some user-supplied parameters to translate from EBCDIC to ASCII

when calling DSNRLI has been corrected. The dsnrli.cpy copybook and dsnrli.inc PL/I include
file have been revised to have the full declaration of ACCOUNT-STRING. You must recompile
copybooks that use either of these modules.

(161065)
• The JCL spool file has a new format. Starting with this release, you must use the mfsplcnv tool to

convert spool files created using a previous release from the old format to the new. See Spool Files and
mfsplcnv Spool Conversion Utility in your product Help for more information.

(113011)
• An excess of 999 duplicate DD statements per step caused a hang in JCL processing. This has been

corrected and an error message indicating that this number has been exceeded is now generated
(JCLCM0640U).

00775329 (90002)
• The new MFJ_LEX_LOCATION JCL environment variable enables you to specify an alternative location

for the storage of JCL lexigraphical files, which are created when a job is parsed, and stored in the
same directory as the job log by default. The alternative directory location must be accessible by all
regions that both submit and run jobs.

(116002)
• The layout, including the position of fields, in the IHAPSA.MAC and IKJTCB.MAC copybook files used to

hold information for the JCL control blocks for PLI programs has changed. To apply this fix to existing
applications, recompile and validate all PLI programs that include these copybooks.

(105043)
• MFFTP now converts from EBCDIC to ASCII in PUTs and from ASCII to EBCDIC in GETs, for files

cataloged as EBCDIC when a TYPE A or ASCII sub-command is issued and when the new
environment variable MFFTP_ASCII_CMD_XLATE is set to Y (default is N).

02157927 (202176)
• JCL job behavior has been updated to address an issue that caused the generation of a //SYSIN entry

when non-JCL statements, such as blank lines, preceded the first step. The generated //SYSIN entry
is now marked as invalid, and a JCLCM0642U parsing error is issued.

00368443 (11497)

Machine Administration

Back to the list

• A problem with using the .NET 3.5 framework has been fixed.

(204144)
• A problem with CPU conversion has been corrected.

(199042)

Mainframe Access

Back to the list

• Previously when authenticating with the mainframe, login failure messages provided too much
information which could potentially be exploited for username enumeration. Login failure messages will
now only state that invalid credentials were provided. This applies to MFDAS, MFDASMX, Mainframe
Explorer in Eclipse and Visual Studio, MVS Explorer in Eclipse, and SyncMon.

01868545 (119073)
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Micro Focus Communications Server

Back to the list

• When an enterprise server region is configured to use External Security, access to the Communications
Server's "statistics" Web page is now restricted, just as access to the Communications Server log is. To
permit access to this page for secured enterprise servers do one of the following:

• Disable Communications Server control listener security by adding the following to the
Configuration Information field for the communications server:

[security]control listener=noInstruct

Users must provide Enterprise Server credentials when prompted. This can occur when you attempt
to view the page, and when Allow unknown resources is checked in the region security
configuration (use this with caution)

• Add a resource security definition named "Statistics" to the "Communications Server" class, with an
ACL that grants READ permission to those users who should have access to the page

00368582 (11442)

Micro Focus Batch Scheduler Integration

Back to the list

• The Micro Focus Batch Scheduler Integration (MFBSI) no longer hangs while waiting for a response
from the license manager.

02006571 (162055)

Micro Focus Directory Server

Back to the list

• The mfds /s option supports the specification of the optional Enterprise Server user id and
password parameters using a configured Micro Focus Vault Facility location rather than using literal
strings for credentials. For example:

mfds /s 1 mfsecret:user/user_001/id mfsecret:user/user_001/pwdwhere user/
user_001/id and user/user_001/pwd

Are secrets stored in the default-configured vault. These values can be populated and administered
using the mfsecretsadmin utility. See Vault Facility in your product Help for more information.The
mfds /x and /g command-line options also support credentials stored in the vault.

02131532 (193088)
• If MFDS is configured to store sensitive values in the vault (for example, XA openstring or autostart

credentials), these values were not being included in legacy data format or XML export of Enterprise
Server configuration information. Subsequently, these values could not be reimported. These sensitive
values are now included in the exported data. Micro Focus recommends that you protect the exported
files with appropriate access control.

(202272)

PL/I Support

Back to the list

• Previously, if STRINGRANGE had been enabled by the -prefix stringrange compiler option, and
a user program did not contain an ON STRINGSIZE statement, there was no message printed out
indicating that STRINGRANGE had been triggered. The message now appears in this scenario.

00696776 (73031)
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• Nested TYPEs (TYPE of TYPEs) are now supported.

00366179 (11649)
• Nested LIKEs (LIKE of LIKEs) are now supported.

00366181 (13419)
• A problem that prevented the CONTROLLED parameter from displaying correctly in the compiler listing

has been fixed.

01916288 (130002)
• The compiler listing file has been updated to provide enhanced output when the -xref compiler option

(cross-reference listing) is in effect. The listing file now indicates which variables and other identifiers,
such as procedures and labels, are unreferenced, and where they are declared. This helps you to
eliminate unnecessary declarations, thus reducing storage requirements and improving code readability.
Where a member of a structure is referenced, this flags the entire structure as referenced. External
variables and procedures are not flagged as unreferenced. To accommodate include files, the
nomenclature for a definition (DEF) or reference (REF) in the cross-reference listing is a number of the
form n.m, where n is the line number and m is a file identifier. A list of file indenters and corresponding
file names is generated at the end of the cross-reference listing. 

02159460 (203162)
• The compiler listing file has been enhanced to indicate which variables and other identifiers, such as

procedures and labels, are unreferenced, and where they are declared. This helps you to eliminate
unnecessary declarations, thus reducing storage requirements and improving code readability. Where a
member of a structure is referenced, this flags the entire structure as referenced. External variables and
procedures are not flagged as unreferenced. To accommodate include files, the nomenclature for a
definition (DEF) or reference (REF) in the cross-reference listing is a number of the form n.m, where n is
the line number and m is a file identifier. A list of file indenters and corresponding file names is
generated at the end of the cross-reference listing.

01858879 (120030)
• An application doing a WebSphere MQ SIGNON caused an invalid result from a PL/I exponentiation

calculation if WebSphere MQ was using a locale other than C/Posix. This has been corrected for the
de_DE or derivative locale.

01991479 (155012)
• I/O directed by PUT LIST now uses BX format for type OFFSET.

(195051)
• A problem with PLIDUMP prevented control from being returned to the ON ERROR after completing the

dump when PLIDUMP was driven with the H option from an ERROR on unit that had established ON
ERROR SYSTEM. This has been fixed.

02134496 (194112)
• The dumping of H(eap) memory in a PLIDUMP now checks for patterns of three or more identical lines

and issues a "same as above" message indicating the memory range instead of printing the entire
batch of lines.

02160703 (204151)
• When using the PLIDUMP facilities H option on a system that had an artificial limit on maximum file

sizes, an infinite loop sometimes occurred if that maximum file size was reached. This has been
corrected. The PLIDUMP is now truncated at its maximum allowed size.

02162046 (203155)
• Previously, when using PLISAXA, the document length as driven to the Start of Document event was

incorrect if the XML document contained characters that exceeded hex 7F. This has now been fixed.

00381945 (61228)
• A new built-in function. SQRTF, has been added to generate an ERROR condition if its condition

operand is negative. The SQRT function has been updated to do the same. Previously, SQRT
sometimes returned a floating-point NaN.
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(193100)
• In previous releases, FIXEDOVERFLOW was not raised when an attempt was made to assign a value

to a FIXED DECIMAL variable that was too large, causing the value to be truncated. The behavior has
been changed to raise an error if FIXEDOVERFLOW is not present.

02163371 (204181)
• The PL/I run-time system has been enhanced to honor the READ FILE(xx) IGNORE(x) syntax for

sequential files.

02047425 (183067)
• The OPTIONS(NOEXECOPS) attribute of a procedure statement is no longer ignored, but is now

honored for programs running under the control of JCL.

3238380 (11686)
• A new feature, PL/I data breakpoints has been added. A data breakpoint breaks execution when a

specified memory location is written. Use of data breakpoints assumes expert-level knowledge of how
memory works, how variables are allocated, and how data is written to memory. For complete details,
see the Using Breakpoints topic in your product documentation.             

00370003 (12178)

REXX Support

Back to the list

• In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not
validated for user access. This has been fixed. You do not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
dataset '<DATASET NAME>'." is written to the SYSTSPRT. A message will be written to the job log:
"*MSG User not authorized to access SYSEXEC <DATASET NAME>".Note: This fix might require
updates to the DATASET access rules.

(247033)
• EXECIO * DISKW was stopping on the first line containing no characters, writing out no further records.

Now after encountering an empty record, a line with only a linefeed is written and processing stops.

01991499 (158007)

Run-time System

Back to the list

• The native COBOL multi-threaded demo is now available for Windows development products.

(3765)
• Basic support for xterm-256color has been implemented.

(57591)

SQL: OpenESQL

Back to the list

• A performance problem in a SQL program using fixed-length character arrays when compiling a COBOL
program and using array fetch has been resolved.

02152406 (203060)
• A new feature to assist migration between databases has been added. SQL error codes and messages

may be mapped to different values or supressed to match those expected by the application.

(193003)
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SQL Option for DB2

Back to the list

• An incorrect SQLCODE of -406, indicating a decimal value was too large, has been resolved by an
update that ensures flag bits for query constants are full initialized within the query common space.

00739861 (86050)

Significant Changes in Enterprise Developer 7.0
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• Application Workflow Manager
• Assembler Support
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Eclipse IDE
• Enterprise Server
• File Handling
• Header-to-COPY Utility
• Interface Mapping Toolkit
• JCL Support
• Licensing requirements
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• PL/I Support
• REXX Support
• Run-time System
• SQL: Mainframe Batch Database Tools
• SQL: OpenESQL

Application Workflow Manager

Back to the list

• The checkout tool has been extend with the new input parameter "Resource Depth" which indicates
how the checkout will be performed. Allowed values are:

5 Infinite (all files and folders are check out recursively).
4 Immediate (direct files and empty folders are check out).
3 File (only files are check out).
2 Empty (the selected resource is check out without content).

See Checkout in your product Help for more information.

00486821 (71096)

• The ChangeMan attachment model now enables you to define job cards by a context menu action on
the application level. The action "Set Job Cards" is provided under the group "Quick ChangeMan
Access". If job cards are set, they are used in ChangeMan actions which submit a job, for example, the
build action.
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(10698)
• There are now new import/export functions available in the filter definitions view. The import/export

functions are available as context menu and tool bar actions.

00371941 (13136)
• The Endevor attachment model now displays an error message when an attempt is made to open a

nonexistent element for editing.

3221338 (12418)

Assembler Support

Back to the list

• Define Constant character items are now filled with EBCDIC spaces when you specify a null character
string to match the IBM HLASM behaviour. For example:

ALAB 40C'' or ALAB CL40''

DC C'' instructions are now IBM HLASM compatible. This should not affect any customer but some may
notice cobol like DEFAULTBYTE(X'40') values in their DC C... data items now. Such a change should be
innocuous for existing customer programs.

3237050 (12504)
• On Unix/Linux environments assembler data tables (.MOD files) can now be generated entirely from the

command line with the new MFMODGEN utility:

mfmodgen   filename.MLC

This assembles and links filename.MLC to filename.MOD suitable for use in EXEC CICS LOAD
COBOL statements.

00367288 30004 00377337 (11608)

Common Communications Interface

Back to the list

• The default TLS Security Level has been increased from 0 to 1. This change will not affect you if you
have specified your own security options.If you rely upon the default TLS security options you might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See Security Levels and Specifying a Server Protocol and Cipher Suite Preference in your product Help
for more information on the change to Security Level 1.

(8453)

Communications Server

Back to the list

• The functionality of GIVE and TAKESOCKET have been modified to make them more similar to the
documented IBM behavior:

• If a caller issues a GIVESOCKET specifying a subtask, then only a caller will be allowed to take the
socket if they specify the same subtask.

• A caller can supply an empty (spaces) subtask on the client parameter to indicate that anyone can
take the socket.In order to achieve this, a dummy client is inserted during a GIVESOCKET call if the
subtask name does not match an existing client entry.

00422057 (59129)

Compiler

Back to the list
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• Programs with file records greater than the documented limit of 62KB will now generate an error that
they previously did not (COBCH0649) - although being an E level message, the program can still be
executed and will work if it did so previously.

3227892 (12447)
• Two of the available Ant parameters for compiling COBOL programs have been renamed as follows

(functionality remains the same):

• forceCompile becomes mf.forceCompile
• threadCount becomes mf.buildThreadCount

3230709 (12665)

Data Tools

Back to the list

• The editor now automatically selects the first record in comparison when first loaded. The Editor will
automatically select first record in comparison when first loaded

3212848 (11362)
• Data File Tools now provides the Data Explorer, which is a catalog view that can connect to either

ESMAC or ESCWA. When connecting to ESCWA, it enables you to open multiple data sets.

(70242)
• The scrolling speed for formatted records has been increased.

00366018 (11378)

Eclipse IDE

Back to the list

• In Server Explorer, the "associate with project" option is not longer available for remote servers. Remote
servers are defined as any belonging to a remote directory server or remote ESCWA.

(57093)
• When using the embedded Rumba display in Eclipse, three new features have been added:

• Secure server connections using SSL/TLS.
• Multiple TN3270 display views: one view per connection.
• Import and export connection details. Additionally, the connection information is now retained

between workspace restarts.

See Running Applications in a TN3270 Mainframe Display in the product documentation for more
details.

(9212)
• The Format Program option is no longer available for projectless files. Instead, select the Format option

and the text you want to format.

(8743)
• Customers using Eclipse on Windows who connect to a Development Hub on UNIX can now create

remote unit test projects. Remote unit test projects are available for native COBOL when you use a
Samba or RSE connection to the DevHub.

3164533 (13318)
• Within a debug configuration for a remote project, you can now specify source files and debug symbol

files that reside on remote hosts other than the one containing the remote project.

00363627 (12609)
• When starting a server from Server Explorer, if that server is unsecured, you are not prompted to add

any credentials.
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(62136)

Enterprise Server

Back to the list

• The structure returned by EXEC CICS ADDRESS ACEE now conforms to the IBM IHAACEE definition.

3241109 (11667)
• There are more security checks performed in addition to the verification against casout under the

OPERCMDS class. Depending on what options are used, checks are also performed to ensure that the
user has access to a particular job - such as for restarting, modifying, or viewing datasets. The
corresponding rules are under the JESSPOOL class. When trying to retrieve a dataset, additional
checks are made for the particular dataset being accessed. This is also under the JESSPOOL class.

3234588 (11576)
• Previously, there was no security check performed when an ESMAC user tries to access the console,

traces, or dumps. This is no longer the case. If you use LDAP-based security you can now add the new
DIAGS resource under OPERCMDS class and provide access to ESMAC users accordingly.

3231918 (12556)
• When locks are being stored in a database (for example, when running in a PAC), a CICS ENQ will, by

default, be stored in the region database. ENQs are directed to the cross-region database if they match
an ENQMODEL that has an ENQSCOPE value that is not equal to spaces. This enables ENQs to be
shared outside of the region (or PAC). There is a performance overhead to storing ENQs in the
database. If an application uses ENQs and does not need them to be shared outside of the region, then
you can specify the new attribute in the ENQMODEL resource to direct matching ENQs to shared
memory, this can improve performance. For example, this might be used for an application running in a
PAC that issues multiple STARTs to each ENQ on the same resource. In this case, the STARTed
transactions will all run in the same region and it would be safe to store those ENQs in shared memory
provided that the resource being ENQed on is unique to these STARTed transactions. Note: An EXEC
CICS START that uses the TERMID option might not run in the same region as the STARTing program.
When running in a PAC, the transaction will be transferred to whichever region the terminal is connected
to. In this case, it would NOT be safe for ENQs taken by the STARTed transaction to be stored in shared
memory. You can now specify the _SHAREDMEM option in the ENQMODEL resource to enable
matching ENQs to be stored in shared memory when running in an environment where locks are
normally stored in a database, such as a PAC: _SHAREDMEM(YES | NO) The default value is NO.
Specifying an ENQMODEL with _SHAREDMEM(YES), will store matching CICS ENQs in shared
memory.Caution: This option should only be used if the ENQed resource will not be accessed by any
other region.

00367119 (13432)
• An abend in the service provider CICS application was not being propagated back to the soap client

when CICS WEB SERVICES were used. This has been fixed.

00365431 (13583)
• The "Requested Licenses" field has been removed from the ESCWA General Properties page as it is

not used.

(3956)
• If CASRDO44_NEWSUB=OFF has been specified in the region's Configuration Information field of the

General Properties page or as an environment variable, then the JES control page will submit only local
jobs, rather than remote jobs.Behaviour Change:When CASRDO44_NEWSUB=OFF is specified in the
region environment, the JES control page will allow for submission of local jobs, rather than remote
jobs.

(9431)
• Added the option to delete the associated package when the service has an associated package and

that service is the only one with that associated package.

00370971 (22264)
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• When a new region is created in ESCWA, the Web listener's conversation type is now correctly set to
"Web" instead of "SOAP and J2EE (legacy)".

3244594 (21270)
• The Group can now be specified when starting or stopping a region using ESCWA.

00371543 (12436)
• For Enterprise Developer 6.0 and later, the installer on Windows has automatically started the

Enterprise Server Common Web Administration (ESCWA) service as part of the installation process.
When using the Japanese system locale on the Windows operating system, the ESCWA service does
not start automatically. During the installation process you might be required to press Retry to complete
a successful product install. Even after a successful product install, ESCWA does not start until you
have installed a valid license.

00368527 (12747)
• Added StepCC to the Spool DD Display page in ESCWA.

3236954 (13587)
• The Initial Tran field on the region ES Control page has changed from a list to a text box field.

3232139 (11506)
• In ESCWA, the Security Manager properties could be set too long, causing a crash. This has now been

fixed.

(61192)
• This fixes an issue with the change to the behavior introduced with the passtoken changes in previous

patch updates. An issue might occur in a stacked environment with OS ESM and MLDAP_ESM. Job
dispatch would issue a deny when cassub was used.

3229601 (11524)
• An issue when using a secured MFDS, with an LDAP ESM as first in the stack, and a PAM ESM as

second in the stack, and with federation enabled, has been resolved.Previously, if the security was
reinitialized through any means (such as clicking the apply button, or reordering the ESMs and
changing them back), the MLDAP ESM would not be able to correctly determine that the PAM ESM
user user1 in group1 matched the LDAP resource rule which described group1 within the resource rule.
This should have worked because the group information is shared when federation is enabled.With this
fix, the resource rule in LDAP correctly identifies that the group1 rule applies to the PAM ESM user
user1, on both initialization and reinitialization.Behaviour Change:When SAFMGR was reinitialized,
PAM ESM was pointing to the old shared groups table, so MLDAP ESM and PAM ESM ended up
pointing to different shared groups tables. It should have been the same table as federation was
enabled.PAM ESM groups table is now cleared on initialization, so that the ESMs will now point to the
same groups table.

3221760 (11697)
• EZA Socket transactions failed under load. To fix this a new version of the CSKL transaction has been

supplied with the product (EZACIC02.cbl).

00422057 (51114)
• ESMAC now includes cross-site request forgery protection. A 403 Forbidden page is now returned

whenever a user attempts to bypass the protection. If you want to access more than one region in
ESMAC at the same time, it can no longer be done in the same browser session. You can access the
regions in separate private browsing sessions.

3216052 (13208)
• A new resource class, DCBINFO, enables you to control who can access the DCB information for

cataloged datasets in ESMAC for a LDAP secured region. DCBINFO must be created for existing users
to be able to access the DCB information in ESMAC.

3231918 (13300)
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• We now take note of VALUE clauses for fields and properties defined in a JVM attribute (annotation),
and output the default value to the class file. When using an attribute, any field that does NOT have a
default value must now be specified explicitly.

(30021)
• The call format of the first parameter of CEEGTJS has been corrected to be "call by reference" rather

than "call by value".

3231324 (12494)
• MQ commands did not work because Windows installations of MQ are client, not server. This has been

ccorrected.

(46022)
• MFDS now correctly uses the specified region user in the ESCWA Directory Server Scripts page or

Directory Server user in the ESCWA Directory Server Configuration page. Otherwise, it defaults to the
current user.

(8727)
• If MFDS is set to "Restricted Access" and the MFDS "Anonymous access" option is off (the default),

then valid authorized credentials will be required to access information stored in the Directory Server
either via the legacy UI, ESCWA, or utilities such as mdump.

(62100)
• When MFDS is TLS enabled and a client connects on the non-TLS port, it will now send a HTTP 302

Found response to the client to redirect it from the non-TLS port to the TLS-enabled port. This is
seamless to the Web browser.

(46024)

File Handling

Back to the list

• The key definitions of newly-created database-hosted files and existing files deployed to a database will
now be honored. Previously, all alternate keys were being created by MFDBFH as "with duplicates"
irrespective of how they were specified in the key definition area of the FCD. This affected files both
created directly by COBOL programs, and those deployed into datastores from disk. One of the side
effects of this problem was that if a catalog and associated SPL*.dat files were extracted from a
datastore, and a CAS JCL region configured to use them, JES failed to initialize during region start-up
due to a file status 3/9 occurring on the SPLJOB.dat file. The dbfhdeploy utility has been enhanced
to allow the keys of existing files to be listed, and to be changed from "with duplicates" to "without
duplicates" if required. It is strongly recommended that if you are using a database-hosted catalog and
associated spool files for an Enterprise Server JES region, that you update the SPLJOB.dat file's
alternate keys by running the following commands:

dbfhdeploy keys 1:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

dbfhdeploy keys 2:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

dbfhdeploy keys 3:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

dbfhdeploy keys 4:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

dbfhdeploy keys 5:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

dbfhdeploy keys 6:dup=n sql://MYSERVER/MYFILES/SPLJOB.dat?folder=/MyFolder

See The dbfhdeploy Command Line Utility in the documentation for more details and examples.

00372425 (69057)
• Within MFDBFH, enhancements have been made to optimized I/O to further improve

performance.Enterprise Developer 6.0 and Enterprise Developer 7.0 only: The dbfhconfig utility has
been enhanced with the addition of the -optiokeyreads and -optioseqreads command-line options.
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These options are used to override the default number of records read ahead by MFDBFH when
optimized I/O is enabled.

00726932 (83019)
• MFJSORT now supports RESTART in SEQNUM processing. The format RESTART=(p,m) is supported.

00368449 (13606)
• The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (12477)
• A File Handler limit on the maximum record size (62KB) has resulted in the documented limits for data-

driven unit tests to be revised. See Restrictions in the Micro Focus Unit Testing Framework.

(25064)

Header-to-COPY Utility

Back to the list

• When h2cpy is used to convert C header files to COBOL copy files, function prototypes with const *,
which produce BY REFERENCE parameters in the ENTRY statement for the COBOL call prototype, will
now include the CONSTANT reserved word. In this context, it means the variable is read-only in the
callee, just like in C.

(10214)

Interface Mapping Toolkit

Back to the list

• Headers are no longer mapped in the output of WS2LS.

3235120 (12606)
• Top-down CWS generation from WSDL now properly marks hexBinary fields in the generated WSBIND.

3236069 (11690)
• WS2LS now assigns usage COMP-3 to items mapped from decimal and integer types in the

WSDL.Behaviour Change:WS2LS will now assign usage COMP-3 to items mapped from decimal and
integer types in the WSDL. This will affect the generated copybooks and WSBIND. Previously-
generated files will still work, and users should be using the WSBIND and copybooks from a single
execution of WS2LS in their environment anyway, since changing one results in (or reflects) changes to
the other.

3235120 (13494)
• In copybooks generated by WS2LS, several data types now have mappings that are closer to those

generated by IBM's DFHWS2LS.Behaviour Change:In copybooks generated by ws2ls, several data
types will now have mappings closer to those generated by IBM's DFHWS2LS.

00365433 (11693)

JCL Support

Back to the list

• The IDCAMS DEFINE ALIAS command has been added to enable you to create an ALIAS, or, for a PO
member, the TSO RENAME ALIAS command. When referencing an ALIAS, the related dataset is
resolved. You can also use SYMBOLICRELATE datasets, and the symbol is resolved at run time using
system symbols defined in SYS1.PARMLIB(IEASYM00).

00368450 (13425)
• The IDCAMS DELETE command has been enhanced to now accept % and * wildcards with the use of

the "MASK" keyword. Because support for multiple wildcards has been enhanced, IDCAMS commands
that previously reported a JCLAM0163S error and set CC to 12 may now be accepted and processed.
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00375690 00367509 00368440 (12180)
• The support for wildcards when using the IDCAMS LISTCAT command has been improved: both * and

% are accepted within the data set name, and multiple wildcards may be used; for example:

LISTCAT LEVEL(MFI01.MFI%%%%.D*.DAT)

00366749 (11515)
• When a job contains duplicate step names, you can now specify which step to start.

(69229)
• You can now restart a JCL job by specifying a value for MF_UCC11.

(71227)
• A new topic, Advanced Restart Functionality, has been added to the JCL documentation to document

the use of the casout /jrestart option, which enables you to restart a job with additional
parameters. The #t parameter to identifies the step on which to end a restarted job. See your product
documentation for details.

(70223)
• A new topic, Advanced Restart Functionality, has been added to the JCL documentation to document

the use of the casout /jrestart option, which enables you to restart a job with additional parameters. The
#k parameter enables you to specify whether or not ABEND and COND codes from a previous run are
used or not. In addition, the #k parameter enables you to specify the COND code to use for a specific
step. See your product documentation for details.

(70224)
• By default, a non-zero return code from a commit at the end of a unit of work for DSNAL or IKJEFT**

will now be reported and set a step abend code of S482. You can control this behavior by using the
MF_JES_ABEND_CAF_COMMIT environment variable; see JCL-specific Environment Variables in the
documentation for more details.Behaviour Change:A non-zero return code from the commit issued at
the end of a unit of work, i.e. when the program run as part of the step returns control to the JES
system, will now generate a message in the systsprt and cause the step to abend with the cond code
S482. This behaviour is configurable using the environment variable MF_JES_ABEND_CAF_COMMIT.
A value of ‘NO’ will provide the current behaviour, i.e. we ignore the return code. A numeric value (up to
3 digits) would cause that value to be used as the return code from running the program.

3239642 (11750)
• If a MGMTCLAS is defined for a dataset, it will be included in the MGMTCLAS field of the MFJCTLBP

control block.Behaviour Change:The mfjctlbp dataset control block will now include the MGMTCLAS if it
is defined in the catalog record for the dataset

3231081 (13361)
• A problem that set the wrong parameter override value for a step in a procedure because of the

alphanumeric ordering of the step names was not consistent has been corrected.

3235581 (12478)
• When changing a GDG roll disposition to EMPTY, the number of rolled-in data sets was incorrect. Now,

if a NONVSAM data set is defined in IDCAMS that is a GDG version, it will be included in the GDG set.

3238565 (12731)
• A problem that caused the incorrect resolution of output statements in steps with duplicate names has

been corrected. An output statement class of "*" is now replaced by the msgclass of the job.

(30104)
• The value of the ALTER NEWNAME will now be checked to ensure it conforms to naming convention

before trying to update the catalog. An error message, JCLAM0105S(12) - Invalid entry name syntax or
length, will be issued if the check fails.Behaviour Change:As per readme

3236388 (12641)
• When running in a PAC or with the MFDBFH database locking for multiple regions, active jobs are not

flushed at region start-up.Behaviour Change:As per ReadMe
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3227362 (12487)
• It is now possible to include a set of default ON conditions in the VSE configuration file and these will be

added to all VSE jobs.

3230967 (11486)
• User labels (DLBL & TLBL) are now removed when a new one is assigned following the running of a

program.

3213728 (12340)
• The system symbols file, SYS1.PARMLIB(IEASYM00), can use the EBCDIC encoding. Support for

EBCDIC programs calling the system symbol entry point, IEFSJSYM, has been added.

3226132 (11503)

Licensing requirements

Back to the list

• The following platforms - Solaris, Red Hat on IBM Z System, SUSE on IBM Z System, and Ubuntu - are
now licensed using a new licensing model called AutoPass. These platforms and licenses are not
available from the Software Licenses and Download portal (sld.microfocus.com) if you are using the
existing SafeNet license technology. To obtain AutoPass licenses for the aforementioned platforms,
contact your account manager to discuss your actual requirements, and also raise a support incident to
track the request.

Mainframe Access

Back to the list

• Users will now be able to specify a volume when cataloguing a data set.

(41007)

Micro Focus Batch Scheduler Integration

Back to the list

• The %%LIBSYM/%%MEMSYM Control-M function variable value is now delimited by the first ending space.
For values that request one or more embedded spaces, use the %%BLANKnn Control-M function.

00422148 (51104)

PL/I Support

Back to the list

• DEFINE STRUCTURE statements are now supported.

00368478 (12186)
• Previously, if STRINGRANGE had been enabled by the -prefix stringrange compiler option, and a user

program did not contain an ON STRINGSIZE statement, there was no message printed out indicating
that STRINGRANGE had been triggered. The message now appears in this scenario.

00696776 (73031)
• A performance bottleneck present in Enterprise Developer 5.0 and 6.0 has been resolved to provide

faster record I/O.

00669680 (71440)
• Previously, if a job was cancelled while in an active state, PL/I would, as part of RTS cleanup, attempt to

RELEASE all fetched routines. This resulted in a problem because some of the fetchables had the
potential to be active on the callstack and be in a non-cancellable state. This no longer occurs.

00368471 (27328)
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• Previously, if using PLISAXA() and XML Element's content contained a character greater than x"7F"
(ASCII), the CONTENT_CHARACTERS event would be driven twice - once for the characters that
preceded the x"7F", and once for the remainder. This no longer occurs and the
CONTENT_CHARACTERS event is driven for the entire XML Element's contents.

00381945 (30084)
• Previously, when using PLISAXA, the document length as driven to the Start of Document event was

incorrect if the XML document contained characters that exceeded hex 7F. This has now been fixed.

00381945 (61228)
• The diagnostic MPLIE0056 has been changed from a "Severe" level diagnostic to an "Error" level

diagnostic. This provides you with the ability to tailor behavior to your environments. If you wish
compiles to fail in this scenario, you can use the compiler message exit to bump severity back to "S"
level. If you do not wish to have an "Error" level diagnostic in this scenario, you can use the compiler
message exit to reduce severity to "W".Behaviour Change:The diagnostic MPLIE0056, which tells the
customer they have SQLCA declared in an internal procedure, has been changed from a "Severe" level
diagnostic to an "Error" level diagnostic. If the customer desires the old behavior they can bump this
diagnostic to an "S" level diagnostic using the compiler message exit, or if they intend to have the
potential confusion from having multiple SQLCA's declared they can bump the severity down to a
"Warning" level using the same compiler message exit.

3239052 (12538)

REXX Support

Back to the list

• EXECIO * DISKW was stopping on the first line containing no characters, writing out no further records.
Now after encountering an empty record, a line with only a linefeed is written and processing continues
with the remaining records.

00366667 (27187)

Run-time System

Back to the list

• When defining the file name for CBL_CREATE_STACKDUMP, %f now expands to basename of the
program correctly when used cross-process.

(60049)
• When CTF trace level is set to info (for post-offset values only) or debug (for pre-offset, offset and post-

offset values) and component rts#process is set to true, the API will now dump the captured metrics to
the output CTF file.

(27040)

SQL: Mainframe Batch Database Tools

Back to the list

• An equivalent of the mainframe DB2 utility DNSTIAUL, SQLTUL, is now available in the MBDT utility
suite.

2148818 (10857)

SQL: OpenESQL

Back to the list

• An issue with compiling native programs that use SQL TYPE IS XML AS CLOB has been resolved.

3240037 (12679)
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Significant Changes in Enterprise Developer 6.0
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Application Workflow Manager
• AppMaster Builder
• Assembler Support
• Call prototyping in library routines
• Common Communications Interface
• Communications Server
• Compiler
• Database Access - OpenESQL
• Data Tools
• Documentation
• Early warning of compatibility issues with current operating systems
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• File Handling
• Handling of Anonymous Root Field in JSON
• IDE
• Interface Mapping Toolkit
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• National data items in JVM COBOL code
• PL/I Support
• Rebuild required for projects unable to locate the Windows Resource Compiler
• Run-Time System
• SQL Option for DB2
• VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when

ODOSLIDE in effect

Adis

Back to the list

• In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.

3138718 (1112690)

Application Workflow Manager

Back to the list

• REST Connection function package attribute has been added, and Status Handlers for REST tools. See
"REST Function Package" in your product Help for more information.

• If the Search button is used in the Endevor attachment application, duplicate values are no longer
displayed in the resulting list.
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3201329 (1117831)

AppMaster Builder

Back to the list

• Data View preferences have been enhanced to provide a setting that limits Data View generation
searches to a single SQLDDL member instead of searching for all SQLDDL members identified by the
full SQLDDL path saved in the SQLSCHEMA file. When searching for an SQLDDL member, the
generation process searches the primary project path first, followed by SQLDDL workgroup paths.

3216343 (1119348)
• In the SQL Schema Maintenance dialog box, the SQLDDL members were not always sorted

alphabetically. This has been corrected. In addition, the SQL Schema Maintenance dialog box has been
updated with "LOAD" and "Filter" buttons that enable filtering.

3215756 (1119133)

Assembler Support

Back to the list

• A problem with the MFASM command-line processor program caused RC=4 warnings that prevented
the linker from being invoked. To correct this, the MFASM.EXE and MF370CHK.DLL modules have
been updated to produce .390 executable modules even when warnings occur during assembly.

3224507 (1119933)
• A problem that caused the &SYSNEST macro processor to be incompatible with mainframe assembler

has been fixed by reducing the system value by 1.
• A problem that caused National Language Characters in assembler listings to be echoed to the console

during assembly and appear as box drawing characters has been fixed.
• MNOTE errors are no longer treated as fatal errors. If only MNOTE errors are reported at assembly

time, the Assembler .obj file will be produced and the linker will be invoked.

3204758 (1118136)
• Invalid parameters specified in the Additional Directives text box are no longer treated as fatal errors by

the Assembler command-line processor. Previously, invalid parameters would prevent the Assembler
linker from being invoked even if the assembly was successful.

3204319 (1118090)

Call prototyping in library routines

Back to the list

The copybooks cbltypes.cpy and cblproto.cpy, provided by this system for call prototyping in library
routines, include features of the latest syntax, specifically the CONSTANT keyword. If these files are used
in conjunction with the MF directive, it should be set to the current level, 21; otherwise, you should remove
the directive, or do not use these copybooks.

Common Communications Interface

Back to the list

• The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.
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Communications Server

Back to the list

• The optional Digital Certificate Authentication Service (DCAS) feature of Enterprise Server, most
commonly used to provide single-sign-on for TN3270 clients, has been updated to address a severe
security issue. Customers using DCAS should refer to the topic "DCAS security" in the product
documentation. To determine whether your enterprise server regions use DCAS, look for listeners with
the "dcas" conversation type. DCAS listeners now require client certificate authentication by default. If
you are using DCAS with an external DCAS client such as Host Access for Cloud (formerly Host Access
MSS), and that client does not supply a certificate, you need to add the following setting to your DCAS
listener configuration: [Operation] allow unauthenticated clients=yes

Compiler

Back to the list

• "file not found" error messages now provide more information about the key the user needs to press.
The new format of the messages is as follows: "File name.cpy not found - Press [S]top/[R]etry/
[C]ontinue/[A]lter-path".

Data Tools

Back to the list

• You are no longer able to modify data in a structured record that is identified as comp-2 floating point -
an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.

3213037 (1118867)
• Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see

'Working with Different Character Sets' in the documentation for more information.

3161243 (1114482)

Database Access - OpenESQL

Back to the list

Just like other DBMS SQL COBOL precompilers, OpenESQL now follows embedded SQL standards and
disallows the use of group host variables in WHERE <column> = :hostvar clauses. In the past, this was not
flagged at compile-time, and would lead to unpredictable results when executed.

Documentation

Back to the list

• The information about the -flag and warn compiler options has been updated.

3190928 (1120000)

Early warning of compatibility issues with current operating systems

Back to the list

In order to better support modern operating systems, we are aligning closely with their operability
guidelines. We now detect previously-undefined behavior when interacting with OS level functions.

Error RTS096 alerts you to any calls to the operating system's fork() API, in a process that has directly or
indirectly called COBOL functionality, in your code.

The error gives you an early diagnosis of a situation which, if left unchecked on modern operating systems,
could lead to deadlocks, crashes or other failures at run time. These problems would often occur
intermittently and be very challenging to track down.
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See the KB article https://community.microfocus.com/t5/Visual-COBOL-Knowledge-Base/fork-rts64-
Error-96-encountered-in-child-process/ta-p/1771191 for more details.

Enterprise Server

Back to the list

• IF an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_????_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.

3213379 (1118913)
• The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the

command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.

(642125)
• Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites" in the "Scale-Out

Performance and Availability Clusters" chapter in your product Help for more information.

• When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.

3223257 (1119804)

• Deferred work elements for cancel will not be processed until the End of Task. This means that the
cancel will not be processed during a user syncpoint.

3193871 (1117144)
• A problem where a failed syncpoint did not result in a failed transaction, leading to incorrect commit

states, has been fixed by changes in syncpoint processing. A syncpoint involving XA resource
managers can fail in one of three ways: 1 - During phase 1 - xa-prepare. When one of the RMs enrolled
in a LUW returns an error on the prepare, the LUW is rolled back. An application can now intercept the
EIBRESP and EIBRESP2 using the NOHANDLE option: EIBRESP = 78-EIBRESP-is-ROLLEDBACK -
82 EIBRESP2 = 78-EIBRESP2-sync-prepare - value 124 Otherwise the transaction abends with abend
code AEXJ - ROLLEDBACK. 2 - During phase 2 - xa-commit or xa-rollback. When one of the RMs
enrolled in a LUW returns an error on the commit, the LUW is left as is, and a severe error is sent to the
console. The application cannot handle this failure. (This is mainframe-compatible behavior.) 3 – A
syncpoint can also fail during the systematic xa-start called after the completion of the syncpoint commit
phase 2. Behavior in this case is unchanged; the transaction will abend with system code AEIJ -
NOSTART. This failure cannot be handled by the application.

3193283 (1117153)
• For regions that are not TRANCLASS-enabled, the EXPIRYINTMIN attribute of the TSMODEL resource

is now supported. In addition, the LASTUSEDINT option is now supported on the INQUIRE TSQNAME
and INQUIRE TSQUEUE commands. Note that this changes the queue control record and will affect
any existing queues that were created with earlier versions of the product (affects non-TRANCLASS
regions only). As a result of this, you need to cold start the Temporary Storage and Transient Data after
applying this Patch Update. You also need to cold start any PACs that have existing TS\TD queues.
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Enterprise Server Common Web Administration

Back to the list

• By default, ESCWA now runs on port 10086.
• When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique

Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.

• PAC names are now limited to eight characters or fewer in ESCWA.
• The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server Security

Back to the list

• The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.

3206992 (1118359)

File Handling

Back to the list

• The supervisor password is no longer displayed when cobfsclose is executed from the command line.

3195772 (1117571)
• Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

3120656 (641976)
• Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting

Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.

• The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (1119504)
• The calculated output length of SORT and the memory required could be calculated incorrectly when

symbols were used.

3203471 (1118031)

• File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.

Handling of anonymous root field in JSON

Back to the list

For JSON (RESTful) service interfaces, the IMTK no longer forces the outermost (root) structure of a JSON
message body to always be a JSON object, but now also supports a root JSON array or primitive. Though
the root is obligatorily nameless in the JSON message, in the Interface Mapper the anonymous root must
now be defined in the operation's interface fields as the top-level body field. Consequently, since there
cannot be more than one input top-level body interface field nor more than one output top-level body
interface field in an operation, all interface fields that appear in the body of a message must now be
children of the top-level body field. Any non-conforming pre-6.0 JSON service interface is still supported
as-is, but conformance would be required upon any modification in the Interface Mapper.
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HCO for DB2 LUW

Back to the list

• There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)

IDE

Back to the list

• A bug that prevented adding multiple Program Breakpoints has been fixed.

3222576 (1119722)
• Environment variables with the format ${env.<name>} are now handled correctly during compilation and

background parse.

3215414 (1119077)
• A new option has been added to the Window> Preferences> Micro Focus> Debug dialog box: Ignore

breakpoints in resources within unrelated projects. When selected, this option guards against the
situation where you have identically-named programs within your workspace, and setting a breakpoint in
one could cause the other programs to break when they are debugged (if the corresponding lines are
debuggable). To continue current behavior, this option is not selected by default.

3211196 (1118694)
• Populated folders can now be used as output folders for JVM COBOL projects.

3210830 (1118646)
• A new option has been added to allow you to edit the location of a remote linked folder. It opens the

same wizard as when creating a new remote linked folder, but in edit mode.

3200758 (1117951)
• It is now possible to access a breakpoint's properties from the breakpoint's context menu in JVM

COBOL code.

Interface Mapping Toolkit

Back to the list

• The COPYEXT directive on remote projects now works correctly.

3206621 (1118324)

JCL Support

Back to the list

• The wrong Symbol value was used when a symbol was assigned a different value following a
procedure.

3223719 (1119901)
• When replacing symbols in in-stream data, space-separated elements will be taken into account, and if

possible, the original position will be maintained.

3222942 (1119802)
• An issue where procedure COND statements were applied to the wrong procedure steps when the

procedure was called multiple times, notably the steps from the first call to the procedure when they
should be applied to steps from the specific call, has been resolved.

3222081 (1119699)
• The JCL JOB JOBRC parameter is now honored, and the correct return code set for the job.
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3218927 (1119420)
• The MFFTP LCD, MGET and MPUT commands have been enhanced to process the members of a

partitioned data set.

3216865 (1119242)
• The removal of datasets with DISP=NEW because MF_UCC11=YA or MF_UCC11=M is set has been

restricted so that the DSORG, if defined on the DD Card, must match the catalog attribute. The removal
of a GDG Base by this method is prohibited. If the dataset cannot be removed and recreated, an error
message JCLCM0200S is issued.

3216471 (1119195)
• You now receive a correct error code, if an error occurs while processing the TSO RENAME command.

3215386 (1119281)
• The JCL File Action exit, MFJFAXIT, is now notified of the deletion of cataloged data sets.

3212961 (1118856)
• A problem in the public catalog API, mvscatpb, where the LRECL values for variable length files were

not validated correctly, producing false errors, has been corrected. The API will now return the catalog
record that has been changed.

3212769 (1118940)
• The incorrect changing of a VSAM data set file status from pristine to used when REPROing an empty

data set has been corrected. When REPROing records into a data set, if the source data set is empty,
the destination data set is not opened.

3212733 (1118839)
• GDG restart information is usually created only when ES_JES_RESTART=Y and MF_UCC11=Y or M;

however, by setting environment variables GDG_RESTART_UCC11_ONLY=N and
ES_JES_RESTART=Y results in the restart information for GDGs to be created. This ensures that the
dynamic setting of MF_UCC11, via the MFJUXIT user exit, can be applied to GDG versions. The
MFJUXIT user exit has been enhanced to provide a new event call, event-job-restart, which is called
when a job is restarted, and provides the option for the user exit to be notified of future event calls - one
of which is ‘event-job-ready’, where the user exit can set the MF_UCC11 value for the job (see
mfjdxit.cpy for user exit event information).

3207134 (1118753)
• If a JOB CARD includes a USER ID and a PASSWORD that are different from the ones for the user

submitting the job, the credentials specified in the JOB CARD will be used to validate the permissions to
submit a job in place of the surrogate user.

3207055 (1118326)
• LISTDS now returns 8 if the requested dataset does not exist. Previously, it would return zero.

3204627 (1118102)
• PDS directories (PO) identified by environment values (the path to the directory starts with $<ENV-

NAME>), are now removed in the same way as those that do not use an environment value. The last
member is removed and the directory is empty.

3196118 (1117345)
• The MFJPTPCH module now supports the PREFORM and CNTRL parameters.

3194158 (1117171)
• Using MFFTP, a GET request that used SENDEOL no longer attempts EOL processing if the file is not

found. This now emulates the behavior on the mainframe. Previously, processing would cause
unexpected errors in cases where the file was not found.

3192989 (1117084)
• If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened

during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.
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3186942 (1116611)
• It is now possible to export symbols from Enterprise Server and to use them in in-stream data. You can

also pass symbols on jobs submitted using the Internal Reader.

3164066 (1114816)
• When trying to export entries from a catalog that does not exist, mfcatxml will now report an error and

exit with a value of 12. Previously, it returned zero and created the catalog.

• An issue with error conditions incorrectly carried forward from one VSE job to the next one has been
resolved.

3220394 (1119913)
• The length of a SYSIN is no longer being checked unnecessarily.

3201488 (1117900)

Micro Focus Batch Scheduler Integration

Back to the list

• When running against an Enterprise Server PAC environment, mfbsijcl could return an invalid return
code to the scheduler. This has been resolved. Note that both of the following environment variables
must be present in the mfbsi.cfg configuration file in order for mfbsijcl to work with the Enterprise Server
PAC environment: ES_PAC and ES_PAC_ENDPOINT.

3215408 (1119254)

Micro Focus Directory Server

Back to the list

• UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y'.

National data items in JVM COBOL code

Back to the list

JVM COBOL code that uses IS NUMERIC tests on NATIONAL or NATIONAL NUMERIC data items, or
uses NATIONAL NUMERIC data items in programs compiled with the CHECKNUM Compiler directive
must be recompiled in this release. Compiled code from earlier products that uses such constructs will
generate a MissingMethodException error when run under this release.

PL/I Support

Back to the list

• A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

3192381 (1117048)
• The macro preprocessor loop no longer occurs when there is a "DO" statement with "BY" and without

"TO". For example, statements such as "DO J=1 BY 1" are treated as infinite loops.

3216391 (1119216)
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Rebuild required for projects unable to locate the Windows Resource Compiler

Back to the list

Projects that were last built in a version prior to 6.0, and that rely on the Windows Resource Compiler
(RC.exe) need to be rebuilt in Eclipse, otherwise they may produce an error. This is due to the relocation
of RC.exe in this version of the product. Affected projects will be those that explicitly reference a manifest
file (used to include such things as cursors, fonts, and icons), and that are built directly from the command
line.

The problem is fixed if you open and build the project within the Eclipse IDE (as .cobolBuild is rebuilt to
find the new location of RC.exe). Alternatively, you should ensure that PATH contains a reference to
RC.exe if you continue to run projects from the command line.

Run-Time System

Back to the list

• Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.

3138692 (1112552)

SQL Option for DB2

Back to the list

• The XDB Service name has been shortened.

3195822 (1119897)

VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Back to the list

If your Working Storage contains a data item with the OCCURS DEPENDING ON phrase, and ODOSLIDE
is in effect, any subsequent data items at the same or higher level must not contain a VALUE clause. If they
do, an error (COBCH1962) is now generated.

If you cannot remove the VALUE clauses from your source code or remove ODOSLIDE, contact
SupportLine.

Significant Changes in Enterprise Developer 5.0
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Documentation
• Eclipse IDE
• Enterprise Server
• Enterprise Server Auditing
• File Handling
• HCO for SQL Server
• IMS Support
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• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• MFCRYPTLIB
• PL/I Support
• Request Packet Interface API

Common Communications Interface

Back to the list

• Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost" should now work as expected.

• The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.

• If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.

• By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCI.INI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCI.INI File” in your product Help for more information. When connecting to a non-CCI
protocol server, all clients perform strict certificate checking as the new default behavior

Communications Server

Back to the list

• Passphrases specified in the mf-server.dat file can now contain spaces.

2832222 (1100976)
• Configuring MFCC when run under MFCS now works as expected.

Compiler

Back to the list

• The Search order has been updated, to allow the Compiler to find Java.

Data Tools

Back to the list

• Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.

3170479 (1115346)

Documentation

Back to the list

• The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

• The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
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For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.

3192497 (1117068)

Eclipse IDE

Back to the list

• In the Expressions view, there has been a change to the way that the number of characters displayed is
controlled. The Hex part now always displays the same number of characters as the raw data part (note
that Eclipse enforces the character limit, so the number entered by the user will include those used to
display the hex values). A maximum length entry of 0 is now correctly interpreted as "no limit".

3161694 (1114658)
• Eclipse now colorizes files that it will not build because they are preceded by other files of the same

name on the build path. The icon of such files is overlaid by an I or P and Eclipse shows a tooltip with
an explanation. This is to clarify the difference between this scenario and build-action-ignored.

3161416 (1114607)
• Micro Focus Find/Replace now provides a Column Scope group that enables you to limit searches

between columns. You can specify columns or alternatively you can search only in the main code area
for the file type open in the editor. By default, it searches in all columns.

3142899 (1112931)
• Compiler directives are now stored in .mfdirset files which can be specified for particular languages, at

project/config/folder/file level.

2853665 (1104556)
• By default, COBOL, COBOL JVM, and Mainframe COBOL Projects have the EXITPROGRAM"ANSI"

directive set in the Project Settings > COBOL Properties. This specifies that if the EXIT PROGRAM
statement is executed in a program that is not under the control of a calling program, it causes
execution of the program to continue with the next executable statement. See EXITPROGRAM in your
product Help for more information.

• The COBOL JVM method breakpoint can now be toggled on the heading of the method.
• The Eclipse IDE has an improved user interface for settings. The COBOL, IMS, and the Run-time

Configuration settings pages now use a property grid that also displays the definitions of the settings.
As part of these changes the Output path, Target type, and Bitism are now specified in the project's
Link properties, click Micro Focus > Build Configurations > Link.

Enterprise Server

Back to the list

• A number of audit events now contain some additional information.

3140310 (1112666)

• Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.

3180233 (1116108)
• casfhsf could hang when processing HSF files that contain records from tasks that ran in different

months.

3177385 (1115884)
• A new system transaction, CRCN, is now available to monitor the state of XA connections for each

resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
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Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.

3174272 (1115727)
• On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if

the environment variable ES_CAS_API is not set to "ON".

3160400 (1114458)

• A new environment variable, ES_SNATRC_DIR, is available for configuring the location of the SNA
traces written by IMB's communication manager. To ensure that the SNA trace files are written to a valid
directory, ES_SNATRC_DIR must be set before you start the region.

3173516 (1115523)
• When defining CICS term in ESMAC, if the terminal definition includes a user ID, Enterprise Server

honors the terminal user ID, and you can leave the User ID field blank. Caution: When the terminal
definition includes a user ID, this logs you into the terminal without password verification. Use with care!

3158468 (1114309)

Enterprise Server Auditing

Back to the list

• Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling

Back to the list

• RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

3164916 (1114803)
• The SORT-CONTROL special register is now supported during a SORT statement.

3159740 (1114389)
• To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use

the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)

3157247 (1114149)

• The FORMAT parameter is now correctly ignored when the format is explicitly set in the Include
statement. Also, an error is now returned if a numeric item is compared with a quoted value in an
Include statement.

3186371 (1116564)
• For MFJSORT, the SORT-EBCDIC instruction is now supported through the PARM parameter of an

EXEC statement.

3165343 (1114824)
• When reading continuation lines from SYSIN for MFJSORT, if line 1 breaks at column 71 with a

nonblank in column 72, and columns 2-15 of line 2 are blank, DFSORT continues on line 2 with
whatever character it finds in column 16 (blank or nonblank).

3159842 (1114565)

HCO for SQL Server

Back to the list

• HCOSS DB2 schema extraction has been updated to use the DB2 system default of EBCDIC SBCS
CCSID <value> for DB2 columns in tables with a CCSID value of 0 (zero, CHAR family types). This has
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been done to appropriately handle the CCSID value for tables created using DB2 version 8 or earlier,
and that have been migrated to a newer version of DB2. In addition, HCOSS DDL generation maps
Euro collection sequences to the nearest match to a supported SQL Server collation sequence.

3163636 (1114937)

IMS Support

Back to the list

• A performance delay that occurred when rapidly writing checkpoint records to the IMSLOGR file has
been corrected by updating the method used to verify the uniqueness of the timestamp in the key.

3131126 (1112901)
• The IMS Support feature has been updated to support checkpoint/restart for output GSAM processing.

3107543 (1109558)

Interface Mapping Toolkit

Back to the list

• If you try to deploy a stateful EJB SVI from the Visual Studio IDE after unchecking the “Reuse container
after application termination” check box (in the Deployment Characteristics tab of the Runtime
Environment Configuration dialog box), you receive a warning message informing you that the “Reuse
container after application termination” setting will be set to true for the deployment in order to prevent
the crash. In the Eclipse IDE, the unchecking of this option will just be ignored, and the option re-
selected. A warning to not uncheck the option for stateful EJB SVIs is also displayed on the prior page
(to the dialog box).

2663812 (1090987)

• WSDL and JSON Schema files generated for bottom-up CICS Web services now include a
"maxLength" parameter for all string fields.

3175039 (1116241)

JCL Support

Back to the list

• If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened
during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.

3186942 (1116611)
• When security is enabled and a JCL job includes either JOBLIB or STEPLIB entries, the system now

checks that the user has READ access to each of the Partition Datasets (PO). If the user does not have
the required access, the job abends with a COND CODE of S913.

3176759 (1115814)
• The DATACLAS and MGMTCLAS attributes are now applied to a DATASET when it is added to the

catalog and SMS support is enabled (MF_SMS=ON).

3174534 (1115630)
• The DSNRLI reason-code value will be hexadecimal 0x00000000 when the return-code is zero. This is

a change from the previous value of decimal zero, '0000'.

3171133 (1115344)
• MFFTP quote handling has been reworked to support IBM behavior. Filenames that contain spaces are

now required to be defined within double quotes ("). This change is required to support mainframe
hosted files, where single quotes (') will no longer append the user ID to start of the filename as the first
node.
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3168300 (1115058)
• If JES security is enabled, when a JCL job is submitted that uses a PROC or INCLUDE file that is part

of a cataloged Partitioned Dataset (PO), READ access for the dataset will be checked, and if the user
does not have permission to read the dataset then an error will be reported.

3166921 (1114955)
• When restarting a job, the COND CODES for steps prior to the restart step will not be evaluated. This is

a change in the behavior where previously the values of the COND CODES from the previous run was
checked. You can revert to the old behavior by setting the environment variable
MFJ_ALL_STEP_CHECK=Y.

3163358 (1114688)
• The Spool Housekeeping history file, INDEXO, can now support 7-digit job numbering. A conversion

utility, MFHKHCOV, is supplied to convert any existing dataset to the new format. Run this utility using
the sample JCL job CONVERT.JCL. Once converted, the newly formatted dataset supports both 5- and
7-digit job numbering. If you only use 5-digit job numbering, you do not need to run the conversion. See
the 'MVSSPLHK Spool Housekeeping Process' section in the Help for more information.

3162868 (1114648)
• When performing an IEBCOPY to a partitioned data set (PDS), a check is now made to ensure that the

user has DATASET ALTER permission for the PDS.

3159837 (1114347)
• The DSNRLI functionality for the TERMINATE THREAD call has been improved so that it now calls

tx_end and then tx_close for a particular XA resource. A ROLLBACK call will not be issued prior to the
tx_close. If an error is returned from the tx_end function, it is reported back to the calling program as
return code 12, reason code 0X00F30093.

• Missing and incorrect key values in the MF_JCL_AUDIT event output have been corrected. Also, the
audit event code resulting from MF_JCL_AUDIT has also been changed from '2 1' to '5 5' to avoid
conflict with the same code being used by other components.

• For RISC-based systems when running JCL jobs, you might need to set COBMAINSTACK to a high
value such as 8000000.

• An issue resulting in a Run-Time System error "RTS 119 Name is not unique" when calling 'setenv' to
dynamically assign a dataset from a COBOL program on a UNIX platform has been resolved. The call
to "SETENV" must be made in uppercase characters.

Mainframe Access

Back to the list

• By default, VSAM files whose average LRECL are the same as the maximum LRECL are now treated
as Variable when generating a .PRO file. You can override this with the existing /FIXEDVSAM flag, or by
specifying a fixed VSAM import type (ESDS-FIXED, KSDS-FIXED, or RRDS-FIXED).

3181871 (1116216)

• SyncMon2 now uses the Endevor "Source Date" and "Source Time" information to determine if a file
has changed since the last synchronization.

3177475 (1115904)

Micro Focus Batch Scheduler Integration

Back to the list

• When using MFBSI, the message JES000020W (JOB number warning percentage exceeded) is now
correctly handled, and no longer results in an invalid MFBSIJCL 208 return-code (JCL error).

3186963 (1116620)
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Micro Focus Directory Server

Back to the list

• The event codes for several MFDS audit points have changed.
• On Windows, by default, the Enterprise Server Administration Web interface can only be contacted

using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web
interface by turning off the loopback mode. See "Using the Loopback Address" in your product Help for
more information.

MFCRYPTLIB

Back to the list

• Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.

3181743 (1116186)

PL/I Support

Back to the list

• A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

3192381 (1117048)
• The Open PL/I compiler now generates a W-Level diagnostic if a constant array dimension or extent is

of type CHAR or BIT. This is usually unintended coding.

• The macro preprocessor now supports the use of %INSCAN and %XINSCAN.

2880348 (1107310)

• Previously, if a condition prefix for STRINGRANGE was enabled and a STRINGRANGE condition
occurred, it was raised to ERROR after being processed. This no longer occurs.

3182428 (1116254)
• PLISAXA, PLISAXB, and PLISAXC processing has been enhanced to use ENTRY LIMITED functions

and procedures which utilize OPTIONS(BYVALUE).

3150969 (1113745)

• A problem causing the SQL pre-compiler to hang has been fixed.

3165345 (1114825)
• SQL is now supported in a PL/I PACKAGE. A SQLCA declaration (usually via include of SQLCA) in a

nested block (PROCEDURE or BEGIN)is not allowed. It is allowed only in the outermost block(s) or in a
PACKAGE.

3159844 (1114355)

• The PL/I Eclipse debugger now supports double-clicking in the left margin on a DCL line to set a watch
on the variable for the content to change during execution.

• The PL/I Eclipse debugger now supports displaying the current value of a variable by placing the cursor
over a variable name in the PL/I source.
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Request Packet Interface API

Back to the list

• The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fully-
qualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.

To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart –
m command line parameter, set MFDS_DNS_RESOLVE=N.

3194613 (1117203)

Significant Changes in Enterprise Developer 4.0
This section describes significant changes in behavior or usage in Enterprise Developer 4.0. These
changes could potentially affect the behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Application Server JCA Support
• Application Workflow Modeller
• CICS Support
• Code Coverage
• Codeset Support
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Documentation
• Enterprise Server
• Enterprise Server Auditing
• Executables require relinking
• File Handling
• HCO for Microsoft SQL Server
• IDE
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• MF Server Administrator (GUI)
• Micro Focus Directory Server
• PL/I Compiler
• Run-Time System

Application Server JCA Support for Enterprise Server

• With this release, all CICS-related Java artifacts have been delivered using a new directory structure
under the javaee-ccl directory of your Enterprise Developer installation directory. The javaee-ccl
directory structure mimics the structure of the javaee directory. For example, mfccl.jar is no longer
located in the bin subdirectory, but can be found in the javaee-ccl\common directory.
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Application Workflow Modeller

Back to the list

• Source or listing files are now opened in read-only mode when a browse action is executed in the
ChangeMan attachment model.

3138354 (1112546)
• A new function package, Micro Focus Background Parser, enables you to define the SYSLIB or

PROCLIB concatenation in which to search for COBOL copybooks, PL/I or JCL include files on the
mainframe or on network drives. The package also enables you to define any identifiers which
determine the structure of the local cache for COBOL copybooks, PL/I or JCL include files.

3132249 (1111922)
• The Endevor attachment application now validates the input of a CCID or a comment. They must not be

blank.
• Added the new "Modeled Edit Sessions Only" AWM model attribute to control whether modeled editor

actions should be available in non-modeled edit sessions.

CICS Support

Back to the list

• Starting with version 4.0 Patch Update 2, all applications that use WEB CONVERSE or WEB SEND
SESSTOKEN explicitly with the AUTHENTICATE, BASICAUTH, or NONE options, and that do not use a
URIMAP that specifies the AUTHENTICATE attribute, must be recompiled. (This does not affect
applications that use a URIMAP that specifies the AUTHENTICATE attribute.)

• Client ECI timeouts now propagate CTG requests to ABEND AITH the ECI server program.

• The update resource definition file utility, CASRDTUP, now supports the DELETE command. Note that
the REMOVE option is not currently supported.

2885020 (1108004)

Code Coverage

Back to the list

• Schema changes that affect the test coverage results generated from the tcutil utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).

Codeset Support

Back to the list

• Code-set mappings between ASCII and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\”
character to “$”.

3124321 (1111464)
• New single-byte character set tables for MFCODESET have been added in order to improve support for

DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.

3111843 (1109984)
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Common Communications Interface

Back to the list

• You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.

2866265 (1105526)

• In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.

• In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server

Back to the list

• TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.

3144133 (1113024)
• Web access to the Enterprise Server Console Log and Communications Server Log is now restricted

when the region is secured using external security. Users will be required to provide a valid username
and password in order to view either log file. Web access to the logs can be controlled using the
standard ACL definitions under the new "Communications Server" Resource Class, with resources
"Enterprise Server Console Log" and "Communications Server Log". If these resources exist, users
require read access to be allowed to view the logs. If they do not exist, the default behavior is to allow
read access. The new resource class and resource definitions can be found in the
"es_default_ldap(_msuser/_unix).ldf" file in the bin or etc sub-directory of your product install directory.

3113539 (1110155)
• MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.

2868627 (1105777)
• MFCS no longer initializes the Security Facility if there are no External Security Managers defined for

the region.

Compiler

Back to the list

• Programs containing EVALUATE statements of the form: EVALUATE true | false WHEN conditional-
expression where conditional-expression included inline method invokes would give an RTS 114 error
when run as .int code, and an "Illegal .int code" error when generated. This has been fixed. Also, short
circuit evaluation is now correctly observed, such that when evaluating condition-1 AND condition-2, if
condition-2 contains an inline method invoke and condition-1 is false, then the inline method invoke is
not executed. Previously, despite being correctly evaluated, the inline method invoke in condition-2 was
being executed. Similar behavior relating to OR evaluations has also been corrected.

3138510 (1112492)
• During compilation, characters within literals that are unknown in the current locale are now less likely to

cause spurious errors. However, the correct (and safest) solution is to ensure that the locale has been
set correctly, to match the source encoding of these characters. On UNIX, this means setting LANG,
LC_CTYPE, or LC_ALL appropriately; each of these variables takes precedence over the former. On
Windows, this means setting the system locale in the 'Region and Language' section of Control Panel.
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3123935 (1111148)
• The Compiler now produces an E level message - COBCH1888 Typedef is defined differently in another

external program - if different external programs have conflicting definitions of the same typedef name.
(To restore the previous behavior, where the earlier definition was ignored, use the directive
HIDEMESSAGE"1888".)

• An issue with the Compiler has been fixed so that in the RECORD VARYING clause, if the minimum
and maximum lengths are specified, the maximum length must be greater than the minimum length.

Data Tools

Back to the list

• Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.

2853226 (1103406)

Documentation

Back to the list

• You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.

3147576 (1113323)
• As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly

referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.

3121002 (1111373)

Enterprise Server

Back to the list

• The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.

3113639 (1110160)
• The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no

longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.

• The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.

• The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:

******************************
# Sample security definitions for ESMAC MQ Listeners/Writers pages

#######################
###### MQL*          ##
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#######################
dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro 
Focus,CN=Program Data,DC=X
changetype: add
cn: MQL*
objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid
#description: Allow full access any ESMAC MQ Listeners/Writers Screen

******************************

3143258 (1112990)
• You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors

from Enterprise Server.

3142092 (1113248)
• Communication with the console daemon has been improved. Messages are displayed more quickly

and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.

3136867 (1112483)
• Administrators can now add, delete or modify XA resources in the Enterprise Server Administration

Web UI while a region is running.

2589624 (1085625)

• CICS Web services has been updated to include the ES_TRANCLASS_CWI environment variable,
which enables you to prioritize and limit Web requests in a TRANCLASS-enabled region. When the
ES_TRANCLASS_CWI environment variable has been set to either TCPIPSERVICE (default) or
URIMAP, a TRANCLASS-enabled region processes the elected transaction according to its priority and
associated TRANCLASS.

Note: When using CICS® Transaction Server for z/OS®, Version 3 Release 1, and IBM CICS
initiates the ATTACH transaction followed by the ALIAS transaction for a single Web request, this is
intended to enable the application of different limitations and priorities on these transactions.
Enterprise Server does not support this. Instead, a TRANCLASS-enabled region processes the
requests as a single ATTACH transaction, and uses the ALIAS transaction for security checks.

3126381 (1111349)
• Web access to the Enterprise Server Console Log and Communications Server Log is now restricted

when the enterprise server region is secured using external security. Users will be required to provide a
valid username and password in order to view either log file.

Web access to the logs can be controlled using the standard ACL definitions under the new
Communications Server resource class, with resources Enterprise Server Console Log and
Communications Server Log. If these resources exist, users require 'read' access to be allowed to
view the logs. If the resources do not exist, the default behavior is to allow 'read' access on entry of a
valid username and password.

An example of the new resource class and resource definitions can be found in the
es_default_ldap_msuser.ldf (Windows), or es_default_ldap_unix.ldf (UNIX) file, which is
located in the bin (Windows), or etc (UNIX) sub-directory of your product directory.

• In UNIX environments, DB2 and ODBC switch modules can now be enabled together in the same
region if the DB2 switch is built with the "-o" option.

3137455 (1112398)
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Enterprise Server Auditing

Back to the list

• The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.

3150566 (1113592)
• Any extra information that was added to the syslog messages will now correctly appear in the structured

data items.

Executables require relinking or recompiling

Note: Windows-only.

• Due to an internal change in version 4.0 of your product, you must at least relink any executable
programs compiled prior to this version, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables
to benefit from the product's latest programming and performance enhancements.

Relinking an executable without recompiling means using the original object code with the cbllink
utility. Original object code is typically the binary file output (usually containing the .obj extension)
produced during the original compilation process. An application can contain one or more binary files.

File Handling

Back to the list

• In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.

3124294 (1111259)
• The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,

description, and ACL. Previously, you could only filter on Class name.

2871549 (1106119)

• Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

3113802 (1110183)
• The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

3109432 (1109745)
• OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.

2887724 (1108443)

• The TO parameter is now supported for TOT|TOTAL, MIN, MAX, and AVG in the TRAILER3 trailer item.

3135298 (1112194)
• The OUTFIL statement of a SORT operation now supports the NULLOFL parameter.

3110364 (1109822)
• The MFJSORT OUTFIL emulation now supports the VLTRIM parameter.

3107105 (1109820)

HCO for Microsoft SQL Server

Back to the list

• The HCOSS Manage Connections tool was incorrectly limited to using the default CCSID for mainframe
DB2 connections, causing problems when mainframe database did not use the default CCSID of 37.
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This has been corrected by the addition of a text box that enables the setting of a specific CCSID value
for the connection.

3130137 (1112180)
• When using the DIALECT=MAINFRAME setting, the OpenESQL STRICTPARSE SQL compiler

directive option is now turned on by default for ODBC (DBMAN=ODBC). This ensures strict compliance
with z/OS DB2 syntax.

If your applications require the OpenESQL preprocessor to behave as it did in an earlier release,
compile using NOSTRICTPARSE.

IDE

Back to the list

• New functionality to support the debugging of CICS channels and containers has been added to this
release.

2810448 (1098047)

• Code blocks in PL/I editor can now be folded. You can configure the PL/I editor to fold various block
types. To do this, click Window > Preferences > Micro Focus > PL/I Editor > Folding, and check the
options that you require.

2867993 (1105654)

Interface Mapping Toolkit

Back to the list

• Refresh Resources functionality has been added to regenerate existing service interfaces for COBOL
programs whose linkage section has been updated after the service interface was initially created.

2849403 (1103036)
• Due to changes made to the Configure Runtime Environment dialog box in this release, after you

upgrade your system, you must reenter all previously set values on this dialog box before running a
service.

JCL Support

Back to the list

• You can now configure MFFTP to not process trailing blank spaces for a GET command, by setting the
new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and setting the LOCSTAT value
TRAILINGBLANKS=FALSE.

3138375 (1112486)
• ICEGENER now does not copy the RECFM from SYSUT1 to SYSUT2 if SYSUT2 RECFM is not

specified in JCL and when SYSUT1 is VSAM. It defaults to F/FB if SYSUT2 is non-VSAM, or V/VB if
SYSUT2 is VSAM.

3131268 (1111805)
• An error in identifying the IDENT in IEBGENER when the record included high values at the start of the

record has been corrected.

3109443 (1109759)
• FOR ED 2.3.2 HF7: The following changes have been made to the MF_UCC11 environment variable:

MF_UCC11=Y - when running a job with DISP=(NEW,CATLG), it will not result in job failure caused by
the data set already being cataloged. MF_UCC11=YR - when restarting a job with
DISP=(NEW,CATLG), it will not result in job failure caused by the data set already being cataloged. For
ED 3.0 HF1: The following changes have been made to the MF_UCC11 environment variable: The
default behavior of MF_UCC11=Y has changed: DISP=NEW is changed to DISP=MOD only when the
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job is restarted. MF_UCC11=YA reverts to the old behavior of changing DISP=NEW to DISP=MOD
even when the job is first run.

3107409 (1109722)
• The introduction of a new environment variable, ES_OLD_DYN_PDS, has changed the resulting

behavior of dynamic PDS members when specified in a JCL DD statement. Default behavior
(ES_OLD_DYN_PDS=N) no longer creates physical files or catalogs the PDS members when specified
in a JCL DD statement. Set this variable to Y to enable the previous default behavior of creating the
physical files and cataloging PDS members when specified in a JCL DD statement.

2845176 (1102528)
• To prevent unintended deletion of a GDG Bias, a GDG in use by one job may not be accessed by a

second job until the first job has completed.

2816745 (1101569)

Mainframe Access

Back to the list

• Calling mfmon2.exe with the following options has the given effect:

1. If you do not specify "EXTENSION" or specify "EXTENSION=" it will result in files downloaded
without an extension.

2. If you specify "EXTENSION=*" you will get an extension that matches the last part of the data set
name. For example, if the source data set is a.b.c.d then the file extension will be .d.

3. Everything else results in the extension specified. For example, "EXTENSION=txt" will result in files
downloaded with a .txt extension.

MF Server Administrator (GUI)

Back to the list

• The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server

Back to the list

• The mfds -g options D, O, and S have been added to the product Help.

2848627 (1102864)
• On UNIX, specifying an invalid user ID in the MFDS "General" options value for "Default process user

ID" no longer causes the child process (such as a region start or stop request launched from the Web
interface) to fail. The user ID under which the MFDS process was started will be used instead.

• MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

PL/I Compiler

Back to the list

• Previously, storing PL/I named constants in big-endian form was incorrect and impaired some instances
of restricted expression evaluation. In ED 4.0, named constants are stored in native form when the -
bigendian compiler option is in effect.

3150931 (1113613)
• Open PL/I now supports the FLUSH statement.

3134294 (1112117)
• The %PROCESS statement now includes new compile-time options, -pporder and -options. See the

product help for more information.
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3107667 (1109861)
• Pointer subtraction in 64-bit mode now works as expected.

Run-Time System

Back to the list

• The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.

• scan64 is no longer available. This has been superseded by the COBOL Analysis functionality in the
IDE.

Significant Changes in Enterprise Developer 3.0
Enterprise Developer version 3.0 includes significant changes in the following areas:

• AppMaster Builder
• CICS Support
• Compatibility AddPack
• Compiler
• Documentation
• Enterprise Server
• File Handling
• IDE
• IMS Support
• JCL Support
• JES-enabled Enterprise Server Regions
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• OpenESQL
• PL/I Support
• Reserved words
• SQL: HCO for SQL Server
• HCO for DB2 LUW

AppMaster Builder

• A new parm "STS" can be passed into the Program Generator. This parm tells the Program Painter to
issue an error when it encounters a STUB keyword and the stub program is not specified in the
application definition. This new parm is specified in the ISPSLIB\SSMPCOM file tailoring skeleton. Do a
search for "STUBSCAN" to see where this parm is specified. By default, this new option is not in effect.
To turn it on uncomment the line where the value is set to "YES". This feature is only available when
generating programs via the IDE. When using the Distributed Generation Server (DGS) this setting is
ignored.

2988372 (1108572)

CICS Support

• The value specified in the LENGTH field of the SEND TEXT command is now honored when the target
terminal has its SOSI or PS attributes switched on. This means that trailing spaces will no longer be
removed for SOSI/PS terminals.

2884877 (1107983)
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Compatibility AddPack for Visual COBOL

Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Enterprise Developer for Visual Studio.
The run-time components are installed as part of Enterprise Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

Compiler

• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

Documentation

• There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server

• WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.

2989188 (1108602)

IDE

• You can now open data files in RSE configured remote projects using the mfdatatools2 on the remote
machine displaying back to an X display. You can configure the remote tools display by clicking Window
> Preferences > Micro Focus > X Display. In the X Display (DISPLAY) field, type the display details. In
addition, COBOL Explorer displays the Open With Remote Data File Editor context menu item for
remote data files.

2852872 (1104085)
• Enterprise Server sign on credentials which were created on Windows when using the 32-bit versions of

Enterprise Developer or Visual COBOL for Eclipse are not compatible with the 64-bit versions of those
products, and vice versa. Users are required to re-enter credentials which are not compatible with the
current version of the product. You only need to do this the first time they are used in the current
product.

(625819)

File Handling

• Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.

2988222 (1108521)
• A problem that generated a 39 error when attempting to access a VSAM file via an alternate index

PATH element has been fixed.

2874622 (1106562)
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• Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a
file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)

• New PARM option SIGN-EBCDIC documented for MFJSORT.

2880037 (1107256)
• The MFJSORT ICETOOL emulation now supports the USING parameter in the SELECT operator.

2821176 (1099529)
• An empty, space-filler record is no longer produced at the end of an ICETOOL listing file.

(622789)

IMS Support

• Inconsistent results returned to a GET call issued from a PROCOPT=GO application when segments
within the same database record were updated and locked by another session. Symptoms included an
invalid (GE) status code or the wrong segment returned to a GN call. This has been fixed.

2862879 (1104899)

• The IMS control page is now secured according to the IMS* entity in MFESMAC.

2877405 (1107099)

JCL Support

• An emulation of the LE run-time option CBLQDA has been implemented in the form of the environment
variable MF_CBLQDA. The default is OFF, but when set ON, QSAM files can be dynamically created.

3104665 (1109251)
• A new event call to the JCL user exit (MFJUXIT) has been included. The event 'job-queued' (event code

27) occurs when a JCL job has been parsed and put on either the Input Ready queue or the Input Hold
queue.

2990395 (1108734)
• When reading commands, MFFTP now checks the charset (EBCDIC or ASCII) of each concatenated

INPUT dataset to determine if it should be translated. The output is written in the charset which
appropriate for the dataset.

2876407 (1106795)
• The PHYSFILE security setting will now be checked when a dataset entry is inserted into the catalog, or

when a dynamic PDS member is created.

2857819 (1104844)

JES-enabled Enterprise Server Regions

Important: Existing JES-enabled Enterprise Server regions must perform this upgrade to continue
using JES functionality. If you start a region without upgrading, the following message is displayed in
the console log, and JES functionality is disabled:

JES000058E JES validation - Product requires new spool control files. Run
spool conversion utility, splconv, to create them.

In this release, the infrastructure of the JES spool repository has been upgraded in order to improve
performance (see the Enterprise Server section of What's New for more details). For each JES-enabled
region, before you can submit any jobs to JES, you must run the spool conversion utility; any newly created
regions will automatically be configured to use the new spool files.

The conversion process converts the information in the existing spool files to a set of new files required
under the new system. There should be no loss of data in moving to the new system.
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Important: After converting to the new JES spool infrastructure, we recommend that you do not
employ the increased range of job numbers until you have thoroughly tested the new infrastructure.
Reverting back to the previous JES spool files is possible, but requires that you remove all job entries
using more than 5 digits, for which there is no easy process.

To run the spool conversion utility

1. At the Enterprise Developer command prompt, set the following environment variables, as required:

Variable Description

MFSYSCAT The location and name of the current JES catalog. This
is mandatory.

If multiple catalog files are being used (that is, one or
more user catalogs are defined), this environment
variable should point to the catalog where JES spool
datasets are cataloged.

MVSSPOOLDIR The location of the current JES spool files. This is only
mandatory if the location is different to the location of
the JES catalog.

NEWSPOOLDIR The location for the resulting JES spool files (that is, the
SPL* files if running the conversion, or the old-style
spool files if running the regression). This is only
mandatory if the location is to be different to the location
of the existing spool files.

MFSYSCAT_ERRS The number of catalog errors that will be tolerated
during the conversion process before the conversion is
terminated. This is optional, and defaults to 100.

If the process is terminated, the following error is
produced:

MVSCATIO Error limit exceeded = nnnn
(where nnnn is the error count)

2. Type splconv, then press Enter.

The conversion process runs, and details of the files and records converted are displayed to screen.
3. If MVSSPOOLDIR and NEWSPOOLDIR were set to different locations prior to running the conversion,

you must now set MVSSPOOLDIR to the value of NEWSPOOLDIR.

Note: If you do not perform this step, you will receive the following error when you start your
region, and JES fails to initialize:
JES000058E JES validation - Product requires new spool control files. Run spool conversion utility,
splconv, to create them.

4. You can now start the region identified by the variables, and begin to submit jobs.

Reverting to the previous JES spool repository

If you plan to downgrade to an older version of your current product, any enterprise server region that has
been converted or created with the current product will not be compatible. Before you can use them, they
must be reverted to using the old JES spool repository.

Use this process if you are wanting to use a JES-enabled region in a previous version of the product:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to PRE30.
3. If the region has started to use 6- or 7-digit job numbers (an enhancement new to version 3.0 of the

product), then before you run the regression, you must remove the jobs that are using these numbers,
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and ensure that the MF_MVSJOB environment variable (or the SPLJNO.dat file if the variable is not
used) does not specify an upper limit greater than 5 digits.

Note: If using the MF_MVSJOB environment variable, to revert to 5-digit job number support, set
MF_MVSJOB=<low number>+<high number>, where high number is less than 0099999, and
ensuring that the + sign is used to separate the low and high values.

4. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.

You can now use the region identified by the variables in previous versions of Enterprise Developer.

Exporting the spool files to Enterprise Server for .NET

If you plan to export a region to Enterprise Server for .NET, any enterprise server region that has been
converted or created with the current product will not be compatible. Before you can use them, they must
be reverted to using the old JES spool repository.

Use this process if you are exporting a JES-enabled region to Enterprise Server for .NET:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to the appropriate value:
DOTNET5

Create spool files for use on Enterprise Server for .NET, using a maximum of 5 digits for
job numbers.

DOTNET7
Create spool files for use on Enterprise Server for .NET, using a maximum of 7 digits for
job numbers.

3. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.

You can now use the region identified by the variables in Enterprise Server for .NET.

Micro Focus Batch Scheduler Integration

• MFBSI no more requires that the name of the last folder specified in the path in MFBSI_DIR matches
the name of the target Enterprise Server region. It is now possible to specify any directory path in
MFBSI_DIR. You must use the same value for MFBSI_DIR in both the Enterprise Server configuration
and for MFBSIJCL execution. When the name of the last folder specified in the path in MFBSI_DIR
does not match the name of the target Enterprise Server region, you need to specify the region name in
one of the following ways: 1. From the mfbsijcl command line, using the parameter
REGION=ESRegionName. 2. In an MFBSI configuration file, in a line containing
REGION=ESRegionName. You can specify this either in the default configuration file, mfbsi.cfg located
using the path specified by MFBSI_DIR, or using a custom location or configuration file and the
following parameter: CFG=[path]/name[.ext] See your product help for more details.

2869805 (1105939)

Micro Focus Directory Server

• In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.

3101625 (1109025)
• Some additional CSRF security measures have been added to the Enterprise Server Administration

HTML GUI.

3101205 (1108916)
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OpenESQL

The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for ODBC
(DBMAN=ODBC). This ensures that embedded SQL cursors that use WITH HOLD and FOR UPDATE
clauses have the same data integrity across all databases.

If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

PL/I Support

• PUT output-items of type POINTER are now output as a hexadecimal string rather than a fixed bin
integer value.

(623184)
• Enterprise Developer 3.0 includes some changes that result in a significant performance improvement

when assigning a null character string '' to arithmetic data items, pointers, and structures. In versions of
the product earlier than 3.0, pointer = ''; assigned the value sysnull(). This has been fixed and null() is
now assigned. See the product help for details about the -setnull compiler option.

(627517)

• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)

Reserved words

• There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:

ALLOCATE
FREE
JSON
END-JSON

SQL: HCO for SQL Server

• The HCOSS Assess Application Migration tool now enables you to view the original DB2 SQL and the
converted TSQL together in both the HCOSS tool itself and in any exported CSV files.

HCO for DB2 LUW

• Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.

Significant Changes in Enterprise Developer 2.3
Update 2
Enterprise Developer version 2.3 update 2 includes significant changes in the following areas:

• AppMaster Builder
• Compiler
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• Eclipse IDE
• Enterprise Server
• MF Directory Server
• Monitoring and Management
• JCL Support
• PL/I Support
• Run-Time System

AppMaster Builder

• To correct a problem with generating programs when no APRPROG member is present, a new Output
Generation preference has been added that, when enabled, creates a temporary APSPROG member at
generation time if none is found. In addition, a new customizable APRPROG template is available to
enable customization of the temporary APSPROG member.

2849347 (1103014)

Compiler

• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)
• There is no longer a problem opening an RM/COBOL indexed file when the program has a RECORD

CONTAINS n CHARACTERS clause and there are record descriptions with lengths less than n. This
situation previously caused a 39 error on the OPEN (other than OPEN OUTPUT) because there was a
mismatch in the minimum record length.

Eclipse IDE

• This update modifies any existing connections defined in an Eclipse workspace. If the connections had
any non-default values, those values could revert to their original default setting. After installing this
release, before you use any remote connections for the first time, you need to check the settings and
amend them as necessary.

2852872 (1103699)

Enterprise Server

• Previously, it was possible to install groups that should not have been installed. If a group name, as
defined in the Startup List, did not exist in the list of Groups then the next Group in the alphabetical
order would be loaded instead. Now, if a Group is not defined in the list of Groups, a warning that the
Group could not be loaded is issued.

2869848 (619107)
• On UNIX, if the "File Path" setting was not specified in the configuration of an Enterprise Server, the

environment variable TXFILEP was defaulting to $COBDIR/etc/cas. This has been changed and
TXFILEP is not populated when the "File Path" is not specified.

(618668)

MF Directory Server

• The "-n" option for the mfds command now supports hostnames as the network addresses in addition to
IPv4 addresses.

2816871 (1099564)
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Monitoring and Management

• Messages that are written to the console log by applications that perform "display upon console" now
contain a standard message ID (CASMG0001I).

2854207 (1103659)

JCL Support

• A printer exit can now evaluate the spool copybook field lk-dest-source-is to find the source of the value
in the spool DEST-NODE and DEST-USERID fields, to determine if it is from a SYSOUT 'DEST=' value
or from a /*ROUTE PRINT value.

2852302 (1103304)

PL/I Support

• A problem with PUT STRING when compiled with the -bigendian option in effect has been fixed. Note
that when upgrading to ED 2.3 U2 you must recompile any program using PUT SPRING.

2857374 (1104039)

• Previously, if using the -incafter option of the macro preprocessor to infuse a %INCLUDE with macro
logic, you were required to schedule a second macro pass to preprocess the contents of the
%INCLUDE. This is no longer necessary and the macro logic will be preprocessed on the first macro
pass as if it was part of the original source.

• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)
• Previously, if SIGPIPE was triggered when a PL/I program was in the callstack, then PL/I error handling

got control and processed the ERROR. This no longer occurs. Users who rely upon catching SIGPIPE
can re-enable it by adding a call to cobpostsighandler() to their code to turn it back on.

2859980 (1104399)

Run-Time System

• The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

2838118 (1101539)

Significant Changes in Enterprise Developer 2.3
Update 1
Enterprise Developer version 2.3 update 1 includes significant changes in the following areas:

• Application Workflow Modeller
• AppMaster Builder
• Communications Server
• Data Tools
• Editor Writing Assistance
• Enterprise Server
• IBM Language Environment for OS/390 & VM Support
• IDE
• JCL Support
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• Run-Time System
• SQL: OpenESQL
• SQL Option for DB2

Application Workflow Modeller

• Tools used in the File_Descriptor_Has_Action relationship now support Resource Processing. This
means tools defined within a dialog table action can modify properties of the selected table rows.

2835290 (1101493)
• The standard ED project model now contains additional context menu actions under "Open With..." for

IMS DBD and PSP files to open either the DBD, the PSP or the IMS Database editors.

• You no longer receive a REXX error when recompiling a component from a baseline.

AppMaster Builder

• A new checkbox, "Use File Tailoring for Dataview generation", has now been added to the Database
View dialog box in the AppMaster Builder (AMB) preferences. When checked, the Database Views will
be generated using File Tailoring files and the AMB Builder Server.

2820090 (1099354)

Communications Server

• A new option, [Operation] synchronous=yes (or 1, or Yes, or y or Y) is now supported in the
Fileshare listener configuration.

Data Tools

• When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.

• The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.

• The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.

• The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Editor Writing Assistance

• IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.

Enterprise Server

• In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for IO. This has been fixed. In addition, the '-oo' (and the
synonymous '-o ') option of the casfile command has been deprecated. If '-oo' is used, you will now
receive a return code 4 (warning). Instead of '-oo', you need to use the '-ooi' option (open immediate). If
-oo is used with a region configured for VSAM shareoption use, the '-ooi' option is now forced.

2839272 (1101672)
• When using an external security manager to secure a region, the EXEC CICS START TRANSID API

now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.

2835112 (1101201)
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IBM Language Environment for OS/390 & VM Support

• When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.

2841220 (1101955)

IDE

• When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.

2848855 (1102932)
• For a file added to a JVM COBOL project by adding the folder that stores the file (using the Source tab

on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a new
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.

2699374 (1094326)

JCL Support

• The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.

2834206 (1101079)
• Under Enterprise Server, flushing an active job previously resulted in all associated spool records for

the job being deleted, but left the job running. A subsequent attempt to kill the running job using casout/
seeout failed due to the job spool record no longer existing. This change causes the flush request to fail
if the job is active. You must kill the active job first before attempting to flush it.

• The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.

2698700 (1094266)
• REXX can now be executed in VSE via IKJEFT01 and IRXJCL using in-stream data.

2831984 (1100883)

Run-Time System

• The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
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‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)
• Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE

class condition tests:

• IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

• IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.

• IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.

When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

• The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

• Run a DSN bind against the customer database. Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

This is a one-time only change to the database.

2843818 (1102248)

SQL Option for DB2

• Spurious errors were sometimes returned while querying using an ALIAS.

2830383 (1100609)

Significant Changes in Enterprise Developer 2.3
Enterprise Developer version 2.3 includes significant changes in the following areas:
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• AMB
• Assembler Support
• CAS Security
• CAS XA Switch modules
• Compiler
• Data Tools
• Discontinued Support for cwgui
• File Handling - External File Handler
• File Locking
• IDE
• J2EE Connector
• JCL Support
• Mainframe Access
• MF Server Administrator (GUI)
• PL/I Support
• SQL - HCO for SQL Server
• Updated Run-Time System

AMB

• Loading PSBs sometimes caused an error that prevented the building of DDI symbols required for
generation.

2813119 (1098471)

Assembler Support

• Previously, the Assembler run-time error SOC4 (Invalid 370 address abend) was mapped to the COBOL
run-time error 200 (Internal logic error) which was misleading. It is now mapped to the COBOL run-time
error 205 (COBRT205 Invalid mainframe pointer value (Fatal)). Note that, in most cases, you receive an
Assembler SOC4 abend if the calling COBOL program was compiled without the AMODE"24" or the
AMODE"31" Compiler directives.

2806239 (1097738)

CAS Security

• The Enterprise Server External Security Facility now includes MLDAP ESM Module 2.0, with a new
algorithm for identifying the best-matching resource-access rule and ACE for resource-access security
checks. This algorithm is faster and matches most customers' expectations. The new algorithm also
provides an optional "username substitution" feature. It can be enabled by setting "rule substitutions" to
"yes" in the [Operation] section in the Security Manager configuration text area. When this is enabled,
the string "${user}" in a resource-rule name will be replaced with the name of the user that makes the
request. For example, a DATASET rule named "USERS.${user}.**" would apply to datasets with the
requesting user's name as the second qualifier. In rare cases, customers with complex, ambiguous
resource-access security rules might see experience changes in behavior as a result of the new
algorithm. The old algorithm is still supported and can be enabled by setting "version 1 authentication"
to "yes" in the [Operation] section of the Security Manager configuration.

2807531 (1097783)

CAS XA Switch modules

• The XA switch modules now support dynamic registration.

2682101 (1092325)
• The XA switch modules now support batch-only operations when multiple XA Resource Managers have

been defined.
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2664675 (1091082)
• In Enterprise Developer 2.2 update 2, Micro Focus identified undefined run-time behavior when the

following combination of directives was specified: SIGN"EBCDIC", CHARSET"ASCII", and one of the
following: HOST-NUMMOVE, HOST-NUMCOMPARE or SIGN-FIXUP. Previously (Enterprise Developer
2.2 update 1 and earlier), if this combination was specified, the SIGN”EBCDIC” directive should have
been ignored, to avoid a mixture of ASCII and EBCDIC characters; however, SIGN”EBCDIC” was still
being honored, resulting in undefined run-time behavior. Therefore, this combination of directives is now
invalid for Enterprise Developer 2.2 update 2 or later, and if specified, will be rejected at compile time.

2786397 (1095265)

Compiler

• For native COBOL, the size limit of the Data Division now stands at 2GB -1.

2796076 (1096384)
• COBDATA has no effect on compilation. The output of the Compiler is the same location regardless of

whether COBDATA is set.

Previously, it was not possible to specify sign(EBCDIC) with sign-fixup, host-num-move or with host-
num-compare. This combination is now supported in native COBOL but remains invalid for managed
COBOL code. This is applicable to version 2.2 U2 HotFix 10 onwards.

2824577 (1100823)

Data Tools

• DFCONV now returns the correct return-code; previously, it would always return 0.

Discontinued support for cwgui

The cwgui debugger is no longer available. You can now use the cw_java debugger which provides a richer
graphical debugging experience.

File Handling - External File Handler

• Custom file handlers (using DYNREDIR) are now called for each part of a concatenated file.

2795077 (1096322)

File Locking

• In versions prior to Enterprise Developer 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX
and Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the
tunable strict_file_locking=true is set, which is the default setting.

Example of potential changes in behavior:

• Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

• Process-B then attempts to open the file with read-only access and a sharing mode that denies
other processes read access (SHARING WITH NO OTHER).

With strict_file_locking=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

With strict_file_locking=false, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result
of the new file locking behavior. In such circumstances, we recommend that you review the file locking
and sharing requirements of your application and refactor your source code to work with the default
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setting. The original file locking and sharing behavior can be restored by setting
strict_file_locking=false.

IDE

• Enterprise Developer for Eclipse now ships with Eclipse 4.4.2 (Luna). If your applications contain JVM
COBOL code that was built with a previous version of the product, those parts of your application must
be rebuilt; otherwise you will experience errors at either compilation or run time.

(609469)
• A project can have one of two connection modes: NFS/Samba, where the target location is mounted as

a local drive, and RSE, which is a purely remote connection to the target location. For project types
such as Mainframe COBOL, NFS/Samba is required to use some tools which do not support RSE. For
most other projects, it is possible to switch between connection modes using the Remote Settings
context menu option. In the dialog box, there are radio buttons allowing for selection of connection
modes. On changing mode, you must select an existing connection of the appropriate type, or create a
new one. If switching to NFS/Samba mode, you must specify the local path to the project.

2792882 (1096196)
• By setting "-Denable.projectrepair=true" in the eclipse.ini file, .cobolProj and .pliProj files will be repaired

to reflect the workspace on project refresh.

2696707 (1095994)

J2EE Connector

• Enterprise Developer version 2.3 provided a new command-line argument to Java, mf.ssl.algorithm,
which can be set to an appropriate algorithm.

2799213 (1096684)

JCL Support

• When allocating a dataset to a step using MVSCTLBP, the values returned for the dataset attributes are
those defined in the catalog. If these are unset in the catalog, then the values defined in the
MVSCTLBP call are returned.

2816179 (1098882)
• The program attributes for the SSTM job have been changed to default to a mainframe dialect, AMODE

31 program. These attributes will be used when constructing the MVS Control Blocks for the job, which
means that the pointers to the sub-block areas will be in mainframe format rather than native format.

2815695 (1098825)
• Any OUTPUT statement information passed to the printer exit now includes the correct class of that

statement.

2814249 (1098636)
• In ESMAC, when deleting the Spool, the physical spool files and the entries in casspool.dat are deleted.

2812899 (1098412)
• New functionality has been added to the printer exit interface that enables you to delete the printer spool

file after a file has been printed. Set (ws)-prn-file-disp, which is defined in cascbprn.cpy, to 1 to delete
the spool file after printing. Additionally, the environment variable ES_JESYSMSG_OUTPUT=Y now
correctly routes spool files to the Output queue. Previously, ESMAC still showed the job on the HELD
display, even when there were no spool files HELD.

2812899 (1099966)
• A new environment variable has been introduced - ES_JESYSMSG_RESTRICTED. JESYSMSG spool

files are normally routed to HELD. This can be overridden by setting the environment variable
ES_JESYSMSG_OUTPUT=Y, which causes all JESYSMSG spool files to be routed to OUTPUT. If
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ES_JESYSMSG_OUTPUT=Y is set but you require specific classes to be held, set the environment
variable ES_JESYSMSG_RESTRICTED to a string containing the classes to be HELD.

2812878 (1098417)
• The IEBDG PICTURE value length must match the length specified. The value can now contain any

characters including quotes as on the mainframe.

2794881 (1096221)
• Changes to the IDCAMS ALTER processing prohibit applying MGMTCLASS changes to GDGs and to a

VSAM element other than a Cluster. Shareoption settings in a SMS DATACLASS are now applied to the
VSAM elements correctly.

2789939 (1095803)

Mainframe Access

Mainframe Access is now built using the IBM XL/C compiler rather than the SAS/C compiler that was used
previously. This change requires you to update your production JCL procedures with reference to the
supplied samples MFA, MFAS, and MFAAS. In each JCL procedure, change the STEPLIB DD statement
and add a new one, CEEOPTS.

The web administration feature is no longer available in Enterprise Developer.

To use the Mainframe Access support for Endevor you must be using Endevor R14 or later. CA stabilized
the Endevor API at R14, so if you upgrade from R14 to a later version you will not need to update the
support module that Mainframe Access uses.

MF Server Administrator (GUI)

• Passwords that entered through either the MFDS or the ESMAC interface now use the same encoding.

2792382 (1096011)

PL/I Support

• For BASED variables declared using the form BASED (ADDR(x)), storage checking is now performed
on the base reference “x”. This behavior requires the compiler option –nolaxbased. See the Open-PLI
User guide for more information on the options –[no]laxbased and –[no]laxdefined.

2819663 (1099293)
• The behavior of the –zp1 option has been reverted to that of before Enterprise Developer 2.2 Update 1,

with an additional correction relating to Char Varying data items. For a full description of the –zp1
option, refer to the Open-PLI User’s Guide in your product help. If you are installing ED 2.2 U1 HF5 as
an upgrade to ED 2.2 U1, you must rebuild any applications that are compiled using the –zp1 option
after the upgrade.

2789213 (1095636)
• Previously, when using any of the complier options -mvs, -dli, -ims, or -cics, the BINARY attribute was

incorrectly applied if the FIXED attribute is specified without BINARY or DECIMAL. The default attribute
DECIMAL is now applied.

• The BIGENDIAN attribute, when explicitly applied to a structure, is now propagated to its CHAR
VARYING and WIDECHAR VARYING members.

• Declarations using DEFINED storage are now checked for compatible types between the DEFINED
variable and its base variable. This behavior requires the compiler option –nolaxdefined. See the Open-
PLI User guide for more information on the options –[no]laxbased and –[no]laxdefined.

• The PL/I Macro preprocessor has been enhanced to support the use of the ANSWER statement from
within a PL/I Macro.

2698537 (1094243)
• The macro preprocessor has been enhanced to support arrays of CHAR and FIXED variables. New

macro builtin functions have been implemented (HBOUND, LBOUND, DIMENSION).
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2696129 (1094011)

SQL: HCO for SQL Server

• The return type for the HCOSS DB2 CHAR() function has changed from CHAR(255) to
VARCHAR(255).

2804069 (1097253)

Updated Run-Time System

• Enterprise Server now provides an execution environment capable of running applications that were
each built using different development products. A consequence of this is that if your application has a
main COBOL executable (.exe) that was built with a version of Enterprise Developer prior to version 2.3,
you should ensure that the executable is rebuilt and packaged with the new run-time system. This does
not affect mainframe subsystem projects deployed to Enterprise Server. You can rebuild from the IDE or
the command line.

Other COBOL subprograms built with previous versions of Enterprise Developer are not required to be
rebuilt.

Significant Changes in Enterprise Developer 2.2
Update 2
Enterprise Developer version 2.2 update 2 includes significant changes in the following areas:

• Compiler
• Compiler Front-end
• Documentation
• Enterprise Server
• File Handling - External File Handler
• J2EE Connector
• MTO: CICS Communications
• MTO: IMS DB
• MTO: IMS MFS
• MTO: JCL MVS
• MTO: JCL Utils
• Open PL/I Compiler
• Open PL/I Debugger

Compiler

• When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end

• Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

• The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.
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2697571 (1094370)

Enterprise Server

Starting with this release, IMSCONFG.DAT is no longer used for configuring enterprise servers. Instead,
you need to use environment variables to control the following fields:

Field Environment Variable

LANG=PL/I PCB address lists ES_IMS_PLI_INDIRECT_PCBADDR=D|Y|N

Where:

D
Dynamic (default) use indirect
PCB address list when PSB
language is PL/I and main
program is PL/I.

Y
Always use indirect PCB
address list if PSB language is
PL/I.

N
Never use indirect PCB
address list.

IBM Platform ES_IMS_IBMPLATFORM=M|D

Where:

M
MVS (default)

D
DOSVS Required by some
DOS/VS customers.

Secondary Index Sparse exit language ES_IMS_SPARSE_EXIT_LANG=C|A

Where:

C
COBOL

A
Assembler

Not set (default)
Sparse exits disabled

File Handling - External File Handler

• The ES_IMS_TLOG_FLUSH environment variable is now deprecated. To control TLOG flushing, use
the following environment variable: ES_IMS_DB_TLOG_WRITETHRU=0|1

0 Forces the flushing of TLOG buffers to disk on COMMIT only (default)

1 Forces the flushing of TLOG buffers to disk on all database I/O

To control database flushing, use the following environment variable: ES_IMS_DB_COMMIT_FLUSH=0|
1
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0 Forces the flushing of database buffers to disk on CLOSE only (default)

1 Forces the flushing of database buffers to disk on COMMIT only

Depending on the number of database updates, the frequency of COMMITs, and other concurrent
computer activities, use of these environment variables could cause significant performance
degradation.

2784949 (1095190)
• The use of the environment setting MFJ_INPUTDS_ERROR=N has been extended so that an input file

for a JCL step is now considered as optional and you no longer receive an error when the file is missing.

2784622 (1095971)

J2EE Connector

• The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)

MTO: CICS Communications

• In CRTE mode, the transactions are now run using the correct userid if the user has signed on after
running CRTE.

2663890 (1091979)

MTO: IMS DB

• The NODCX mfims dbdgen directive has been added to enable you to compile DBD source without
executing data capture exit routines contained in the DBD source. Previously, data capture exit routines
contained in the DBD source but that were not found during compilation were ignored. The new default
behavior is to process all data capture exit routines unless NODCX has been specified.

2579600 (1084675)

MTO: IMS MFS

• All existing IMS Global Physical Terminal edit routines (DFSGPIX0) in use must be recompiled with
charset EBCDIC instead of charset ASCII.

(606142)

MTO: JCL MVS

• Following the detection of an unrecoverable file status error on the casspool file, a message is displayed
on the console and an ACCEPT statement is issued. This stops processing, allowing you to fix the
underlying file problem, before continuing the job.

2651654 (1090287)

MTO: JCL Utils

• You can now activate support for the VSAM Shareoption for batch jobs and for CICS files that use a
catalog entry. For more details, see your product help.

2660651 (1091290)
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Open PL/I Compiler

• Important: If you are installing this release as an upgrade to Enterprise Developer 2.2 Update 1,
after the upgrade you must rebuild any applications that are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise Developer earlier
than 2.2 Update 1, with an additional correction relating to Char Varying data items. For a full
description of the –zp1 option, refer to the Open PL/I User’s Guide in the product help

This fix restores the behavior in Enterprise Developer versions earlier than 2.2 where, when compiling
with –zp1, all parameters are treated as unaligned. (In Enterprise Developer 2.2 Update 1, the behavior
when compiling with –zp1 was to not treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated as if unaligned.
In previous versions of Open PL/I, for Character Varying data items, the –zp1 unaligned requirement
was applied only to structure members and parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then multiplied by 4
equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned and each equals
10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the parameter z

element size (9 bytes) due to –zp1. This is incorrect and causes unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using –zp1, the size
of CHAR VARYING arrays now differs from previous versions of Open-PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in previous 
versions of Open-PL1 */ 
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2789213 (1095636)

Open PL/I Debugger

• Previously, the SRC list in the debugger only included the source filename without the path to the file. If
a source file did not exist in the current directory, the debugger could not find it using the filename as it
always expects a fully qualified filename. The SRC list now contains the fully qualified file name which
includes the path. Also, when changing the SRC or ENV values the source is updated correctly.

2783734 (1094988)

Significant Changes in Enterprise Developer 2.2
Update 1
Enterprise Developer version 2.2 update 1 includes significant changes in the following areas:

• MTO - JCL ESMAC
• MTO - JCL MVS
• MTO - JCL System Catalog
• MTO - JCL Utils - IDCAMS
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I RTS
• SQL: COBSQL

MTO - JCL ESMAC

• As part of an enhancement to improve performance of the spool display function, several new indices
have been added to the casspool.dat file. If you are upgrading from a previous release, you must
convert the casspool.dat file of any enterprise server created before Enterprise Developer2.2
Update 1 to the new format before starting any JES-enabled enterprise server and submitting jobs to it.

Enterprise Developer version 2.2 update 1 provided the following scripts that convert the
casspool.dat file to the new format:

• On Windows: fixcasspool.bat in %COBDIR%\bin or %COBDIR%\bin64
• On UNIX/Linux: fixcasspool.sh in $COBDIR\bin

,

To convert the casspool.dat file, run the appropriate script from an Enterprise command prompt
using the following syntax:

• On Windows:

fixcasspool.bat <old-location>casspool.dat <new-location><backup_filename>

• On UNIX/Linux:

fixcasspool.sh <old-location>casspool.dat <new-location><backup_filename>

Where:

• <old-location> - the fully or partially qualified location of the existing casspool.dat file, if not in the
current directory. Optional.

• casspool.dat - the spool file that will be updated. The file is located in the same directory as the
enterprise server's system catalog.

• new-location - the fully or partially qualified location where the backup file will be created, if not in the
current directory. Optional.

• backup_filename - the name of the file that will be a back-up of the old casspool.dat file. If the file
name already exists, the script terminates without converting the casspool.dat file.
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If you do not convert casspool.dat, attempts to start the enterprise server fail with the following
messages:

JES000011E Batch Spool File Error; Status [39]  
          JES000130E Note JES000011 Error - New casspool indexes may need 
generating. See error 
          description in product docs  
      

2654417 (1090421)

MTO - JCL MVS

• The final disposition processing of temporary datasets has been corrected to be in line with the
mainframe processing, with a default value of PASS unless DELETE has been specified in the DD card.
Previously, the default value was DELETE.

2671175 (1091627)
• When running batch programs, receiving an "Out of Space" error requires operator intervention to

continue processing.

2642115 (1089055)

MTO - JCL System Catalog

• You can now use MGMTCLAS to provide an EXPIRE AFTER number of days. This is used to calculate
an expiry date for datasets allocated using the MGMTCLAS parameter.

2664639 (1090992)
• MFLEX*.DAT files were not being moved with spool files. Spool housekeeping now deletes LEX files

when it deletes JESYSMSG. Also, to identify any remaining orphan LEX files, the
MF_SPOOL_HK_LEX_SCAN environment variable sets spool housekeeping to scan the data directory
for LEX files older than the max retain period.

2659555 (1090759)
• Spool housekeeping has been rewritten to provide a number of new features. These will be described in

the product documentation.

(592452)

MTO - JCL Utils - IDCAMS

• The state of VSAM virgin files is now being correctly processed.

2686149 (1093587)
• A REPRO COUNT of zero is now processed as zero records to be included in the REPRO operation.

2665006 (1091034)

Open PL/I Compiler

• On Intel platforms, the -bitsltr Compiler option can be used to store bit strings left-to-right within each
byte. This is similar to Big Endian bit ordering on Intel platforms. The Intel default is to store bit strings
right-to-left within each byte similar to the Intel hardware bit ordering.

2675860 (1092098)
• The libraries libmf.so, libespli.so and libespliz.so are no longer delivered. This is

transparent if linking PL/I objects using mfplx or ldpli, and no changes are needed to your build process.

However, if linking PL/I objects using either the UNIX ld command or the Enterprise Developer cob
command, you must include the libraries libmfpli.so when linking stand-alone Open PL/I objects
(executed outside of Enterprise Server), or libmfpliz.so when linking PL/I objects executed under
the control of Enterprise Server.
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To do this, use the option -lmfpli for stand-alone Open PL/I objects or -lmfpliz, respectively, for PL/I
executed under Enterprise Server. These options replace the –lmf option.

• Open PL/I applications must be recompiled and re-linked in order to use them with this release.

Open PL/I Debugger

• The debugger now stops before an ON UNIT triggers. This lets you perform debugging on the ON UNIT
itself. You can configure the ON UNITS the debugger stops on.

2674783 (1092319)

Open PL/I RTS

• Writing to SYSPRINT when running outside of Enterprise Server now drives output directly to the
terminal and does not buffer the I/O.

2477031 (1076203)

SQL: COBSQL

• COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)

Significant Changes in Enterprise Developer 2.2
Enterprise Developer version 2.2 included significant changes in the following areas:

• ASM Compiler: HLL Macro Assembler
• CAS (COBOL App Server) General
• CCI Session Layer Code
• Compiler
• Eclipse IDE
• File Handling - Sort / JCL Sort
• Interface Mapping Toolkit
• JCL System Catalog - Dataset Allocation
• MF Directory Server
• MF Server Administrator (GUI)
• MFBSI
• MTO - IMS Other
• MTO - JCL MVS
• MTO - JCL System Catalog
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I RTS
• Request Handler

ASM Compiler: HLL Macro Assembler

• A "." (dot) specification is no longer ignored in the SYSIN environment variable or in the mf370ctl.cfg file
when used to specify an output directory, and indicates the current directory. This is a change in
behavior from Mainframe Express, where the "." (dot) character in the SYSIN environment variable or in
the mf370ctl.cfg file is still ignored and assembler output files are placed in the directory specified by the
SYSIN environment variable.

• Assembler Build Output will now be sent to the location specified in the COBOL output path project
setting. Previously, all Assembler build output went to the project directory.
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CAS (COBOL App Server) General

• Previously, on cancelling an active JCL job on UNIX (after you have used STOP on the ESMAC > SEPs
page to stop the INITIATOR that it is running in), the INITIATOR was terminated and a new one was
restarted in its place. Now, the new INITIATOR will not be started, as the STOP request was received
before the CANCEL.

2559087 (1084226)

CCI Session Layer Code

• A new option, use_global_namespace, is available for the cci.ini file in the Windows %SystemRoot%
folder. If use_global_namespace is set, all the ccishared memory objects are created in a system-wide
address space, and the applications hosted by different users, including system services, can
communicate. To use this facility, edit the cci.ini file and ensure use_global_namespace is set to "yes".
[ccismem-base] # Allow interaction between users on a # single system. Using this option reduces
security as # all users will have access to the same name space. use_global_namespace=yes If the
value of this option is anything other than "yes", or if the option is missing, no change is made to the
existing behavior.

2195519 (1062800)

Compiler

• The default for the NSYMBOL directive under DIALECT(ENTCOBOL) has been changed to
NSYMBOL(NATIONAL) to emulate the equivalent IBM default.

2657471 (1090355)
• To improve RM/COBOL and ACUCOBOL compatibility, the SIGN clause at a group level is no longer

applied to non-DISPLAY usage signed numeric data items within the group, just as it is not applied to
unsigned numeric data items and non-numeric data items within the group.

2549904 (1082171)
• Previously, even though no code was generated, the Compiler allowed the ON EXCEPTION and NOT

ON EXCEPTION phrases in the DISPLAY statement in formats that do not allow these phrases. As a
result, if the DISPLAY statement was in the ON EXCEPTION phrase of another statement, the NOT ON
EXCEPTION phrase would bind incorrectly with the DISPLAY statement instead of with the intended
containing statement - for example, ACCEPT or CALL.

Eclipse IDE

• The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. If the column is not present in the view by default, it can be added through the
Configure Columns dialog box in the View Menu.

2608496 (1088530)
• The outline of the ruler in the COBOL editor now changes on modelChanged depending on the current

source format.

2488419 (1077143)
• Deleting a Web service or a Java interface mapping now deletes the files relating to it from the repos

directory and, if it is empty after the files have been deleted, will remove the repos directory itself.
• The IDE now performs an automatic directive determination when files are added to a project. You can

also use a command to perform directive determination of the project manually.

File Handling - Sort / JCL Sort

• When used with MFJSSTRICTSORT=ON, MFJSORT now errors (return code 16) if the input RECFM is
different to a SORTOUT RECFM. It also errors if the input RECFM is different to an OUTFIL RECFM
when FTOV or VTOF/CONVERT has not been specified.
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2643384 (1088993)

Interface Mapping Toolkit

• For program-based Service Interfaces, if the program-id name in the COBOL source is in lowercase and
is not surrounded by quotes, its corresponding entry-point name is now forced to uppercase when used
in a Service Interface Operation. Previously, the case was preserved. As a result of this change, existing
Service Interfaces will become invalidated if you refresh their program's annotations because of the new
spelling of the entry-point name. To avoid this, you need to surround the program-id name in the
COBOL source with quotes before you refresh the annotations.

• The default for previous releases was to create a catalog entry with no physical file until data was
actually written to the catalog. Now, a PC file is allocated for non-VSAM files by default. You can
emulate the previous behavior if you set the environment variable MFALLOC_PCFILE to N.

MF Directory Server

• The mfds command line option for exporting registered Enterprise Server definitions to an XML file now
supports the "*" option. This exports all registered servers rather than a specified server. Multiple server
definitions are now exported into the target directory and saved into a file with the default name
ALLSERVERS.xml. The import option now also supports the import of multiple server definitions from a
single XML file.

2641890 (1088838)
• mdump now supports a new option, -e, to help you query the Security Manager configuration details.

The possible values of the option are: "1" - shows security configuration that applies to any returned
enterprise servers; "2" - shows security configuration for MFDS and the default Enterprise Server
security configuration. This requires MFDS version 1.15.00 or higher; "3" - returns the properties of all
configured external Security Managers.

2487164 (1081693)

MF Server Administrator (GUI)

• When adding a user to an external security manager, you can now include a password expiry time in
the Advanced Configuration section of the Add New User wizard in Enterprise Server Administration.
The field value is specified using generalized time format (YYYYMMDDHHMMSS.0Z), and can be used
by the MLDAP ESM for calculating whether a user's password has expired and requires updating. This
value may only be specified using this page when adding a user. You need to use an external directory
services configuration tool to edit it.

2562118 (1083203)

MFBSI

• casout now correctly sets return-code to the job status for the sysout retrieval when the file is less than
65K. Also, MFBSI now considers return codes of 0, 7 or 8 to be successful for JESYSMSG retrieval
where, previously, it only considered 0 as successful.

2655482 (1090444)

MTO - IMS Other

• The DBDCPY, MFSCPY, and PSBCPY environment variables are no longer required and have been
deprecated. Use the IMSCPY environment variable to specify copybook locations.

MTO - JCL MVS

• Empty values for the USER or NOTIFY parameters on the JCL JOB card no longer cause an error when
parsing the JCL.
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2646770 (1089380)
• The disposition processing of PASSed datasets has been revised to be consistent with mainframe

processing. Particularly, received datasets are removed at the end-of-step processing, unless they are
to be passed on to another step in the job. Any passed datasets that were not received at the end of the
job may be removed if they conform to the mainframe conditions for this.

2610362 (1087601)

MTO - JCL System Catalog

• The value for the JCL DD UNIT=device parameter is now stored in the system catalog entry for the
dataset.

2619050 (1089095)

Open PL/I Compiler

• Open PL/I applications must be recompiled and re-linked in order to use them with this release.

2675860 (1092098)
• If using the -cics, -ims, or -mvs options when compiling on a little endian platform, the possibility for

errors existed. Starting with this release, using the -cics, -ims, or -mvs options automatically uses -
bigendian, thereby eliminating the possibility for these errors. Evaluate any applications that were built
with a prior release to determine any impact on any data files being used, or where programs compiled
with the -mvs option pass data to sub-programs compiled without it. The -bigendian option can be
suppressed by adding the -native option after the -cics, -ims, or -mvs options.

Open PL/I Debugger

• CodeWatch no longer attempts to use an incorrect directory when starting. Also, CodeWatch is now the
default debugger when no other debugger is specified, and is the only debugger available when using -
optexec plitest.

2655906 (1090193)
• Support for the evaluation of X, NX, Z, A, and E constants nas been added to CodeWatch.

Open PL/I RTS

• A problem with possible truncation or trailing zeroes within PICTURE assignments has been fixed. As
the fix depends on changes to both the Compiler and the run-time, you must perform a complete rebuild
of all your source code (recompile and relink) in order to apply it.

2662261 (1090768)
• Previously, when taking a PLIDUMP, if the .PDB file needed for a PLIDUMP was not in the same

directory as the .DLL and the .STB files, and they were not in the first CAS_BATCH_PATH subdirectory,
then the PLIDUMP was not successfully generated and an S0C4 abend could occur.

2615412 (1090483)
• The Open PL/I debugger no longer loses its place and behaves erraticly when debugging code

containing the same PL/I macro multiple times within the same source routine, even if the -nodebuginfo
and -pp options are not specified.

2612530 (1087809)

Request Handler

• A problem that caused BIS to create log files in a directory named C:\ProgramData\AcuCorp\BIS
\LogFiles was fixed. BIS no longer creates log files unless specified and the BIS logging service is now
disabled by default. To enable it, you need to use the following global environment variable:
BIS_LOG=[ OFF | ON | <directory> ] Where the values are:
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• OFF - disables logging (the same as if BIS_LOG is not specified or is left blank)
• ON - enables logging and directs the log files into the default location, which must not be read-only.
• <directory> - enables logging and directs the log files into the specified directory. The user must

ensure that the BIS request handler has write rights for this directory. The directory must be an
absolute path or network path. If the specified directory does not exist, BIS will attempt to create it.
The containing directory must exist.

The BIS_LOG variable is only examined when the BIS application pool is started or recycled. After
setting or changing BIS_LOG, IIS must be restarted in order for the variable to take effect.

Significant Changes in Enterprise Developer 2.1
Update 1
Enterprise Developer version 2.1 update 1 includes significant changes in the following areas:

• Documentation
• IDE
• JCL Support

Documentation

• To ensure no loss of functionality when accessing Vision and RM/COBOL data files, you should use the
appropriate IDXFORMAT Compiler directive setting or file handling option, and not use the
CALLFH(ACUFH) Compiler directive. See 'Configuring Access to Vision Files' and 'Configuring Access
to RM/COBOL Data Files' for more information.

IDE

• You can now set program breakpoints as follows - click "Add Program Breakpoint" in the Run menu or
on the Breakpoints view toolbar, and enter the program name in the dialog that is displayed.

• Local Enterprise Server regions without secure user credentials are now started with casstart and
stopped with casstop commands.

JCL Support

• Input files are no longer optional so you can receive errors if you catalog a file without creating the
physical file. To help avoid failures of JES job steps because of a missing input file, you can use one or
both of the following environment variables: 1) MFALLOC_PCFILE=Y - results in the creation of a
catalog file if DSORG=PS is set in the DCB parameters. 2) MFJ_INPUTDS_ERROR=N - results in
IEBDG, IEBGENER and IEBCOMPR utilities to treat missing input files as though they were present but
empty files.

Significant Changes in Enterprise Developer 2.1
Enterprise Developer version 2.1 includes significant changes in the following areas:

• CICS Support
• IDE
• Run-Time System
• Vision File System

CICS Support

• If external security is configured (MLDAP) and the default ESMAC user is not allowed to login, the
region does not startup.

2550800 (1082337)
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IDE

• You can now specify in the IDE whether directories that you add to the project should be added to the
copypath. You configure this in the project's properties under Micro Focus COBOL > Build Paths, and
on the Copybook Paths tab.

(589096)

Run-Time System

• When running a full-screen application inside a terminal emulator on Linux, the actual size of the
terminal is read at startup and reread when the terminal is resized. This behaviour is also supported on
AIX, HP/UX, and Solaris. The Micro Focus vt220 terminfo entry now correctly describes a 24-line
display. A vt220-25 terminfo entry is included for compatibility with the previous behaviour.

2579335 (1084817)

Vision File System

• When you configure your application to return RM/COBOL file status codes, by setting
COBFSTATCONV=rmstat, the codes returned are ANSI'85 codes.

2553438 (1082469)

Significant Changes in Enterprise Developer 2.0
Enterprise Developer version 2.0 includes significant changes in the following areas:

• Compiler
• HCO for DB2 LUW
• File Handling
• IDE
• Run-Time System

Compiler

• The scope of the ILUSING Compiler directive when used in a $set command has changed. The scope
of the directive is now limited only to the source file it is set in, and not globally. This new behavior may
mean that your source files no longer compile. To resolve this, add the required ILUSING statements to
the required individual source files, or add the ILUSING directive on the command line. Alternatively,
use the IDE to achieve the required behavior: in Visual Studio, use the Namespaces tab; in Eclipse, set
the directive in the Additional Directives field.

HCO for DB2 LUW

• The DB2 ECM has been updated to resolve run-time errors returned when compiling against mainframe
databases in 64-bit mode.

2549058 (1082441)

File Handling

• When reading a file cataloged as DISP=SHR the file handler now buffers the read for better
performance.

2518330 (1079491)

• Using SKIP=nL in the SECTIONS section of SORT will now cause the following behavior: 1)Under a
mainframe sort, (n/3 rounded up) blank lines (when n>0) will be skipped and the appropriate carriage
control character will be placed in column 1 of each blank line. 2) For sequential file organizations, the
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same behavior will occur but no carriage-control characters will be printed. 3) For line sequential files, n
blank lines will be skipped.

2525670 (1080092)

IDE

• Typing in the sequence area moves text after the cursor to the right and doesn't delete the characters at
area end. To overwrite characters in the area, switch to insert mode by pressing the Insert key. Pressing
the Tab key in the sequence area indents the text if the option "Pressing Tab in the sequence number
area moves caret to area A" is not selected. Pressing the Tab key when there is a multiline selection
aligns the text to the area margins.

• Typing in the sequence area now works like typing in a regular text editor - it moves to the right all the
text after the cursor and doesn't delete the charaters at area end. If you want to overwrite characters in
the area, you can switch insert mode to overwrite by using "Insert" key.

Run-Time System

• On Windows 7, building 64-bit native COBOL applications always rebuilt the entire project. This was
caused by the Microsoft FileTracker tool, used by the COBOL projects to track dependencies, not
working because of Windows 7 security updates. This product now includes a fix to work around this
issue.

Unsupported or Deprecated Functionality
The following topics describe functionality that was removed or deprecated at each product release.

Unsupported or Deprecated at Enterprise Developer
9.0
The following features or functionality are no longer supported or are deprecated at version 9.0:

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release after release 9.0. The SafeNet Sentinel licenses will not be
supported after release 9.0 and you need to use AutoPass licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.

Unsupported or Deprecated at Enterprise Developer
8.0
• Data File Editor - The method used to filter data files has been deprecated and replaced with new

functionality.
• Application Workflow Model - Legacy Element List Creation using a Boolean type is deprecated.

Starting in this release, you must create an element list using an explicit Create Element List step
specified under an action.
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Unsupported or Deprecated at Enterprise Developer
7.0
The following Compiler directive option has been deprecated:

• ILCLR(2) - this is as a result of deprecating support for versions 3.0 and 3.5 of the .NET Framework.
Applications that have this option set will produce an E level message when compiled in this release of
Enterprise Developer.

Unsupported or Deprecated at Enterprise Developer
6.0
No additional features were unsupported or deprecated at version 6.0.

Unsupported or Deprecated at Enterprise Developer
5.0
No additional features were unsupported or deprecated at version 5.0.

Unsupported or Deprecated at Enterprise Developer
4.0
The following features or functionality are no longer supported or are deprecated at version 4.0:

• Support for Eclipse 4.4 and 4.5 has been discontinued.

Unsupported or Deprecated at Enterprise Developer
3.0
The following features or functionality are no longer supported or are deprecated at version 3.0:

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.

• Compatibility AddPack for Visual COBOL - this is now deprecated and will not be available with release
3.0 and later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows
and UNIX) which were part of the AddPack are now installed as part of Enterprise Developer for Visual
Studio. The run-time components are installed as part of Enterprise Server. These are only included for
backward compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

• Audit Manager is deprecated and provided for backward compatibility only. We recommend that you use
syslog events instead. See Enterprise Server Auditing for more information.

• The following DB2 environment variables are deprecated at version 3.0, and provided for backward
compatibility only.

• HCOBND - Micro Focus recommend you use either the BIND or the BINDDIR compiler directive
option.

• The following compiler directives are deprecated at version 3.0, and provided for backward compatibility
only.
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• CONVERTRET
• IDYSRCPATH
• ILOBJECTIFY
• OPTION
• SPZERO
• TRICKLE

• The following file handling options are deprecated at version 3.0, and provided for backward
compatibility only. Micro Focus recommend you use IDXFORMAT"8" instead:

• STRIPING
• MAXSTRIPEDIGITS
• MAXSTRIPEFILES
• MAXSTRIPESIZE
• STRIPE-X
• STRIPENAMETYPE

Unsupported or Deprecated at Enterprise Developer
2.3 Update 2
The following features or functionality are no longer supported or are deprecated at version 2.3 Update 2:

• The command_line_linkage tunable has been deprecated; equivalent functionality can be achieved by
using the COMMAND-LINE-LINKAGE Compiler directive instead.

Unsupported or Deprecated at Enterprise Developer
2.3 Update 1
The following features or functionality are no longer supported or are deprecated at version 2.3 update 1:

Unsupported or Deprecated at Enterprise Developer
2010
The following Net Express features or functionality were not supported or were deprecated from the first
version of Enterprise Developer:

These Net Express compiler directives are not supported by Enterprise Developer :

01SHUFFLE
64KPARA
64KSECT
AUXOPT
CHIP
DATALIT
EANIM
EDITOR
ENSUITE

EXPANDDATA
FIXING
FLAG-CHIP
MASM
MODEL
OPTSIZE
OPTSPEED
PARAS
PROTMODE

REGPARM
SEGCROSS
SEGSIZE
SIGNCOMPARE
SMALLDD
TABLESEGCROSS
TRICKLECHECK
WB2
WB3
WB

Note: The directive SPZERO was already deprecated from Net Express 5.0 onwards, and is provided
for backward compatibility only. You should instead use SIGN-FIXUP.
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and the pseudovariables of the following Net Express environment variables are obsolete and cannot
be used:

BASENAME
FILENAME
PATH
TARGETDIR

Known Errors and Restrictions
Refer also to the Known Issues and Restrictions topic in the Product Information section of your product
Help.

The following errors and restrictions are known to apply to Enterprise Developer version 9.0:

ChangeMan Attachment Models

• The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0 or later. This is a result of several tools that are called with a static
value=`*` in the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan
attachment model 5.0 and earlier under Enterprise Developer 9.0 you must remove the static value=`*`
from all CMG_PROP_STATIC_SUBSYSTEM input parameters.

Compiler

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0 and later, the .NET COBOL and JVM COBOL
run-times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a
version 5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue,
you need to recompile any programs that use this construct in the newer versions of Enterprise
Developer.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 or later are not affected.

Enterprise Server Common Web Administration

• On the Solaris platform, Enterprise Server Common Web Administration (ESCWA) cannot enable the
External Security Facility (ESF). This results in ESCWA failing to enable user authentication and
authorization. However, you can still enable authentication and authorization for the Micro Focus
Directory Server (MFDS) and corresponding enterprise server regions.

Operating Systems

• The Server Core form of Windows Server 2019 is not supported.
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Upgrading from Mainframe Express to Enterprise
Developer

An introduction to the process of upgrading your
COBOL applications
Enterprise Developer enables you to develop applications that run on the mainframe or offload applications
from the mainframe and develop them locally on Windows. If you are upgrading from Mainframe Express,
you can move your existing applications to Enterprise Developer and continue to develop them in the new
environment.

Once you have familiarized yourself with the basics of the Enterprise Developer IDE, you can import your
existing code in Enterprise Developer.

See the Upgrading to Enterprise Developer guide for full details on upgrading your applications from
Mainframe Express to Enterprise Developer, the changes between the two products and what technologies
are not supported or have been superseded.

How to create an application created with Mainframe
Express to Enterprise Developer
The following provides an outline of the incremental approach to upgrading a Mainframe Express
application to Enterprise Developer where you use both development products to maintain the application
while gradually moving the sources to the new IDE.

1. Review your Mainframe Express application:

• Create an inventory of the sources it uses, the copybook dependencies, data files, SQL, JCL and
IMS files, third party utilities, integrated preprocessors.

• Check what workgroups are used and what the workflow processes are, what repositories are used
to store the sources, what the build scripts and command line parameters are, how the application
accesses the mainframe.

Note: Use the MFECL command line utility of Mainframe Express to export the project details
to an .xml file which will include all project details at a glance - files in use, workgroups, output
and dependency folders, Compiler directives, project and file options. The command to use is:

mfecl /exportxml project-name.mvp [ xml-filename.xml]

• Review the XML file to see what information it includes:
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The file provides details about the project and file settings, as well as of the workgroup levels. You
are going to use this information when you are configuring the new projects in Enterprise Developer.

• Analyze the strengths and weaknesses of your application in the Mainframe Express environment
and to what extent it meets the business requirements. The application might be a good candidate
for being modernized by upgrading it to Enterprise Developer.

2. Define a small selection of the source files of your Mainframe Express application that you will move
across to Enterprise Developer as a start – this could be the files responsible for a single operation of
the application.

See Considerations for whether the files need to be recompiled in the new environment.
3. Prepare your original application:

• Replace any hard-coded paths in your Mainframe Express project with concatenated ones – to do
this, in Mainframe Express, click Project > Convert Paths to Relative.

• Backup the sources.
4. Create mainframe subsystem projects in Enterprise Developer.

In Eclipse:

a. Click File > New > Mainframe COBOL Project.

To emulate workgrouping behavior in Eclipse, you can use copybook projects that will define the
copybook paths for each level, and you can add these projects as dependency projects to the ones for
the source files. See Emulating workgroups in Eclipse in this guide.

5. Configure the projects in Enterprise Developer.

In Eclipse, to specify project properties:

• Navigate to the project properties, expand Micro Focus and set the project properties as taken from
the xml-filename.xml file.

6. Import the source files and establish a product baseline – use linking to add the files to the new projects
in order to store the files in their original location:

In Eclipse:

a. Right-click the project, and click New > Folder if you wish to add an entire folder, or New > File.
b. Click Advanced, and click Link to alternate location (Linked Folder) or, respectively Link to File

in the file system.
c. Browse to the folder in your Mainframe Express project that includes the files you wish to add, select

the folder or the file to add, and click Finish.
7. Set individual file properties:
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• Right-click a file in your project, and click Properties.
• Set individual file properties as taken from the xml-filename.xml file.

8. Compile the sources in Enterprise Developer.

In Eclipse:

• By default, Eclipse performs a build automatically as you are adding the source files. Check the
Console view to see if there are any errors.

9. Create and configure an enterprise server instance for the projects.

Check the xml-filename.xml file to see what regions the original application uses, and what its
settings are.

10.Run the application.

• Run JCL applications by submitting the JCL file – right-click the JCL file in your project, and click
Submit JCL (in Visual Studio) or Submit to Enterprise Server (Eclipse).

Use the Micro Focus Rumba emulator supplied with Enterprise Developer to connect to the
enterprise server instance you have created. Run the application in Rumba.

11.Debug and perform thorough testing.
12.Configure MFA and the Mainframe Explorer window or the Remote Systems view.
13.Plan for rolling out Enterprise Developer project and servers to your development and QA teams. Also,

organize relevant training for them.

a. As a first step, ensure your project is configured as desired and that it builds successfully.
b. Distribute the project:

In your Eclipse workspace, copy the project folder with all the files. You can store this on a shared
network location. Users need to import the existing project and sources locally in their workspaces.

Enterprise Server templates:

Create your own templates using the following command at an Enterprise Developer command
prompt:

mfds -x [repository type] [repository address] [server name] <options> 
<user id> <password>

Distribute the server .xml files across your development teams. The file should be saved in the
%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ServerTemplates
subfolder in the local Enterprise Developer installation folders.

Using Enterprise Developer for Visual Studio

Understanding the structure of Enterprise Developer solutions

On creating a new project, the following files are created in the file system with the following structure:

...
   |_Location
     |_Solution
     | |_Name
     |   |_bin
     |   | |_x86
     |   | | |_Debug
     |   | | |_Release
     |   | |
     |   | |_x64
     |   |   |_Debug
     |   |   |_Release
     |   | 
     |   |_obj
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     |   | |_x86
     |   | | |_Debug
     |   | | |_Release
     |   | |
     |   | |_x64
     |   |   |_Debug
     |   |   |_Release
     |   | 
     |   |_Properties
     |
     |_Solution.sln
     |_Name.cblproj
     |_Name.dep
     |_Program1.cbl

If you select the Create Directory for Solution option when creating a solution, the structure is slightly
different.

In the Solution folder:

• Solution.sln - a description of the solution and what it contains.
• Name.cblproj - the project file that is opened in Visual Studio, which holds the description of the project

and all its related configuration and directives information.
• COBOL source files - when you create a project, a skeleton COBOL source file Program1.cbl is

added for most of the project templates.

In the Name folder:

• ..\bin - this is the default location of build artefacts. With this folder are the subfolders x86\Debug
that contains the executables or libraries, and .idy file for each of the project's COBOL source files.
The .idy files contain information required for debugging your application. When you use the Release
build configuration, build output goes to a subfolder x86\Release and no .idy files are created.

Debug and Release are standard build configurations that you launch from the Visual Studio task bar.
They use a different set of compiler directives as well as outputting different files. You can create your
own build configurations by clicking Build > Configuration Manager and choosing New from the
Active solution configurations drop-down list.

The x86 folder exists because the default output platform is 32-bit. If you change this to be 64-bit, you
will instead find your ouptut in an x64 folder.

• ..\obj - this also has x86\Debug subfolders, and contains an .obj file for each source file, used in
intermediate build stages. The obj folder also holds supporting information such as logs and file lists.

Note: The project file .cblproj is an msbuild file, much like a makefile but consisting of XML that
you can extend and modify to customise your builds. You can use this directly from command line, as
it uses the same build environment as the IDE, and behavior is identical. This means you can have a
single source of configuration information that makes your build process easier to maintain.

If you open a command prompt and change to the Location folder, you can execute the msbuild
command, without needing to specify the .cblproj file.

Finding your way around the IDE's features

• Solutions and projects

A solution is a container holding one or more projects that work together to create an application. The
solution has the extension .sln. A COBOL project has the extension .cblproj and a C# project has
the extension .csproj.

Solution Explorer shows the solution that is open and the projects therein.
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You can use the project's properties pages to display a list of the files in your solution with file details
like output file type and location, COBOL dialect, and the number of errors generated by the file. To
display the properties, click Project > Name Properties.

• COBOL editor

The COBOL editor provides help such as column cut and paste, and background syntax checking,
which underlines errors with red wavy lines (also known as "squigglies"), which you can then hover over
to display details of the syntax error.

When you are editing, you can insert code snippets and navigate forward and backward quickly, and the
Find All References option enables you to search for references of any COBOL data items, section
and paragraph names in the solution.

You can customize the editor to display line numbers, adjust colorization, tabs, and margins, from the
Text Editor > Micro Focus COBOL > Advanced page in Tools > Options.

When developing code, the editor provides IntelliSense that helps you write syntactically correct code
and, in .NET COBOL code, helps when you need to type more complicated constructs, such as the
code to override the members that a class inherits from a base class or the code for implementing an
interface.

The Light Bulbs feature for implementing an interface helps complete incomplete interface declarations.
A Light Bulbs appears at the beginning of the declaration: click it and choose the missing member(s) of
the inheriting interface.

When you encounter a COPY statement, or data item that is defined in a copybook, if you put your
cursor on that code and press F12 the appropriate copybook opens in the editor at the relevant line. You
can also do this by right-clicking the line and selecting Show copybook name.

• Setting Compiler directives

Many Compiler directives are set automatically by certain configuration options in the IDE, but you can
explicitly add directives to your project. Right-click on the project in Solution Explorer and choose
Properties. In the COBOL tab, you can see directives that are set by the IDE in the Build Settings text
box. Enter others in the Additional Directives text box as a space-separated list.

If you use a separate text file to manage your directives, you can reference this instead by entering the
USE"directives file" directive. You should enter a relative path.

• Build Tools, the Output Pane and the Error List

Build configurations define how to build a project or solution. There are default configurations of Debug
and Release for each project type, and you can create your own specific configurations.

The Output window shows the results of your build together with errors. You can double-click an error
and navigate directly to the appropriate line in the source code. You can do the same from the Error
List.

• Debugging

When you debug the application, you can step through the code, hover over a data item to see its value,
and watch data item values in a variety of ways. You can specify breakpoints on a range of conditions,
such as when an expression is true or changes, or when a line is hit a specified number of times.

In native code, you can set COBOL watchpoints on data items and watch for changes in the area of
memory associated with the watchpoints. When the memory changes or a condition associated with the
watchpoint has been met, the debugger breaks on the line that follows the line on which the data
change occurred.

Also in native code, you can use the Memory window to watch the contents of the memory that is
associated with data items or expressions.
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Change the Defaults to Replicate Your Existing Project
Structure

Change the location of source files

To add an existing COBOL source file to your project, right-click the project in Solution Explorer and choose
Add > Existing item. You can then browse to the sources you want to add.

• If you click Add, Enterprise Developer makes a copy of the file, which it saves in the project folder. Any
edits you make to this file do not get applied to the original.

• If you click Add As Link, a reference to the original file, rather than a copy of it, is added to the project
in Solution Explorer. If you then open the file in Visual Studio, any edits are applied to the file in its
original location.

You can also drag files from Windows Explorer and drop them into your project in Solution Explorer. This
also makes a copy of the file and leaves the original in place.

To remove a file from your project, but not delete the file on disk (whether added as a link or not), right-click
the file in Solution Explorer and choose Exclude From Project.

Change the location of built files

By default, built artefacts for the Debug configuration are created in the ..\Location\Solution\Name
\bin\x86\Debug folder.

You might want to change this, so that several developers can save built items in the same folder for
example. To do this, right-click the project in Solution Explorer and choose Properties. In the COBOL tab,
change the value of the Output path field to the preferred folder. (We recommend you always use relative
paths when entering this value.) When the project builds, the output files will be saved in this folder, and the
folder created if it doesn't already exist.

To change the output path for the Release configuration, select Release Configuration in the COBOL
property page and change the value of the output path.

Change the type of built files

The default output and target types when you create a project depend on the project type. You can change
these settings on the project Properties page. Use the following table to show the default output and target
types for each project and the possible changes once the project has been created :

Project type Output type Target type Possible output
types

Possible target type

Native Console application .exe single .dll, .exe single, multi

Windows application .exe single .dll, .exe single, multi

Link library .dll single .dll, .exe single, multi

Enterprise Server
application

.dll multi .dll, .exe single, multi

INT/GNT application .int multi .int,.gnt multi

Managed Console application .exe single .dll, .exe single

Windows application .exe single .dll, .exe single

Link library .dll single .dll, .exe single
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Project type Output type Target type Possible output
types

Possible target type

Procedural multi-
output project

.dll multi .dll, .exe multi

Best Practice in Enterprise Developer Development

Break down large projects

Projects with a large number of source files and build artefacts can be hard to navigate and slow to build. If
you find this the case. we recommend that you review the contents of large projects and split them into
separate projects (and possible separate solutions) in which you group items that are logically related.
These projects can still be built in the same output folder if required.

For example:

• If you have different versions of a product for different customers, keep common source in one project
and a separate project for each customer. You could also have a master solution into which you add
projects from other solutions by right-clicking a solution and selecting Add > Existing Project.

• If you have core code that is rarely changed or recompiled, keep that in one project and have separate
projects for those areas that change regularly.

Referencing common sources

To avoid repetition and reduce maintenance effort, you should consider keeping all your Compiler directive
settings in a directives file and reference this file in each project. Similarly you should keep copybooks in a
single project and add this project as a dependency to your COBOL projects.

If using .NET COBOL code and multiple projects, use project references rather than file references.

Create templates

After creating and configuring a project, you can save the settings as a template that can be reused and
distributed to other users. It can be added to the list of project types available when clicking File > New >
Project and then .

To create a template of the open project, click File > Export Template and follow the steps explained in the
Export Template Wizard.

Use relative paths

Keep source relative to a base path and avoid full paths so that code is portable and easy to use with
source control systems. You should also avoid using network shares or drives.

Modernize Your Applications and Processes

Following industry standard development practices

Many source code control systems and Agile tools can be integrated into the Visual Studio IDE.

You should also consider using continuous integration, which involves the automatic building and testing of
an application after a change occurs to the source code. This method traps errors sooner in the
development life cycle and can greatly improve efficiency and reduce costs.

Interface modernization

Enterprise Developer enables you to use Visual Studio's built-in design tools to create more intuitive user
interfaces. By wrapping existing procedural COBOL in an wrapper class you can integrate your code into
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Windows Forms (WinForms) and Windows Presentation Foundation (WPF) technology, and WebForms for
ASP.NET browser-based applications.

Multi-user applications

Enterprise Developer includes a Run Unit API to enable multiple users to simultaneously use an application
based on COBOL code that was designed originally for a single user.

Developing Web-based applications

You can use Enterprise Developer to migrate existing, core applications to a service oriented architecture
as Web services, and deploy them using Micro Focus COBOL Server and Enterprise Server, so that you
can develop COBOL-based software components to be invoked across the Web.

You can do this by creating an Enterprise Server application

Developing .NET applications

Both new and existing COBOL can be compiled as .NET code. This enables you to:

• Reuse existing COBOL business logic and data access across the .NET environment
• Access .NET Framework classes and features from COBOL applications including Windows Forms and

Web Forms
• Create and extend composite applications consisting of COBOL, C#, VB.NET, C++ and ASP.NET
• Reuse and extend Open ESQL applications

Both procedural and native OO COBOL are supported within the .NET framework. Native OO COBOL
classes can inherit classes written in other Microsoft .NET languages and vice versa.

The .NET COBOL syntax includes many extensions to the COBOL language to support .NET features; for
example, the TRY ... CATCH syntax to enable exception handling in COBOL.

There are also certain directives that help integrate your .NET COBOL with other languages in the .NET
environment. For example, you can now expose the Linkage section and entry points in your COBOL to
other managed languages by compiling with the ILSMARTLINKAGE directive.

Modernizing Dialog System applications

Enterprise Developer provides the following support for Dialog System applications:

• Dialog System run-time system and run-time components.
• Panels V2.
• Dialog System painter.
• GUI class library and OLE class library. These libraries are needed if you migrate an existing Dialog

System application that was extended using those libraries.

Projects for building the GUI and OLE class libraries from source are also supplied. Additionally, a
project file for the Base class library was added in Enterprise Developer 2.0.

• Visual Studio plug-in to associate screensets in Visual Studio with Dialog System. Double-clicking a
screenset in Solution Explorer in Enterprise Developer starts the Dialog System painter.

• Sample applications demonstrating a range of modernization techniques.
• Supporting documentation in this Help explaining the significant elements of the sample code.

You can modernize Dialog System applications within Enterprise Developer. You migrate an application to
Enterprise Developer and from there you can run the application without change, or modernize it over time.

Modernization techniques include:

• A Windows Forms form replacing a Dialog System dialog, where the form can contain .NET controls.
See the Customer + .NET WinForm sample CustomerWinForm.sln.

• A Windows Forms control wrapped as an ActiveX control and used on a Dialog System dialog. See the
Customer + .NET GridView User Control sample custgrid.sln.
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• A WPF user control hosted by a Windows Forms user control, which is then exposed as ActiveX ready
for use by Dialog System. See the Customer + .NET WPF GridView User Control sample
CustGridWPF.sln

• A .NET code application interacting with Dialog System as native COBOL .dll. See the .NET COBOL
Customer sample ManagedCustomer.sln.

Data File Tools

Enterprise Developer comes with two versions of the Data File Tools utility: Data File Tools and Classic
Data File Tools.

The Classic Data File Tools is the utility that was previously available in Net Express. It includes the Data
File Converter, Data File Editor, IMS Database Editor, Segment Layout Editor and the Record Layout
Editor. This utility is only available on Windows.

Data File Tools is a new version of the utility and comprises the Data File Editor and the Structure File
Editor. This utility is available on both Windows and UNIX.

Procedural COBOL Compared with JVM COBOL
Note: Enterprise Developer for Eclipse supports JVM COBOL. To develop applications for .NET
COBOL, install one of our Enterprise Developer for Visual Studio products.

Procedural COBOL is regular COBOL without any of the new syntax that has been added for .NET and
JVM. Procedural COBOL is still actively supported today and is being enhanced. Since the days of Net
Express, Server Express, and Mainframe Express, it now supports inline local declarations (as in
DECLARE). It also supports new syntax such as XML PARSE, JSON GENERATE, UTF-8, and more.

You can compile to native or (in most cases) JVM COBOL. The core COBOL syntax is supported in JVM
COBOL. However, there are some features that are not supported (for example Panels V2, Dialog System
and ACUCOBOL-GT). This means that you can take most existing COBOL applications and recompile to
create JVM COBOL applications.

JVM COBOL

JVM COBOL is COBOL with extensions to support the JVM. It offers OO syntax support and syntax to
allow access to the available class libraries.

When you compile JVM COBOL, the compiler generates code: .class or .jar for JVM that runs on the
Java Virtual Machine.

JVM COBOL and Native COBOL

You can compile your COBOL program to JVM COBOL code using the jvmgen compiler directive. From
within the IDE this happens automatically if you are using a JVM COBOL project.

The compiler has now created an intermediate language (JVM byte code .class/.jar).

COBOL and all other JVM languages (for example Java, JRuby and Jyphon) compile to this format, which
makes mixed language applications easy to write.

You can also create native code applications.In Eclipse, the default COBOL project compiles to native
code.

The compiler generates .exe/.dlls as the result of a native compilation.

The native COBOL application has to call the appropriate management services available for the operating
system, whereas a managed application can take advantage of the management services provided by the
run time such as exception handling, garbage collection, and thread management.
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Run Time

The JVM byte code (.class/.jar files) can be deployed to a Java Virtual Machine for execution.

The JVM's just-in-time (JIT) compiler compiles the byte code into code native to the operating system. The
JVM provides additional services including memory management, exception handling, garbage collection
and thread management.

Developing Native and JVM COBOL Applications

You use the IDE to develop, compile and debug both native and JVM COBOL applications. You can write
new COBOL code or you can recompile existing COBOL applications to native or JVM COBOL code,
potentially without any code changes.

You can deploy and further debug the application under the run-time system provided by Enterprise Server.

JVM COBOL applications are deployed to a Java Virtual Machine for execution.
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